PLEASE CAREFULLY READ THIS LICENSE AGREEMENT BEFORE INSTALLING THE SOFTWARE. BY INSTALLING THE SOFTWARE YOU AGREE TO THE TERMS OF THIS LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH THE TERMS OF THIS LICENSE AGREEMENT, YOU MAY OBTAIN A FULL REFUND OF YOUR PURCHASE PRICE BY RETURNING THE SOFTWARE, THE USER GUIDE AND ALL PACKAGING AND RELATED MATERIALS, TOGETHER WITH YOUR DATED PROOF OF PURCHASE, WITHIN FIVE DAYS AFTER YOUR DATE OF PURCHASE TO THE PARTY FROM WHOM YOU PURCHASED THIS SOFTWARE.

LICENSE AGREEMENT

1 License. Principia® Products a division of Gravic, Inc. ("Principia") grants to you a non-exclusive license of this copy of the Remark Office OMR® Software ("Software") and User's Guide and related materials ("Documentation") subject to the following conditions. This License continues until any violation by you of any of the following conditions, in which event this License will automatically terminate without notice from Principia, and you will return to Principia or destroy all copies of the Software and Documentation. While you own the physical disks and materials on which the Software and Documentation are located, Principia retains exclusive copyright, title and ownership to and the right to periodically modify the Software and Documentation. You agree to take all reasonable actions to protect the confidentiality and Principia's ownership of the Software and Documentation, even after termination of this license.

2 Permitted Uses. You may:

- Use the Software on a single terminal connected to a single computer at a single location.
- Use the Software and Documentation for your own personal or business needs.
- Make one backup copy of the Software (for your own protection) that includes Principia's copyright notice.
- Transfer the Software to a single hard disk drive or other permanent storage device for your own use.
- Allow any one employee at any one time to use the Software and Documentation in your business.
- Transfer all of the Software and Documentation (including all updates and all disks) to another individual or entity, provided you retain no copies and the other party registers in advance with Principia as a user subject to terms of this License Agreement.
• Use the disks for the software as provided above.

3 Prohibitions. You may not:

• Modify, adapt or alter the Software or Documentation.

• Reverse engineer, disassemble, decompile, create derivative works or merge the Software or Documentation into another software product.

• Translate the Software or Documentation into another language or format.

• Operate the Software at any one time on more than one computer or allow use at any one time by more than one individual.

• Make the Software or Documentation available to anyone other than an employee as provided under Permitted Uses.

• Copy the Software or Documentation except to make one backup copy of the Software and to transfer the Software to a single hard disk drive or other permanent storage device.

• License, sublicense, sell, transfer, distribute, publish, rent, lease, lend, electronically transfer or communicate, use in a network, timesharing arrangement, interactive cable television, computer service business, multiple central processing unit or multiple user arrangement or otherwise make available or grant rights in the Software or Documentation, except as expressly provided under Permitted Uses.

• Remove, alter or obstruct Principia's copyright notices or trademarks on the Software and Documentation.

• Transfer the Software or Documentation in violation of this License Agreement or applicable laws.

• Use any trade secrets or proprietary information of Principia contained in the Software or Documentation, except for the Permitted Uses set forth above.

4 Limited Warranty. For a period of 90 days after your purchase of this License, Principia warrants that the Software disks and the Documentation materials will be free from material physical defects under normal use, and that the Software will perform in substantial conformity with the Documentation. Principia does not warrant that the Software or Documentation is error-free or that any error or non-conformity can be remedied. THE ABOVE WARRANTIES ARE EXCLUSIVE. PRINCIPIA MAKES NO OTHER WARRANTIES, ORAL OR WRITTEN, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, CONCERNING THE SOFTWARE OR DOCUMENTATION. ANY WARRANTIES
IMPLIED BY LAW SHALL BE LIMITED TO A PERIOD OF 90 DAYS AFTER PURCHASE OF THIS LICENSE. THIS LIMITED WARRANTY IS VOID IN THE EVENT OF ANY VIOLATION OF THIS LICENSE AGREEMENT OR ACCIDENT, ABUSE OR MISUSE OF THE SOFTWARE.

5 Remedies. In the event of any failure of warranty as provided above within 90 days after your purchase of this license, Principia without charge will replace any Software disk or Documentation materials having a material physical defect or use its best efforts to correct any substantial non-conformity of the Software with the Documentation, or at Principia's option, refund the purchase price for the Software and Documentation. To receive the benefit of these warranties, you must submit dated proof of purchase and the defective items to Principia with a description of the defect, and you must register your product with Principia. THE ABOVE REMEDIES ARE EXCLUSIVE. IN NO EVENT SHALL PRINCIPIA BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING CLAIMS FOR LOSS OF DATA, USE OR REVENUES, WHETHER ACTION IS BASED ON TORT, CONTRACT, STRICT LIABILITY, OR ANY OTHER THEORY, EVEN IF PRINCIPIA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPIA'S AGGREGATE LIABILITY EXCEED THE PURCHASE PRICE FOR THIS COPY OF THE SOFTWARE AND DOCUMENTATION.

6 Other Rights. The above warranties give you specific legal rights, and you may have other rights that vary from state to state. Some states do not allow the exclusion or limitation of duration of implied warranties or the exclusion of liability for incidental or consequential damages, so some of the above exclusions and limitations may not apply to you.

7 Registration. To receive the benefit of Principia's warranty and user announcement programs, you must register your product with Principia to confirm your agreement with the terms of this License Agreement.

8 U.S. Government Restricted Rights. The Software and Documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c) (1)(ii) of The Rights in Technical Data and Computer Software clause at 52.227-7013. Contractor/manufacturer is Principia Products division of Gravic, Inc. 301 Lindenwood Drive, Suite 100, Malvern, PA 19355 USA.

9 Governing Law. This Agreement is governed by the laws of the Commonwealth of Pennsylvania.

10 Entire Agreement. This License Agreement constitutes the complete agreement between you and Principia regarding the Software and Documentation. No other information, whether supplied by Principia or its
dealers, distributors or representatives, may be relied upon, and any such information is not a part of our agreement regarding the Software and Documentation. This License Agreement can be modified, supplemented or amended only by a written instrument signed by you and Principia. If any provision of this License Agreement is unenforceable or unlawful, the remaining provisions shall continue to be valid and enforceable.

Should you have any questions concerning this Agreement, or if you wish to contact Principia Products for any reason, please write: Principia Products division of Gravic, Inc., 301 Lindenwood Drive, Suite 100, Malvern, PA 19355 USA.
Disclaimer
The information contained in this document is subject to change without notice and should not be construed as a commitment by Principia Products, who assumes no responsibility for any errors or omissions. Principia Products reserves the right to revise this document and to make changes to the products described herein for the purpose of product improvement at any time, without obligation to notify any person of such revisions or changes.

Notice
The information contained in this document is the exclusive property of Principia Products, a division of Gravic, Inc. This work is protected under United States Copyright Law and other international copyright treaties and conventions. No part of this work may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, or by any information storage or retrieval system, except as expressly permitted in writing by Principia Products, a division of Gravic, Inc., 301 Lindenwood Drive, Suite 100, Malvern, PA USA 19355-1758 USA, Attention: Product Manager.

Trademarks
Remark Office OMR, Remark Quick Stats, Remark Web Survey and Principia are registered trademarks of Principia Products, a division of Gravic, Inc. All other products mentioned are trademarks of their respective holders.

Copyright
Copyright © 2005 Principia Products, a division of Gravic, Inc. All Rights Reserved.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LICENSE AGREEMENT</td>
<td>ii</td>
</tr>
<tr>
<td>Disclaimer</td>
<td>vi</td>
</tr>
<tr>
<td>Notice</td>
<td>vi</td>
</tr>
<tr>
<td>Trademarks</td>
<td>vi</td>
</tr>
<tr>
<td>Copyright</td>
<td>vi</td>
</tr>
<tr>
<td><strong>Contents</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Remark Office OMR Overview</strong></td>
<td>9</td>
</tr>
<tr>
<td>1.1 What is Included with your Software</td>
<td>10</td>
</tr>
<tr>
<td>1.2 New Features in this Version</td>
<td>11</td>
</tr>
<tr>
<td>1.3 Technical Support</td>
<td>14</td>
</tr>
<tr>
<td><strong>Installing Remark Office OMR</strong></td>
<td>15</td>
</tr>
<tr>
<td>2.1 Overview</td>
<td>15</td>
</tr>
<tr>
<td>2.2 System Requirements</td>
<td>15</td>
</tr>
<tr>
<td>2.3 Installing the Software</td>
<td>16</td>
</tr>
<tr>
<td>2.4 Uninstalling the Software</td>
<td>17</td>
</tr>
<tr>
<td>2.5 Starting and Exiting Remark Office OMR</td>
<td>17</td>
</tr>
<tr>
<td><strong>Navigating Remark Office OMR</strong></td>
<td>19</td>
</tr>
<tr>
<td>3.1 Overview</td>
<td>19</td>
</tr>
<tr>
<td>3.2 Remark Office OMR Components</td>
<td>19</td>
</tr>
<tr>
<td>3.3 Navigation Tools</td>
<td>20</td>
</tr>
<tr>
<td>3.4 Using the Mouse and Keyboard</td>
<td>20</td>
</tr>
<tr>
<td>3.4.1 Using the Mouse</td>
<td>20</td>
</tr>
<tr>
<td>3.4.2 Using the Keyboard</td>
<td>21</td>
</tr>
<tr>
<td>3.4.3 Using Keyboard Shortcuts</td>
<td>21</td>
</tr>
<tr>
<td>3.4.4 Scrolling</td>
<td>21</td>
</tr>
<tr>
<td>3.5 Menu Items</td>
<td>22</td>
</tr>
<tr>
<td>3.5.1 File Menu</td>
<td>22</td>
</tr>
<tr>
<td>3.5.2 Edit Menu</td>
<td>25</td>
</tr>
<tr>
<td>3.5.3 View Menu</td>
<td>28</td>
</tr>
<tr>
<td>3.5.4 Tools Menu</td>
<td>29</td>
</tr>
<tr>
<td>3.5.5 Page and Region Menus</td>
<td>32</td>
</tr>
</tbody>
</table>
6.1 Overview ............................................................... 97
6.2 Finding an Application for Designing Forms ................. 98
6.3 Mark Selection ...................................................... 99
6.4 Form Spacing ....................................................... 100
6.5 Grouping Questions ............................................... 100
6.6 Shading ............................................................. 101
6.7 Margins ............................................................. 102
6.8 Barcodes ............................................................ 102
6.9 Paper ................................................................. 103
6.10 Form Duplication .................................................. 104
6.11 Form Testing ....................................................... 105
6.12 Form Review Service ............................................ 105

Using the Template Editor .............................................. 107
7.1 Overview ............................................................... 107
7.2 Creating Form Templates ......................................... 108
  7.2.1 Understanding the Template Editor Interface ........... 108
  7.2.2 Beginning the Form Template .............................. 109
  7.2.3 Creating Regions ............................................ 112
  7.2.4 Creating an OMR Region .................................... 114
  7.2.4.a OMR Region Types ....................................... 114
  7.2.4.b Region Orientation ....................................... 120
  7.2.5 Defining the OMR Region .................................. 121
  7.2.6 Linking OMR Regions ...................................... 125
  7.2.7 OMR Region Colors ......................................... 127
  7.2.8 Creating an Image Region .................................. 128
  7.2.9 Barcode Regions ............................................. 132
7.3 Advanced Region Options ......................................... 134
  7.3.1 Region Item Properties ...................................... 134
  7.3.1.a Test Settings ............................................. 134
  7.3.1.b Survey Settings ......................................... 136
  7.3.1.c Analysis Respondent ID .................................. 137
  7.3.1.d Recognition Threshold ................................... 138
  7.3.1.e Blank and Multiple Exception Handling ............... 139
  7.3.1.f Required Items .......................................... 141
  7.3.2 Question Text and Names .................................. 142
  7.3.2.a Question Text ............................................ 142
  7.3.2.b Question Names .......................................... 143
  7.3.3 Tracking ..................................................... 145
  7.3.3.a Setting up an Auto Form ID region ...................... 145
  7.3.3.b Setting up a Page ID region ............................. 147
  7.3.3.c Setting up a Respondent Tracker region ............... 148
  7.3.4 Database Lookup .......................................... 149
7.4 Additional Template Editor Features ........................................ 152
  7.4.1 Copy/Paste ........................................................... 152
  7.4.2 Copy Special/Paste Special ...................................... 153
  7.4.3 Drag/Drop ........................................................... 154
  7.4.4 Deleting Regions .................................................. 155
  7.4.5 Undo/Redo .......................................................... 155
  7.4.6 Adjusting Region Borders ...................................... 156
  7.4.7 Region Positioning .............................................. 156
  7.4.8 Reset Images ..................................................... 157
  7.4.9 Auto Align ........................................................ 159
  7.4.10 Spell Check ...................................................... 160
  7.4.11 Response Scales ............................................... 161
  7.4.12 Zoom ............................................................. 162
  7.4.13 File Properties ................................................ 162
  7.5 Saving a Form Template ............................................ 163
  7.6 Editing an Existing Form Template .................................. 163
    7.6.1 Editing OMR Regions ....................................... 165
  7.7 Template Editor Preferences ...................................... 167
    7.7.1 General Preferences ....................................... 167
    7.7.2 OMR Region Preferences ................................. 169
    7.7.3 Image Region Preferences ............................... 173
    7.7.4 Barcode Region Preferences ............................ 175

Processing Forms ............................................................. 177
  8.1 Overview .................................................................... 177
  8.2 Opening a Form Template .......................................... 177
  8.3 The Remark Office OMR Read Wizard .............................. 179
    8.3.1 Scanning Forms with the Read Wizard .................. 179
      8.3.1.a Scanning Using Default Settings (Easy Scan) .... 183
    8.3.2 Processing Image Files with the Read Wizard ......... 184
  8.4 Reviewing Exceptions .............................................. 186
    8.4.1 Reviewing Exceptions by Modifying Individual Cells 188
    8.4.2 Using Review Exceptions ................................... 189
      8.4.2.a Using the Review Exceptions Window ............... 192
  8.5 Using Collate Mode (Scanning Double Sided Forms with 194
    a Single Side Only Scanner) .................................... 194
  8.6 Overwriting Data Records ........................................ 196
  8.7 Using Form, Page and Respondent Detection .................. 197
    8.7.1 Auto Form ID ................................................ 197
    8.7.2 Auto Page ID ............................................... 199
    8.7.3 Respondent Tracker ...................................... 200
    8.7.4 Reviewing Unrecognized Images ......................... 202
    8.7.5 Using the Unrecognized Images Utility ................ 204
A.7 Analysis

**Understanding File Formats**

B.1 Overview 
B.2 Remark File Format (RMK) 
B.3 Remark Office Archive File Format (ROA) 
B.4 Access Formats (MDB) 
B.5 Excel Formats (XLS) 
B.6 Questionmark Format (QSF) 
B.7 SPSS File Format (SAV) 
B.8 Survey Pro File Format (SRV) 
B.9 Survey Pro STL File Format (STL, ST3) 
B.10 ASCII File Formats (ASC) 
B.11 Spreadsheet File Formats (TXT) 
B.12 The Survey System File Format (DAT, CRS) 
B.13 dBase Formats (DBF) 
B.14 Paradox Formats (DB) 
B.15 Lotus Formats (WKS, WK1, WK3, WK4) 
B.16 LXR Test Format (MRG) 
B.17 Report Format (RPT) 
B.18 Data Interchange Format (DIF) 
B.19 CCI Assessment Format (DAT) 
B.20 XML Format (XML) 
B.21 HTML Format (HTM, HTML) 
B.22 ODBC 
B.23 Custom (TXT, ASC)

**Remark Office OMR Windows**

C.1 Overview 
C.2 The Remark Office OMR Template Editor 
C.2.1 New Form Template Properties 
C.2.2 Create Page Elements 
C.2.3 Template Editor Main Window 
C.2.4 OMR Region Properties Window 
C.2.5 Barcode Region Properties Window 
C.2.6 Image Region Properties Window 
C.2.7 Region Item Properties Window 
C.2.8 Question Text and Names 
C.2.9 Tracking 
C.2.10 Database Lookup 
C.2.11 Reset Images 
C.2.12 Template Editor Preferences – General 
C.2.13 Template Editor Preferences – OMR Regions
Remark Office OMR Overview

Chapter 1

Remark Office OMR is a software package designed to collect data from marks (bubbles, checkboxes) and barcodes on plain paper forms. The software works in conjunction with an image scanner to collect the data. The software then analyzes that data or allows you to export it to various file formats.

The following overview provides the basic steps to using the software:

- Create a scannable form in the software package of your choice: word processing, survey design, etc. Remark Office OMR can read marks (bubbles, checkboxes, etc.) and barcodes. You are allowed a great deal of flexibility in the design process because you do not need special marks or drop-out inks, nor do your respondents need to use a number 2 pencil to fill in the forms. Because Remark Office OMR works with forms that you create, Principia Products provides form design guidelines to help you get the best results possible. Please refer to Chapter 6 for form creation guidelines and tips.

- Use the Template Editor portion of the Remark Office OMR software to create a form template definition. To create the form template, scan a blank copy of the form into the software and use the mouse to drag boxes around the areas you want recognized. You then provide the software with information about the area, including what type of data to output.

- Process filled-in forms using a scanner or saved image files. Remark Office OMR displays the data in a spreadsheet style grid based on the form template you created. Each row of this grid corresponds to one scanned form in its entirety and each column corresponds to one question or variable on the form.

- Correct any exception cases. Remark Office OMR denotes exceptions with color-coded flags and by providing a descriptive word in the answer cell (e.g., “BLANK” for a question that was not answered). The software provides a Review Exceptions function to correct exception cases as you process the forms or after the forms are processed. Remark Office OMR assists you in the data cleaning process by storing an image of each
form as it is being scanned. The software then uses these images to help automate the correction of output errors and exception cases without needing to locate the appropriate paper form.

- Save the data to one of over thirty output formats, including Access, Excel, SPSS, Survey Pro, The Survey System, dBase, etc. Or, use the software’s built-in analytical tools to tabulate your survey or grade your test. If you use the software’s analysis, Remark Quick Stats®, you can take advantage of powerful grade results, crosstabs, graphs and charts and more.

Remark Office OMR works with image scanners, which are the type of scanners that can also be used for scanning pictures or pages of text and are readily available from your local computer dealer or via mail order and online companies. See Chapter 4 for more specific information about scanners and their relationship to Remark Office OMR.

This User’s Guide is designed to provide information about all of the features of the software as well as guidelines for using the software. Tutorials are provided to help you get started. Software features are not only described, but you are also given steps for how to use the features. Items taken directly from the software, such as menus, buttons and dialogs, are in bold format whenever they are used in an instructional context.

You are encouraged to read the following chapters and perform the tutorials before designing your own forms or using the software with your own forms. This User’s Guide contains answers to many of the common questions and/or problems users potentially face, and includes “Understanding Error Messages” and “Tips and Helpful Hints” appendices to help you solve and avert problems.

### 1.1 What is Included with your Software

Each purchase of Remark Office OMR includes the following:

- One copy of the software on CD-ROM
- One printed user’s guide
- One Remark Quick Stats user’s guide in PDF format (installs with the software)
- 30 days of free technical support from the date of purchase (see Section 1.2 for further details regarding technical support)
1.2 New Features in this Version

Remark Office OMR 6 has many new features. The following list provides an overview of what is new in this version. Please see the specific sections of this user’s guide corresponding to the listed feature for complete details.

- **New Interface:** The interface for the software has been completely updated. In addition to the new look and feel, you will find a task pane on the left side of every window to help you navigate the software. This task pane updates automatically based on the last step performed to help you understand your possible next steps. The task pane can be turned on or off via the View menu.

- **New Terminology:** What was once a "field" in your template is now called a "region." "Templates" are now called "form templates" to help distinguish them from analysis grading templates in version 5. "Joined fields" in a form template are now called "linked regions." Finally, "Review Mode," the process of reviewing exception cases, is now called "Review Exceptions." All of these new names more accurately describe the feature or function being performed.

- **New Template Editor Look:** As you create regions in your form template, you will see that they have a solid color. OMR regions are green, barcode regions are orange and image regions are blue. The solid color should help with seeing exactly where a region is positioned as well as when moving regions by dragging them with a mouse. A solid red OMR region still indicates a problem, in which case you can hover your mouse over the region to see a description of the problem. In addition, the corresponding node in the tree view will be colored red and italicized to alert you to a problem.

- **Multiple Question OMR Regions:** A single OMR region can contain one or more questions. You can now access the entire region's properties or just the properties of individual questions within the region. This feature allows you to create one OMR region around question groups, yet change the properties for single questions within that region (e.g., if one out of ten questions in a region allows more than one response, you can create an OMR region around all ten questions, but change the multiple responses allowed property for a single question within the region).

- **Database Verification:** Database Verification has been changed to Database Lookup. With this enhanced feature, you can still verify that data exist in an external database and lookup and replace data. However, you can now lookup an entry once and replace it multiple times (e.g., lookup a student ID number and replace it with First Name,
Last Name, etc.). You can also designate the replace options to be respondent identifiers on your reports.

- **Auto Form ID, Auto Page ID and Respondent Tracker:** In addition to the Auto Form ID feature, where you can process various form types and have the software automatically match a form to its corresponding form template, we have added the ability to automatically match pages to a form and keep respondent's data together. Through the use of form, page and respondent identifiers, you can process various forms, pages and respondent's data together and the software will figure out the form, page and respondent to which the data belong.

- **Reset Images:** If you have an existing form template that needs new images due to a minor change in the form, you can use the Reset Images feature. This feature provides a quick way to refresh your form template images without creating a new form template from scratch.

- **Read Wizard:** There is a new Read Wizard that controls form processing. When scanning forms, you no longer have to have an even number of pages when scanning double sided forms. In addition, images for each scanned form are automatically stored and each image has a time and date stamp in its name so that you don't have to worry about overwriting existing images when you scan a new batch of forms.

- **Updated Recognition:** We have updated our recognition to improve form processing accuracy.

- **Batch Scanning:** You can now scan batch header forms that contain information about the group of forms you will be processing. The batch header form is scanned first and the information gathered from it is prepended to each data record that follows.

- **Respondent Detection:** If using Database Lookup, you can run a report that shows which of your respondents have been processed, which have not and which have been processed more than one time. Remark Office OMR will look at what is in the data file and compare it against the external database used for Database Lookup.

- **Remark Office Archive Format:** A new Remark Office OMR Archive format is available when saving data. This format packages the form template, data file and stored images from scanning forms into one file. You can then open this file on another system with a Remark Office OMR license and you will have everything you need to process more forms, clean the data or run reports.
• Review Exceptions (formerly Review Mode): Review Exceptions has been updated with a cleaner interface and more searching options. You can even play sounds to alert you when an exception is found.

• PDF Support: Remark Office OMR can now read PDF files and save scanned images as PDF files. Note that use of this feature is very memory intensive and should only be used on systems with robust processors and memory.

• New Remark Quick Stats: Remark Quick Stats has been completely overhauled. You will still see your favorite reports, but with a new look and feel, plus some new reports. A new comparative report allows you to look at cross-sections of your data on a single report.
  o Grading: The Grade Wizard now supports the following features:
    - Benchmark scores to compare student progress to established benchmarks,
    - Multiple test version (answer key) scoring,
    - Easier to use learning objective measurement screen, including benchmarks for each objective and a separate grade scale for all of the learning objectives,
    - The ability to change question properties on the fly for one or more questions (e.g., points awarded, respondent identifiers, question text, etc.).
  o Surveys: A new survey wizard supports the following features:
    - Benchmark scores to compare respondents responses to established benchmarks,
    - The ability to group questions together to gain an overall survey analysis as well as a concentrated analysis on specific, related questions. You can also weight individual questions within the group for emphasis on those questions that are most important to you.

For those of you who have a favorite report in your current version of Remark Quick Stats (now called Legacy Analysis), you can still use this version, too. Legacy Analysis can be turned on in the software preferences, via the Tools menu.

All of the new features in this version are too numerous to mention. We have highlighted some of the bigger features here. Take some time to review this manual and the software to see all of the new enhancements.
1.3 Technical Support

Remark Office OMR includes a printed user's guide and online help. You will also find a knowledgebase on the Principia Products web site (see the back of this user's guide for the web address), where you will find the answers to frequently asked questions. In addition, there are two tutorials included in this user's guide, which we strongly recommend you perform before using the software with your forms. Most questions can be answered by consulting these reference materials.

If a problem with Remark Office OMR arises that cannot be solved using the materials above, customers may contact Principia Products' technical support.

Note: If you are past your 30 days of free technical support (starts from date of purchase), Principia Products makes support available only to registered users of the Remark Office OMR software who hold a valid support agreement. For more information about purchasing a support agreement, please go to our web site (address provided on back of this user's guide).

Before contacting technical support, please gather the following information:

- The version and serial number of the Remark Office OMR software (you can find this information by selecting the Help menu and then clicking About)
- The steps required to reproduce the problem
- The type, model and configuration of your computer and scanner, if applicable

Principia Products’ technical support team provides product support to customers with valid support agreements via email, phone and fax. Please see the back of this user's guide for current contact information and hours. In addition, you will find free support tools on our web site.
Installing Remark Office OMR

Chapter 2

2.1 Overview

This chapter provides system requirements, software installation instructions and starting and exiting procedures. Please consult your scanner’s installation guide for specific scanner installation instructions.

2.2 System Requirements

The following section provides the system configuration for running Remark Office OMR.

- Personal computer with a 400-MHz or faster processor
- 512 MB RAM
  - Important Note: Analysis reports require memory to run. Lengthy or graphic-intensive reports may take longer to run; you may need additional memory to run these reports.
- 250 MB free hard disk space to install software
- 1 GB free hard disk space recommended to use software
- Screen/monitor resolution of 1024x768 or higher and at least 16-bit color (32-bit color recommended)
- Mouse
- CD-ROM drive (for installation purposes)
- Supported scanner (recommended)
• Windows-supported printer (optional)

2.3 Installing the Software

You must run the Remark Office OMR installation program in order to use the software. Install Remark Office OMR on a fixed drive with at least 1GB of free disk space. To scan directly into Remark Office OMR, you must install the software on the same system to which the scanner is attached.

If you are upgrading to Remark Office OMR 6 from version 5 or earlier, do not install the software in the same directory as your previous version. Once the installation is complete, you can copy information from your old installation that you want to use in the new version (e.g., form templates, data, etc.).

**Note:** Form template files are upward compatible only. Remark Office OMR 6 will convert form templates from previous versions of the software automatically. However, once a form template has been converted, it cannot be opened in a previous version of the software. Always make copies of form templates before converting them.

**To install Remark Office OMR**

The Remark Office OMR CD-ROM contains an auto play feature so that when it is inserted into your CD-ROM drive, the installation will begin automatically. This feature is only available if your CD-ROM drive’s auto play feature is enabled. If the software installation does not automatically start, use the following instructions to install the software.

1. Insert the installation CD-ROM into your CD-ROM drive.
2. Select **Start** on the taskbar, click **Settings** and then click **Control Panel**.
3. Double click **Add or Remove Programs**.
4. Click **Install** and then follow the on-screen instructions to display the **Remark Office OMR Installation** window.
5. Click the button for **Install Remark Office OMR** to begin the installation.
6. Follow the on-screen instructions to complete the installation. You will be prompted for a **serial number** and **authentication code**. You can find this information on a sticker on the back of your user’s guide.
Some operating systems may ask whether you wish to install the software for all users or only the person currently logged into the computer. If multiple people use this computer and will need to use Remark Office OMR on this computer, you should choose the option for "all users."

2.4 Uninstalling the Software

If you need to uninstall the software for any reason, use the Windows Control Panel|Add or Remove Programs function.

To uninstall Remark Office OMR
1. Select the Start menu, click Settings and then click Control Panel.
   Note: Accessing the control panel may vary slightly based on the version of Windows you are running.
2. Select the Add or Remove Programs option.
3. Select Remark Office OMR 6 from the list and then click Remove.
4. Follow the on-screen instructions to complete the de-installation.
   Note: When uninstalling the software, all program and default files will be removed. Files that you have created will remain on the system.

2.5 Starting and Exiting Remark Office OMR

Use the following procedures to start and exit Remark Office OMR:

To start Remark Office OMR
1. If you chose to install a shortcut on your desktop during installation, double click this shortcut. Otherwise, select Start from the taskbar.
2. Highlight Programs, highlight Remark Office OMR 6 and then click Remark Office OMR Data Center. To go directly to the Template Editor, click Remark Office OMR Template Editor.
The About Remark Office OMR window displays. This informational window remains for a few seconds while the program loads. When complete, the main Remark Office OMR window displays.

To exit Remark Office OMR
1. Select the File menu and then click Exit, click the X in the upper right-hand corner of the main window or double click the control box in the upper left-hand corner of the main Remark Office OMR window.
Navigating Remark Office OMR

Chapter 3

3.1 Overview

This chapter provides an overview of how to get around in Remark Office OMR, including the menu items and tools available in the Remark Office OMR software. Wizards and other navigation tools are also described. Specific functions are explained in more detail in the appropriate sections of this user’s guide.

3.2 Remark Office OMR Components

The Remark Office OMR software interacts with you through three main components, which can display multiple windows. You may display many windows simultaneously, allowing you to use multiple Remark Office OMR documents at one time.

Remark Office OMR contains a Template Editor component, a Data Center component and a Remark Quick Stats component. The Template Editor is used to create form templates for each form you want to process in the software. The Data Center is used to process forms, clean data and save/export data. Remark Quick Stats is used to grade or tabulate processed data.

A shaded title bar designates the active or current window. Minimize documents on the desktop by clicking the minimize button located in the upper, right-hand corner of the window. Double clicking the minimized icon causes the document to become the current window.

The software contains a menu bar, a toolbar and a status bar. The toolbar displays tools that, when selected, perform the function of an option under a
menu pull-down item. Shifting between different types of windows causes the menu bar and the toolbar to change. Tools and options that lack functionality in a particular window do not display. The status bar displays information about the active document or the selected command.

### 3.3 Navigation Tools

Remark Office OMR includes many wizards and navigation shortcuts to help you move through the software. The left portion of each component contains a task pane that acts as a guide to help you decide what you would like to do. Once you perform a function, this task pane will automatically update with new options based on the last function you performed. You may use this tool as a way to understand what options are available to you at any time. Most options displayed in the task pane are also available from the menus or tool bar. If you would prefer not to use the task pane, you may close the window by selecting the **View** menu and disabling the option titled **Task Pane**.

In some windows you will also notice an information button ![Information Button]. When you see this button, hover the mouse over the button to view details about the current window, action, etc.

### 3.4 Using the Mouse and Keyboard

This section details the different mouse and keyboard conventions used in the Remark Office OMR software. You can use either the mouse or the keyboard to perform functions within Remark Office OMR. Occasionally, you might find it easier to combine the mouse and keyboard functions.

#### 3.4.1 Using the Mouse

In this User’s Guide, the phrase “the mouse button” refers to the left mouse button, unless otherwise stated. The following table lists the different mouse actions and their meanings:

<table>
<thead>
<tr>
<th>Mouse Action</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Press and release the mouse button</td>
</tr>
<tr>
<td>Double click</td>
<td>Press and release the mouse button twice</td>
</tr>
</tbody>
</table>
## Mouse Action Meaning

<table>
<thead>
<tr>
<th>Mouse Action</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right click</td>
<td>Press and release the right mouse button</td>
</tr>
<tr>
<td>Press</td>
<td>Press and hold the mouse button</td>
</tr>
<tr>
<td>Drag</td>
<td>Move the mouse while holding down the mouse button</td>
</tr>
</tbody>
</table>

### 3.4.2 Using the Keyboard

You can use the keyboard or the mouse and the keyboard to make selections and perform functions within Remark Office OMR.

**To use the keyboard to select objects**

1. Press **Tab** to activate the next item in a window.
2. Press **Shift+Tab** to activate the previous item.

### 3.4.3 Using Keyboard Shortcuts

Most menu items and window objects provide "shortcut keys" as an alternative to using the mouse. An underlined letter in the label indicates the shortcut letter for the particular object or menu item.

**To pull down a menu item using keyboard shortcuts**

1. Press **Alt** + the shortcut letter of the menu item shown on the menu bar. (For example, press **Alt+F** to access the **File** menu.)
2. Press the underlined letter of the desired item from the pull-down menu.

Many Remark Office OMR menu pull-down options also employ “hot key” shortcuts (e.g., use **Ctrl+X** for “Cut”).

### 3.4.4 Scrolling

When you select a scrolling list, the Up/Down arrow keys, the Page Up/Page Down keys, and the Home/End keys perform the following actions:

- The arrow keys move the list up or down a line at a time.
- The Page Up/Page Down keys move up or down a “page” (window) of text at a time.
• The Home/End keys move to the top or bottom of a list.

Use scroll bars to view additional items in a list or different parts of a window. The following table explains how to use the mouse within a vertically oriented scroll bar to produce various results:

<table>
<thead>
<tr>
<th>Mouse Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the arrow at the bottom of the scroll bar</td>
<td>Moves your view in the list down one line</td>
</tr>
<tr>
<td>Click the arrow at the top of the scroll bar</td>
<td>Moves your view in the list up one line</td>
</tr>
<tr>
<td>Drag the elevator on the scroll bar</td>
<td>Allows you to see various parts of the window. To drag the elevator, point to the elevator with your mouse, press the mouse button and drag the elevator along the scroll bar</td>
</tr>
<tr>
<td>Click the mouse pointer above the elevator in the scroll bar</td>
<td>Moves the elevator up one section</td>
</tr>
<tr>
<td>Click the mouse pointer below the elevator in the scroll bar</td>
<td>Moves the elevator down one section</td>
</tr>
</tbody>
</table>

3.5 Menu Items

Context-sensitive help is available for all menu items by highlighting the item in question and pressing F1. The following sections provide menu options for the Remark Office OMR Template Editor and Data Center. Menu options for Remark Quick Stats are detailed in the Remark Quick Stats User’s Guide, which you can access under Start|Programs|Remark Office OMR 6|Documentation. Please see the corresponding sections in this user’s guide for complete descriptions of the features that can be accessed from the menus.

3.5.1 File Menu

Use the items in the **File** menu to perform operations on files. The operations include creating, editing, opening, closing, saving, displaying, and printing the data contained in these files. The file types include form template files, data files and analysis files.
### Template Editor:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td>Creates a new form template.</td>
</tr>
<tr>
<td>Open... Template</td>
<td>(Ctrl + T)</td>
<td>Opens an existing form template for editing.</td>
</tr>
<tr>
<td>Save (for form templates)</td>
<td>(Ctrl + S)</td>
<td>Saves the open form template to a new or existing file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clicking the Save button will create a new form template file or save the form template to the current file if one has already been established.</td>
</tr>
<tr>
<td>Save As (for form templates)</td>
<td>(Ctrl + A)</td>
<td>Saves an existing form template file under a new name or allows you to change the path to which the file saves.</td>
</tr>
<tr>
<td>Close</td>
<td>(Ctrl + F4)</td>
<td>Closes the current form template.</td>
</tr>
<tr>
<td>Recent Files</td>
<td></td>
<td>Displays the most recently used files. Click a file to open it.</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td>Displays the properties for the open form template.</td>
</tr>
<tr>
<td>Exit (Alt + F4)</td>
<td></td>
<td>Exits Remark Office OMR.</td>
</tr>
</tbody>
</table>

### Data Center:
<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open... Form Template (Ctrl + T)" /></td>
<td>Open... Form Template (Ctrl + T)</td>
<td>Opens an existing form template for processing forms, opening data and running reports. Multiple form templates can be opened simultaneously, and the same form template can be opened multiple times.</td>
</tr>
<tr>
<td><img src="image" alt="Open... Data (Ctrl + O)" /></td>
<td>Open... Data (Ctrl + O)</td>
<td>Opens an existing data file and displays the data in the current template grid window. Remark Office OMR can read and save data in dozens of different file formats.</td>
</tr>
<tr>
<td><img src="image" alt="Open... Report (Ctrl + R)" /></td>
<td>Open... Report (Ctrl + R)</td>
<td>Opens an existing report file that was saved in Remark Quick Stats.</td>
</tr>
<tr>
<td><img src="image" alt="Edit Form Template (Ctrl + E)" /></td>
<td>Edit Form Template (Ctrl + E)</td>
<td>Launches the Template Editor with the active template automatically open for editing.</td>
</tr>
<tr>
<td><img src="image" alt="Batch Wizard" /></td>
<td>Batch Wizard</td>
<td>Opens the batch wizard so that you can create batch files. Batch files allow you to process a header sheet with identifying information for the forms that will follow.</td>
</tr>
<tr>
<td><img src="image" alt="Save (for data) (Ctrl + S)" /></td>
<td>Save (for data) (Ctrl + S)</td>
<td>Saves data from the grid to a new or existing data file. Clicking the Save button will create a new data file or save the data to the current file if one has already been established.</td>
</tr>
<tr>
<td><img src="image" alt="Save As (for data) (Ctrl + A)" /></td>
<td>Save As (for data) (Ctrl + A)</td>
<td>Saves an existing data file under a new name, allows you to select an output format, or allows you to change the path to which the file saves.</td>
</tr>
<tr>
<td><img src="image" alt="Close (Ctrl + F4)" /></td>
<td>Close (Ctrl + F4)</td>
<td>Closes the current document. The document may be a form template grid window or image window.</td>
</tr>
<tr>
<td><img src="image" alt="Print (Ctrl + P)" /></td>
<td>Print (Ctrl + P)</td>
<td>Prints the contents of the grid, results or image. For results, you can also choose whether to print all sections, the current section or the current page.</td>
</tr>
<tr>
<td><img src="image" alt="Recent Files" /></td>
<td>Recent Files</td>
<td>Displays the most recently used files. Click a file to open it.</td>
</tr>
<tr>
<td><img src="image" alt="Exit (Alt + F4)" /></td>
<td>Exit (Alt + F4)</td>
<td>Exits Remark Office OMR.</td>
</tr>
</tbody>
</table>
3.5.2 Edit Menu

Use the items in the Edit menu to perform common Windows functions on one of the Remark Office OMR documents. The operations include typical clipboard operations, such as copying and pasting information, and several data manipulation operations, such as finding & replacing.

Template Editor:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo (Ctrl + Z)</td>
<td></td>
<td>Undoes the most recent change to the form template.</td>
</tr>
<tr>
<td>Redo (Ctrl + Y)</td>
<td></td>
<td>Redoes the last action to which Undo was applied.</td>
</tr>
<tr>
<td>Cut (Ctrl + X)</td>
<td></td>
<td>Moves a section of text or region from one place to another (or to another document) by cutting it from the original position and pasting it in a new position (paste is a separate command).</td>
</tr>
<tr>
<td>Copy (Ctrl + C)</td>
<td></td>
<td>Allows for easy duplication and movement of information. You can copy a selected portion of text or a region from one part of a document (or a different document altogether), and paste it in a different part of the document.</td>
</tr>
<tr>
<td>Paste Before (Ctrl + B)</td>
<td></td>
<td>Pastes information from the clipboard before the selected node in the tree view.</td>
</tr>
<tr>
<td>Paste After (Ctrl + V)</td>
<td></td>
<td>Pastes information from the clipboard after the selected node in the tree view.</td>
</tr>
<tr>
<td>Copy Special</td>
<td></td>
<td>When copying and pasting between two instances of the Template Editor, use Copy Special to copy a region or regions to the clipboard.</td>
</tr>
</tbody>
</table>
### Tool Menu Pull-Down Item | Function
---|---
Paste Special (Ctrl + U) | When copying and pasting between two instances of the Template Editor, use Paste Special to paste a region or regions from the clipboard. (Note: You must use Copy Special to copy this information to the clipboard.)
Delete (Delete) | Erases the highlighted information. This operation does not use the clipboard, and Remark Office OMR retains no copy of the deleted information (except by Undo).

## Data Center:

### Tool Menu Pull-Down Item | Function
---|---
Cut (Ctrl + X) | Moves a section of text from one place to another (or to another document) by cutting it from the original position and pasting it in a new position (paste is a separate command).
Copy (Ctrl + C) | Allows for easy duplication and movement of information. You can copy a selected portion of text from one part of a document (or a different document altogether), and paste it in a different part of the document.
Paste (Ctrl + V) | Whenever a section of text is copied or cut, Remark Office OMR places the contents on the clipboard. This intermediary holds the information so you can paste it (multiple times if desired) until you place something new on the clipboard (by cutting or copying something else).

Data can be copied from a document of one program and pasted to a document of another as long as the data are compatible.
<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste Special</td>
<td></td>
<td>Allows you to paste information from one cell in the template grid to multiple cells.</td>
</tr>
<tr>
<td>Delete</td>
<td>(Delete)</td>
<td>Erases the highlighted information. This operation does not use the clipboard, and Remark Office OMR retains no copy of the deleted information (except by Undo).</td>
</tr>
<tr>
<td>Insert Rows</td>
<td>(Shift + Insert)</td>
<td>Inserts a row into the template grid based upon the active cell. The row will be added above the row containing the active cell.</td>
</tr>
<tr>
<td>Delete Rows</td>
<td>(Shift + Delete)</td>
<td>Deletes a row in the template grid. The row containing the active cell(s) will be deleted.</td>
</tr>
<tr>
<td>Find</td>
<td>(Ctrl + F)</td>
<td>Displays a window asking for the search text. Remark Office OMR searches forward from the cursor position for the text requested.</td>
</tr>
<tr>
<td>Find Next</td>
<td>(F3)</td>
<td>Searches for the next instance of the previous search. If Find has not yet been chosen, or could not locate the previous search, Find Next disables.</td>
</tr>
<tr>
<td>Replace</td>
<td>(Ctrl + H)</td>
<td>Displays the Replace text window. The search text box contains either the highlighted text or the previous search text, and the replace text contains either the previous replace text or is blank. You can replace all occurrences of the search text by clicking Replace All.</td>
</tr>
<tr>
<td>Select All</td>
<td>(Ctrl + A)</td>
<td>Highlights the entire text document. This is equivalent to clicking the top-left corner of the grid and dragging the mouse to the bottom-right, selecting all cells in the process.</td>
</tr>
<tr>
<td>Sort</td>
<td></td>
<td>Allows the sorting of data in ascending or descending patterns based on particular regions.</td>
</tr>
</tbody>
</table>
3.5.3 View Menu

The View menu allows you to choose which toolbars you would like to be displayed and allows you to customize the current view.

**Template Editor:**

<table>
<thead>
<tr>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Pane</td>
<td>Displays the task pane that is used as a shortcut to perform functions (e.g., open, save, etc.)</td>
</tr>
<tr>
<td>Fit Height</td>
<td>Positions the image portion of the Template Editor so that it fits in the entire window in terms of height.</td>
</tr>
<tr>
<td>Fit Width</td>
<td>Positions the image portion of the Template Editor so that it fits in the entire window in terms of width.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Makes the image portion of the Template Editor window larger.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Makes the image portion of the Template Editor window larger smaller.</td>
</tr>
</tbody>
</table>

**Data Center:**

<table>
<thead>
<tr>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Pane</td>
<td>Displays the task pane that is used as a shortcut to perform functions (e.g., open, save, etc.)</td>
</tr>
<tr>
<td>Image Viewer</td>
<td>Displays the Image Viewer in the Data Center to show images of forms as they are processed or when clicking in</td>
</tr>
</tbody>
</table>
3.5.4 Tools Menu

The items available in the **Tools** menu are the primary Remark Office OMR operations. These items vary slightly from the Template Editor to the Data Center.

**Template Editor:**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset Images</td>
<td></td>
<td>Resets the open form template’s images. This feature will allow you to reacquire images from the scanner or image file and is useful if your form has changed slightly but you have already created a form template.</td>
</tr>
<tr>
<td>Response Scales</td>
<td></td>
<td>Accesses the Scales that have been saved so that you may edit them or create new scales. Scales are used as Labels when creating OMR regions and are the output you will see when processing forms.</td>
</tr>
<tr>
<td>Auto Align Form Template</td>
<td></td>
<td>Remark Office OMR attempts to align regions based on where they were originally created and the current form image. This feature is useful after resetting images. If there are slight differences between the original image and the new image, the regions will be adjusted accordingly. (Note: You should review the form template after aligning to ensure regions are positioned correctly.)</td>
</tr>
<tr>
<td>Perform Spell Check (F7)</td>
<td></td>
<td>Checks the open form template for spelling errors in the region names, labels and question text.</td>
</tr>
<tr>
<td>Scanner Properties (F8)</td>
<td></td>
<td>Accesses the Scanner Properties window so that you setup a scanner or make changes to the current setup.</td>
</tr>
</tbody>
</table>
### Tool Menu Pull-Down Item Function

<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Preferences (F9)</td>
<td>Allows you to modify settings that control the way the Template Editor looks, feels and performs. Use the task pane to perform software customization. Remark Office OMR saves any changes you make and applies them to future actions.</td>
</tr>
</tbody>
</table>

### Data Center Options:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Read Wizard (F5)" /></td>
<td>Read Wizard (F5)</td>
<td>Opens the Read Wizard so that you may read page(s) from a scanner or an image file and place the data into the template grid.</td>
</tr>
<tr>
<td><img src="image" alt="Easy Scan (F12)" /></td>
<td>Easy Scan (F12)</td>
<td>Begins the scanning process based on the last settings used in the Read Wizard. Note that you will not be able to adjust the settings. If you are unsure of the last settings used, you should use the Read Wizard to scan your forms.</td>
</tr>
<tr>
<td><img src="image" alt="Review Exceptions (F4)" /></td>
<td>Review Exceptions (F4)</td>
<td>Searches the open data grid and allows the user to correct exception cases (e.g., blank or multiple responses) and enter image region information.</td>
</tr>
<tr>
<td><img src="image" alt="Review Unrecognized Images" /></td>
<td>Review Unrecognized Images</td>
<td>When processing forms with Auto Form ID, Auto Page ID or Respondent Tracker regions, unrecognized images enter a list for later review. Use this command to review images that Remark Office OMR did not recognize when processing the forms.</td>
</tr>
<tr>
<td>Tool</td>
<td>Menu Pull-Down Item</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Analysis           | Access the grade and survey options in the software:  
|                    | Easy Grade: grades the current data set using the first grid row as the answer key and grading options as defined in the form template. (F6)  
|                    | Grade Wizard: launches the Grade Wizard for customized grading. (Ctrl + W)  
|                    | Easy Survey: tabulates the current data set using tabulation options as defined in the form template. (Ctrl + U)  
|                    | Survey Wizard: launches the Survey Wizard for customized survey tabulation.  
|                    | Analysis Preferences: accesses the Remark Quick Stats preferences to customize report options.                                          |
| View Image         | Opens an image file.                                                                                                                      |
| Automation Wizard  | Launches the Automation Wizard, which allows you to set up executable files that automate basic Remark Office OMR functions.         |
| Respondent Detection | Allows you to determine which respondents in your data have been processed, not been processed or have been processed multiple times. This feature is used in conjunction with the Database Lookup feature. |
| Perform Spell Check (F7) | Checks the selected data file for spelling errors.                                                                                     |
| Scanner Properties (F8) | Accesses the Scanner Properties window so that you setup a scanner or make changes to the current setup.                                      |
| Preferences (F9)   | Allows you to modify settings that control the way the Data Center looks, feels and performs. Use the task pane to perform software customization. Remark Office OMR saves any changes you make and applies them to future actions. |
3.5.5 Page and Region Menus

The **Page** and **Region** menus are available in the Template Editor as you are creating or editing a form template. These menus give you options to add, delete, edit and view the properties of regions in the template. The items change depending on whether you have selected a Page node or a Region node in the tree view.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu (Page or Region)</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page &amp; Region</td>
<td>Insert</td>
<td>Insert</td>
<td>Inserts a page or region before or after the selected node.</td>
</tr>
<tr>
<td>Region</td>
<td>Auto Align Page</td>
<td></td>
<td>Allows you to auto align the selected page to a new image. This feature is useful when you need to rescan the form due to form changes, skew, etc (e.g., when using the Reset Images feature).</td>
</tr>
<tr>
<td>Region</td>
<td>Append Linked Region</td>
<td></td>
<td>Adds a region to another region, linking them into one question. This feature is used for regions that have text or lines separating the answer choices because the OMR box cannot be drawn around all of the marks together.</td>
</tr>
<tr>
<td>Region</td>
<td>Link Regions</td>
<td></td>
<td>Links multiple regions together so that they are considered one question.</td>
</tr>
<tr>
<td>Region</td>
<td>Break Region Link</td>
<td></td>
<td>Separates a linked region into individual regions.</td>
</tr>
<tr>
<td>Page &amp; Region</td>
<td>Properties</td>
<td></td>
<td>Shows the properties for the page or region.</td>
</tr>
</tbody>
</table>

3.5.6 Help Menu

When you have questions about the use of Remark Office OMR, or about a specific menu or command, look here.
Navigating Remark Office OMR

Note: Help is context-sensitive. Press F1 while any Remark Office OMR window is active and help text appropriate to that window displays.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Menu Pull-Down Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Contents</td>
<td>Displays the contents of the Remark Office OMR help file.</td>
</tr>
<tr>
<td></td>
<td>Copyrights</td>
<td>Displays copyright information for Remark Office OMR.</td>
</tr>
<tr>
<td></td>
<td>About</td>
<td>Displays the About Remark Office OMR window, showing information about Principia Products as well as the serial number and current version of the software that is running.</td>
</tr>
</tbody>
</table>

3.6 Accessing the Software Help File

Remark Office OMR includes a help file to provide answers to your questions. Use the following procedures to access help when running Remark Office OMR:

To access online help
1. To view context-sensitive help on the current window, press F1.
2. To view the main help contents window for Remark Office OMR, select the Help menu and then click Contents, or click .
Setting Up Your Scanner

Chapter 4

4.1 Overview

This chapter will provide general information about scanners and how to configure your scanner in Remark Office OMR. You should already have your scanner connected to your computer and the drivers installed that will allow the scanner to work before attempting to use your scanner with Remark Office OMR.

4.2 Scanners- General Information

A scanner is a peripheral device that is attached to a computer to scan paper-based documents, photographs, etc., in order to produce equivalent image file representations. Remark Office OMR works in conjunction with image scanners, which are the type of scanners that can also be used for scanning pictures or pages of text and are readily available from your local computer dealer or via mail order and online companies. Scanners come in many different models and fall into many different price ranges depending on their performance and features. For Remark Office OMR purposes, it is recommended that you use a scanner with a sheetfeeder (ADF - Automatic Document Feeder), which will allow you to scan multiple pages in batches, thus facilitating the data collection process. Principia Products keeps a list of supported scanners on our web site (see the back of this user's guide for web site information). Use this list to verify whether your scanner is likely to be compatible with Remark Office OMR.
4.2.1 Scanner Connections

Scanners are connected to a computer via a cable. Scanners are typically connected to the computer in one of four ways:

- USB Port
- Parallel Port
- SCSI Card
- Video Card

A video connection is not supported in Remark Office OMR. For parallel and USB port connections, you simply connect the scanner’s cable to the appropriate port on the computer. For SCSI connections, you connect the scanner’s cable to a SCSI card that is located inside the computer. Some scanners will come with their own SCSI cards, or the computer may already have one installed. Otherwise, a SCSI card will need to be purchased. Please see your scanner’s installation guide for the specifics on your particular model.

**Note:** Read the scanner manufacturer’s directions BEFORE installing your scanner. You may need to install items in a specific order.

4.2.2 Scanner Drivers

Communication between software and a scanner occurs through a driver. There are several different scanner communications protocols. Remark Office OMR supports the most common protocol: TWAIN. TWAIN is a standard protocol for controlling scanning equipment. With TWAIN, each scanner manufacturer provides a TWAIN compliant driver for their scanners, and each software application includes TWAIN support as part of the software. Software applications supporting the TWAIN protocol can control many different scanners. When using the TWAIN option in Remark Office OMR, you will have the option of using legacy support for older scanner drivers.

**Important Note:** Remark Office OMR will work with legacy ISIS drivers. When you are setting up your scanner, you will notice ISIS listed in the choices. However, we recommend using the TWAIN driver for your scanner. If you have a legacy ISIS driver that you would like to try to use, please see Section 4.3.3 for further information.

Once you have connected your scanner to the computer, install the appropriate drivers and verify that the scanner is functioning properly. Then proceed to the next section: 4.3 Selecting Your Scanner.
Note: Read the scanner manufacturer’s directions BEFORE installing your scanner and drivers. You may need to install items in a specific order.

4.3 Selecting Your Scanner

To use your scanner with the Remark Office OMR software, you must first select your scanner from the list of supported scanners/protocols. Remark Office OMR supports some scanners through both TWAIN and ISIS drivers. In general, try using the TWAIN driver first.

4.3.1 TWAIN Support

TWAIN is a standard for controlling scanning equipment. Most scanners ship with a TWAIN driver. If you are uncertain whether you have a TWAIN driver, check with your scanner manufacturer.

Note: Individual scanner manufacturers write their own scanner drivers. The TWAIN standard leaves some areas unclear/open for interpretation, and as a result, the functionality of some TWAIN drivers is questionable. Remark Office OMR supports the TWAIN protocol, however, since scanners come onto the market so quickly and different companies have different software quality standards, Principia Products cannot guarantee that all TWAIN drivers will work correctly. Scanner manufacturers typically revise TWAIN drivers frequently to correct for any problems; therefore it is a good idea to check for updated drivers for your scanner from time to time. Manufacturer web sites often have updated drivers available for download.

In order to select a TWAIN driver in Remark Office OMR, the driver must first be installed. Consult your scanner’s documentation for installation instructions and information about obtaining a TWAIN driver for your scanner. Once the driver has been installed, use the following procedures to select the driver in Remark Office OMR.

To select the TWAIN scanner protocol

1 Select the Tools menu and then click Scanner Properties to display the Scanner Properties window.
2 Click the Scanner Type down arrow to display a list of available scanner types.
3 Select **TWAIN** to select the TWAIN protocol.

4 Click the **Source...** button to display the TWAIN drivers that are currently installed on your computer.

   **Note:** You must install your scanner’s TWAIN driver in order for it to be displayed in this list.

5 Click the appropriate TWAIN driver and then click **Select** to return to the **Scanner Properties** window. When you return to the **Scanner Properties** window, you will notice several options, which are summarized in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use legacy driver</td>
<td>Mark this checkbox if you are using an older TWAIN driver. Legacy support allows you to use scanner drivers that support older versions of the TWAIN scanning protocol. It is not recommended that you use this option unless you find that your scanner driver is not working correctly.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Use this setting to set the scanning resolution in Dots Per Inch (DPI). We recommend scanning at 200 DPI. This setting is not available if you have chosen to show the scanner’s user interface (you will select DPI when you scan a page).</td>
</tr>
<tr>
<td>Brightness</td>
<td>Use this setting to set the scanner’s brightness. We recommend scanning at your scanner’s default brightness setting unless you encounter problems. The default setting in Remark Office OMR is 0. This setting is not available if you have chosen to show the scanner’s user interface (you will select brightness when you scan a page).</td>
</tr>
<tr>
<td>Flatbed only</td>
<td>Mark this checkbox if your scanner only contains a flatbed area for scanning.</td>
</tr>
<tr>
<td>ADF only</td>
<td>Mark this selection if your scanner only contains a sheetfeeder (ADF) for scanning.</td>
</tr>
<tr>
<td>Flatbed and ADF</td>
<td>Mark this setting if your scanner contains both a flatbed and a sheetfeeder (ADF).</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Center feed</td>
<td>Mark this checkbox to have the page aligned with the center portion of the ADF, regardless of how the ADF is positioned (note that not all scanners utilize this feature).</td>
</tr>
<tr>
<td>Duplex scanner</td>
<td>Mark this checkbox if the scanner you are using has duplex capabilities for double sided form scanning.</td>
</tr>
<tr>
<td>Invert image</td>
<td>Use this setting to correct an image that scans in reverse: black background with white text. The default setting is No.</td>
</tr>
<tr>
<td>Auto deskew</td>
<td>Mark this selection to have Remark Office OMR automatically correct for skewing during the scanning process.</td>
</tr>
<tr>
<td>Auto despeckle</td>
<td>Mark this selection to have Remark Office OMR automatically remove unwanted specks on the scanned image.</td>
</tr>
<tr>
<td>Show TWAIN interface</td>
<td>Mark this selection to show your scanner’s interface. Principia recommends turning this selection on initially to verify your scanner’s settings (e.g., scanning mode, page size, resolution, brightness). Some scanners, but not all, will support having the interface hidden.</td>
</tr>
<tr>
<td>Scan duplex</td>
<td>Mark this checkbox if you have selected a duplex scanner and wish to scan both sides of a page.</td>
</tr>
<tr>
<td>Rotate front side</td>
<td>Use this option to rotate the front side of each page that is scanned. Select the rotation degrees in the box provided. Only use this option if the front side of your form does not rotate correctly on its own.</td>
</tr>
<tr>
<td>Rotate back side</td>
<td>Use this option to rotate the back side of each page that is scanned. Select the rotation degrees in the box provided. Only use this option if the back side of your form does not rotate correctly on its own.</td>
</tr>
</tbody>
</table>

**Tip:** It is recommended that you initially show the scanner’s interface so that you can set the scanner settings. Once you have successfully scanned a page, many scanners will support turning off the interface. If you disable this feature, you may use Remark...
Office OMR’s resolution and brightness settings in the **Parameters** section of the **Scanner Properties** window.

6 In the **Hardware Options** section, choose the type of scanner you are using: **Flatbed, ADF or Flatbed and ADF**.

**Note:** The Hardware Options setting refers to the type of scanner you are using, not whether you will scan a page using the ADF or flatbed of the scanner.

7 If you have a duplex scanner (one that scans both sides of a sheet of paper in one pass through the scanner), mark the checkbox for **Duplex scanner**.

8 If appropriate, change the setting for **Invert image**. You only need to adjust this setting if your scanner inverts the image so that the background of the image is black and the text is white.

9 If desired, mark the checkboxes for **Auto deskew** and **Auto despeckle** to have Remark Office OMR attempt to straighten a skewed image and remove any stray specks from the image. We recommend that you only use these settings if you encounter skewing or speckled images during the scanning process.

10 Enable or disable the checkbox for **Show TWAIN interface** by clicking the checkbox.

11 If you wish to scan both sides of the page and have a duplex scanner, mark the box for **Scan duplex**.

12 Click the **OK** button to save the scanner settings.
4.3.2 Configuring a TWAIN Driver

Most TWAIN drivers will not require any special adjustments, but some drivers may have special requirements. If you experience problems scanning in Remark Office OMR with your TWAIN driver, use the following sections for assistance.

When scanning in Remark Office OMR with a TWAIN driver, there are several basic settings that you want to use. Remark Office OMR will support color and grayscale scanning. However, it is not necessary. Most scanners will achieve optimum scanning rates when used in black and white scanning mode (sometimes called line art). The resolution on the scanner, measured in dots per inch (DPI), should be set at 200 DPI. If your scanner allows you to adjust the scaling setting, you want it to be set at 100%. You should also verify that the page size your scanner is using matches the actual page you are scanning. You can also utilize the scanner's brightness (sometimes called threshold) setting to make scanned images lighter or darker. Under normal conditions, you want to use the scanner's default brightness setting. If, however, you need to make shading or a lightly colored paper background drop out (disappear), you could raise the brightness setting to accomplish these tasks. On the same token, you could set the brightness setting to a darker level to help compensate for light marks or lightly filled marks on forms.

**Tip:** It is important to remember that the settings used to create the template should also be used to scan the filled-in forms in order to maintain a level of consistency and achieve optimum recognition rates.

4.3.2.a Controlling the TWAIN User Interface

Not all TWAIN drivers support having their user interface hidden. It is recommended that you turn on the option to **Show TWAIN interface** in the **Scanner Properties** window. When you scan, the scanner manufacturer’s TWAIN interface will appear. In this interface, you can specify TWAIN settings. The following table recaps the settings of which you should be aware:

<table>
<thead>
<tr>
<th>Option</th>
<th>Appropriate Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>200 DPI</td>
</tr>
<tr>
<td>Scan Mode</td>
<td>Black and White or Line Art (the software will convert grayscale and color images to black and white, but scanning in black and white mode is faster)</td>
</tr>
<tr>
<td>ADF</td>
<td>Yes/On</td>
</tr>
<tr>
<td>Page Size</td>
<td>Letter (or your specific paper size)</td>
</tr>
</tbody>
</table>
Once you have scanned a page successfully, it may be possible to hide the scanner’s user interface in Remark Office OMR by turning off the **Show TWAIN interface** checkbox in the **Scanner Properties** window. If any problems occur, you will need to show the scanner user interface again.

**Tip:** If your scanner is used for scanning in programs other than Remark Office OMR, there is a good chance its settings will be altered. In this case, we recommend that you make a note of what settings you are using in Remark Office OMR. Keep the **Show TWAIN interface** option on at all times so that you can see what settings are being used and maintain consistency with your forms. This practice may help you achieve a higher level of accuracy in the software.

### 4.3.2.b Obtaining Updated TWAIN Drivers

Most scanner manufacturers release new TWAIN drivers on a regular basis. Updated drivers are created to correct problems. If you experience any problems scanning in Remark Office OMR while using a TWAIN driver, contact your scanner manufacturer to ensure that you have the latest driver release. You can find drivers on the web sites of most scanner manufacturers.

### 4.3.3 Using the ISIS Scanning Protocol

ISIS is a scanning protocol developed by Pixel Translations, Inc. for controlling scanning equipment. Some scanners ship with an ISIS driver, especially high-end scanners.

**Important Note!** Remark Office OMR only supports legacy ISIS drivers. Legacy ISIS drivers ship with older scanners. Newer scanners may not be supported under the ISIS protocol. Therefore, we provide limited information about ISIS scanning in this user’s guide. Always try using your scanner’s TWAIN driver first.

### 4.3.3.a Selecting the ISIS Scanner Protocol

In order to use an ISIS driver in Remark Office OMR, you must first install the scanner’s ISIS driver. Once the ISIS driver has been installed, you may select the ISIS driver in Remark Office OMR.
To select an ISIS driver
1 Select the **Tools** menu and then click **Scanner Properties**.
2 Click the **Scanner Type** down arrow to display a list of available scanner types.
3 Choose **ISIS** from the list.
4 Click the **Source**… button to display the ISIS drivers that are currently installed on your computer.
   
   **Note:** You must install your scanner’s ISIS driver in order to select it from this list.
5 Click the appropriate ISIS driver and then click **Setup** to specify default scanner settings.

Most ISIS drivers allow you to specify a default page size and other appropriate settings.

6 Select the page size you plan to use.
7 Click the **OK** button to return to the **Scanner Properties** window. The following options will appear:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Use this setting to set the scanning resolution in Dots Per Inch (DPI). We recommend scanning at 200 DPI.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Use this setting to set the scanner’s brightness. We recommend scanning at your scanner’s default brightness setting unless you encounter problems. The default setting in Remark Office OMR is 128.</td>
</tr>
<tr>
<td>Flatbed only</td>
<td>Mark this checkbox if your scanner only contains a flatbed area for scanning.</td>
</tr>
<tr>
<td>ADF only</td>
<td>Mark this checkbox if your scanner only contains a sheetfeeder for scanning.</td>
</tr>
<tr>
<td>Flatbed and ADF</td>
<td>Mark this checkbox if your scanner contains both a flatbed and a sheetfeeder.</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ADF check supported</td>
<td>Mark this checkbox if your scanner supports having its sheetfeeder checked for paper. This type of scanner is capable of sensing when a page is placed in the automatic document feeder.</td>
</tr>
<tr>
<td>Duplex scanner</td>
<td>If using a duplex scanner, mark this checkbox to enable duplex capabilities.</td>
</tr>
<tr>
<td>Invert image</td>
<td>Use this setting to correct an image that scans in reverse: black background with white text. The default setting is No.</td>
</tr>
<tr>
<td>Auto deskew</td>
<td>Mark this selection to have Remark Office OMR automatically attempt to correct for skewing during the scanning process.</td>
</tr>
<tr>
<td>Auto despeckle</td>
<td>Mark this selection to have Remark Office OMR automatically attempt to remove unwanted specks on the scanned image.</td>
</tr>
<tr>
<td>Scan ahead</td>
<td>Mark this checkbox if your scanner supports the Scan Ahead feature that allows the scanner to scan at higher speeds (most high-end scanners utilize this feature).</td>
</tr>
<tr>
<td>Scan duplex</td>
<td>Mark this checkbox to turn on the duplex capabilities of your scanner.</td>
</tr>
<tr>
<td>Rotate front side</td>
<td>Use this option to rotate the front side of each page that is scanned. Select the rotation degrees in the box provided. Only use this option if the front side of your form does not rotate correctly on its own.</td>
</tr>
<tr>
<td>Rotate back side</td>
<td>Use this option to rotate the back side of each page that is scanned. Select the rotation degrees in the box provided. Only use this option if the back side of your form does not rotate correctly on its own.</td>
</tr>
</tbody>
</table>
5.1 Overview

We want you to be immediately successful with your new software. To that end, we highly recommend that you walk through the tutorials provided here before you do anything else with your new software. The following sections contain the tutorials, which are designed to give you an overview of the Remark Office OMR software and allow you to quickly learn the basic functions of the software. Two of the most common uses for Remark Office OMR are surveys and tests; therefore we have covered both in these tutorials. Completing these lessons will help position you for mastering the software. Please keep in mind that even though you may only currently do one or the other (surveys or tests), completing both tutorials will still help you understand basic software premises.

- Tutorial I - Survey: The first tutorial outlines how to create a form template for a basic survey form. It also details how to process forms, correct the output and run a report.

- Tutorial II - Exam: The second tutorial outlines how to create a form template for an exam and includes coverage of some of the more advanced options. The second tutorial also covers processing exams and grading the exam data.

Sample forms have been provided with your software for performing these tutorials using a supported scanner. If you do not have a supported scanner available, you may still complete the tutorials using special images installed on your computer. By default, the image files used in the tutorials will be located in C:\Program Files\Principia Products\Remark Office OMR 6\Tutorials.

Important: Please consult your scanner installation guide for scanner installation instructions. This tutorial assumes you have completed scanner installation and setup. Refer to Chapter 4: Setting up Your Scanner for more information.
If you do not have a supported scanner, you may still complete the tutorials by following the set of directions in the right-hand column for using image files. The image files needed are installed on your computer when Remark Office OMR is installed (e.g., C:\Program Files\Principia Products\Remark Office OMR 6\Tutorials\Tutorial 1).

Please note that there are several ways to access basic software functions. Three of the most common methods include:

- **Getting Started Task Pane:** The task pane on the left side of each Remark Office OMR window can be used to access the most common functions in the software. The task pane will automatically update based on the functions you perform. You can show or hide the task pane by selecting the **View** menu and then clicking **Task Pane**.

- **Toolbar:** The toolbar is the series of icons across the top of each Remark Office OMR window. These icons represent shortcuts for common functions within the software. Hover your mouse over any button to see tool tip text explaining the functionality of the button.

- **Menus:** The pull-down menus have all of the functions available within the software. Many of these functions can also be found in the toolbar and task pane.

It is up to you to decide how you wish to access software functions. We will work with all three methods to allow you an understanding of each.

Before we begin, we need to touch briefly on some important concepts that may be new to you. Just take in the big picture for now; details will be built as these concepts are used in the lessons.

### 5.1.1 Form Template Overview

The following concepts are explained in greater detail in other sections of this user’s guide, but are important to understand in performing these tutorials. Here is a quick overview to help you get started:

#### 5.1.1.a What is a Form Template File?

The first thing you will do in Remark Office OMR is create form templates for the forms you wish to process in the software. A form template file contains the information needed to instruct Remark Office OMR about each form. The form template conveys the location of the information on the pages (e.g., the
bubbles the respondents will darken) and the specifics of the data the user 
requires. The form template defines the backend database you will use for 
storage of the processed data. You will create a form template for each form 
that you wish to process using the software.

5.1.1.b How are Form Templates Created?
Form templates are created by scanning an unmarked copy of the form to 
create an equivalent image in the Remark Office OMR Template Editor. You then 
use the mouse to drag boxes (called regions) around the marks (e.g., bubbles) 
and other areas you want to have recognized on your form. These regions tell 
the software where each piece of information you want to capture is located on 
the page and other pertinent information about the form. They also tell the 
software what type of data you need the software to output from each area.

5.2 Tutorial 1 – The Hospital Stay Evaluation Survey
The first tutorial will quickly teach you how to use the basic software functions 
and how to easily navigate the software’s user interface. You will create a form 
template for a hospital stay evaluation. This evaluation is a typical survey form 
containing several types of areas that Remark Office OMR will recognize, 
including a barcode, OMR bubbles and an area for gathering comments. The 
survey asks previous hospital patients to provide details about when and where 
they stayed and then answer some basic questions to evaluate their stay. A 
survey such as this one can be scanned to produce data and subsequently, 
reports to show how the hospital is performing.

You will perform the following steps in this tutorial:

- Create the Hospital Stay Evaluation form template
- Process completed Hospital Stay Evaluation forms
- Review and correct the data output
- Save the Hospital Stay Evaluation data
- Analyze the Hospital Stay Evaluation data with Remark Quick Stats
- Save the Hospital Stay Evaluation report
5.2.1 Creating a Form Template for the Hospital Stay Evaluation Survey

The Hospital Stay Evaluation tutorial is designed to provide you with experience in the basic functions of creating a form template and processing forms. The following procedures describe how to set up a form template for the sample Hospital Stay Evaluation form included with the software. Subsequent sections of this tutorial will detail how to process forms and export or analyze the data.

The form template creation process consists of:

- Scanning an unmarked copy of the form (or importing an image of a previously scanned copy of the form)
- Dragging boxes around the areas to be recognized
- Providing Remark Office OMR with information about the data you need to collect

To begin the Hospital Stay Evaluation form template

1. If not already running, start Remark Office OMR.
2. Begin a new form template. Select the File menu and then click New form template or click . Alternatively, in the left-hand panel, known as the Task Pane, select New form template. Any of these actions will open a second window containing the Remark Office OMR Template Editor.

   Tip: If you use File|New Form Template or the New form template link in the Task Pane, the Template Editor will open with the new form template window already opened for you.

3. If the Template Editor opens but you do not see the New Form Template Properties window, select the File menu and then click New Form Template or click . Alternatively, select the New form template link in the task pane.
The **New Form Template Properties** window opens. The **New Form Template Properties** window is where you describe your form to Remark Office OMR. You will do this by entering basic information about your form, including the form template description, page size and page orientation.

4. Enter **Hospital Stay Evaluation** in the **Form template description** box.

5. Locate the **Page Size** area where you can tell the software the size paper your form uses. Select **US Letter** in the **Size** drop-down list.

6. Locate the **Orientation** area and select **Portrait**.

7. Click the **Next>>** button to continue.

The **Create Page Elements** window appears. The Create Page Elements window allows you to either acquire an image of your form from your scanner, or acquire an image of your form from an existing image file. Each page in a template is created using an image of the appropriate page in your form. The image allows you to see the form so that you can easily teach Remark Office OMR how to read it.

**To obtain a form template image**

As previously mentioned, there are two ways to acquire an image for a form template page. Images can be acquired by scanning to create a new image file or by opening an existing image file.

1. To acquire an image, locate the **Select Method to Use for Image Acquisition** area of the window. Beneath it are two choices, **Read from scanner** and **Read from image files**.

2. To see how easy it is to acquire your image either way, try moving the radio button from **Acquire images from scanner** to **Read from image files**. When you select **Read from image files**, the **Image Acquisition** button text will change to read **Acquire Images from File**. This option allows you...
to import a previously scanned and saved image file of your form and is helpful to many users who work with a networked scanner.

The following table provides instructions for either using a scanner or an image file as the image source.

- If you have a supported scanner installed and the forms included with the tutorial, follow the instructions for using a scanner entitled **Acquire Images from Scanner**.

- If you do not have a supported scanner, you may still complete the tutorial using special image files of scanned forms that were installed on your computer as part of the Remark Office OMR application. In this case, follow the instructions for using image files entitled, **Acquire Images from File**.
3 Click the radio button for **Read from scanner** in the **Select Method to Use for Image Acquisition** area.

4 Place the blank copy of the **Hospital Stay Evaluation** form in the scanner.

5 Click the **Acquire Images from Scanner** button.

**Note:** If scanning with a TWAIN driver, your scanner’s TWAIN interface may appear after clicking the acquire button. Use this interface to set scanning parameters, including the scanning mode (black and white or line art), page size (US Letter) and resolution (200 DPI).

3 Click the radio button for **Read from image files** in the **Select Method to Use for Image Acquisition** area.

4 Click the **Acquire Images from File** button. The **Select Images** window will open.

5 Select the **Tutorial 1 – Hospital Stay Evaluation.pcx** file from the Tutorial 1 folder of your Remark Office OMR installation directory (e.g., C:\Program Files\Principia Products\Remark Office OMR 6\Tutorials\Tutorial 1) and then click the **Open** button.

Once an image is acquired either by scanning or by opening an existing image file, the Template Editor will display a thumbnail of the image for your approval.

6 When a thumbnail image of your form appears, click the **OK** button to accept the image. If you see a crooked or skewed image in the thumbnail display, place your form back in the scanner and acquire another image.

7 Once the thumbnail image is accepted, the Template Editor will open the new template where you can begin to define the regions.
To define form template regions

The purpose behind making a form template is to tell the software where to locate the information on your specific form and how to understand your data requirements.

As you create the form template, you will designate different areas where you want Remark Office OMR to recognize marks on your form and convert them into data. You will accomplish this by dragging boxes around areas containing barcodes, OMR marks or written comments. Barcodes, OMR marks and written entries are three differing types of information requiring three specific methods of capture. The software employs three types of regions to accomplish this task.

The following table details the three region types employed by Remark Office OMR:

<table>
<thead>
<tr>
<th>Region Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMR Region</td>
<td>OMR regions recognize data from filled in marks, such as bubbles or checkboxes. An OMR region only contains these marks, not surrounding text. A single OMR region can contain either one question or multiple questions.</td>
</tr>
<tr>
<td>Barcode Region</td>
<td>Barcode regions recognize preprinted barcodes from the forms you process. Do not capture anything other than a barcode in this region.</td>
</tr>
<tr>
<td>Image Region</td>
<td>Image regions tell the software to allow for the subsequent data entry of handwritten information or to allow for the storing of an image clip of the actual response. Both types of image regions can be reported on in Remark Quick Stats.</td>
</tr>
</tbody>
</table>
The following table lists the six regions on the Hospital Stay Evaluation form and their corresponding region types:

<table>
<thead>
<tr>
<th>Area on Form</th>
<th>Corresponding Region Type</th>
<th>Practical Use in the Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hospital Division Name</td>
<td><strong>Barcode</strong></td>
<td>Displays the name of the hospital so that performance can be linked to a specific hospital.</td>
</tr>
<tr>
<td>Hospital Unit</td>
<td><strong>OMR</strong></td>
<td>Allows respondents to choose the unit in which they stayed in order to better understand how each unit is performing.</td>
</tr>
<tr>
<td>Length of Stay</td>
<td><strong>OMR</strong></td>
<td>Specifies how long respondents were in the hospital. Reviewing length of stay could show trends in performance versus time spent in the hospital.</td>
</tr>
<tr>
<td>Room Number</td>
<td><strong>OMR</strong></td>
<td>Specifies a room number so that performance can be reviewed based on specific departments and personnel within the hospital</td>
</tr>
<tr>
<td>Hospital Stay Evaluation</td>
<td><strong>OMR</strong></td>
<td>Evaluates various aspects of the patient’s stay based on a scale of Strongly Agree to Strongly Disagree</td>
</tr>
<tr>
<td>Comments</td>
<td><strong>Image</strong></td>
<td>Allows the respondent to enter additional comments that may not have been reflected in the questions on the form.</td>
</tr>
</tbody>
</table>

**Tip:** You can change the way you see the image portion of the screen by using the **Fit Height** and **Fit Width** buttons on the toolbar. For the tutorial, it is recommended that you use the **Fit Width** setting and also maximize the window as you normally would do in a Windows environment. To change the magnification of the image, use the **Zoom In** and **Zoom Out** buttons on the toolbar.
To define the Hospital Division as a Barcode region
The Hospital Division barcode will be defined as a barcode region. The advantage to using a barcode is that Remark Office OMR can read and enter the information collected from the barcode directly into your data without the need for any manual data entry.

1. Highlight the Page 1 node on the left side of your screen if it is not already highlighted.

2. Select the Page menu, click Insert and then click Barcode Region After Selected Page, or click the orange toolbar button . Alternatively, select the Define regions link in the Task Pane and then select Insert Barcode region.

The mouse changes to a crosshair.

3. To create the Barcode region place the cursor just beyond the top left of the barcode, then press and hold the left mouse button while dragging the rectangle beyond the bottom right corner of the barcode, making sure you have selected the entire allotted space. Because barcode length may vary depending on the text of each barcode, capture a little extra space at the end of the barcode to accommodate the largest possible barcode you might process.

Tip: When creating form templates for your own forms that include barcodes, use a blank copy of the form with the longest barcode you intend to process for the form template. By creating the region around the longest barcode you have, you will be ensured that the region will be large enough to capture all barcodes you will be processing.
4. After positioning the box, release the mouse button and the **Properties - Barcode Region** window will appear to allow you to define the region’s properties. This window allows you to provide pertinent information about the barcode.

**Tip:** You can use your cursor to drag/slide the Properties box on your screen if you need to see anything on your form. Do not worry if the region is not drawn perfectly at this point because you will easily be able to adjust it by dragging the borders as needed after the region’s properties are defined and the **Properties - Barcode Region** window is closed.

5. Type **Hospital Division** in the **Region name** box. The Region name provides a brief description of the region and will become the name for this column in your data set.

6. Set the **Barcode type** to **Auto Detect** and the **Barcode orientation** to **Horizontal**. These settings allow you to set specific barcode types and/or positioning if your form design ever requires it.

7. Click the **OK** button to return to the main Template Editor window. You will now see an orange box around the barcode in the image area, identifying it as a Barcode region. Adjust the shape of the region to look like the example.

**Progress Note and Tip:** Have you noticed the region you defined in the form template is now represented in the list on the left of your screen? This list is referred to as the **tree view**. The order of the regions as displayed in the tree view will determine the order of the fields in the data set you create. If needed, within any single page, these region nodes can be dragged and dropped into a preferred order for your resulting data set.
To define the Hospital Unit as an OMR region

1. Highlight (if not already highlighted) the **Hospital Division** node by clicking it in the tree view.

2. Select the **Region** menu, click **Insert** and then click **OMR Region After Selected Region**, or click the green toolbar button.

   Alternatively, select the **Insert OMR region** link in the Task Pane.

   The mouse changes to a crosshair.

3. Place the cursor just to the left of the top bubble in the column of marks representing the Hospital Unit, then press and hold the left mouse button while dragging the rectangle to the bottom right corner of the region, capturing all four bubbles in the region.

   **Tip:** When defining an OMR region, include only the actual marks; never include the nearby labels, text, etc. Also, create a buffer space between the marks and the edge of the defined region. This buffer will allow Remark Office OMR to accommodate minor shifting or skewing during form processing and decrease the number of data exceptions you will need to clean in the resulting data.

After positioning the box, release the mouse button. The **Properties - OMR Region** window appears. The Properties - OMR Region window allows you to enter information that will define the OMR region and the data it produces, including:

- **Region Definition** (the area containing **Region name**), the type of OMR region or **OMR type** and the **Data type**).

- **Region Layout** of the region (the area detailing how many **Rows** and **Columns** of marks are contained in the region).

- **Possible Responses** (the Labels you actually want to see as your data).

4. In the **Region Definition** area, enter **Hospital Unit** in the box titled **Region name**.
5 For the **Region Type**, select **Multiple**. The Multiple region designation is used for typical multiple choice style questions.

*Note:* There are other types of available OMR regions which can be seen if you click the down arrow to the right of **Multiple**. These additional region types offer differing types of data output. Additional region types are explained in detail in Chapter 7.

6 For the **Data Type**, select **Textual**. This region contains Hospital Unit names, so textual data is appropriate. When creating your own form templates, the data type you select can be textual or numeric, depending on the type of data you require.

7 In the **Region Layout** area to the right, select **Column** for **Region orientation**. Region orientation lets Remark Office OMR know how the region is structured on the form. For this question, the question’s answer choices are listed in one column.

8 Enter **1** in the **Columns in the region** box and **4** in the **Rows in the region** box. The region size lets Remark Office OMR know how many rows and columns of marks are in the region.

9 Locate the **Labels** area, and then type in the text for each unit: **Maternity, Cardiac, Pediatric, ICU**, one per line. Your choice of Labels in the form template determines what you will see in the data set when your filled in forms are processed. The Labels represent the response choices for each bubble, moving from top to bottom. You will notice that as you type the Labels, numbers will automatically fill the **Values** column to the right. While the Labels represent the actual data you will see returned from the processed forms, the Values represent the information Remark Office OMR uses to perform any statistical analysis.

*Tip:* When entering **Labels** into **Possible Reponses**, you may use the **Enter Key** to move to the next row.

10 Click the **OK** button to return to the main Template Editor window.
You will now see a green box around the **Hospital Unit** region in the form area, identifying it as an OMR region. You will also see that **Hospital Unit** has been added to the tree view on the left side of the Template Editor.

**To define Length of Stay as an OMR region**
The **Length of Stay in Days** region is a second OMR region designed to output the number of days the respondent stayed in the hospital. The steps involved in creating this OMR region will be the same as for creating the OMR region for Hospital Unit. You will notice that many of the region’s properties will change to reflect that the area on the form has a single row with five columns instead of a single column with four rows.

1. Highlight (if it is not already highlighted) **Hospital Unit** by clicking its node in the tree view.
2. Select the **Region** menu, click **Insert** and then click **OMR Region After Selected Region**, or click the green toolbar button. Alternatively, select the **Insert OMR region** link in the Task Pane.

The cursor changes to a crosshair.

3. Place the cursor just to the top left of the row of marks representing the **Length of Stay**, then press and hold the left mouse button while dragging the rectangle to the bottom right corner capturing all of the bubbles in the region.
4. In the **Region Definition** area, enter **Length of Stay** in the box titled **Region name**.
5. For the **Region Type**, select **Multiple**.
6. For the **Data Type**, select **Textual**. This region contains numbers of days but because one of the choices (5+) is not numeric, textual is the correct data type.
7. In the **Region Layout** area to the right, select **Row** for **Region orientation**.
Region orientation lets Remark Office OMR know how the region is structured on the form. For this question, the question’s answer choices are listed in a row.

8 For **Columns in the region**, enter 5 and for **Rows in the region** enter 1.

9 For the **Labels** area, type the number for each length of stay on each of the rows: 1, 2, 3, 4, 5+, one per line. This label range represents the response choice for each bubble, moving from left to right. Again you will notice that as you type the Labels, numbers will automatically fill the **Values** column in the grid.

10 Click the **OK** button to return to the main Template Editor window.

You will now see a green box around the **Length of Stay** region in the form area, identifying it as an OMR region. You will also see that **Length of Stay** has been added to the tree view.

**To define Room Number as an OMR region**

The Room Number region needs to capture all five digits as one piece of information. To do this we will employ a Grid OMR region to define the bubbles on the form. A Grid OMR region outputs a single piece of data regardless of the number of rows and columns included in the region. This type of region is used for items such as dates, ID numbers, social security numbers, etc. (Region types are explained in greater detail in Chapter 7.)

The steps involved to create a Grid region will be the same as you used to create the OMR regions we have already created. However, the specific properties of the region will change to reflect the way the region is formatted on the form and the way we want the software to report the data.

1 Highlight (if not already highlighted) the **Length of Stay** node in the tree view, click the green toolbar button to insert and OMR region, and then draw the OMR region box for the entire group of bubbles.

2 After positioning the box, release the mouse button, and the **Properties - OMR Region** window appears.
In **Region Definition** area, enter **Room Number** in the **Region name** box.

4. Select **Grid** for the **OMR type**.

5. Select **Numeric** for the **Data type**. We will be capturing a five digit number.

6. In **Region Layout** area, select **Column** for the **Region orientation**. Each column in this region represents one digit of the room number.

7. In the **Columns in region** box, enter 5 and in the **Rows in region** box, enter 10.

8. Enter the appropriate **Labels** in **Possible Responses**. For the **Labels** area, click the down arrow for **Possible label scales** and choose the scale 0 to 9 from the list of choices. This range represents the response choices for bubbles in all five columns, moving from top to bottom. The numbers will fill the **Labels** grid automatically. The Labels represent the actual data that will be returned from the processed forms when filled in by the respondent, and the Grid region will return all selections to make a five digit number.

9. Click the **OK** button to return to the main Template Editor window.

You will now see a green box around the **Room Number** region in the form area, identifying it as an OMR region. You will also see that **Room Number** has been added to the tree view.

**To define the Hospital Stay Evaluation questions as an OMR region**

There are six questions on the form that ask the patient to evaluate his or her hospital stay. All six questions share the same evaluation scale of Strongly Agree to Strongly Disagree, which allows them to share one set of labels on the form. This compact and logical question area can be captured with a single OMR region even though it contains six separate questions. Defining similar questions in one region saves time and effort, and is preferable.
1. Highlight (if not already highlighted) the Room Number node in the tree view.

2. Click the green toolbar button to insert an OMR region, and use the crosshair to draw a box around the entire group of 24 bubbles (all four columns and six rows). This region contains six individual questions and each question has four possible answer choices.

3. When the Properties – OMR Region box opens, enter Evaluation in Region name box.

4. Select Multiple as the OMR type.

5. Select Textual for the Data type. This region contains a scale from Strongly Agree to Strongly Disagree, so textual data is appropriate.

6. In the Region Layout area, select Row for the Region orientation because each individual question occupies one row of the region.

7. Enter 4 in the Columns in the region box and 6 in the Rows in the region box.

8. In the Labels grid, enter the correct Labels: Strongly Agree, Agree, Disagree and Strongly Disagree, one per line.

9. In the Task Pane, select Question Text and names. The next step will be to enter the Question Text and Question Names for each of the six questions.

   **Tip:** Question Text appears on the reports generated in Remark Quick Stats and is useful when exporting to some data formats. Question Names can be used to enter individual names for every question within one OMR region. If the Question Names grid is left blank, the software will use the Region Name defined on the previous screen and append sequential numbers to the end of the name to differentiate the questions. Individual Question Names are useful if you are exporting data to an existing file that requires specific field names (e.g., an Access table).
Enter the **Question Text** and **Question Names** for each of the six questions as shown on the next page.

<table>
<thead>
<tr>
<th>Question Text</th>
<th>Question Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Preadmission and admission procedures were well-handled.</td>
<td>Admission</td>
</tr>
<tr>
<td>2. The staff looked after my comfort and well-being.</td>
<td>Comfort</td>
</tr>
<tr>
<td>3. The staff treated me with respect.</td>
<td>Respect</td>
</tr>
<tr>
<td>4. Medical procedures were explained in terms I understood.</td>
<td>Explanations</td>
</tr>
<tr>
<td>5. My doctor was confident and knowledgeable.</td>
<td>Knowledge</td>
</tr>
<tr>
<td>6. My overall rating of this hospital is favorable.</td>
<td>Overall</td>
</tr>
</tbody>
</table>

Click the **OK** button to return to the main Template Editor window.

You will now see a green box around the **Hospital Stay Evaluation** region in the form area, identifying it as an OMR region. You will also see that **Evaluation** has been added to the tree view.

**To define the Comment area as an Image region**

Areas in which you expect your respondent to use handwriting can be captured by Remark Office OMR as Image regions. Image regions can either take a snapshot of the handwriting and store it on your computer as an image file, or can allow you to hand enter the written information into your data set using image assisted data entry. In either case, you can run a Comment Report in Remark Quick Stats to view the information from the Image region.
1 Highlight (if not already highlighted) the **Evaluation** node in the tree view and then click the blue toolbar button ![Image region](image.png) to insert an Image region.

2 Once the cursor becomes a crosshair, place the cursor at the top left of the area where you would expect the respondent to enter their comments. Press and hold the left mouse button while dragging the rectangle to the bottom right corner of the area, making sure you have selected the entire allotted space (see example on next page).

**Comments:**

![Image region](image.png)

3 After positioning the box, release the mouse button and the **Properties – Image Region** window will appear to allow you to define the region’s properties.

4 Enter **Comments** in the **Region name** box.

5 Set the **Region type** to **Data entry**. This type will allow you to hand enter the comments that are written on the forms.

6 Set the **Data type** to **Textual**.

7 At the bottom of the **Region Definition** area, mark the setting for **Attempt to detect the presence of handwriting in the region**. By using this feature, Remark Office OMR will search for handwriting in the Image region area during form processing. If writing is found, the area will show a visible indicator that text was found so that you know exactly where you need to enter information.

8 Click the **OK** button to return to the main Template Editor window.

You can now see the new Image region visible as a blue field on your form and that **Comments** is now listed in the tree view of your form template.
To save the Tutorial 1 form template
Once you have defined all of the regions on your form, you may save the form template.

1. Select the File menu and then click Save or click . Alternatively, select the Save template link in the Task Pane.

2. In the File name box, type Tutorial1 and then click the Save button.
   
   Note: If someone has already completed the tutorial with this file name, you may modify the file name.

3. You have now created the Tutorial 1 form template. Close the Template Editor by selecting the File menu and then clicking Exit. Alternatively, you may also simply click the X in the upper right hand corner of the Template Editor window.

5.2.2 Processing the Completed Hospital Stay Evaluations
Now that you have created the form template for the Hospital Stay Evaluation survey you are ready to begin processing the completed forms using your scanner or the supplied image files.

The following section provides instructions for both reading from scanner and for reading from image files. If you will be using images instead of scanning, skim over this first section to familiarize yourself with how to use a scanner to read forms, then proceed to the instructions for reading from images.

If you have installed a supported scanner, use the filled in sample forms provided with the software and follow the instructions for using the scanner.
To open the Hospital Stay Evaluation form template

1. If not already running, start the **Remark Office OMR Data Center**. When the Data Center opens, it will display a blank spreadsheet-style data grid. The **Data Center** offers a **Task Pane** on the left containing the most commonly requested actions.

2. Select the **File** menu and then click **Open Form Template** or click ![Open Form Template icon]. Alternatively, select the **Open form template** link in the Task Pane. You must open a form template in order to process forms.

3. Select the **Tutorial1.omr** file (or the file you created in the previous section of this tutorial) and then click the **Open** button. (The .omr file extension is the one used for all Remark Office OMR templates.)

When the Tutorial1 form template opens, its name will appear on the title bar at the top of the screen and you will see the region names you specified as your column headers in the data grid. Each column in the grid corresponds with one variable or question in the form template, as the column headers indicate. Each grid row will contain information from one processed form regardless of the number of pages the form contains. The data grid will fill row by row as your completed forms are processed.

To scan completed forms

The Read Wizard is used to scan completed forms and produce data. The Read Wizard has several steps to help customize the scanning process. This tutorial will focus on the basic scanning functions.

**Note:** If you wish to scan the supplied forms for the tutorial, it is assumed you have already setup a scanner in Remark Office OMR. If you do not have a scanner setup in the software, skip to the next section “To read from images files” and use the supplied images files.

1. Place the supplied completed **Hospital Stay Evaluation** forms in your scanner in the following order (use the **Room Number** area to locate each form): **12345, 34567, 78901**.

2. Select the **Tools** menu and then click **Read Wizard**, or click ![Read Wizard icon]. Alternatively, select the **Read wizard** link in the Task Pane.

The **Read Method** window appears.
3. In the **Select Method to Use for Data Collection** area, mark the radio button for **Read from scanner**.

4. Click the **Next>>** button to continue.

The **Scanned Image Naming Conventions** window appears. The Data Center will automatically store an image for each form that is scanned. You can use these stored images to clean your data later instead of looking through the actual paper forms. This window allows you to set the parameters for the images that will be stored.

5. By default the name of the form template will be listed in the **Begin image names with** box. If another user has changed the defaults, type the form template name in this box: **Tutorial1**. The date and time will be appended to this name to create unique names for each image file that gets stored during scanning.

6. The **Image target directory** box is used to hold the stored images. You may accept the current setting or click the **Browse...** button to choose a new location on your computer.

7. If not already selected, mark the checkbox for **Save images in a subfolder based on the form template’s name**. Using this feature places all images belonging to one form template in the same folder on your computer for easy access.

8. Click the **Next>>** button to continue.

The **Review Exceptions** window appears. This window allows you to configure options for reviewing exception cases such as blank and multiple responses. We will not be using this feature in this tutorial.

9. If the **Activate Review Exceptions** checkbox is marked, click in the checkbox to deselect this option.

10. Click the **Read** button to begin scanning forms.
11 When all forms have been scanned, and the **Would you like to continue scanning?** prompt appears, click the **No** button.

As each form is scanned, you will see a row added to the data grid. Skip to Section 5.2.3 to continue the tutorial.

---

**To read from image files**

1. Select the **Tools** menu and then click **Read Wizard**, or click ![Read Wizard](image). Alternatively, select the **Read wizard** link in the Task Pane.

   The **Read Method** window appears.

2. In the **Select Method to Use for Data Collection** area, mark the radio button for **Read from image files**.

3. Click the **Next>>** button to continue.

   The **Image Selection** window appears to enable you to view and select the images you want to process.

4. From the listed image files select **HospitalStay1.pcx**, **HospitalStay2.pcx** and **HospitalStay3.pcx**, respectively by clicking them as you hold down the **Ctrl** key. (Note, by default, these images are installed to Tutorial 1 folder on your system, e.g., C:\Program Files\Principia Products\Remark Office OMR 6\Tutorials\Tutorial 1.)
5 Click the **Add Selected Images** button to move them into the **Images in Read Order** window on the right.

**Tip:** You can use the **Ctrl** or **Shift** keys to select multiple image files and then use the **Add Selected Images** button to move the images to the **Images in Read Order** window.

6 Click the **Next>>** button to continue.

The **Review Exceptions** window appears. This window allows you to configure options for reviewing exception cases such as blank and multiple responses. We will not be using this feature in this tutorial.

7 If the **Activate Review Exceptions** checkbox is marked, click in the checkbox to deselect this option.

8 Click the **Read** button to begin reading image files.

As each image is processed you will see a row added to the data grid.

### 5.2.3 Reviewing and Correcting the Data

After the three forms have been processed, three rows of data will be displayed in the data grid. Each row represents the responses collected from one of the three forms. You are now ready to inspect the data for missing or unrecognized responses in order to prepare for either analysis or export.

**How does the software handle data exceptions?**

Remark Office OMR informs you of unrecognized or questionable responses by placing a visible marker in each appropriate data grid cell. Each one of the six types of problematic or potentially inaccurate data is represented by a specific color flag. The **Exceptions Legend** in the **Task Pane** provides an easy reference key to the six exception flags and their meanings.

The software will then assist you to correct exception cases or problems by allowing you to see what was entered on the actual form. The stored images for each processed form will be available to show your respondents’ answer choices. You can click inside any cell to view the corresponding image of that form. (If click in a cell and do not see an image beneath the data grid, select the **View** menu and then click **Image Viewer** to open the Image Viewer.)
To run Review Exceptions

1 Select the Tools menu and then click Review Exceptions, or click . Alternatively, select the Review exceptions link in the Task Pane.

The Review Exceptions window will appear in the Task Pane.

2 The top half of the pane allows you to select the search cases (e.g., multiple responses, blank responses, etc.). Make sure Multiple responses and Blank responses are checked.

3 The bottom half of the window allows you to configure and begin the search. You may search by Row/Respondent (across rows) or by Column/Item (down the columns). For this tutorial, select Row/Respondent.

4 Click the Begin Review button to start the automated review. The software will search through the data set to locate the flagged cells.

The first piece of flagged data is a multiple response in the first grid row for the item called Comfort. In the Review Exceptions window, you will see a green flag and Response for [Comfort]. The green flag tells you that a multiple response was encountered. The text in the brackets ([Comfort]) tells you the question or item where the multiple response was encountered.

5 In the box beneath Response for [Comfort] use the drop-down list to select the appropriate response. Use the Image Viewer beneath the data grid to review the respondent’s form. It appears that the patient changed his response from Agree to Strongly Disagree by crossing out the original mark and filling in a second bubble. We will assume that Strongly Disagree is the correct response. Select Strongly Disagree from the drop-down list.

6 Click the first green arrow, titled Search Forward to move to the next exception. Or, simply press Enter.

7 The next exception is a multiple response in row one for the item called Respect. Look at the Image Viewer to see the intended response. In this case, it looks like the respondent also changed his response from Agree to Strongly Disagree. Select Strongly Disagree from the drop-down list.

8 Click the first green arrow, titled Search Forward to move to the next exception. Or, simply press Enter.
The next exception is an image region where handwriting was detected in the first row of data for the item called Comments. The software uses a blue flag to mark Image regions that contain writing and may require data entry (when using the Automatically attempt to detect the presence of handwriting in the region feature).

9 In the box beneath Response for [Comments] type the comment displayed in the Image Viewer: Mrs. Smith was not a very nice person!

10 Click the first green arrow, titled Search Forward to move to the next exception. Or, simply press Enter.

The next exception is another image region where handwriting was detected in the second row of data for the item called Comments.

11 In the box beneath Response for [Comments] type the comment displayed in the Image Viewer: Mrs. Smith was very kind and generous!

12 Press the Enter key. There are no more exception cases in the data.

13 When prompted, click Yes to the message Are you sure you are finished reviewing exceptions?

14 Click the Back button in the Review Exceptions pane to return to the regular Task Pane.

Your data is now ready to be saved and analyzed.

5.2.4 Saving the Course Evaluation Data

After reviewing the data, you may save it one of many file formats available for exporting data to other applications. For this tutorial, the data will be saved to the Remark (RMK) format, which is a proprietary format within the software. This format saves the exception flags (if any are present) as well as the link from the data to the stored images so that you can open your data and still view the image that corresponds with any piece of data.
To save the Hospital Stay Evaluation data
1. Select the **File** menu and then click **Save**, or click ![Save icon](image).

2. Data can be saved anywhere on your system. By default, a Data folder is installed in the Remark Office OMR directory; we recommend using this folder for storage of data files. In the **Look in** box, navigate to this **Data** folder on your system (e.g., C:\Program Files\Principia Products\Remark Office OMR 6\Data).

3. Click the **Save as type** down arrow to display a list of file types.

4. If not already selected, click the **Remark (.RMK)** format.

5. Type **Tutorial1** in the box titled **File name**.

6. Click the **OK** button to save the file.

5.2.5 Analyzing the Hospital Stay Evaluation Data

Remark Office OMR provides statistical analysis functionality for tabulating data from your forms. The **Easy Survey** feature is one such facility and will provide you with a choice of standard reports based on your data.

Before beginning this portion of the tutorial, ensure that the legacy analysis for the software is not being used. Remark Office OMR includes two analysis packages: legacy analysis for previous users who may have existing reports they still wish to use, and a new analysis version with updated reports and tools. For this tutorial, we will be demonstrating the new analysis tool. In the **Data Center**, select the **Tools** menu and then click **Preferences**. Make sure the checkbox for **Use Legacy Analysis as Your Default Analysis Tool** is not selected.
Tip: The Remark Quick Stats module of the software includes various ways to tabulate/grade data and display reports. Review the Remark Quick Stats User’s Guide PDF file by clicking Start|Programs|Remark Office OMR 6|Documentation to see all available analysis features.

To tabulate the Hospital Stay Evaluation data
1. Select the Tools menu, then click Analysis and then click Easy Survey, or click . Alternatively, click the Analysis tab and then select the Easy Survey link in the Task Pane.

The Remark Quick Stats window appears.

2. In the Task Pane, select the Display Reports link to view the selection of available reports.

3. Select the Condensed Item Analysis Report link in the list; the report will display on the right.

The Condensed Item Analysis Report shows several statistics for each question, such as Label, Total and Percent. Each table displays statistics for a separate question in the survey. This simple, straightforward report may be all that you need to communicate your survey’s results. Although we will not view every available report in this tutorial, you will want to explore the other available reports and experiment with the report options by clicking Tools|Report Properties and Tools|Preferences.

4. To gain some comfort with the Remark Quick Stats window, go to the toolbar and use the Full Screen button to expand the report. Then toggle back to the default view by selecting the button again. If you need to, use the Zoom In and Zoom Out buttons to increase or decrease the size of the report image.
5 Return to the **Task Pane** to display the available report options again.

6 Select the **Detailed Item Analysis Report** link. The Detailed Item Analysis report provides a more detailed look at individual question statistics, including frequency, percent, valid percent and cumulative percent. A corresponding graph is also displayed by default.

7 View each page by using the **Previous Page** and **Next Page** buttons located in the upper left area of the report window. Because the report opens to page 1, only the **Next** page button is enabled initially. The box to the right will display the report page you are currently viewing (e.g., 1/8).

### 5.2.6 Saving the Detailed Item Analysis Report

Once you have tabulated your data, you can save a report file and/or export the report to one or more formats for either storing or sharing with others. For the Tutorial I report, we will save the Detailed Item Analysis Report in the Windows My Documents folder.

**To save the Detailed Item Analysis Report**

1 To save the report in the software’s report format, select the **File** menu and then click **Save**, or click ![Save icon]. Alternatively, click the **Save report** link in the Task Pane.

The **Save Report** window appears.
2 Use the **Save in** drop down list to locate the **My Documents** folder.

3 In the **File name** box, type **Tutorial1**. The report will be saved in Remark Quick Stat’s .rdf file format. You can open the report again in Remark Quick Stats for viewing or editing. (To open an existing report from the **Data Center**, select the **File** menu, then click **Open** and then click **Report**. If you are already in Remark Quick Stats, simply select the **File** menu and then click **Open**, or click ![File Icon].)

### 5.2.7 Tutorial I Summary

The first tutorial illustrated the basics of using the software, including:

- Creating a form template
- Processing forms
- Reviewing data
- Saving data
- Analyzing the results

To gain a better understanding of some of the more advanced software functions, use the Remark Office OMR tutorial II.
5.3 Tutorial 2 – The General Exam Answer Sheet

The second tutorial will quickly teach you more about basic software functions as well as some of the more advanced features. You will create a form template for a generic test. This test is a typical test answer sheet containing different types of areas that Remark Office OMR will recognize, including a barcode and several types of OMR bubbles. We recommend that you perform Tutorial 1 before completing this tutorial, as the first tutorial contains more in depth descriptions of software features aimed at new users of the software.

You will perform the following steps in this tutorial:

- Create the General Answer Sheet form template
- Process completed test answer sheets
- Review and correct the data output
- Save the test data
- Analyze the test data with Remark Quick Stats
- Export the Student Grade report

5.3.1 Creating a Form Template for the General Answer Sheet

The General Answer Sheet tutorial is designed to provide you with experience in the basic and advanced functions of creating a form template and processing forms. The following procedures describe how to set up a form template for the sample General Answer Sheet form included with the software. Subsequent sections of this tutorial will detail how to process forms and export or analyze the data.

The form template creation process consists of:

- Scanning an unmarked copy of the form (or importing an image of a previously scanned copy of the form)
- Dragging boxes around the areas to be recognized
- Providing Remark Office OMR with information about the data you need to collect
To begin the General Answer Sheet form template

1. If not already running, start Remark Office OMR.

2. Begin a new form template. Select the File menu and then click New form template or click . Alternatively, in the left-hand panel, known as the Task Pane, select New form template. Any of these actions will open a second window containing the Remark Office OMR Template Editor.

   **Tip:** If you use File|New Form Template or the New form template link in the Task Pane, the Template Editor will open with the new form template window already opened for you.

3. If the Template Editor opens but you do not see the New form Template Properties window, select the File menu and then click New Form Template or click . Alternatively, select the New form template link in the task pane.

The New Form Template Properties window opens. The New Form Template Properties window is where you describe your form to Remark Office OMR. You will do this by entering basic information about your form, including the form template description, page size and page orientation.

4. Enter General Answer Sheet in the Form template description box.

5. Locate the Page Size area where you can tell the software the size paper your form uses. Select US Letter in the Size drop-down list.

6. Locate the Orientation area and select Portrait.

7. Click the Next>> button to continue.

The Create Page Elements window appears. The Create Page Elements window allows you to either acquire an image of your form from your scanner, or acquire an image of your form from an existing image file. Each page in a form template is created using an image of the appropriate page in your form. The image allows you to see the form so that you can easily teach Remark Office OMR how to read it.
To obtain a form template image
As previously mentioned, there are two ways to acquire an image for a form template page. Images can be acquired by scanning to create a new image file or by opening an existing image file.

The following table provides instructions for either using a scanner or an image file as the image source.

- If you have a supported scanner installed and the forms included with the tutorial, follow the instructions for using a scanner entitled Acquire Images from Scanner.

- If you do not have a supported scanner, you will be able to complete this tutorial by using special image files of scanned forms that were installed on your computer as part of the Remark Office OMR application. In this case, follow the instructions for using image files entitled, Acquire Images from File.
Once an image is acquired either by scanning or by opening an existing image file, the Template Editor will display a thumbnail of the image for your approval.

4 When a thumbnail image of your form appears, click the OK button to accept the image. If you see a crooked or skewed image in the thumbnail display, place your form back in the scanner and acquire another image.

5 Once the thumbnail image is accepted, the Template Editor will open the new form template where you can begin to define the regions.

To define form template regions

The purpose behind making a form template is to tell the software where to locate the information on your specific form and how to understand your specific data requirements.

The following table lists the six regions on the General Answer Sheet form and their corresponding region types:
To define the Student ID as a Barcode region

The Student ID will be defined as a barcode region. Using a barcode allows you to quickly collect each student’s ID number and then use this information on subsequent grade reports.

1. Highlight the **Page 1** node on the left side of your screen if it is not already highlighted.

2. Select the **Page** menu, click **Insert** and then click **Barcode Region After Selected Page**, or click the orange toolbar button to insert a Barcode region. Alternatively, select the **Define regions** link in the task pane and then select **Insert Barcode region**.

The mouse changes to a crosshair.

3. To create the Barcode region, place the cursor just beyond the top left of the barcode, then press and hold the left mouse button while dragging the rectangle beyond the bottom right corner of the barcode, making sure you have selected the entire allotted space. For barcodes, capture a little extra space at the end of the barcode to accommodate the largest possible barcode you might process.
After positioning the box, release the mouse button and the **Properties - Barcode Region** window will appear to allow you to define the region’s properties. This window allows you to provide pertinent information about the barcode.

Type **Student ID** in the **Region name** box. The Region name provides a brief description of the region and will become the name for this column in your data set.

Set the **Barcode type** to **Auto Detect** and the **Barcode orientation** to **Horizontal**. These settings allow you to specify specific barcode types and/or positioning if your form design ever requires it.

Click the **Region item properties** link in the Task Pane to the left.

In the area called **Analysis Respondent ID**, mark the checkbox for **Designate as a respondent ID**. When you run reports in Remark Quick Stats, any regions marked as Respondent IDs will appear on select reports to identify each respondent.

Click the **OK** button to return to the main Template Editor window.

You will now see an orange box around the barcode in the image area, identifying it as a Barcode region, and a new node in the tree view titled **Student ID**.

### To define the Grade Level section as an OMR region

The Grade Level section of the form allows the student to mark his or her grade level. This region is different however, in that the bubbles have text between them. When capturing an OMR region, you must only capture the marks, not any text near them. Therefore, for this region, we will demonstrate the Add Linked Region feature, which allows you to link one OMR region to another to form a single region (e.g., one question).
1 Highlight (if not already highlighted) the Student ID node in the tree view.

2 Click the green toolbar button to insert an OMR region, and use the crosshair to draw a box around the first column of six bubbles (representing grades 1-6). Only capture the bubbles; do not include any text. You will link the second column to the first in a later step.

3 When the Properties – OMR Region box opens, enter Grade Level in the Region name box.

4 Select Multiple as the OMR type.

5 Select Numeric for the Data type. This region contains grades from 1-12, so numeric data is appropriate.

6 In the Region Layout area, select Column for the Region orientation because the question is laid out in two columns.

7 Enter 1 in the Columns in the region box and 6 in the Rows in the region box.

8 Use the Possible label scales drop-down list to select 1-6. These labels will automatically fill the Labels grid. The Labels represent the data output you will see when you process forms.

9 Click the Region item properties link in the Task Pane.

10 In the Test Settings area, mark the radio button for Do not grade this item. We do not want a student’s grade level to be included when we grade this exam. Data will still be collected from this region when we are processing the completed forms.

11 Click the OK button to return to the main Template Editor window.

You will now see a green box around the column representing grades 1-6 in the image area, identifying it as an OMR region, and a new node in the tree view titled Grade Level.

To link the second set of grade levels to the first
The next step is to create another OMR region around the column representing grades 7-12. However, since they logically belong to the OMR region you just created ("Grade Level") we will use the Append Linked Region feature to create this OMR region.

1. With the **Grade Level** node highlighted in the tree view, select the **Region** menu and then click **Append Linked Region**, or click ![Append Linked Region](Image).

The mouse changes to a crosshair.

2. Draw a box around the second column of the **Grade Level** region, representing grades **7-12**.

When the **Properties – OMR Region** window opens, you will notice that the **Region Definition** and **Region Layout** areas have already been pre-filled with the information from the previous OMR region.

3. In the **Possible label scales** box, type **7** and then press **Enter**. The labels 7-12 will automatically fill the **Labels** grid.

4. Click the **OK** button to return to the main Template Editor window.

You will now see two dark green boxes around the columns representing grades 1-6 and 7-12 in the image area, identifying them as linked OMR regions.

**To define the exam questions as OMR regions**

The 50 exam questions are broken into five sections, each containing ten questions. You will create an OMR region for the first ten questions and then copy and paste that region to the other four sections.

**Tip:** When creating similar regions, using copy and paste can save time. Once you paste a region, you can access its properties to...
Learning Remark Office OMR

make any changes. However, by copying similar regions, you save time in entering all of the region information.

1 Highlight the **Grade Level** node in the tree view.

2 Click the green toolbar button 🟢 to insert an OMR region, and use the crosshair to draw a box around the first set of ten questions.

3 When the **Properties – OMR Region** box opens, enter **Question** in the **Region name** box. We will call all five regions containing the 50 questions “Question.” Your region names will then become Question1 through Question50.

4 Select **Multiple** as the **OMR type**.

5 Select **Textual** for the **Data type**. This region contains the answer choices A-E, so textual data is appropriate.

6 In the **Region Layout** area, select **Row** for the **Region orientation** because each question occupies one row.

7 Enter **5** in the **Columns in the region** box and **10** in the **Rows in the region** box.

8 Use the **Possible label scales** drop-down list to select **A-E**. These labels will automatically fill the **Labels** grid. The Labels represent the data output you will see when you process forms. Corresponding values will automatically be entered in the **Values** grid. These Values will be used for statistical analysis.

9 Click the **OK** button to return to the main Template Editor window.

You will now see a green box around questions 1-10 in the image area, identifying it as an OMR region, and a new node in the tree view titled **Question**.

**To copy and paste the Question OMR region**
We will now copy the region you just created and paste it over the remaining 40 questions.

1. With the **Question** node highlighted in the tree view, select the **Edit** menu and then click **Copy**, or click ![Copy icon](image).

2. Select the **Edit** menu and then click **Paste After**, or click ![Paste After icon](image). A red region will be drawn near questions 1-10.

3. Place the mouse directly over the red region until it becomes two double arrows and then drag the new region to questions 11-20, positioning it directly over the ten questions.

4. Release the mouse. Check your positioning; if the solid red color disappears, this is an indication that you have moved the box successfully.

5. Select the **Edit** menu and then click **Paste After** or click ![Paste After icon](image). Another red region will be drawn near questions 1-10.

6. Using your mouse, drag the new region to questions 21-30 and position it over the ten questions.

7. Repeat steps 5-6 for questions 31-40 and 41-50.

   **Tip:** You can use the keyboard shortcut keys for **Copy (Ctrl + C)** and **Paste (Ctrl + V)** for quick copying and pasting.

You should now have five OMR regions, one covering each of the groups of ten questions and 5 nodes in the tree view titled **Question (1-10)**, **Question (11-20)** and so forth.

**To save the Tutorial 2 form template**
1. Select the File menu and then click Save or click \[\text{Save} \]. Alternatively, select the Save template link in the Task Pane.

2. In the File name box, type Tutorial2 and then click the Save button.

   Note: If someone has already completed the tutorial with this file name, you may modify the file name.

3. You have now created the Tutorial 2 form template. Close the Template Editor by selecting the File menu and then clicking Exit. Alternatively, you may also simply click the X in the upper right hand corner of the Template Editor window.

5.3.2 Processing the Completed Answer Sheets

Now that you have created the form template for the General Answer Sheet you are ready to begin processing the completed forms using your scanner or the supplied image files.

The following section provides instructions for both reading from scanner and for reading from image files. If you have installed a supported scanner, use the filled in sample forms provided with the software and follow the instructions for using the scanner.

To open the General Answer Sheet form template

1. If not already running, start the Remark Office OMR Data Center. When the Data Center opens, it will display a blank spreadsheet-style data grid.

2. Select the File menu and then click Open Form Template or click \[\text{Open} \]. Alternatively, select the Open form template link in the Task Pane. You must open a form template in order to process forms.

3. Select the Tutorial2.omr file (or the file you created in the previous section of this tutorial) and then click the Open button.

When the Tutorial2 form template opens, its name will appear on the title bar at the top of the screen and you will see the region names you specified as your column headers in the data grid. Each column in the grid corresponds with one variable or question in the form template, as the column headers indicate. Each grid row will contain information from one processed form regardless of the number of pages the form contains. The data grid will fill row by row as your completed forms are processed.
To scan completed forms

The Read Wizard is used to scan completed forms and produce data. The Read Wizard has several steps to help customize the scanning process. This tutorial will focus on the basic scanning functions.

1. Place the supplied completed General Answer Sheet forms in your scanner in the following order (use the number beneath the Student ID barcode to locate each form): KEY, 12345, 67890, 09876.

2. Select the Tools menu and then click Read Wizard, or click . Alternatively, select the Read Wizard link in the Task Pane.

The Read Method window appears.

3. In the Select Method to Use for Data Collection area, mark the radio button for Read from scanner.

4. Click the Next>> button to continue.

The Scanned Image Naming Conventions window appears. The Data Center will store an image for each form that is scanned. You can use these stored images to clean your data later instead of looking through the actual paper forms. This window allows you to set the parameters for the images that will be stored.

5. By default the name of the form template will be listed in the Begin image names with box. If another user has changed the defaults, type the form template name in this box: Tutorial2. The date and time will be appended to this name to create unique names for each image file that gets stored during scanning.

6. The Image target directory box is used to hold the stored images. You may accept the current setting or click the Browse... button to choose a new location on your computer.
7 If not already selected, mark the checkbox for **Save images in a subfolder based on the form template’s name**. Using this feature places all images belonging to one form template in the same folder on your computer for easy access.

8 Click the **Next>>** button to continue.

The **Review Exceptions** window appears. This window allows you to configure options for reviewing exception cases such as blank and multiple responses. We will not be using this feature in this tutorial.

9 If the **Activate Review Exceptions** checkbox is marked, click in the checkbox to deselect this option.

10 Click the **Read** button to begin scanning forms.

11 When all forms have been scanned, and the **Would you like to continue scanning?** prompt appears, click the **No** button.

As each form is scanned, you will see a row added to the data grid. Skip to section 5.3.3 to continue the tutorial.

**To read from image files**

1 Select the **Tools** menu and then click **Read Wizard**, or click ![Read Wizard](image). Alternatively, select the **Read Wizard** link in the Task Pane.

   ![](image)

   The **Read Method** window appears.

2 In the **Select Method to Use for Data Collection** area, mark the radio button for **Read from image files**.

3 Click the **Next>>** button to continue.

The **Image Selection** window appears to enable you to view and select the images you want to process.
4 From the listed image files, double click the images in the following order: \texttt{key.pcx, 12345.pcx, 67890.pcx and 09876.pcx}. Make sure you select the files in this order. As you double click each file, it will be added to the Images in Read Order box.

5 Click the \textbf{Next} button to continue.

The \textbf{Review Exceptions} window appears. This window allows you to configure options for reviewing exception cases such as blank and multiple responses. We will not be using this feature in this tutorial.

6 If the \textbf{Activate Review Exceptions} checkbox is marked, click in the checkbox to deselect this option.

7 Click the \textbf{Read} button to begin reading the image files.

As each image is processed you will see a row added to the data grid.

\textbf{5.3.3 Reviewing and Correcting the Data}

After the four forms have been processed, four rows of data will be displayed in the data grid. Each row represents the responses collected from one of the four forms. The first row is the answer key for the exam, and the following three rows are student exams. You are now ready to inspect the data for missing or unrecognized responses in order to prepare for either analysis or export.

As mentioned in the first tutorial, Remark Office OMR informs you of unrecognized or questionable responses by placing a visible flag in each appropriate data grid cell. The software will then assist you to correct exception cases or problems by allowing you to see what was entered on the actual form. The stored images for each processed form will be available to show you respondents’ answer choices.

For this tutorial, we will run \textbf{Review Exceptions}, which provides an automated way to search through the data for exceptions and then correct them.

\textbf{To run Review Exceptions}

1 Select the \textbf{Tools} menu and then click \textbf{Review Exceptions}, or click \includegraphics[width=1cm]{image.png}. Alternatively, select the \textbf{Review exceptions} link in the Task Pane.

The \textbf{Review Exceptions} window will appear in the Task Pane.
2 The top half of the pane allows you to select the search cases (e.g., multiple responses, blank responses, etc.). Make sure Multiple responses and Blank responses are checked.

3 The bottom half of the window allows you to configure and begin the search. You may search by Row/Respondent (across rows) or by Column/Item (down the columns). For this tutorial, select Row/Respondent.

4 Click the Begin Review button to start the automated review. The software will search through the data set to locate the flagged cells.

The first piece of flagged data is a multiple response in the second grid row for the item called Grade Level. In the Review Exceptions window, you will see a green flag and Response for [Grade Level]. The green flag tells you that a multiple response was encountered. The text in the brackets ([Grade Level]) tells you the question or item where the multiple response was encountered. In the box beneath Response for [Grade Level] use the drop-down list to select the appropriate response. Use the Image Viewer beneath the data grid to review the student’s exam. In this case, you will see the student accidentally marked 10 and then put an X through it. The intended response was 11. Select 11 from the drop-down list.

5 Click the first green arrow, titled Search Forward to move to the next exception. Or, simply press Enter.

6 The next exception is a multiple response in row three for question 15. Look at the Image Viewer to see the intended response. In this case, the student marked both D and E, but crossed out D. Use the drop-down list in the Review Exceptions pane to select E from the list.
7 Click the first green arrow, titled **Search Forward** to move to the next exception. Or, simply press **Enter**.

8 The next exception is a blank response in row 4 for question 6. Look at the Image Viewer to see the intended responses. In this case, the student truly left the question blank. You may simply press **Enter** to ignore it. The question will be marked as incorrect when the data are scored.

9 When prompted, click **Yes** to the message **Are you sure you are finished reviewing exceptions?**.

10 Click the **Back** button in the **Review Exceptions** pane to return to the regular Task Pane.

Your data is now ready to be saved and analyzed.

### 5.3.4 Saving the Exam Data

Remark Office OMR provides many file formats for exporting data to other applications. For this tutorial, the data will be saved to the Remark (RMK) format, which is a proprietary format within the software. This format saves the exception flags (if any are present) as well as the link from the data to the stored images so that you can open your data and still view the image that corresponds with any piece of data.

#### To save the exam data

1 Select the **File** menu and then click **Save**, or click ![image](image.png).

2 Data can be saved anywhere on your system. By default, a Data folder is installed in the Remark Office OMR directory; we recommend using this folder for storage of data files. In the **Look in** box, navigate to this Data
folder on your system (e.g., C:\Program Files\Principia Products\Remark Office OMR 6\Data).

3 Click the **Save as type** down arrow to display a list of file types.

4 If not already selected, click the **Remark (.RMK)** format.

5 Type **Tutorial2** in the box titled **File name**.

6 Click the **OK** button to save the file.

### 5.3.5 Grading the Exam Data

Remark Office OMR provides statistical analysis functionality for grading data from your exams. There are two ways to grade an exam:

**Easy Grade**: Uses the first grid row as the answer key by default as well as all settings defined in the form template (e.g., whether a question is graded, assigned point values and respondent identifiers).

**Grade Wizard**: Allows you to customize the grading process, including adding benchmark values, customized grade scales and learning objectives (subtests).

For this tutorial, we will demonstrate the **Grade Wizard**.

**Tip**: The **Remark Quick Stats** module of the software includes various ways to tabulate/grade data and display reports. Review the Remark Quick Stats User’s Guide PDF file by clicking **Start|Programs|Remark Office OMR 6|Documentation** to see all available analysis features.

---

**To grade the exam data**

1 Select the **Tools** menu, click **Analysis** and then click **Grade Wizard**, or click **.** Alternatively, select the **Analysis** tab in the Task Pane and then click the **Grade Wizard** link.

The **Grade Wizard Getting Started** window appears.

2 In the **Designate Learning Objectives** area, mark the
checkbox for **This test contains one or more learning objectives.** We will define two learning objectives from the test. A learning objective is a subset of questions that pertains to a particular topic (e.g., Spelling or Grammar on a Language Arts exam). Questions will be mapped to each learning objective, producing a separate score for the objectives in addition to an overall score for the test.

3  Mark the checkbox for **Define Benchmark Value for Overall Test.** In the box titled **Benchmark percent** below, enter the number **75**. A Benchmark is a target score you want your students to achieve. Reports that include benchmarks will show you which students achieved the benchmark percent, which did not and the differential. Using Benchmarks is useful for seeing how well your students are mastering topics.

4  Click the **Next>>** button to continue.

The **Answer Key** window appears. This window is where you specify an answer key. You may scan a key, import a key from an image file, use a grid row as the key or type an answer key. In our case, we processed the answer key as the first row of our data grid.

5  In the **Answer key source** box, use the drop-down arrow to select **Grid Row**. By default, the Grid Row box will be filled with the number 1.

6  Click the **Get Key** button to obtain the answer key responses from the data grid.

7  Click the **Next>>** button to continue.

The **Question Properties** window appears. This window allows you to change properties you defined in the form template for this grading session. You may change things such as respondent identifiers, point values, correct answers, data type and question text. You may also add a benchmark value for individual questions. Changes made here do not change the form template. You may hold down the **Shift** or **Ctrl** keys and select multiple questions to make the same change to each question. For the purposes of this tutorial, we are not going to make any changes to the question properties.
8 Click the Next>> button to continue.

The Learning Objectives window appears. This window is where you define learning objectives (sometimes called subtests). You may assign questions to each learning objective you define so that the software will provide a separate grade for that subset of questions. This feature allows you to track progress on specific objectives that you are teaching your students. For this tutorial, we will define two learning objectives.

9 In the Create New Learning Objectives area, enter Spelling in the Name box.

10 Click the Add Objective button.

11 Enter Grammar in the Name box.

12 Click the Add Objective button.

You should now have two learning objectives defined: Spelling and Grammar. The next step is to pick the questions that belong to each Learning Objective.

13 Highlight Spelling in the Learning objectives column.

14 In the Available questions column, click Question1. Hold down the Shift key and then click Question5. Question1 through Question5 should be selected.

15 Click the Add questions to the selected learning objectives button (>>). The questions will appear under Spelling in the Learning objectives column.

16 Mark the Define Benchmark Value box and enter a Benchmark percent of 75. Using a benchmark score indicates that your students need to score at least 75% on this learning objective (Spelling - Questions 1-5) to be considered proficient at spelling.

17 Highlight Grammar in the Learning objectives column.

18 In the Available questions column, click Question6, hold down Shift and then click Question10. Question6 through Question10 should be selected.
19 Click the **Add questions to the selected learning objectives button** (>>). The questions will appear under **Grammar** in the **Learning objectives** column.

20 Mark the **Define Benchmark Value** box and enter a **Benchmark percent** of **80**. Using a benchmark score indicates that your students need to score at least 80% on this learning objective (Grammar - Questions 6-10) to be considered proficient at grammar.

21 Click the **Next>>** button to continue.

The **Grade scales** window appears. This window allows you to select or create grade scales used to determine final grades.

22 For this tutorial, we will use the default Grade Scale. If it does not appear automatically, click the **Scales** drop-down list and select **Default**.

23 Click the **Next>>** button to continue.

The **Review selections** window appears. This window allows you to check all of the parameters you have just specified.

24 Once you are satisfied with the review, click the **Finish** button.

You will be prompted to save the answer key. Saving answer keys is useful if you administer the same test on multiple occasions.

25 Click the **Yes** button to save the answer key.

26 In the **Save Answer Key** window, type **Tutorial2** in the **File name** box.

27 Click the **Save** button to save the file. You will receive a confirmation notice that the file was saved and then Remark Quick Stats will open.
5.3.6 Reviewing Grade Results
Once Remark Quick Stats opens, you have access to a variety of grade reports. You can report on the test itself, the class or individual students. For this tutorial, we will look at the Student Statistics and Student Grade Reports.

To run the Student Statistics Report
1. In the Task Pane, select the Display Reports link to view the selection of available reports.
2. Select the Student Statistics Report link in the list; the report will display on the right.

The Student Statistics Report displays the grades for the entire class. Each student can optionally be identified by an Analysis Respondent ID region (chosen in the form template or Grade Wizard) if desired. In this tutorial, we designated the Student ID barcode as an Analysis Respondent ID. You can also view the benchmark information and learning objectives. This report provides a nice overview of how your class is performing.

Next, we will take a look at the Student Grade Report.

To run the Student Grade Report
1. In the Task Pane, select the Student Grade Report link in the list; the report will display on the right.

The Student Grade Report shows an individual report of each student’s grades. You can show the correct and incorrect responses, as well as an image of the actual test as it was scanned. You can also add customized headings such as high, low and mean scores for the class.

5.3.7 Exporting the Student Grade Reports
Once you have tabulated your data, you can save a report and/or export the report to one or more formats for either storing or sharing with others. For this tutorial, we will export the Student Grade Reports to PDF files. Saving to this format could allow you to email exam grades to parents, for example.

To export the Student Grade Reports
1. Select the **File** menu and then click **Export**, or click ![Export icon](image). Alternatively, click the **Export report** link in the Task Pane.

2. In the **Export format** box, select **Portable Document Format (PDF)**.

3. In the **Page Range** area, select **All**.

4. In the **Export Options** area, click the ellipse (...) next to **File name** to choose a location and file name for the PDF file.

5. In the **Save As** window, use the **Look in** drop-down list to locate a folder on your computer for the file. For this tutorial, use **My Documents**.

6. Set the **Acrobat version** to its default value **4.x** and the **Image quality** to its default value of **High** (there are no images in this report).

7. Click the **Export** button to export the report.

You may now go to the My Documents folder on your computer and view the resulting PDF files.

### 5.3.8 Tutorial 2 Summary

The second tutorial illustrated basic and some more advanced features of the software, including:

- Creating a form template, including linking regions and setting grading options
- Processing forms
- Using Review Exceptions
- Saving data
- The Grade Wizard
- Exporting Reports

You are encouraged to read the rest of this user’s guide to gain a more in depth understanding of the concepts explained in these tutorials, as well as other functionality within Remark Office OMR.
Designing Forms

Chapter 6

6.1 Overview

Remark Office OMR provides a flexible solution for scanning forms you create and producing data and reports. Because there is so much flexibility, a wide variety of forms can be created. Good form design is a key component to using Remark Office OMR successfully. Therefore, Principia Products has created a set of form design guidelines to help you create forms that will work well with the software.
Remark Office OMR User’s Guide

**Note:** Remark Office OMR is not a form designer. Forms that will be used with Remark Office OMR are created independently of the software in programs such as word processing and survey design packages.

Remark Office OMR will work with plain paper forms; no special inks or marks are needed. Respondents can use pen or pencil to complete the forms.

Designing scannable forms for Remark Office OMR can be broken down into the following elements:
- Finding an application for designing forms
- Mark selection
- Form spacing
- Question grouping
- Using shading
- Barcodes
- Paper selection
- Duplicating forms
- Testing forms
- Form review service

### 6.2 Finding an Application for Designing Forms

The first step in designing a scannable form is determining where you prefer to design the form. Some of your options include:
- Word processing software
- Survey design software
- Form design software

Word processing software (e.g., Microsoft Word, Corel WordPerfect) is commonly used for creating forms, as many people already have this software and are familiar with using it. If you are comfortable with word processing software, this may be the best choice for you.

Software created specifically for survey design and analysis can offer the additional benefits of question banks (the ability to draw and save questions to and from a question library), layout assistance and analysis components. Form
design software can give you advanced layout tools to create professional looking forms.

Determining what software application to use is an individual decision. You should base your decision on what you are comfortable with using, your budget and your overall data collection needs. No matter what your choice, the design guidelines set forth in the next several sections apply. Please read through them thoroughly before undertaking your own form design.

You may wish to consult the Principia Products web site (see the back of this user's guide for web site information) for up to date partner information about survey and form design software. We provide links to manufacturer web sites, many of which have demonstration software you can try. By seeing what tools are available, you can make an educated decision on what is the best solution for your needs.

6.3 Mark Selection

Forms need to be created so that Remark Office OMR can recognize the data on them. Remark Office OMR recognizes optical marks, which include bubbles (a circle or oval), checkboxes, etc., that respondents darken with a pen or pencil to indicate their response. Although Remark Office OMR works with almost any complete shape (e.g., circle, square, triangle), experience indicates that bubbles between 10 and 14 points in height work the best. Non-oval shapes are somewhat harder to fill completely. Respondents will typically fill bubbles more completely and neatly, which leads to better recognition rates.

When using word processing software, we recommend using a capital "O" in an Arial font. You may also use our OMR Bubbles font, which creates an encircled letter or number (©). The OMR Bubbles font installs with the Remark software. It can also be downloaded from the Principia Products web site (see the back of this user's guide for web site information). Once installed, you may access it from programs on your computer just as you would any other font. While it is possible to place numbers or letters inside of marks, the number/letter must be as small and light as possible. Dark, thick or bolded characters may cause Remark Office OMR to interpret the mark as being filled.

We do not recommend creating bubbles using the Times New Roman font, which is often the default font in word processing programs. This font does not create an evenly defined bubble and can therefore break apart when scanned. Using the Arial font will yield a well defined bubble that scans consistently.

**Important Keyword:**

**Mark:** A mark is any type of complete shape used on a form.
Respondents will darken the marks to indicate their answer choice. Marks are typically bubbles or checkboxes on OMR forms.

6.4 Form Spacing

Allowing enough white space on a form is an important part of good form design. Allow at least 3/8 inch of space between any text, lines or graphics on the form and all user-markable areas (bubbles, checkboxes, etc.). The white space around your marks provides a buffer that can help Remark Office OMR accommodate scanner skew, form offset and not-so-perfect markings from your respondents. The more white space you have, the better Remark Office OMR is able to tolerate differences from form to form. In contrast, the more crowded a form (or the less white space there is), the harder it is for Remark Office OMR to compensate for form differences.

Although groups of bubbles need to be 3/8 inch away from any visible lines or text, the individual bubbles within the group can be as close to one another as two character spaces.

We recommend staying away from the use of lines or boxes around or between the marks on a form. If you find it necessary to use lines or boxes, you may make them a light gray that will drop out (completely disappear) during the scanning process. In addition, follow the spacing guidelines above.

**Note:** You cannot photocopy forms that use gray lines as the gray will become too dark. Only use clean printouts for forms utilizing gray lines.

Example of good form spacing:

<table>
<thead>
<tr>
<th></th>
<th>Excellent</th>
<th>Good</th>
<th>Fair</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question 1</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Question 2</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Question 3</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
</tbody>
</table>

6.5 Grouping Questions

Positioning all of the marks for the same question type in a single region area minimizes your efforts when you create form templates within the software.
Whenever possible, try to place similar types of questions together. For example, place all true/false questions in one area of the form and all multiple choice questions in another. All marks you want to define in a single OMR region must align horizontally and vertically.

When possible, place the labels for a group of questions on the top of each column or at the beginning of each row (at least 3/8\textsuperscript{th} inch away from the marks); this will allow you to select the entire group of questions within one region when you create a form template in the software. If the labels are between marks, you may have to select questions individually and/or link marks together to form logical questions.

Example:

Original Layout:    Better Layout:
What is your gender?   What is your gender?

O     Female   O     Female
O     Male

6.6 Shading

Remark Office OMR works best with marks printed in black ink on white paper without shading. While we do not recommend the use of shading in areas containing marks, you can create shading that completely drops out when scanned (a 5-10\% gray typically works well). A better alternative is to shade the questions but leave the area containing the marks white:

Example:

<table>
<thead>
<tr>
<th></th>
<th>Excellent</th>
<th>Good</th>
<th>Fair</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text for Question 1</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Text for Question 2</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
</tbody>
</table>
Always test your form with your scanner before printing large quantities.

**Note:** You cannot photocopy forms that use shading as the shading will become too dark. Use clean printouts for forms utilizing shading.

### 6.7 Margins

Margin space along the edges of a form is important. We recommend leaving a 1 inch margin around all sides of the page. At a minimum, do not go below ½ inch margins. The margin space will allow some shifting in forms without having the marks fall off of the page when scanned. The smaller the margin, the less tolerance you will have for inconsistencies from form to form.

### 6.8 Barcodes

In addition to marks, Remark Office OMR can also read barcodes. Barcodes can be used to capture a variety of information, including, but not limited to, names, ID numbers, session/class numbers, other demographic information, etc. The software recognizes three different barcode types:

- **Code 3 of 9 (Code 39):** Alphanumeric
- **Interleaved 2 of 5:** Numeric only
- **Codabar:** Numeric only

The Code 39 barcode is created by installing the Code 39 barcode font. This font installs automatically with the software or can be downloaded from our web site (see the back of this user's guide for web site information).

**Important Tip:** When using the Code 39 barcode font you will need to begin and end the barcode with asterisks. These asterisks become bars in the barcode and aid with proper recognition of the
Designing Forms

Barcode. In addition, do not use spaces in the barcode. If you need to represent a space, use the exclamation point (!) character.

Example: To barcode the name Jane Doe, you would type: *Jane!Doe* and then convert the entire sequence to the Code 39 barcode font.

Use the following guidelines when placing barcodes on your forms:

- Barcodes should be at least 26 points in terms of size (about 1/4 inch high)
- Barcodes may be placed on forms horizontally or vertically
- If using barcode stickers, place a lightly colored placeholder on the form so that the person affixing the stickers to the form knows where to place the barcodes. The barcodes must be in the same place on each form in order for Remark Office OMR to recognize them. Ideally, the placeholder should be covered by the sticker or light enough to drop out (completely disappear) when scanned. You do not want the placeholder to interfere with recognition of the barcode.

Example:

- Do not put text, lines, etc., within ½ inch of the barcode (*with the exception of the tip below)

Tip: If you would like to be able to read the barcode with the human eye, place the text of the barcode in small, light print directly beneath the barcode. Example:

!12345!

6.9 Paper

Remark Office OMR works best with plain white paper and black ink. Utilizing standard 20# copier paper works well for single sided forms and 28# or higher paper works well for double sided forms (heavier paper helps avoid bleed-
through). While we recommend using white paper for the best recognition, you may use colored paper (pastel colors tend to work well), as long as the coloring completely drops out when scanned. Test your paper selection with your scanner before printing large quantities of your forms.

**Tip:** You can test colored paper by scanning a form in the Remark Office OMR Template Editor. The resulting image should have a white background with black text. If you see speckles or other black marks in the background, your paper may be too dark. You can try raising the brightness setting on your scanner to see if the rest of the color from the paper will drop out without compromising the marks on the form.

Remark Office OMR will support any paper size or thickness supported by your scanner. Consult your scanner’s user’s guide for further information.

### 6.10 Form Duplication

Quality and consistency in form reproduction reduce form processing errors. You have the flexibility to duplicate forms in several ways: using a laser printer, a high quality photocopier or a professional printer. Consistency from form to form is important. Try to use the same source to duplicate all of the forms you will need for a single form type.

When photocopying forms, the accuracy of page placement into the photocopier and your overall form design are the limiting factors as to how large your margins must be in order to minimize errors. Forms with inadequate spacing will have a low tolerance for offset/skew. Carefully placing forms directly on the photocopy machine’s glass tends to yield better copies than using the document feeder, which can skew the page as it is pulled into the copier. Test your form by creating a form template in the software and processing a batch of forms that are filled out as you expect to have them returned (e.g., not perfectly) before printing large quantities. Once you feel that your form design is adequate, try to photocopy all of the forms that you will need in one batch. This will eliminate the need to make photocopies from photocopies at a later date, which can lead to form inconsistencies.

Regardless of how you duplicate your forms, be sure to keep blank copies on hand. You always want to create your Remark Office OMR template using the same quality form that you distribute to your respondents. For example, if you photocopy your form, use a blank photocopy to make the form template in the software.
It is best to maintain as much control over form duplication as possible. However, if you use multiple sources for form duplication (e.g., two different printers), obtain at least one blank copy of the form from each source. This will allow you to realign your scanning template to the printout if you find that the forms have shifted significantly.

**Tip:** Save forms to the Adobe PDF format to retain original form formatting. If you need to have someone else print your form, this format is preferable over other native word processing formats. Remember to embed the fonts you use in case the person printing the form does not have the same fonts.

### 6.11 Form Testing

The best way to know whether you have created a good, scannable form is to test it. Always test any forms you plan to use with Remark Office OMR before printing and distributing them. It is much easier to find and fix problems before the forms are printed and distributed.

To test your form, make a form template in the Remark Office OMR Template Editor (see Chapter 7 for more information). Then fill out a sampling of forms as you expect to get them back from your respondents (not perfectly!). Scan the forms and check your results. If you do not get the accuracy you expect, check your form’s design against the guidelines presented in this user’s guide and make the appropriate modifications.

### 6.12 Form Review Service

Principia Products will review any form to ensure it is compatible with Remark Office OMR. You can email or fax forms to our technical support department and we will check them for known issues. We can often head off potential issues before they become problems. Be sure to use this service before you print and distribute your forms. Please see the back of this user’s guide or our web site (see the back of this user's guide for web site information) for up to date contact information for sending your forms.
Using the Template Editor

Chapter 7

7.1 Overview

You must create one form template file for each type of form that you process with the Remark Office OMR software. The template file defines all of the information needed for the software to process your form correctly. Creating
and editing form templates is accomplished through the Remark Office OMR Template Editor.

The form template file holds information about where the marks, barcodes and text are located on the page, how many pages your form contains and what type of output you would like. A single template can hold up to 150 pages.

**Tip:** The form template is the key to accurate recognition in Remark Office OMR. When creating form templates, be sure to use the same quality form as you will be distributing to your respondents (e.g., if you will be photocopying forms, use a blank photocopy for the template). Also use the same scanner and scanner settings for both the form template and the filled in forms (e.g., resolution and brightness).

The following topics are covered in this chapter:

- Understanding the template editor interface
- Creating form templates
- Region types
- Creating regions
- Region properties
- Editing regions
- Additional template editor features
- Saving form templates
- Editing existing form templates
- Template Editor preferences

### 7.2 Creating Form Templates

#### 7.2.1 Understanding the Template Editor Interface

The Remark Office OMR Template Editor contains three basic components that you will use to create and edit your form templates. The left portion of the template editor window contains a tree view with nodes representing each region in your template.

**Important Keyword:**

**Region:** A region is an Image, Barcode or OMR area that you
define. A single OMR region can contain one question or multiple questions.

Also in the left portion of the window, you will find the Task Pane. The Task Pane contains links to commonly used features and updates automatically based on your selections to help you navigate through the software. (Note that you may turn off the Task Pane by clicking View|Task Pane.) The right side of the window contains an image representation of your form. You provide this image via the scanner or a saved image file. You may use the tree view and the image representation area to work with your form template. Each node in the tree view contains the properties of that node, which can be accessed by double clicking the node. You may also double click within a region in the image representation area to view the region’s properties. Continue with the following sections for specific instructions on using the template editor.

7.2.2 Beginning the Form Template

Form templates are created in the Remark Office OMR Template Editor. There are two main ways to access the Template Editor to create a new form template:

- From the Remark Office OMR Data Center, select the File menu and then click New Form Template. Alternatively, with the Templates tab selected, click New form template in the Task Pane.
- From your Windows Start menu, click Start|Programs|Remark Office OMR 6|Remark Office OMR Template Editor.

To create a new form template

1 Select the File menu and then click New, or click , to begin a new form template. Alternatively, select New form template from the Task Pane.

The New Form Template Properties window appears. This window allows you to specify general information about the template, including a description, page size and page orientation.

2 If desired, enter a description for the form template in the Description box.
3 Select the appropriate size of the form(s) you will be scanning in the **Size** drop-down box. All pages contained in a form template must be of the same size.

4 Select the orientation of the form in the **Orientation** area. All pages contained in a template must be of the same orientation.

**Tip:** You may not change the Size and Orientation once the form template is created. Therefore, make your selections carefully in this window.

5 Click the **Next>>** button to continue.

The **Create Page Elements** window appears. From this window, select how you want to import the images of your form. You may scan pages directly into the Template Editor or you may import image files (that you previously scanned and saved) of the form. Regardless of how you import these images, remember to always base your form template off of a blank copy of your form.

To create an image source using the scanner

1 In the **Select Method to Use for Image Acquisition** section, click the **Read from scanner** radio button.

   **Note:** If you need to configure your scanner, you may click the **Scanner Properties** link just after Read from scanner to view the **Scanner Properties** window. (See Chapter 4 for further details about using a scanner.)

2 Place the blank page(s) to be scanned in the scanner. You may scan pages one at a time or all of the form’s pages at once.

3 Click the **Acquire Images from Scanner** button to scan the page(s).

The page(s) will be scanned and then a thumbnail image of the form will appear in the **Image** window. If scanning multiple pages at once, use the arrows under the image to view all scanned images. You may also delete
images by clicking the **Delete** icon.

4. If you are satisfied with the image(s), click the **OK** button. Otherwise, click **Acquire Images from Scanner** again to rescan a page. (Make sure images do not look severely skewed; if they are, acquire the images from the scanner again.)

Remark Office OMR will open a window with a tree view on the left and an image representation of your form on the right. In this window you outline the areas to be recognized. You may continue to Section 7.2.3 Creating Regions.

**To create an image source using an image file**

1. In the **Select Method to Use for Image Acquisition** section, select the **Read from image files** radio button.

2. Click the **Acquire Images from File** button to select an image from file.

3. In the **Select Image File...** window, use the **Look in** drop-down list to find the file(s) you wish to use for the form template. You may only select one image at a time; however you can go back to this window to select more images in succession.

A thumbnail image of the form will appear in the **Image** window.

4. Repeat Steps 2-3 to add any other images to the form template.

5. If you are satisfied with the image(s), click the **OK** button. Otherwise, click **Acquire Images from File** again to reselect an image.

Remark Office OMR will open a window with a tree view on the left and an image representation of your form on the right. In this window you outline the areas to be recognized.
**Tip:** For multi-page forms, you can decide whether you want to start with a single template page or all pages at once. If you need to add pages later, simply click a page node in the tree view and use the **Page|Insert** menu to add new pages.

### 7.2.3 Creating Regions

Regions can be created several different ways: by using the tree view, menus, Task Pane or image representation area. The following sections detail these methods.

You can create regions using the tree view by utilizing the appropriate menus and/or the mouse. The tree view contains nodes representing each page and region of your form. You can double click or right click each node in the tree view to perform specific actions.

<table>
<thead>
<tr>
<th>Using Menus to Insert Regions</th>
<th>Using a Mouse to Insert Regions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Click the node above or below where you would like the new region to be added so that it is highlighted. For the first question in a form template, click the <strong>Page 1</strong> node.</td>
<td>1 Click the node above or below where you would like the new region to be added so that it is highlighted. For the first question in a form template, click the <strong>Page 1</strong> node.</td>
</tr>
<tr>
<td>2 Click the <strong>Region</strong> menu if you have selected a region. Click the <strong>Page</strong> menu if you have selected a page.</td>
<td>2 Right click the same node to display a drop-down menu.</td>
</tr>
<tr>
<td>3 Click <strong>Insert</strong>.</td>
<td>3 Click <strong>Insert</strong>.</td>
</tr>
<tr>
<td>4 Make the appropriate selection based on what you would like to insert and whether you want to insert it before or after the selected node: <strong>Page After</strong>, <strong>OMR Region After</strong>, <strong>Image Region After</strong>, <strong>Barcode</strong></td>
<td>4 Make the appropriate selection based on what you would like to insert and whether you want to insert it before or after the selected node: <strong>Page After</strong>, <strong>OMR Region After</strong>, <strong>Image Region After</strong>, <strong>Barcode</strong></td>
</tr>
</tbody>
</table>
Region After, Barcode
Region After, Page Before,
OMR Region Before,
Image Region Before or
Barcode Region Before.

Note: You may also use the toolbar buttons to insert each region type: (green for OMR regions, orange for Barcode regions and blue for Image regions).

The mouse cursor will turn to a crosshair, indicating you need to drag a box around the region in the image representation area of the screen. When you drag a box around an OMR region, do not include any surrounding text, lines or graphics.

5 Place the crosshair in the top left corner of the region, hold down the left mouse button and drag a box to the lower right hand corner of the region.

6 Release the mouse button.

The Region Properties box appears. Region types and properties are explained in the following sections.

Using the image representation area to create regions
1 Right click the mouse in the image representation area and then click Insert.

2 Select the type of region you want to create. The Region Properties box appears.

   Tip: Right clicking anywhere in the image representation will insert the new region after the last region that was defined on the page. To insert a region in a specific order, first select a region then right click and choose Insert. Next, make the selection that best indicates where you want the new item to be placed relative to the selected region (Page After, OMR Region After, etc.).

Region types and properties are explained in the following sections.

Using the Task Pane to create regions
1. If the Task Pane is not visible, select the View menu and then click Task Pane. The Task Pane will update automatically based on your last action.

2. Click the Define regions link.

3. Select the link corresponding to the type of region you would like to insert: Insert OMR region, Insert Image region, Insert Barcode region. The new region will be inserted after the currently selected node in the tree view.

4. Place the crosshair in the top left corner of the region, hold down the left mouse button and drag a box to the lower right hand corner of the region.

5. Release the mouse button.

The Region Properties box appears. Region types and properties are explained in the following sections.

7.2.4 Creating an OMR Region

An OMR region is an area on the form containing OMR bubbles, checkboxes, etc. The respondent darkens the marks that correspond with his or her answer choice. Each OMR region contains a specific number of rows and columns. A single OMR region can contain one question or several questions. When an OMR region is created, you must specify certain properties pertaining to the region, including the size of the region, the type of region and what output Remark Office OMR should generate. These topics are covered in the following sections.

7.2.4.a OMR Region Types

There are six types of OMR regions. The following section describes each type in full detail, and includes examples of each style. The examples include the region as it looks on the printed page as well as how a selected response might appear in the data grid when you are processing forms.

**Multiple Region:** A Multiple region designation is used for multiple choice style questions. These questions can allow a single response or multiple responses. One Multiple region may contain more than one question.

*Example 1:*

Form:                     Data Output:
Gender

- Female
- Male

**Example 2:**

Form:

<table>
<thead>
<tr>
<th>Question 1</th>
<th>Question 2</th>
<th>Question 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Data Output:

<table>
<thead>
<tr>
<th>Question1</th>
<th>Question2</th>
<th>Question3</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
</tr>
</tbody>
</table>

**Grid Region:** A Grid region designation is used for questions where the output from the rows and columns needs to be one piece of data. The respondent typically fills in several bubbles that make up one response (e.g., student ID regions, name regions, social security number regions).

**Example:**

Form:

Identification Number

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
List Region: A List region designation is used for regions that contain multiple choice style questions, but the response bubbles are not contained in a single row or column. Each bubble has a unique output value.

Example:

Form:
What is your middle initial?

Data Output:

<table>
<thead>
<tr>
<th>Id Number</th>
<th>0123456</th>
</tr>
</thead>
</table>

*MI*
**Add Region:** An Add region designates a region where the values of all of the chosen OMR bubbles will be added together to produce one value. You can assign individual values to each answer choice (or mark on the form).

*Example 1:*
For this example, you could add each of the scale values chosen to make up one total response:

**Form:**
Please answer the following questions honestly using the scale provided:

<table>
<thead>
<tr>
<th>Unhappy</th>
<th>Happy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5</td>
<td></td>
</tr>
</tbody>
</table>

How do you feel today?   O  ●  O  O  O
How did you feel yesterday?  O  ●  O  O  O
How did you feel last week?  O  O  ●  O  O

**Data Output (2+2+3):**

<table>
<thead>
<tr>
<th>Feelings</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
</tr>
</tbody>
</table>

*Example 2:*
In this example, you could assign a 1 to each positive response and a -1 to each negative response and Remark Office OMR would output a total:

Form:
Mark the characteristics that you think apply to you:

(+1) (-1)

- happy most of the time
- laid back
- fun
- intelligent
- good looking
- unhappy most of the time
- tense
- boring
- unintelligent
- ugly

Data Output (1+1+1-1-1):

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>1</th>
</tr>
</thead>
</table>

**Boolean Region:** A Boolean region designation is used when you want a user-defined value (e.g., Yes) to be output if an answer choice is selected and another user-defined value (e.g., No) for answer choices that are not selected. Each response is output to a separate cell in the template grid during form processing. In comparison, when you use the Multiple or List region types for questions that allow multiple responses, Remark Office OMR places the data in a single cell, delimited by commas. The Boolean region type is useful for questions that allow multiple responses but for which you need the data in separate cells. For example, the Boolean region type can be used when you will be exporting data to programs such as SPSS that cannot handle multiple responses that are delimited by a comma.

**Example:**

Form:
In which of the following activities do you participate (mark all that apply)?

- Athletics (collegiate)
Binary Region: A Binary region designation is used when you want a predefined value (1) to be output if an answer choice is selected and another predefined value (0) for answer choices that are not selected. Binary regions output all responses to one cell. Using the previous example you would have the following:

**Example:**

Form:
In which of the following activities do you participate (mark all that apply)?

- O Athletics (collegiate)
- ● Athletics (intramural)
- O Chess Team
- ● Debate Team
- O Marching Band
7.2.4.b Region Orientation

An OMR region can be oriented in columns or rows. The region orientation property in the template determines how the region is positioned on the form: by column or by row.

Column: Regions oriented by column contain question(s) that are positioned on the form in columns.

Examples:

Select the best response: What is your gender?

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A</td>
<td>Female</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>Gender</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td></td>
</tr>
<tr>
<td></td>
<td>D</td>
<td></td>
</tr>
</tbody>
</table>

Row: Regions oriented by row contain question(s) that are positioned on the form in rows.

Examples:

Excellent  Good  Fair  Poor
Using the Template Editor

Question 1 0 0 0 0 0
Question 2 0 0 0 0 0
Question 2 0 0 0 0 0

What is your age group?

18-24 25-34 35-44 45-54 55-64 65+
0 0 0 0 0 0

7.2.5 Defining the OMR Region

Once you have inserted an OMR region, the Properties - OMR Region window will appear. The following table contains a brief summary of the OMR region properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region name</td>
<td>A name assigned to an OMR region. Region names are used as grid column headers in the data grid window and are exported when saving data to common file formats. Region names are limited to 60 characters.</td>
</tr>
<tr>
<td>OMR type</td>
<td>The type of OMR region being described. Region types include:</td>
</tr>
<tr>
<td></td>
<td><em>Multiple</em>- indicates a region containing multiple choice questions.</td>
</tr>
<tr>
<td></td>
<td><em>Grid</em>- indicates a grid of marks (bubble, checkbox) that equates to a single piece of data (e.g., student ID number).</td>
</tr>
<tr>
<td></td>
<td><em>List</em>- indicates a region where each mark is assigned a</td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>unique output value, but the marks are not contained in a single row or column.</td>
</tr>
<tr>
<td>Add-</td>
<td>indicates a region where the values for each of the answers that are filled by the user will be added together to produce a single value for numeric data, or concatenated together for textual data.</td>
</tr>
<tr>
<td>Boolean-</td>
<td>indicates a region where a value (e.g., Yes) will be output for filled responses and another value (e.g., No) will be output for non-filled responses.  Boolean regions output one piece of data for each mark in the region.</td>
</tr>
<tr>
<td>Binary-</td>
<td>indicates a region where a value of 1 will be output for filled responses and a value 0 will be output for non-filled responses.  Binary regions output a string of responses (1s and 0s) to a single cell.</td>
</tr>
<tr>
<td>Data type</td>
<td>Sets whether the data should be considered text or numeric when saved/exported.</td>
</tr>
<tr>
<td>Region orientation</td>
<td>Sets the orientation of the region in terms of columns and rows:</td>
</tr>
<tr>
<td>Column-</td>
<td>the region contains questions that are oriented in columns.</td>
</tr>
<tr>
<td>Row-</td>
<td>the region contains questions that are oriented in rows.</td>
</tr>
<tr>
<td>Columns in the region</td>
<td>Sets the number of columns of marks contained in the region.</td>
</tr>
<tr>
<td>Rows in the region</td>
<td>Sets the number of rows of marks contained in the region.</td>
</tr>
<tr>
<td>Possible label scales</td>
<td>Sets a range of pre-determined values as output Labels (e.g., A-E or 1-5). Use this setting to quickly enter Labels into the Labels grid as opposed to entering each value individually. Each mark on your form is represented by a Label. The Label is what is output when the form is processed (e.g., scanned). Note that label scales corresponding to the number of answer choices you have selected only will appear in this list.</td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Labels</td>
<td>Sets the output data that will appear in the data grid when reading forms. Each mark on your form is represented by a Label. The Label is what is output when the form is processed (e.g., scanned). You cannot use the following reserved characters in the list of Labels: commas, quotation marks, semicolons or parentheses.</td>
</tr>
<tr>
<td>Value</td>
<td>Use this setting to associate a numeric value with each textual answer choice (Label). Values are used for calculating statistics for responses that are set to the textual data type. Values are also used when saving to the SPSS file format.</td>
</tr>
<tr>
<td>Possible value scales</td>
<td>Sets a range of pre-determined numbers as Values. Use this setting to quickly enter Values for each of your textual output Labels into the Values grid as opposed to entering each value individually.</td>
</tr>
<tr>
<td>Save Current Scale</td>
<td>Sets a scale of user-defined values as output Labels that you can save and use over again (e.g., Excellent, Good, Fair, Poor). Click the Save Current Scale button after entering your labels in the Labels grid to save the scale for future use.</td>
</tr>
<tr>
<td>Define Format</td>
<td>The Define Format feature applies to Grid regions only. Mark this checkbox to enter a pattern for the output cell’s format. The default setting (*** ) indicates that the characters will be displayed one after the other with no separators. You may change this pattern to enter items such as slashes for a date, decimal points, etc. Enter the appropriate character in the proper position (e.g., for a date: <strong>/</strong>/****).</td>
</tr>
<tr>
<td>Include region in read operation</td>
<td>Mark this checkbox to include data from this region when processing forms. If this checkbox is not marked the region will exist in the form template, but no data will be captured during form processing.</td>
</tr>
</tbody>
</table>

**To create an OMR region**

1. From the **Page** or **Region** menu choose **Insert** and then select **OMR Region After Selected Region**|**Page** or **OMR Region Before Selected Region**|**Page**.
**Tip:** There are several ways to create regions: menus, toolbar, right clicking in the image representation/tree view or the Task Pane. These options are covered in greater detail in Section 7.2.3 Creating Regions. Try creating regions using each method and then decide which way you prefer.

2 The mouse changes to a crosshair. Use the mouse to drag a box around the marks in the region in the image representation area. Only select the marks; do not capture any text near the marks. Place the box around the region so that it is not right against the bubbles, yet is also not too far from the bubbles, as shown in the following example.

**Example:**

Rate the following on a scale of 1 to 5:

<table>
<thead>
<tr>
<th></th>
<th>Facilities</th>
<th>Food</th>
<th>Entertainment</th>
<th>Overall</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3 In the **Properties - OMR Region** box, enter the appropriate properties for the region on the **OMR region properties** screen, as described on the previous page. There are additional advanced features that may be defined. These features will be discussed in detail beginning with Section 7.3.1.
4   Click the **OK** button to create the region.

After creating an OMR region, you will see the region in the image representation area and a new node will be added to the tree view. Each OMR region in the image representation area is green to differentiate the regions. When you select a region, it will have a blue border around it to indicated it is the active region.

**Note:** If the region appears with a solid red fill, it has not been drawn or set up properly. To correct this problem, please see Section 7.2.7.

### 7.2.6 Linking OMR Regions

Marks that are separated by text, lines or graphics cannot be selected in one region definition. When creating an OMR region in an area that contains items such as text or lines, you can only select the marks. The Append Linked Region function allows you to link these types of marks into one OMR region. OMR region types that can be linked include Multiple, Grid, List, Binary and Add. The following is an example of a region that falls into this category:

What is your gender?

<table>
<thead>
<tr>
<th></th>
<th>Female</th>
<th></th>
<th>Male</th>
</tr>
</thead>
<tbody>
<tr>
<td>O</td>
<td></td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

The marks are separated by the response text in between them, but are still logically considered one question. However, you cannot select the word “Female” within your OMR region. Therefore, you will create a region around just the mark for Female and then link the mark for Male to the original region.

**To use the append linked region function**

1. Create an OMR region around the first region to be linked as if it were its own region (in the previous example, you would select the OMR bubble for “Female”).
2. After defining the first part of the region, select the **Region** menu and then click **Append Linked Region**, or click 

---

125
The mouse turns into a crosshair.

3 Drag a box around the second area to be defined (in the previous example, you would select the OMR bubble for “Male”).

When you release the mouse button the **Properties - OMR Region** window appears. This window contains the same settings that were defined for the first part of the region that you selected. You need only define the Labels and Values (if desired) section of the window.

4 Make any necessary changes to the region definition and then click the **OK** button.

Regions that are defined with the Append Linked Region feature are automatically linked to the previous region. These regions are a dark green color in the image representation window to represent their linked status.

**Tip:** Only regions of the same OMR type, data type and orientation can be linked.

To make changes to a region that is already linked, first separate the regions, then make the changes and relink the regions. Many properties can only be accessed by first separating the linked regions.

**To separate a linked region**

1 Use the tree view or image representation area to select one of the OMR boxes within the linked set you want to separate.

2 Select the **Region** menu and then click **Break Region Link**, or click ![Break Region Link](image)

The regions will be separated into individual OMR regions. If you need to make changes to the regions, edit the regions and then relink them.
To relink regions
1 While holding down the Shift key, select each OMR region to be linked by either clicking its node or clicking it in the image representation area.
2 After all regions are highlighted, select the Region menu and then click Link Regions, or click .

7.2.7 OMR Region Colors
Each region in the form template has a different color so that you can tell one from the other easily. As indicated, OMR regions are green and linked OMR regions are dark green. If you create an OMR region and it turns a solid red, this is an indication that Remark Office OMR cannot properly recognize the region as it is setup. When a solid red region is encountered, you can place your mouse over the region and the Template Editor will provide details of the problem. Flagged regions will also be red and italicized in the tree view, indicating that you need to make a correction. Reasons for this issue include the following:

- The number of columns or rows entered in the Properties – OMR Region window are not correct.
- One of the region borders is touching something else on the image. It could be touching a mark, text, lines or graphics that are present on your form image.
- You have captured something other than marks within your OMR region (e.g., text or lines). Only capture the actual marks within a given OMR region. If there is something such as text prohibiting you from selecting all of the marks for a single question, you will need to use the Append Linked Region function (see Section 7.2.6 for further details).
- The image used for the form template is degraded. When scanning forms, the quality of the resulting image is sometimes not as clear as expected. The marks may break up, meaning that they have tiny gaps in them. You can use the zoom options in the software to zoom in on your image to see if your marks are complete. When marks are not complete,
Remark Office OMR cannot properly recognize them. If this problem occurs, reacquire your form template image by scanning it at a darker brightness setting (sometimes called threshold) on your scanner.

Note that you may save templates that have solid red OMR regions but you will need to correct the problem before you begin processing forms to have the software recognize the forms properly.

### 7.2.8 Creating an Image Region

Image regions are used for areas on a form that contain handwriting or machine printed text (e.g., a person’s name, an address, a department name, comments, etc.). Remark Office OMR cannot read this type of information automatically, but does provide you with two options for capturing this information as an Image region. Data Entry Image regions reserve space in the template grid for the manual insertion of text. You can type the information contained in the Image region into the data grid using image-assisted data entry. Image Clip regions save a snapshot image of the particular region to a user-specified location on your computer. You can have this location displayed in the data grid as the forms are being scanned. After collecting the Image region information, you may optionally run a report in Remark Quick Stats to view the results (see the Remark Quick Stats User’s Guide PDF file under Start|Programs|Remark Office OMR 6|Documentation for further details).

An Image region has the following basic properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region name</td>
<td>A name assigned to an Image region. Region names are used as grid column headers in the data grid window and are exported when saving data to common file formats. Region names are limited to 60 characters.</td>
</tr>
<tr>
<td>Region type</td>
<td>Sets the type of Image region, either Data Entry or Image Clip. Use Data Entry to hand enter the data that is captured in a region. Use Image Clip to have...</td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Data type</strong></td>
<td>Sets whether the data should be considered textual or numeric when saved/exported.</td>
</tr>
<tr>
<td>(Data Entry Image region only)</td>
<td></td>
</tr>
<tr>
<td><strong>Default fill</strong></td>
<td>Sets a default entry to be used in the Image region.</td>
</tr>
<tr>
<td>(Data Entry Image region only)</td>
<td>The information typed here will automatically be output to the data grid when forms are processed. You may also select one of the following items from the drop-down list to be used as a default fill option:</td>
</tr>
<tr>
<td></td>
<td>Time Stamp</td>
</tr>
<tr>
<td></td>
<td>Date Stamp</td>
</tr>
<tr>
<td></td>
<td>Time and Date Stamp</td>
</tr>
<tr>
<td></td>
<td>Record Number</td>
</tr>
<tr>
<td></td>
<td>Page Number</td>
</tr>
<tr>
<td></td>
<td>Record and Page Number</td>
</tr>
<tr>
<td></td>
<td>When selecting an item from this list, you can also insert text before or after the selected item if desired.</td>
</tr>
<tr>
<td><strong>Auto increment fill value</strong></td>
<td>When used in conjunction with Default Fill, Remark Office OMR will assign the next value in the range you define to the Image region in sequential order. For example, you can enter the number 1 as the default fill and then mark the Auto increment fill value checkbox. Remark Office OMR will automatically place sequential numbers in the Image region during form processing. When using a default fill, you can create the Image region anywhere on the form as a placeholder.</td>
</tr>
<tr>
<td>(Data Entry Image region only)</td>
<td></td>
</tr>
<tr>
<td><strong>Attempt to detect the presence of handwriting in the region</strong></td>
<td>Use this setting to have Remark Office OMR attempt to determine whether handwriting is in the region. For Data Entry Image regions, when text is detected, the Image Region will contain a blue indicator flag. For Image Clip Image regions, the clip will be captured when handwriting is detected and will not be captured.</td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>when handwriting is not detected. If you are not using this feature, image clips will be captured for every Image region.</td>
<td></td>
</tr>
<tr>
<td>Link Region to an Existing OMR Region (Data Entry Image region only)</td>
<td>Use this setting to link a Data Entry Image region to one of the responses from another OMR region on the page (e.g., an “other” blank from a multiple choice question). The Image region will contain a blue indicator flag if the linked mark is chosen so that you know which regions need attention for data entry. This feature is especially helpful when used in conjunction with Review Exceptions.</td>
</tr>
<tr>
<td>OMR region (Data Entry Image region only)</td>
<td>Use this drop-down list to select the region to which to link the Image region when using the Link Region to an Existing OMR Region option.</td>
</tr>
<tr>
<td>Question (Data Entry Image region only)</td>
<td>Use this drop-down list to select the individual question within the OMR region to which to link the Image region. Note that if the linked OMR region only contains one question, you will only see this question in the list.</td>
</tr>
<tr>
<td>Answer (Data Entry Image region only)</td>
<td>Use this drop-down list to choose an answer response (Label) from the linked question. Alternatively, you may type an answer choice in the box. When this answer choice is detected during form processing, the linked Image region will contain a blue flag in the data grid.</td>
</tr>
<tr>
<td>Target directory:</td>
<td>Click the ellipse (…) to select a location in which to store the Image Clips.</td>
</tr>
<tr>
<td>Begin names with (Image Clip Image region only)</td>
<td>Use this box to enter a beginning name to use when storing Image Clips. This name will have numbers appended to it to allow for the greatest number of images to be stored. For example, if you are storing Image Clips of a comment question on a survey, you may wish to begin the clips with the name “Comments.”</td>
</tr>
</tbody>
</table>
To create an Image region

1. From the Page or Region menu choose Insert and then select Image Region After Selected Region|Page or Image Region Before Selected Region|Page.

   Tip: There are several ways to create regions: menus, toolbar, right clicking in the image representation/tree or the Task Pane. These options are covered in greater detail in Section 7.2.3 Creating Regions. Try creating regions using each method and then decide which way you prefer.

2. Use the mouse to drag a box around the image region in the image representation area. Capture the entire area in which you expect respondents to write. Or, in the case of a machine printed text area, capture all of the text or area where text will be present.

Comments:
3 In the **Properties - Image Region** box, enter the appropriate properties for the region on the **Image region properties** screen, as described on the previous page. There are additional more advanced features that may be defined. These features will be discussed in detail beginning with Section 7.3.1.

4 Click the **OK** button.

After creating an Image region, a new node will be added to the tree view. Image regions are blue in the image representation area.

### 7.2.9 Barcode Regions

Barcodes are a reliable way to capture information from a form while using a small amount of space. Barcodes can be placed directly on a form or on a sticker that is placed on a form. The barcode must be located in the same position on each form. You can create barcodes using special barcode generation software or by using a barcode font in a word processing program. Barcodes can be placed horizontally or vertically on the form. The barcode should be at least 26 points in terms of size (about ¼ inch high).

Remark Office OMR recognizes three of the most common barcode types:

<table>
<thead>
<tr>
<th>Barcode Type</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39 (Code 3 of 9)</td>
<td>Alphanumeric</td>
</tr>
<tr>
<td>Codabar</td>
<td>Numeric</td>
</tr>
<tr>
<td>Interleaved 2 of 5</td>
<td>Numeric</td>
</tr>
</tbody>
</table>
Barcode regions have the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region name</td>
<td>A name assigned to a barcode region. Region names are used as grid column headers in the data grid window and are exported when saving data to common file formats. Region names are limited to 60 characters.</td>
</tr>
<tr>
<td>Barcode type</td>
<td>Use this setting to select the type of barcode to be recognized: Auto Detect, Code 39, Codabar or Interleaved 2 of 5. Use the Auto Detect setting to have Remark Office OMR automatically determine what type of barcode is in the region.</td>
</tr>
<tr>
<td>Barcode orientation</td>
<td>Use this setting to select orientation of the barcode: horizontal or vertical.</td>
</tr>
<tr>
<td>Data type</td>
<td>Sets whether the data should be considered textual or numeric when saved/exported.</td>
</tr>
</tbody>
</table>

**To create a barcode region**

1. From the Page or Region menu choose Insert and then select **Barcode Region After Selected Region|Page** or **Barcode Region Before Selected Region|Page**.

   **Tip:** There are several ways to create regions: menus, toolbar, right clicking in the image representation/tree or the Task Pane. These options are covered in greater detail in Section 7.2.3 Creating Regions. Try creating regions using each method and then decide which way you prefer.

2. In the image representation area, use the mouse to drag a box around the barcode or the location where the barcode will be on the forms (e.g. if using stickers after the forms are returned, place the Barcode region in the area where the stickers will be affixed). Barcodes may vary in length depending on the data that you are capturing. Be sure to make the Barcode region large enough to capture the longest barcode you plan to recognize.
3 In the **Properties - Barcode Region** box, enter the appropriate properties for the region on the **Barcode region properties** screen, as described on the previous page. There are additional more advanced features that may be defined. These features are discussed in detail beginning with Section 7.3.1.

4 Click the **OK** button.

After creating a Barcode region, you will see the region in the image representation area and a new node will be added to the tree view. Each Barcode region is orange to differentiate the regions.

### 7.3 Advanced Region Options

Each region type (OMR, Image and Barcode) has a set of more advanced properties associated with it that are optional. When creating fields, you will see only those options appropriate for the type of region you are creating. Use the navigation bar in the left section of the region properties window to access the additional features.

Each advanced option is explained in detail in the following sections.

#### 7.3.1 Region Item Properties

The **Region item properties** section of the Region Properties window allows you to define test and survey analysis options, recognition thresholds and exception handling. Each item is described below.

#### 7.3.1.a Test Settings

Remark Office OMR provides useful test grading features that you can customize. You decide which regions to grade and set the test points to be used for grading.
The following table lists the region types and their default grade settings:

<table>
<thead>
<tr>
<th>Region Type</th>
<th>Grade Status</th>
<th>Test Type (Objective or Subjective)</th>
<th>Test Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMR</td>
<td>Multiple, Boolean and List: Graded</td>
<td>Objective</td>
<td>Correct: 1</td>
</tr>
<tr>
<td></td>
<td>Grid, Add and Binary: Not Graded</td>
<td></td>
<td>Incorrect: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No Response: 0</td>
</tr>
<tr>
<td>Image</td>
<td>Not Graded</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Barcode</td>
<td>Not Graded</td>
<td></td>
<td>N/A</td>
</tr>
</tbody>
</table>

Questions can be designated as Objective or Subjective questions. An objective question is one where respondents choose one or more pre-defined answers on a form by darkening in a mark (e.g., bubble). These questions are typically multiple choice or true/false questions. A subjective question is one that is open ended and must be graded by a human, such as an essay or short answer question. Remark Office OMR cannot automatically read this type of question; however, you can include points from a subjective question when grading. First, place a region on the form where the instructor can enter the appropriate amount of points earned on the subjective portion of the test. This is typically an OMR region where the instructor bubbles in the points earned. Then designate the region as a subjective item in the form template. This region must be set to the numeric data type in order to use the region as a subjective region. When setting up your answer key, enter the maximum number of subjective points that can be earned (see the Remark Quick Stats User’s Guide PDF file under Start\Programs\Remark Office OMR 6\Documentation for further details about setting up answer keys). When grading, Remark Office OMR will display the overall, objective and subjective scores.

Using the Test Settings section sets the options on an individual region basis. You can change the default setting for whether to grade each region type globally in the Preferences tab control under the Tools menu.
To set grade options

1. Create a region as defined in Section 7.2.3.

2. Click the Region item properties link in the left task pane.

3. In the Test Settings section, mark the radio button for Grade this item.

   Note: If grading and using multiple answer keys, there is a third option for Designate as key identifier. Use this radio button when creating a region that contains the test answer key version information.

4. In the Test Point System section, select the type of question: Objective item or Subjective item.

5. If using an Objective item, enter the values for Correct points, Incorrect points and No Response points that are appropriate for the region. You may use a negative number to subtract points for incorrect or unanswered questions if desired. You may also use decimal places.

6. Click the OK button to save the changes and return to the tree view.

7.3.1.b Survey Settings

Remark Office OMR provides useful survey tabulation features that you can customize. You decide which regions to tabulate.

The following table lists the region types and their default survey settings:

<table>
<thead>
<tr>
<th>Region Type</th>
<th>Grade Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMR</td>
<td>Multiple, Boolean and List: Tabulated Grid, Add and Binary: Not Tabulated</td>
</tr>
<tr>
<td>Image</td>
<td>Not Tabulated</td>
</tr>
<tr>
<td>Barcode</td>
<td>Not Tabulated</td>
</tr>
</tbody>
</table>
To set survey options
1. Create a region as defined in Section 7.2.3.
2. Click the Region item properties link in the left task pane.
3. In the Survey Settings section, mark the radio button for Tabulate this item.
4. Click the OK button to save the changes and return to the tree view.

7.3.1.c Analysis Respondent ID
You may also set a particular region as an Analysis Respondent ID region so that it can be used as an identifier on reports. This feature is useful when you are capturing items such as ID numbers or names. When set as an Analysis Respondent ID region, the resulting reports will show the information captured in the region along side of the results. For example, if you administer a test where the students enter their ID number, the grade report will show the ID number and then that student’s grade. When exporting data to some gradebook packages, you may also be required to set an Analysis Respondent ID.

Note: Analysis Respondent IDs are included as identifiers in the analysis, but they are not tabulated or graded. In order to set a region as an Analysis Respondent ID, make sure it is set to Do not grade this item and Do not tabulate this item.

To set an Analysis Respondent ID
1. Create a region as defined in Section 7.2.3.
2. Click the Region item properties link in the left task pane.
3. In the Analysis Respondent ID section, mark the checkbox for Designate as a respondent ID.
4. Click the OK button to save the changes and return to the tree view.
7.3.1.d Recognition Threshold

The Recognition Threshold setting allows you to compensate for degraded images and poorly marked forms, and assists you with the recognition of handwriting in Image regions. Use the Recognition Threshold setting to increase or decrease standards for mark recognition. You can set the Recognition Threshold on a region-by-region basis. The Recognition Threshold setting ranges from 1 to 6, with 3 being the default setting. It is recommended that you use the default values unless you encounter problems. Use a lower Recognition Threshold to compensate for errors when reading light pages, degraded images or pages where the respondent has not filled the marks completely. Use a higher Recognition Threshold to compensate for errors when reading dark pages or pages with many erasures.

**Note:** The Recognition Threshold can only be set on a region basis. If you have a region containing multiple OMR questions, the Recognition Threshold setting will apply to all questions in the region.

To set the Recognition Threshold

1. Create a region as defined in Section 7.2.3.
2. Click the **Region item properties** link in the left task pane.
3. In the **Recognition Threshold (applies to region)** section, set the **Threshold value** to the desired number. Choose a higher value to have the software be less sensitive and choose a lower value to have the software be more sensitive when processing forms.

**Tip:** Use caution when setting extreme Recognition Threshold values. Decreasing to 1 will cause the software to be quite sensitive and it may pick up unintended marks, such as erasures and stray marks. Increasing to 6 may cause the software to be quite discriminate and it may choose the most filled mark for you when two marks are selected (and are not permitted).

4. Click the **OK** button to save the changes and return to the tree view.

**Tip:** If you are having trouble recognizing an entire form, you can override the form template Recognition Threshold settings for all regions by going to **Tools|Preferences|Recognition** in the Data Center.
7.3.1.e Blank and Multiple Exception Handling

You can specify how Remark Office OMR should handle blank and multiple responses in OMR regions when processing forms and exporting data. By default, the word BLANK is inserted for items that are not answered and the word MULT is inserted when more than one response is chosen. Also by default, only one answer response is allowed. You can replace these values on a region-by-region basis. You may choose one of the default options listed or type in a custom value.

To set blank response settings
1. Create a region as defined in Section 7.2.3.
2. Click the Region item properties link in the left task pane.
3. In the Blank Exception Handling section, choose a value from the Replace with drop-down list or enter a unique replacement of your own. Pre-set choices include BLANK, Asterisk (*), Nothing, Space Character, and Tilde (~).
4. For Grid regions only: You may optionally use the Flag Blanks setting. Using this setting allows you to further customize how Remark Office OMR interprets blank responses. Grid regions are often used to capture data that vary in length, which can lead to unintended blank responses. For example, you may have respondents fill in bubbles corresponding to their name and allow for ten characters. If a name only contains five characters, the region may come up as blank simply because the respondent did not utilize all ten characters. In such a case, you can replace blank characters with Nothing and use the Flag Blanks parameters to further define the output. The options are as follows:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always</td>
<td>If any character in the Grid region is left blank, regardless of the replacement characters being used, the region will be considered blank. Replacement characters, if used, will still be utilized, but the region will contain a yellow BLANK flag.</td>
</tr>
<tr>
<td>Ignore</td>
<td>If a leading or trailing character in the region is left blank, it will be ignored. This will allow you to capture data smaller than the allotted region without it being considered blank. You will see whatever data is captured and the region will not contain a yellow BLANK flag.</td>
</tr>
<tr>
<td>Never</td>
<td>If any character within the region is blank, Remark Office OMR will ignore it. The region will never appear with a yellow BLANK flag in the data grid.</td>
</tr>
</tbody>
</table>

5. Click the OK button to save the changes and return to the tree view.

To set multiple response settings
1. Create a region as defined in Section 7.2.3.
2. Click the Region item properties link in the left task pane.
3. In the Multiple Exception Handling section, select the number of responses allowed in the Multiple responses drop-down list. Select Not Allowed to only allow a single response. Select Allow All to allow an unlimited number of responses. Alternatively, select a specific number from the list to only allow that number of responses. (If the respondent chooses more than you allow, their responses will be replaced by MULT or the value you designate in the Replace with box.) The final option is Select most filled. Selecting this option will force Remark Office OMR to select the mark it thinks is the most filled when more than one mark is detected.

Tip: Use extreme caution when using the Select most filled option. Using this option means that Remark Office OMR will never return a MULT for you to review. The software will always choose what it thinks is the most filled mark.
4 In the Replace with box, choose a value from the drop-down list or enter a unique replacement of your own. Pre-set choices include MULT, Asterisk (*), Nothing, Space Character, and Tilde (~).
5 Click the OK button to save the changes and return to the tree view.

7.3.1.f Required Items
Remark Office OMR allows you to make items required to be filled during processing. This feature is used in conjunction with Review Exceptions (see Section 8.4). If an item is marked as required in the form template and you are using the Review Exceptions feature, Remark Office OMR will flag any items that are left blank. If you are using Review Exceptions during form processing, the processing will stop so that you may review the unrecognized item. If you are using Review Exceptions after form processing, Remark Office OMR will include the unrecognized item during the review operation.

To set an item as required
1 Create a region as defined in Section 7.2.3.
2 Click the Region item properties link in the left task pane.
3 Mark the checkbox for Required item.
4 Click the OK button to save the changes and return to the tree view.
7.3.2 Question Text and Names

The Question text and names section of the Question Properties window allows you to enter custom question text and question names. Question text is displayed on reports and exported to certain formats, such as SPSS. Question names are used as column headers in the template grid and are exported along with your data. Question names are limited to 60 characters.

Important Note: The Question text and names section differs slightly when adding fields as opposed to editing them. This section will cover adding fields. When editing fields, Question text and names becomes Question text, names and responses; this screen is covered in Section 7.6 Editing an Existing Form Template.

7.3.2.a Question Text

Question text may optionally be added to make reports more meaningful. When question text is present, it will be used on the reports to identify the question. If no question text is entered, the region names will be used on the reports.

You may manually type question text into the question text grid or paste text from the Windows clipboard by using the keyboard shortcuts (Ctrl + V) or by double clicking a cell, then right clicking and choosing Paste from the menu. In order to paste information, you must first copy it from another location (e.g., a Word document). You may select multiple rows in the grid to paste multiple lines of question text.

To set question text for a new region

1. Create a region as defined in Section 7.2.3.
2. Click the Question text and names link in the left task pane.
3. Double click the first grid cell under Question Text.
4 Type the desired question text in the first grid cell. Alternatively, right click and select Paste from the menu or press Ctrl + V on the keyboard to paste the contents of your Windows clipboard into the cell.

5 Press the Enter key on the keyboard or double click in the next cell going down to continue adding question text (only applies to regions with more than one question).

6 Once you have entered all of the desired question text, click the OK button to save the changes and return to the tree view.

7.3.2.b Question Names
When defining an OMR region with multiple questions in the same region, you can specify individual question names for each question in the region. By using individual question names, it is easier to save data to existing databases and other file types that may already be setup with specific fields.

By default, Remark Office OMR uses sequential region names for each question in the region. Sequential region names consist of adding numbers sequentially onto the region name you provide in the Properties - OMR Region window. For example, if you enter a region name of Question, Remark Office OMR will call the individual question names within the region Question1, Question2, Question3, etc.

In contrast, if you use the Question Names section of the Question text and names window to enter individual question names, you will be able to customize the question name for each question within the region. Question names are limited to 60 characters each.
**Tip:** The following characters are not allowed in region/question names due to the problems they could cause when exporting data to certain formats:
- Period
- ! - Exclamation
- ’ - Singe quote
- [ - Left bracket
- ] - Right bracket
- , - Comma
- ” - Double quote
- ( - Left paren
- ) - Right paren

**To insert individual question names**

1. Create a region as defined in Section 7.2.3.
2. Click the **Question text and names** link in the left task pane.
3. Double click the first grid cell under **Question Name**.
4. Type the desired question name in the first grid cell. Alternatively, right click and select **Paste** from the menu or press **Ctrl + V** on the keyboard to paste the contents of your Windows clipboard into the cell.
5. Press the **Enter** key on the keyboard or double click in the next cell going down to continue adding question names (only applies to regions with more than one question).
6. Once you have entered all of the desired question names, click the **OK** button to save the changes and return to the tree view.
7.3.3 Tracking

Remark Office OMR offers three types of tracking to assist with the automation of forms processing:

- **Auto Form ID**: Provides automatic identification of a form when processing multiple form types at the same time.
- **Auto Page ID**: Provides automatic identification of pages within a form template.
- **Respondent Tracker**: Provides automatic identification of respondent data.

With Auto Form ID, Remark Office OMR can automatically recognize a form and match it to its template, allowing you to process various form types at once without pre-sorting the forms. With Auto Page ID, Remark Office OMR will take it a step further and identify specific page order within a form template if the pages are processed out of order. With Respondent Tracker, Remark Office OMR will recognize a specific respondent’s page and place it in the correct grid row with the rest of that respondent’s data even if the pages are processed out of order. These features can be used with OMR or Barcode regions. When combined, the three types of tracking will allow you to process forms without pre-sorting and Remark Office OMR will be able to match each page to the correct form (template), page number and respondent within the appropriate template grid.

7.3.3.a Setting up an Auto Form ID region

You must have a form identifier on each page of your form to use the Auto Form ID feature. When you create a form, place optical marks or barcodes that will identify the form on the form pages. These markings must be the same on each page of the same form. However, they should be unique from any other types of identifiers you are using, such as Page IDs or Respondent IDs on this form or other forms.

To setup an Auto Form ID region

1. Create a region as defined in Section 7.2.3.
2. Click the Tracking link in the left task pane.
3. Mark the checkbox for **Use Region as Unique Identifier**.
4 Select the radio button for **Form ID (region’s value identifies this form during the read operation – Auto Form ID).**

5 If using an OMR region, type in the **ID value.** If using a barcode, click the **Recognize** button to have Remark Office OMR automatically recognize the region’s value. This value acts as the identifier for this particular form. All forms that you wish to process with this form template (using Auto Form ID) must have this value present.

6 If desired, mark the checkbox for **Insert ID data into the grid during the read process.** Viewing the ID data captured along with the rest of the data can be useful for verification of processed data.

7 Click the **OK** button to save the changes and return to the tree view.

When you are ready to process forms, open any form templates containing Auto Form ID regions in the Remark Office OMR Data Center. In the Read Wizard, turn on the Auto Form ID feature. Remark Office OMR will begin processing the forms, searching for the Auto Form ID regions first. When it matches a region on the form to the region in the form template, it will automatically place that data in the corresponding template grid. Any regions that are not recognized will be flagged for your review or placed in the Unrecognized Images queue. See Section 8.6 for further details about processing forms using Auto Form ID regions.
7.3.3.b Setting up a Page ID region
You must have a page identifier on each page of your form to use the Auto Page ID feature. When you create a form, place optical marks or barcodes on the form pages that will identify the individual pages. These markings must be unique for each page on the form. They should also be unique from any other types of identifiers you are using, such as Form IDs or Respondent Tracking identifiers.

To setup a Page ID region
1. Create a region as defined in Section 7.2.3.
2. Click the Tracking link in the left task pane.
3. Mark the checkbox for Use Region as Unique Identifier.
4. Select the radio button for Page ID (region’s value identifies the specific page during the read operation).
5. If using an OMR region, type in the ID value. If using a barcode, click the Recognize button to have Remark Office OMR automatically recognize the region’s value. This value acts as the identifier for this particular page. All form pages that correspond to this form template page must have this value present in order for the software to automatically recognize the page. Each page within a single form template must have a different page value.
6. If desired, mark the checkbox for Insert ID data into the grid during the read process. Viewing the ID data captured along with the rest of the data can be useful for verification of processed data.
7. Click the OK button to save the changes and return to the tree view.

When you are ready to process forms, open the form template containing Page ID regions in the Remark Office OMR Data Center. Use the Read Wizard to
process your forms. Remark Office OMR will begin processing the forms, searching for the Page ID regions first. When it matches a region on the form to the region in the form template, it will automatically place that data in the correct page order. Any regions that are not recognized will be flagged for your review or placed in the Unrecognized Images queue. Note that if you are not using the Respondent Tracker feature, you must process all of the pages belonging to one respondent’s form before beginning those of a different respondent. See Section 8.6 for further details about processing forms using Auto Page ID regions.

**Tip:** Page IDs can be used alone if you only want to recognize various pages within the same form. If you want to be able to recognize various pages within different forms at the same time, you will need to use Form IDs as well.

### 7.3.3.c Setting up a Respondent Tracker region

Respondent Tracker regions can be setup to identify each respondent’s form. To use Respondent Tracker, you must also have a page identifier on each page of your form (see previous section). When you create a form, place optical marks or barcodes on every form page to identify the individual respondents. For example, if the respondent will be filling in an identifier such as name or ID number on each page, or you have such information captured in a barcode, these regions could be used as Respondent Trackers. These markings must be unique from any other types of identifiers you are using, such as Form IDs or Page IDs. Each respondent identifier must also be unique among all respondents. However, the Respondent Tracker output must be the same for each page within a particular respondent’s form.

**To setup a Respondent Tracker region**

1. Create a region as defined in Section 7.2.3.
2. Click the **Tracking** link in the left task pane.
3. Mark the checkbox for **Use Region as Unique Identifier**.
4. Select the radio button for **Respondent**.
tracker (region’s value identifies this respondent during the read operation).

5 If desired, mark the checkbox for **Insert ID data into the grid during the read process**. Viewing the ID data captured along with the rest of the data can be useful for verification of processed data.

6 Click the **OK** button to save the changes and return to the tree view.

When you are ready to process forms, open the form template containing Respondent Tracker regions in the Remark Office OMR Data Center. Use the Read Wizard to process your forms. Remark Office OMR will begin processing the forms, searching for the Page ID regions first. When it matches a region on the form to the region in the form template, it will automatically place that data in the correct page order. It will then search for the Respondent Tracker and match that respondent’s data to an existing record or begin a new record. Any tracking regions that are not recognized will be flagged for your review or placed in the Unrecognized Images queue. See Section 8.6 for further details about processing forms using Respondent Tracker.

**Tip:** If you want to be able to recognize various pages and respondents within different forms at the same time, you may want to use the Auto Form ID and Page ID features as well as Respondent Tracker. Use of all three features will allow you to scan various form types without pre-sorting and still keep pages and respondents together.

### 7.3.4 Database Lookup

Remark Office OMR has a Database Lookup feature that can 1) verify that recognized data from a region appear in an existing database, and 2) lookup and replace recognized data with additional fields from an existing database. To use this feature, you link a region in the form template to an existing database. As each form is processed, Remark Office OMR will verify that the recognized data appear in the selected database field. If the data are not present, Remark Office OMR will flag the question as a Database Lookup error for correction. Database verification can be used with OMR, Image and Barcode regions.

This feature is useful for validating names, identification numbers, zip codes, etc. It is also useful for pulling information you have already collected out of a database and inserting it into your processed form data. For example, suppose you are grading tests and you have the students fill in their ID numbers on the forms being processed. You could verify the ID numbers in an existing database and then specify another value that corresponds to the ID number (e.g., a name). If the ID number is found in the database, Remark Office OMR will
automatically display the corresponding value (name in this case) for that ID number in the data. When you run your grade reports, they will be produced with each student’s name, yet you did not have to type in that information.

To use database lookup
1 Create a region as defined in Section 7.2.3.
2 Click the Database lookup link in the left task pane.
3 Mark the checkbox for Use Database Lookup.
4 In the Database Selection area, use the Type drop-down list to select the type of database to which you want to connect this region (e.g., Access, Excel, etc.).
5 Click the Browse... button to locate and select the database file.
6 Select a file and then click the Open button (or double click the file name).

If using an ODBC connection, perform the Steps 7-9 (you will need to obtain specific information from your database administrator to complete these steps). Otherwise, skip to Step 10.

7 OPTIONAL: Select your database type from the DSN drop-down list.
8 OPTIONAL: Select the appropriate checkbox to indicate whether your database is Directory or DSN based: Directory based or DSN based.
9 OPTIONAL: If your database utilizes password protection, use the Username and Password boxes to enter your login information. If the database is not password protected, you may skip this step.

10 In the Lookup & Return section, click the Connect to Database button to link the database to the region.
11 Use the Table drop-down list to select the table in the database containing the fields to which you are linking the region.
12 Use the Lookup drop-down list to select a field in the connected database to which you want to link this region. When the forms are processed, the respondents’ answers will be verified against the values in this database field. If the answer is found in the database field, Remark Office OMR will
output the **Replace** value. If the answer is not found in the database field, Remark Office OMR will flag it for review.

13 Use the **Replace** drop-down list to select a field in the connected database to return when the **Lookup** field is verified. If you only want to verify data and not replace it with anything else, use the same field in both the **Lookup** and **Replace** lists. If you want to lookup the value and then replace it with a different database field’s information, select the appropriate field in the **Replace** list.

14 If desired, select database fields from the **Additional Return Fields** list to insert additional information from the database into the data grid during form processing. You may lookup a field once but return several database fields’ worth of information. This is a quick and easy way to get information out of the existing database and into your processed data. Fields will be listed in the data grid in the order in which they appear in the Additional Return Fields list.

15 If desired, use the **Return Names** column to specify region names for the Return fields. By default, the name will be taken from the external database to which the region is connected. You may type a new name in the **Return Names** cell if desired.

16 Use the drop-down arrow to select **Yes** in the **Respondent ID** box to include the Return field in the reports as a respondent identifier. If this setting is set to Yes, the data collected from this region will be used on the appropriate reports to identify the respondent.

17 Click the **OK** button to save the changes and return to the tree view.
7.4 Additional Template Editor Features

The Remark Office OMR Template Editor provides several other features and functions to help make it user friendly. The following features and/or functions are available:

- Copy/paste
- Copy special/paste special
- Drag/drop (reordering)
- Delete
- Undo/redo
- Adjusting region borders
- Moving regions
- Reset images
- Auto align
- Spell check
- Scales
- Zoom
- File properties

All of these features can be accessed from the menus. Many also have toolbar buttons or can be accessed by right clicking the mouse on a node in the tree view or in the image representation area.

7.4.1 Copy/Paste

When creating regions with similar attributes, using the Copy and Paste options will speed the template creation process. You can copy regions on the same page or on different pages within the same template.

To copy and paste a region

1. Activate the region you want to copy by clicking within the region boundaries in the image representation area or clicking its node in the tree view.
2 Select the **Edit** menu and then click **Copy**, click \( \text{COPY} \), or press **Ctrl+C** on the keyboard.

3 Highlight the node before or after where you would like the region copied.

4 Select the **Edit** menu and then click **Paste Before (Ctrl+B)** or **Paste After (Ctrl+V)** to place the copied node either before or after the selected node.

   **Note:** You may also use the toolbar button for Paste, \( \text{COPY} \), to paste the region after the highlighted node.

After pasting a region, the region will appear in the image representation area of the template editor window. You will then need to position the region correctly in the image representation area by dragging it with the mouse.

### 7.4.2 Copy Special/Paste Special

If you would like to copy regions from one form template to another, you may use the Copy Special and Paste Special features.

**To use copy special and paste special**

1 Open the **Remark Office OMR Template Editor** twice.

2 Open one form template in the first instance of the Template Editor and another form template in the second instance of the Template Editor.

3 Select the region or regions in the first instance of the Template Editor that you want to copy by clicking them in the tree view.

   **Tip:** You can select multiple regions by holding down **Ctrl** on the keyboard and clicking each region or by clicking a region, holding down **Shift** on the keyboard and then clicking another region; all regions in between the selections will be highlighted.

4 Select the **Edit** menu and then click **Copy Special**.

5 In the second instance of the Template Editor, select the node in the tree view after which you want to paste the new region(s).

6 Select the **Edit** menu and then click **Paste Special**. The new node (region) will be pasted after the highlighted node. You will then need to position the region correctly in the image representation area by dragging it with the mouse.
7.4.3 Drag/Drop

The drag/drop feature allows you to click a region in the tree view and drag it to another position within the tree. The order of the regions in the tree view determines the order of the fields in your data set. You may set the order of the regions on a page without regard to where the region is located on the image. When using drag/drop you can either move a node or copy a node.

To move a node using drag/drop

1. Select the node representing the region you would like to move.
2. While holding down the left mouse button, drag the region to its new desired location.
3. When you have reached the new location, release the mouse button. A dialog box will appear, confirming whether you want to move the region to the new location.
4. Click the OK button to move the node.

Tip: You can press the Shift key on the keyboard as you drag a node to toggle between Move Before and Move After options. By pressing Shift, you can move a region before the selected region (otherwise, the region will be placed after the selected region automatically).

To copy a region using drag/drop

1. Select the node representing the region you would like to copy.
2. While holding down the left mouse button, drag the region to its new desired location and then press the Ctrl key while still holding down the left mouse button.
3. When you have reached the new location, release the mouse button. A dialog box will appear, confirming whether you want to copy the region to the new location.
4. Click the OK button.

After copying a region, the region will appear in the image representation area of the template editor window. You will then need to position the region correctly by dragging it with the mouse.
7.4.4 Deleting Regions
Use the Delete option to remove unwanted region definitions.

To delete a region
1. Activate the region you want to delete by clicking within the region boundaries or clicking its node in the tree view.
2. Select the Edit menu and then click Delete, click \[\]
   or press Delete on the keyboard. You may also right click the region and choose Delete from the menu.

7.4.5 Undo/Redo
Remark Office OMR employs Undo and Redo in the Template Editor. Using Undo will negate the last action that was performed. Using Redo will repeat the last action for which undo was used.

To use undo
1. Select the Edit menu and then click Undo, click \[\] or press Ctrl+Z on the keyboard to negate the previous action.

To use redo
1. Select the Edit menu and then click Redo, click \[\] or press Ctrl+Y on the keyboard to repeat the previous action.
7.4.6 Adjusting Region Borders

If you need to adjust a region border, you can do so with the mouse.

**To adjust region borders**
1. Select the region you want to adjust by clicking it in the image representation area.
2. Place the mouse over one of the blue squares in the field border until you see a double arrow.
3. Drag the border to the desired location.
4. When finished, release the mouse button.

7.4.7 Region Positioning

When an OMR region is not positioned correctly around the marks, Remark Office OMR will flag the region by coloring the region definition box a solid red color. In addition, the same node in the tree view will be red and italicized. The red box indicates that you need to move the box so that it is properly positioned around the mark or group of marks, or you need to correct the region definitions in the region properties window. Proper positioning means that the region definition does not touch or include any items other than the marks (e.g., text, lines, graphics, etc.). The region will also be flagged as incorrect if the number of columns and rows specified in the Properties window do not match what was selected in the region. Place your mouse over any solid red region to see the source of the problem.

**To reposition or redefine a region**
1. If a region is solid red in color, check the borders of the region definition to ensure that they are not touching any marks, text, lines, etc. Also make sure that only the marks are included in the region. Adjust any region borders if necessary. If you need to move the entire region, place the mouse over the region until you see a cross symbol with four arrows. Drag the entire region with the left mouse button to its new position and release the mouse.
2. If the region appears to be positioned properly but still appears as solid red, double click inside the red box to display the **Region Properties** window.
3 Ensure that the number of columns and rows specified match what has been captured in the region. Make corrections if necessary and then click the OK button.

7.4.8 Reset Images

There may be times when your form template images no longer match your actual form. For example, suppose that you create a form and then decide to remove one of the questions from the form. Or, perhaps you create the form template from a printed version of the form and then decide to make photocopies for distribution, which causes the entire form to be shifted. In either case, if you have already created your form template, you can use the Reset Images feature to bring in new images with your existing form template without having to recreate the entire form template.

Tip: If using the Reset Images feature you need to acquire images for all pages in the form template. If you want to acquire individual form template pages, double click the page node and then acquire the new image for that page.

To use Reset Images with a scanner

1 Select the Tools menu and then click Reset Images.

2 In the Select Method to Use for Image Acquisition section, click the Read from scanner link option.

   Note: If you need to configure your scanner, you may click the Scanner Properties link just after Read from scanner to view the Scanner Properties window.

3 Place the page(s) to be scanned in the scanner.

4 Click the Acquire Images from Scanner button to scan the page(s).

   The page(s) will be scanned and then a thumbnail image of the form will appear in the Image window. If scanning multiple pages at once, use
the Previous Page and Next Page icons under the image to view all scanned images. You may delete any images you do not wish to keep by clicking the Delete icons.

5 If you are satisfied with the image(s), click the OK button. Otherwise, click Acquire Images from Scanner again to rescan a page.

To use Reset Images with an image file

1 Select the Tools menu and then click Reset Images.

2 Click the Acquire Images from File button to select an image from file.

3 In the Select Image File... window, use the Look in drop-down list to find the file(s) you wish to use for the form template. You may only select one image at a time; however you can go back to this window to select more images in succession.

A thumbnail image of the form will appear in the Image window. If acquiring multiple images, use the Previous Page and Next Page icons under the image to view all images. You may delete any images you do not wish to keep by clicking the Delete icons.

4 Repeat Steps 2-3 to add any other form images to the form template.

5 If you are satisfied with the image(s), click the OK button. Otherwise, click Acquire Images from File again to reselect an image.

To reset a single page

You may optionally reset the image for a single page instead of using the Reset Images function.

1 Double click the page node in the tree view representing the page you want to reset.
2 In the **Page Properties** window, reacquire the image via the scanner or an image file. See the previous sections for information about acquiring images.

3 Click the **OK** button to save the updated image. Once the new image is acquired, the existing image will automatically be overwritten.

Once you have reset your images you will see all of your exiting fields with the new image(s). You may find that you need to adjust the existing fields so that they are in the right position on the new image(s). You may move or delete fields as needed to line them up with the new image(s). You may also use the Auto Align feature to have the software automatically try to readjust the fields (see the next section for further details).

### 7.4.9 Auto Align

The Auto Align feature will attempt to adjust all regions on a page so that they are situated properly around the marks. This feature is useful if you need to scan a new image for the form due to form changes or a badly skewed image. It is also useful if you plan to share form templates with another user. Form templates created with one scanner should be realigned when a different scanner is used. You can align one page or an entire form template.

#### To use auto align for one page

1 Select the page node you wish to align.

2 Right click the page node, select the **Region** menu or right click in a blank section of the image representation area.

3 Choose **Auto Align Page** from the menu.

**Note:** You can also select the page node and click the toolbar button for **Auto Align Page**.

#### To use Auto Align for the entire template

1 Select the **Tools** menu and then click **Auto Align Form Template**.

Once you have aligned pages or the entire form template, you should review the changes to make sure the regions are in the right position. You may need to do some additional moving of regions.
7.4.10 Spell Check

Remark Office OMR has a spell check feature which can be used to check spelling on field names, question text and labels in the template regions. You can specify the dictionary to use by clicking Tools|Preferences|General.

To use spell check

1. With a form template open, select the Tools menu and then click Perform Spell Check, or click .

2. Mark the options you wish to use while checking the form template.

3. Click the Start button to begin searching the form template.

4. When a spelling error is detected, you will be prompted with the word in question and suggestions, if they are available.

5. You may choose to ignore the word once or all times in the form template, add the word to your dictionary, change this or all occurrences of the word in the form template or cancel the spell check operation.

6. When the entire form template has been searched, click the Finish button to close the Spell Checker window.
7.4.11 Response Scales

Remark Office OMR allows you to save the response scales that you use as labels in your OMR regions. When you enter custom labels in the Properties – OMR Regions window, you can save them for later use or edit existing scales. From within this window, you only have access to the response scales that fit the region you are defining. For example, if you have defined an OMR region that has five possible answer choices, you will only have access to response scales that offer five answer choices. Therefore, the software allows you to access all of the saved response scales under the Tools menu.

To view or modify response scales
1. Select the Tools menu and then click Response Scales.
2. Select a scale to view or modify from the Saved scales drop-down list.
3. To delete the scale, click the Delete button.
4. To edit the scale, click the Edit button and then type the new information.
5. To create a new response scale, click the New button, provide a Scale name and then enter the possible responses in the Labels grid and their corresponding numeric values in the Values grid, one per line. You may also click the down arrow on the New button and choose From Copy. This will copy the selected scale and allow you to make modifications to the copy instead of starting over when you want to create similar scales. Click the Save button when you have finished creating your new scale.
6. When you are finished, click the OK button to save the changes.

Tip: You may right click the mouse within the Labels or Values grid to access cut, copy and paste functions.
7.4.12 Zoom

You may use the software’s zoom features to zoom in and out of the image for better viewing. It is recommended that you find a zoom range that allows you to see an entire region as you are creating it.

To use the zoom features
1. With a template open, select the View menu and then click Zoom.
2. Select In to zoom in and Out to zoom out. Alternatively, select Fit Width to have the image fit in the viewer based on width or Fit Height to have the image fit in the viewer based on height. You may also use the toolbar buttons for each of these functions.

7.4.13 File Properties

You may view the properties of a form template at any time by selecting the File menu and then clicking Properties. From this window you can review the form template description, size, orientation, number of pages, number of regions and number of items. You may also reset the form template images from this window.
7.5 Saving a Form Template

You may save a form template at any time. It is recommended that you save your form templates as you go in case you are interrupted.

To save a form template

1. Select the File menu and then click Save, or click , to save the region definitions.

You may also use the Save As function to save the form template under a new name.

2. In the Save dialog box, enter a file name in the box titled File name.

3. Choose a directory location in the box titled Save in.

4. Click the Save button.

Form templates can only be saved with a .omr file extension. The form template images will be stored automatically as part of the overall form template file.

7.6 Editing an Existing Form Template

You can edit previously created form templates to add or delete pages or to make changes to the region definitions or page layout.

Note: Changing the structure of a form template after processing a batch of forms can cause compatibility conflicts between the form template and previously saved data files. Changes to the number of questions, the question order or the output labels will likely invalidate existing data files.

Form templates from previous versions of the software can be opened in the Remark Office OMR 6 Template Editor. The software will automatically convert older form templates to the new version. Form template files are upward compatible only. Once a form template has been converted to the new version,
it cannot be opened in a previous version of the software. Always make copies of form templates before converting them.

Tip: If you accidentally convert a form template without backing it up first and then want to use it in the previous software version, you will find a file with a .old extension in your form templates folder (the folder from which you originally opened the form template). You may rename this file with a .omr extension and then open it in the previous version of Remark Office OMR.

To edit a form template

1. If not already running, start the Remark Office OMR Template Editor program.

2. Select the File menu and then click Open, or click . You may also use the Recent Files option under the File menu or the Task Pane to open files.

3. Select the form template you would like to edit.

4. Click the Open button.

The form template is displayed in the tree view, with the image representation area on the right.

5. Double click within the boundaries of any region you want to edit, or double click the node representing the region in the tree view to display the Region Properties window. If you would like to rescan the pages of the form template, select the Tools menu and then click Reset Images.

6. Make the desired changes to the region’s properties and then click the OK button.

   Note: For more information about region types see the Creating a Template section of this chapter.

7. Save the form template when finished editing.
7.6.1 Editing OMR Regions

OMR Regions can be modified after they have been created in order to change properties such as region names, data types, orientation, labels, etc. If you select the entire OMR region, you will have access to all of the properties that are valid for that region. If you are editing an OMR region that contains multiple questions, you may only edit certain properties when selecting individual questions. The ability to edit individual questions allows you to change items such as test points, the ability to accept multiple responses and blank and multiple exception handling on an individual question basis, yet still only create one OMR region.

**Note:** Changing regions in a form template will not change data that have already been processed. To update data that have been read you will need to process the forms again, or use the Find/Replace option to change the existing data.

To edit a region with multiple questions

1. Double click within the boundaries of any region you want to edit, or double click a region node in the tree view to display the Region Definition window. You will have access to the OMR region properties, Region item properties and Question text and names sections.

2. Make the desired changes and click the OK button. Remember that changes made at this level apply to the entire region.

3. Save the form template when finished editing.
To edit individual questions within an OMR region

1. Expand the region containing multiple questions by clicking the plus sign next to the region node in the tree view.

2. Double click the question node representing the question you wish to change. You can also select multiple nodes by holding down Ctrl on the keyboard and clicking each region or by clicking a region, holding down Shift on the keyboard and then clicking another region; all nodes in between the selections will be highlighted.

   **Note:** If multiple questions are selected, you will not be able to edit Question Text or Question Names. You will be able to adjust the Labels for all selected questions, however.

3. The Properties window will appear. You will be able to adjust Region item properties and Question text, names and responses.

   **Note:** When viewing properties for individual questions within an OMR region, the Question text and names window changes to Question text, names and responses. You will find the question’s labels on this screen. Question text and names will only be displayed for the selected question(s).

4. Make the desired changes.

5. Click the OK button to save your changes and return to the tree view.
7.7 Template Editor Preferences

The Remark Office OMR Template Editor comes with a set of preferences to help you use the software optimally. Use these preferences to customize the software to the way you use it. There are four general preference areas you can customize: General, OMR regions, Image regions and Barcode regions.

Using the Template Editor preferences

1. Select the Tools menu and then click Preferences, or click , to access the preferences.
2. Select the link in the Task Pane corresponding to the preference you wish to edit.
3. Make the appropriate changes.
4. Click the OK button to save the changes.

Preferences are global changes and will take effect the next time you use the applicable feature. Changing the preferences does not affect existing form templates and regions.

7.7.1 General Preferences

The General screen allows you to customize general features of the Template Editor. The following options are available:
<table>
<thead>
<tr>
<th>Section</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Preferences</td>
<td>Default region name</td>
<td>Enter a default region name to be used for every new region created. For example, entering &quot;Q&quot; will cause every region name to be called Q. Remark Office OMR will automatically append numbers to the end of the region name so that your regions will be called Q1, Q2, Q3, etc.</td>
</tr>
<tr>
<td></td>
<td>Format delimiter</td>
<td>Specify the character to use for the Define Format feature for Grid fields. Define Format allows you to format the output of a Grid field (e.g., put slashes in between numbers to produce a date: <strong>/</strong>/**). The Format Delimiter is the character displayed in the region properties window when you use this feature. The asterisk (*) is the default delimiter. Each asterisk represents a character in the region.</td>
</tr>
<tr>
<td></td>
<td>Perform logging</td>
<td>Mark this checkbox to have Remark Office OMR store log files when the software terminates unexpectedly. The log file will contain the work you were doing so that it can be restored when you restart the software. You will be prompted to load the log file in the event of an unexpected termination. Use of this feature is strongly recommended.</td>
</tr>
<tr>
<td>Dictionary Settings</td>
<td>Dictionary location</td>
<td>Use this setting to specify where the spell check dictionary is located. The default location is the Windows\System32 folder.</td>
</tr>
<tr>
<td></td>
<td>Active dictionary</td>
<td>Use this setting to choose the dictionary you want to use for spell check. Any dictionaries installed on your system will be displayed in the list.</td>
</tr>
</tbody>
</table>
### 7.7.2 OMR Region Preferences

The OMR Region screen allows you to setup default settings to be used when creating new OMR regions. When creating new OMR regions, the selected settings will be used automatically. However, you can always change individual OMR region properties as you go. The following options are available:

<table>
<thead>
<tr>
<th>Section</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Region Definition</td>
<td>OMR type</td>
<td>Sets the default OMR region type to be used when creating new OMR regions: Multiple, Grid, Boolean, List, Add, Binary.</td>
</tr>
<tr>
<td></td>
<td>Data type</td>
<td>Sets the default OMR region data type to be used when creating new OMR regions: Textual or Numeric.</td>
</tr>
<tr>
<td></td>
<td>Orientation</td>
<td>Sets the default OMR region orientation to be used when creating new OMR regions: Row or Column.</td>
</tr>
<tr>
<td>Section</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Threshold</td>
<td>Sets the default recognition threshold for OMR regions. Lower thresholds force the software to be more sensitive when reading light or less filled marks. Higher thresholds force the software to be more strict and therefore more discriminate when reading regions with multiple filled marks. Use the default setting of 3 unless you encounter problems when processing forms. Use caution when using extremely low or high thresholds. Low thresholds will cause the software to be very sensitive, possibly picking up items such as erasures. High thresholds may cause the software to choose the most filled mark when two marks are encountered instead of outputting a MULT for your review.</td>
</tr>
<tr>
<td>Default Region Grade Settings</td>
<td>Regions to Grade</td>
<td>Use the checkboxes to select the OMR region types that you want to be graded by default when performing a grade operation.</td>
</tr>
<tr>
<td>Default Region Survey Settings</td>
<td>Regions to Tabulate</td>
<td>Use the checkboxes to select the OMR region types that you want to be tabulated by default when performing a survey operation.</td>
</tr>
<tr>
<td>Section</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Multiple Exception</td>
<td>Replace with (Multiple and List)</td>
<td>Select the replacement option to be used by default when a multiple response occurs for a Multiple or List region during form processing. The text entered in this box will appear as output in the data grid and be exported in any saved data files. The default replacement is MULT. Other pre-defined options include Asterisk (*), Nothing, Space Character, and Tilde (~). You may also type characters into the <strong>Replace with</strong> box.</td>
</tr>
<tr>
<td>Blank Exception Handling</td>
<td>Replace with (Grid)</td>
<td>Select the replacement option to be used by default when a multiple response occurs for a Grid region during form processing. The text entered in this box will appear as output in the data grid and be exported in any saved data files. The default replacement is MULT. Other pre-defined options include Asterisk (*), Nothing, Space Character, and Tilde (~). You may also type characters into the <strong>Replace with</strong> box.</td>
</tr>
<tr>
<td>Default Blank Exception</td>
<td>Replace with (Multiple and List)</td>
<td>Select the replacement option to be used by default when a blank response occurs for a Multiple or List region during form processing. The text entered in this box will appear as output in the data grid and be exported in any saved data files. The default replacement is BLANK. Other pre-defined options include Asterisk (*), Nothing, Space Character, and Tilde (~). You may also type characters into the <strong>Replace with</strong> box.</td>
</tr>
<tr>
<td><strong>Section</strong></td>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td><strong>Replace with</strong></td>
<td>(Grid)</td>
<td>Select the replacement option to be used by default when a blank response occurs for a Grid region during form processing. The text entered in this box will appear as output in the data grid and be exported in any saved data files. The default replacement is BLANK. Other pre-defined options include Asterisk (*), Nothing, Space Character, and Tilde (~). You may also type characters into the Replace with box.</td>
</tr>
</tbody>
</table>
| **Flag Blanks** | (Grid) | Use this setting to further customize how Remark Office OMR interprets blank responses:  

*Always*- If any character in the Grid region is left blank, regardless of the replacement characters being used, the region contain a yellow BLANK flag.  

*Ignore leading/trailing*- If leading or trailing characters in the region are left blank, they will be ignored. This will allow you to capture data smaller than the allotted region without the data being flagged with a yellow BLANK flag.  

*Never*- If any character within the region is blank, Remark Office OMR will ignore it. The region will never appear with a yellow BLANK flag in the data grid. |
7.7.3 Image Region Preferences

The Image Region screen allows you to setup default settings to be used when creating new Image regions. When creating new Image regions, the selected settings will be used automatically. However, you can always change individual Image region properties as you go. The following options are available:

<table>
<thead>
<tr>
<th>Section</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Region</td>
<td>Image type</td>
<td>Sets the default Image region type: Data Entry or Image Clip. Data Entry regions allow you to hand enter data from the region into your template grid with the assistance of image files. Image Clip regions capture a snapshot image of the information in the region and store it on your computer. The information captured from either type of Image region can be viewed in reports in Remark Quick Stats.</td>
</tr>
<tr>
<td></td>
<td>Data type</td>
<td>Sets the default Image region data type to be used when creating new Image regions: Textual or Numeric.</td>
</tr>
<tr>
<td>Section</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Threshold</td>
<td>Sets the default recognition threshold for Image regions. Lower thresholds force the software to be more lenient when reading light or less filled marks. Higher thresholds force the software to be more strict and therefore less likely to pick up stray or light markings within the region. Use the default setting of 3 unless you encounter problems when processing forms. Use caution when using extremely low or high thresholds. Low thresholds will cause the software to be very sensitive, possibly picking up items such as erasures. High thresholds may cause the software to not detect handwriting within light or less filled Image regions.</td>
<td></td>
</tr>
<tr>
<td>Default Image</td>
<td>Target directory</td>
<td>Sets the default storage location for the images that are captured when using Image Clips.</td>
</tr>
<tr>
<td>Clip Options</td>
<td>Grade region</td>
<td>Mark this checkbox to grade Image regions by default when performing a grade operation.</td>
</tr>
<tr>
<td>Default Grading &amp;</td>
<td>Tabulate region</td>
<td>Mark this checkbox to tabulate Image regions by default when performing a survey operation.</td>
</tr>
<tr>
<td>Survey Analysis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
7.7.4 Barcode Region Preferences

The Barcode Region screen allows you to setup default settings to be used when creating new Barcode regions. When creating new Barcode regions, the selected settings will be used automatically. However, you can always change individual Barcode region properties as you go. The following options are available:

<table>
<thead>
<tr>
<th>Section</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Region Definition</td>
<td>Barcode orientation</td>
<td>Sets the default orientation to be used when creating new Barcode regions: Horizontal or Vertical.</td>
</tr>
<tr>
<td></td>
<td>Data type</td>
<td>Sets the default Barcode region data type to be used when creating new Barcode regions: Textual or Numeric.</td>
</tr>
<tr>
<td>Default Grading &amp; Survey</td>
<td>Grade region</td>
<td>Mark this checkbox to grade Barcode regions by default when performing a grade operation.</td>
</tr>
<tr>
<td>Analysis</td>
<td>Tabulate region</td>
<td>Mark this checkbox to tabulate Barcode regions by default when performing a survey operation.</td>
</tr>
</tbody>
</table>
8.1 Overview

This chapter explains how to process forms in the Remark Office OMR Data Center. You should refer to your scanner’s documentation for instructions on installing and using the scanner.

The following topics are covered:

- Opening a form template
- Using the Read Wizard
- Reviewing exceptions
- Collating forms
- Form, page and respondent IDs
- Batch processing
- Server Mode
- Respondent detection

8.2 Opening a Form Template

The Remark Office OMR software requires a form template file for each unique form that you want to process. This file defines all of the information needed for the software to read the form. Form templates are created in the Remark Office OMR Template Editor, which is covered in Chapter 7 of this user’s guide.

To begin the reading process, open the form template file corresponding to your form. The Remark Office OMR template grid window employs a spreadsheet style interface to display recognized data. Each grid column corresponds to an item or question on the form, as it was defined in the form template.
Important Note: Form templates from previous versions of the software can be opened in the Remark Office OMR 6 software. Once they are opened in the new version, form templates are automatically converted. Form template files are upward compatible only. Once a form template has been converted to the new version, it cannot be opened in a previous version of the software. Always make copies of form templates from previous versions before converting them.

To select a form template

1. Select the File menu and then click Open Form Template, or click , to display the Open Remark Template window. Alternatively, select Open form template from the Task Pane.

   Note: Form template file names employ an OMR file extension.

   Tip: You can access recently used form templates from the File menu or the Task Pane.

2. Select the correct form template file by clicking its name.

3. Click the OK button to open the form template and display the corresponding template grid window.

Once the form template is open, you may begin processing forms. By default, when you open a form template, you will see the template grid across the top of the screen and the Image Viewer at the bottom of the template grid. The template grid is where you will see the data as forms are processed. The Image Viewer will display an image of the form as it is processed. If you click within a template grid cell, the Image Viewer will move to that place on the corresponding image.

(Note: If you have the Zoom to Region on Selection toolbar button enabled, the Image Viewer will also zoom in on the selected region.)
8.3 The Remark Office OMR Read Wizard

Form processing is handled through the Remark Office OMR Form Wizard. When reading forms in the Remark Office OMR Data Center, you can have the software read pages directly from the scanner or from image files that you have previously created. Before attempting to read any pages from the scanner, turn on your scanner and open the form template that corresponds to your forms. (See Section 8.2 Opening a Form Template.)

**Note:** The forms you wish to process must correspond to the selected form template.

The Data Center places the recognized data in the open form template grid. All data obtained from reading one form appear in a single grid row. Each column of the template grid corresponds to each variable (question) defined in the form template.

8.3.1 Scanning Forms with the Read Wizard

Forms can be scanned with most TWAIN compliant scanners. See Chapter 4 for more information about scanners and how to set them up in Remark Office OMR. As the forms are scanned, images of each form are stored on your computer. These images are used to review the data for easy clean up.

To read pages from the scanner

1. Open the correct form template. (See Section 8.2 Opening a Form Template.)

2. Select the **Tools** menu and then click **Read Wizard**, or click ![Read Wizard](image). Alternatively, you may select the **Read Wizard** link from the Task Pane.

3. In the **Read Method** window, select the radio button for **Read from scanner**.
Note: If you need to configure your scanner, click the Scanner Properties link to view its setup (see Chapter 4 for detailed information about setting up a scanner).

4 If desired, mark the appropriate checkboxes under Advanced Collection Options. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Mode</td>
<td>Automates form processing by having Remark Office OMR run in the background using specific options. See Section 8.9 Server Mode for further details.</td>
</tr>
<tr>
<td>Auto Form ID Mode</td>
<td>Allows the software to automatically recognize form templates, form pages and respondents by placing identifiers on the forms. See Section 8.7 Form, Page and Respondent IDs for further details.</td>
</tr>
<tr>
<td>Start reading from form template page</td>
<td>Allows you to start processing forms starting with a specific form template page instead of at the beginning. This feature is useful for overwriting data.</td>
</tr>
<tr>
<td>Collate Mode</td>
<td>Allows you to scan forms that are double sided without the use of a duplex scanner. See Section 8.5 Using Collate Mode for further details.</td>
</tr>
<tr>
<td>Resume last Collate Mode session</td>
<td>Resumes scanning from the point in which you left off in your last Collate Mode scan session.</td>
</tr>
</tbody>
</table>

5 If you would like to configure image naming conventions, click the Next>> button to continue. Otherwise skip to step 12.

The Scanned Image Naming Conventions window allows you to specify options about the images that will automatically be stored each time you scan forms.

6 In the Begin image names with box, enter a file base name that the software can use to name the images stored for this form. The default base name is the form template name, however, you may use any name you like. We suggest using something that identifies to you that the images belong to
a certain form. The images that are stored will all begin with this base name and then have the page number (if scanning a multi-page template), date and time appended to them to keep track of the various images. You may optionally choose a region from the form template to use as the base name. The value that is collected from the form for the specified region will be used as the base name for the corresponding stored image (along with the date and time). If you leave the **Begin image names with** option blank, your images will only have the page number (if applicable), date and time as the name of each image.

7 In the **Image target directory** box, click the **Browse...** button to select a location in which to store the images for this form. You may use the default directory for images or select a different directory.

8 Mark the checkbox for **Save images in a subfolder based on the form template’s name** to have the Data Center automatically create a folder in which to store these images. The folder name will be the name of the form template and the folder will be created in the directory you have selected in the Image target directory box.

**Tip:** We recommend using the **Save images in a subfolder based on the form template’s name** feature for easier organization of image files. Use of this feature will keep all images associated with each form template in one folder for easy access. The unique date and time portion of the image names will prevent images from being overwritten.

9 In the **Saved image type** box, select an image type to use for storing images. The choices are: **PCX/DCX**, **PDF** or **TIF**.

**Note:** PDF support is only enabled if you turn on this feature by selecting the **Tools** menu, clicking **Preferences** and then clicking the **Recognition** link in the Task Pane.
10 When saving to the PDF or TIF formats, you can choose the compression rate under **Image compression level: Uncompressed, Group 3, Group 3 2d** and **Group 4**. Group 4 will create the most compressed (smallest file size) image.

11 Mark the checkbox for **Save multiple page form templates as multiple page image files** if you are scanning with a multi-page form template and would like all of the images for one complete form to be saved as one image file. Using this option will create fewer image files.

12 If you would like to configure **Review Exceptions** options, click the **Next>>** button to continue. Otherwise click the **Read** button to begin scanning pages.

Review Exceptions is a way to correct exception cases found on forms, such as blank and multiple responses (see Section 8.4 Review Exceptions for further details about using this feature).

13 In the **Review Exceptions** window, specify whether to review exception cases during the scanning process by marking the **Activate Review Exceptions** checkbox.

14 In the **Review Exceptions Options** area, mark the checkboxes for those cases that you wish to review during scanning. The following options are available: **Multiple responses**, **Blank responses**, **Recognition errors**, **Image regions**, **Database Lookup regions**, **Barcode regions** and **Required items**. Reviewing Exceptions during scanning will cause the software to stop scanning when it encounters any exception cases you select. You can then make the appropriate adjustments and the scanning will then resume.

15 Place the completed forms in the scanner.

16 Click the **Read** button to begin processing pages.
Remark Office OMR will continue scanning pages until the scanner’s sheetfeeder is empty.

17 After processing all of the pages, you will be prompted to continue scanning. Click Yes to scan more pages or No to end the reading process.

8.3.1.a Scanning Using Default Settings (Easy Scan)

Once you have run the Read Wizard, you may optionally scan using default settings without running the Read Wizard each time. This method is called Easy Scan and scanning will occur using the last settings specified in the Read Wizard.

**Caution:** Easy Scan is useful if you are using the same settings each time you scan. If you are uncertain about what settings exist, it is recommended that you run the Read Wizard to initiate scanning.

**To use Easy Scan**

1. Open the correct form template. (See Section 8.2 Opening a Form Template.)

2. Select the **Tools** menu and then click **Easy Scan**, or click the Easy Scan toolbar button, .

All pages in the scanner will be scanned based on the last settings entered in the Read Wizard. You will then see a spreadsheet of data. Each row represents one complete form and each column represents each question you defined in the form template.
8.3.2 Processing Image Files with the Read Wizard

Remark Office OMR can process image files that have already been scanned. For example, if you have a network scanner or a scanner that is not compatible with Remark Office OMR, you can scan your forms in another application and then save the resulting image files. Remark Office OMR will read those image files with the corresponding form template. The end result looks just as if you had scanned the forms directly in the Remark Office OMR Data Center.

Remark Office OMR can read from the following image file formats:

- Graphics Interchange Format (*.gif)
- Portable Document Format (*.pdf)
- JPEG (*.jpg, *.jpeg)
- PNG (*.png)
- Macintosh Pict (*.pct, *.pict)
- TIFF (*.tif, *.tiff)
- Multipage PCX (*.dcx)
- Windows Bitmap (*.bmp)
- PCX (*.pcx)
- Photoshop Format (*.psd)

To read image files with the Read Wizard

1. Open the correct form template. (See Section 8.2 Opening a Form Template.)

2. Select the Tools menu and then click Read Wizard, or click . Alternatively, you may select the Read Wizard link from the Task Pane.

3. In the Read Method window, select the radio button for Read from image files.

4. If desired, click the link for Advanced Image Recognition Properties. This link will allow you to set the following options: Invert image, Auto deskew images during recognition, Auto despeckle images during recognition.

   **Caution:** We do not suggest making changes to the Advanced Image Recognition Properties unless you encounter difficulties related to these settings.

5. If desired, mark the appropriate checkboxes under Advanced Collection Options. The following options are available:
### Processing Forms

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Mode</td>
<td>Automates form processing by having Remark Office OMR run in the background using specific options. See Section 8.9 Server Mode for further details.</td>
</tr>
<tr>
<td>Auto Form ID Mode</td>
<td>Allows the software to automatically recognize form templates, form pages and respondents by placing identifiers on the forms. See Section 8.7 Form, Page and Respondent IDs for further details.</td>
</tr>
<tr>
<td>Start reading from form template page</td>
<td>Allows you to start processing forms starting with a specific form template page instead at the beginning. This feature is useful for overwriting data.</td>
</tr>
</tbody>
</table>

6. Click the **Next>>** button to continue.

7. In the **Select Images to Read** area, use the drop-down list to locate the folder on your computer that contains the images you wish to process.

8. Once you have located the correct folder, select the images you wish to process. You may make multiple selections by holding down the **Ctrl** key and clicking images or holding down the **Shift** key and selecting a range of images (click the first and last image and all images in between will be selected).

9. Click the **Add Selected Images** button to move the images into the bottom window. Alternatively, you can select an entire folder’s images by clicking the **Add All Images** button. The images will be moved to the **Images in Read Order** box. The selected images will be processed in the order in which they appear in this box.
10 If an image appears in the **Images in Read Order** box and you wish to remove it, select the image and then click **Remove**. You may make multiple selections by holding down the **Ctrl** key and clicking images or holding down the **Shift** key and selecting a range of images (click the first and last image and all images in between will be selected). You can also remove all images by clicking the **Remove All** button.

11 If you would like to configure **Review Exceptions** options, click the **Next** button to continue. Otherwise click the **Read** button to begin processing image files.

Review Exceptions is a way to correct exception cases found on forms, such as blank and multiple responses (see Section 8.4 for further details about using Review Exceptions).

12 In the **Review Exceptions** window, specify whether to review exception cases during the reading process by marking the **Activate Review Exceptions** checkbox.

13 In the **Review Exceptions Options** area, mark the checkboxes for those cases that you wish to review during reading. The following options are available: **Multiple responses**, **Blank responses**, **Recognition errors**, **Image regions**, **Database Lookup regions**, **Barcode regions** and **Required items**. Reviewing Exceptions during image processing will cause the software to stop reading image files when it encounters any exception cases you select. You can then make the appropriate adjustments and the image processing will then resume.

14 Click the **Read** button to begin processing image files.

The Data Center will continue processing images until all of the specified images have been read. You will then see a spreadsheet of data. Each row represents one complete form and each column represents each question you defined in the form template.

### 8.4 Reviewing Exceptions

As forms are processed, exception cases will occur. You should edit cells containing exception cases to validate your data before performing any analysis operations or exporting the data to another application. Each exception case is assigned a specific flag with a corresponding color so that you can easily distinguish different types of exceptions. The following table summarizes the types of exception cases and their possible causes.
<table>
<thead>
<tr>
<th>Error Type</th>
<th>Text</th>
<th>Flag Color</th>
<th>Possible Causes</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Response</td>
<td>BLANK</td>
<td>Yellow</td>
<td>Unanswered questions. Response not completely filled.</td>
</tr>
<tr>
<td>Multiple Responses</td>
<td>MULT</td>
<td>Green</td>
<td>More than one answer selected when multiple responses are not permitted. Partially erased forms. Carelessly marked forms.</td>
</tr>
<tr>
<td>Form Errors</td>
<td>ERROR...</td>
<td>Red</td>
<td>Forms that have been enlarged, reduced, offset or skewed by more than 3/8 inch; could result from photocopying or reprinting. Improperly or carelessly placed forms in the automatic document feeder of the scanner. Forms that have text or lines placed too close to markable areas, causing the text or lines to be interfere with the marks. Images scanned with brightness setting too high or low. Carelessly marked forms. Forms processed with wrong form template file.</td>
</tr>
<tr>
<td>Barcode Errors</td>
<td>???</td>
<td>Orange</td>
<td>Used a barcode type that Remark Office OMR cannot recognize. Used the Code 39 barcode type without using beginning and ending asterisks (*). Barcode does not fit within region definition area. Barcode is printed too small.</td>
</tr>
</tbody>
</table>
Remark Office OMR User’s Guide

### Error Type Table

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Text</th>
<th>Flag Color</th>
<th>Possible Causes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extraneous marks</td>
<td></td>
<td></td>
<td>Extraneous marks are located within the Barcode region.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Scanning resolution is too low (should be at least 200 DPI).</td>
</tr>
<tr>
<td>Image Region</td>
<td>None</td>
<td>Blue</td>
<td>Signifies a data entry image region where handwriting was found. You will need to type the information found in the region.</td>
</tr>
<tr>
<td>Database Lookup Errors</td>
<td>Selected Responses</td>
<td>Purple</td>
<td>Response not found within the selected database to which the region is linked.</td>
</tr>
</tbody>
</table>

Remark Office OMR offers image-assisted exception reviewing, which eliminates searching through paper forms to make corrections to the data. You can resolve exception cases in one of two ways: editing individual cells or using the Review Exceptions feature during or after form processing.

#### 8.4.1 Reviewing Exceptions by Modifying Individual Cells

Cells can be edited individually by clicking the cell you wish to change. You can use the drop-down arrow to select correct responses or type the desired text into the cell. As you click in a cell, the Image Viewer at the bottom of the screen will update automatically (select View|Image Viewer if you are not seeing the Image Viewer). You may also zoom to the selected region by enabling the toolbar button for Zoom to Region on Selection in the Image Viewer toolbar.

**Note:** Editing a cell removes any error flags.
To reconcile cells individually

1. Click the cell that you wish to change.
2. If the cell contains a drop-down arrow, click the arrow and choose the correct response from the list.
3. If the cell does not contain a drop-down arrow, type the appropriate response in the cell and press Enter or click another cell.

Note: Each cell contains either a text box or a drop-down list box depending on its region type. Grid, Binary and Add OMR regions, barcode regions and Image regions that are not using the Database Lookup feature are considered text regions. You will not have a drop-down list box for these region types. All other types of OMR regions are considered list regions and will have a drop-down list from which you can choose responses.

8.4.2 Using Review Exceptions

Remark Office OMR provides the Review Exceptions feature as a method to validate data. You may use the Review Exceptions feature to review the following exception cases: blank responses, multiple responses, form errors, barcode errors, database lookup errors, required items or data entry Image regions.

The Review Exceptions feature can be used in one of two ways:

During Form Processing: If used during the reading process, whether scanning forms or processing saved image files, Review Exceptions provides an option to have the Data Center pause after encountering selected exception types. You can then select or enter the correct response.

After Form Processing: Review Exceptions can also be used after the forms have been processed; therefore, you are not required to have the software stop when exceptions are encountered. When reviewing after processing, the software will cycle through the data file to find exception cases and then allow you to make the appropriate changes.

Regardless of how you use Review Exceptions, the Data Center will display a Review Exceptions window in the Task Pane. The software will also zoom in on the question containing the exception case in the Image Viewer at the bottom of your screen. You may use the image to guide you in making the appropriate updates in the Review Exceptions panel. The following table details the available Review Exceptions options:
### Review Option | Function
--- | ---
Blank Responses | Review when a respondent fails to answer a question.
Multiple Responses | Review when a respondent chooses more answers than were permitted.
Image Regions | Review when a flagged Image region is encountered. Allows the hand entry of information into the data grid.
Region Error | Review when a recognition error occurs.
Database Lookup Error | Review when a database lookup error is encountered, meaning that the response is not located in the database that was specified during the form template creation process.
Barcode Error | Review when a barcode error occurs.
Required Items | Review when a required item has not been answered.

### To use Review Exceptions during form processing
1. Open the correct form template. (See Section 8.2 Opening a Form Template.)
2. Begin processing forms by either selecting the Tools menu and then clicking Read Wizard, clicking or clicking the Read Wizard link in the Task Pane.
3. Make the necessary selections on the Read Method screen and the Scanned Image Naming Conventions (if scanning) or Image Selection window (if reading image files) screen. See Section 8.3 The Remark Office OMR Read Wizard for detailed information about these screens.
4 Click the **Next>>** button to go to the **Review Exceptions** screen.

5 Mark the checkbox for **Activate Review Exceptions** to turn on the Review Exceptions feature.

6 In the **Review Exceptions Options** area, select the exception cases you would like to review during form processing: **Blank responses, Multiple responses, Recognition errors,** **Image regions, Database Lookup regions, Barcode regions, Required items.**

7 Click the **Read** button to begin the reading process.

The Data Center will begin processing forms normally. When a selected exception case is found, the Review Exceptions window will appear in the left Task Pane. You will use this window to make changes. Please proceed to Section 8.4.2.a for detailed information about the Review Exceptions window.

**To use Review Exceptions after form processing**

1 After processing forms, select the **Tools** menu and then click **Review Exceptions**, or click **Review exceptions** link from the Task Pane.

2 In the **Review Exceptions Options** area, select the exception cases you would like to review during form processing.

3 Click the **Begin Review** button to begin reviewing the data.

   **Tip:** You may process forms and clean sections of the data as you go. Simply begin Review Exceptions normally. Then, if you wish to process more forms, leave the Review Exceptions window open and process additional forms. When you are ready to review the newly processed forms, in the Review Exceptions window, click the down arrow on the **Begin Review** button and choose **Begin from Last Read Operation**. The Data Center will begin reviewing data grid rows from the point where you most recently began processing forms.
The Data Center will search the data for the specified exception cases. When a selected exception case is found, it will appear in the Review Exceptions window in the left Task Pane. You will use this window to make changes. Please proceed to the next section for detailed information about the Review Exceptions window.

**Tip:** When using Review Exceptions after form processing, you can review the entire data set or sections of the data set. To review sections of the data set, select the column or row header(s) of the area you wish to review, or highlight a group of cells. For example, if you only want to review a specific comment region (Image region) so that you can hand enter data, select the column header of the comment region so that the entire column is highlighted. Then click Review Exceptions; only the selected column will be reviewed.

### 8.4.2.a Using the Review Exceptions Window

Whether you use Review Exceptions during or after form processing, any exceptions found while reading display in the Review Exceptions window. The Review Exceptions window displays the following information:

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search by:</td>
<td>Row/Respondent: Use this option to search across the data grid in rows (by respondent).</td>
</tr>
<tr>
<td></td>
<td>Column/Item: Use this option to search across the data grid in columns (by form template item/question).</td>
</tr>
<tr>
<td>Response</td>
<td>Displays the current response. Use this box to enter the correct response by typing the response or clicking the drop-down arrow and choosing a response. You can view the item in question in the Image Viewer for assistance in verifying the response.</td>
</tr>
<tr>
<td>Search Forward</td>
<td>Moves to the next exception case on the form.</td>
</tr>
<tr>
<td>Search Backward</td>
<td>Moves backwards until it encounters an exception case.</td>
</tr>
<tr>
<td>Next Row/Column</td>
<td>Moves to the next exception case on the next form (it will search by row or column, depending on</td>
</tr>
</tbody>
</table>
Property | Function
---|---

Previous Row/Column | Moves backward one row or column until it encounters an exception case (it will search by row or column depending on your selection in the Search by box).

Finished | Ends Review Exceptions.

Cancel | Cancels reviewing of the current page. Upon canceling you will have three options:

1. **Restore Original Data**: Cancels any changes made to this page during Review Exceptions and restores the original data.

2. **Discard Page Data**: Discards the current page’s data all together. You may rescan or re-import an image file after discarding the data.

3. **Cancel**: Returns to Review Exceptions.

**To replace an exception**

1. Click the **Response** box down arrow (if available) to view a list of possible responses and then click the correct answer(s), or type the desired text into the **Response** box. The down arrow is available for Multiple, Boolean and List OMR regions, as well as Image regions that use Database Lookup. For Grid, Add and Binary OMR regions, as well as Barcode and any other data entry Image regions, you may type the appropriate response.
**Remark Office OMR User’s Guide**

**Note:** The displayed text (e.g., BLANK) remains in the output data unless you replace it.

2 To skip to the next exception case on the current form, click the **Search Forward** button at the bottom of the window. You may also press the **Enter** key on your keyboard to advance to the next exception.

3 To skip any remaining exception cases on the current form and move to the next form containing exception cases, click the **Next Row/Next Column** button at the bottom of the window.

4 When you have completed reviewing exceptions, click the **Finished** button.

**Tip:** If you need to return to the processed data at a later point to complete reviewing exceptions, save the data to the Remark or Remark Archive format. These formats will save the exception case flags and links to the stored images so that you may continue reviewing the data. If the data is exported to other formats, these flags and image links will be lost. See Section 9.5 Saving Grid Data for complete details on saving data.

### 8.5 Using Collate Mode (Scanning Double Sided Forms with a Single Side Only Scanner)

The Remark Office OMR Data Center provides Collate Mode to read duplex (double sided) forms when you have a simplex (single side only) scanner. Therefore, if you do not have a duplex scanner (one that reads both sides of a form in a single pass) you can still process double sided forms in the software.

To use Collate Mode you will perform three basic steps: place a stack of forms in the scanner’s automatic document feeder and scan the odd numbered pages, flip the stack over and then scan the even pages. The forms are placed in the scanner in regular page order. The Data Center will read all odd numbered pages first, regardless of how many sets of forms you place in the scanner. The software will then read the even numbered pages in reverse order so that the data are written to the correct position. For example, suppose you had a 6 page, double sided form. You would first scan pages 1, 3 and 5, then flip the stack over and scan pages 6, 4 and 2.

**Note:** If your form does not have an even number of pages (e.g., the last page has a blank backside), Remark Office OMR will automatically compensate for the blank backside. You do not need to create a blank form template page.
To process pages using Collate Mode

1. Open the correct form template. (See Section 8.2 Opening a Form Template)

2. Select the Tools menu and then click Read Wizard, or click . Alternatively, you may select the Read Wizard link from the Task Pane.

3. In the Read Method window, select the radio button for Read from scanner.
   Note: If you need to configure your scanner, click the Scanner Properties link to view its setup. (See Chapter 4 for detailed information about setting up a scanner.)

4. In the Advanced Collection Options area, mark the checkbox for Collate Mode.

5. Click the Next>> button to continue by modifying Scanned Image Naming Conventions and Review Exceptions options (see Sections 8.3 and 8.4 for further details), or click the Read button to begin processing forms.

6. Place all double sided forms you want to read in the automatic document feeder of your scanner in normal page order and then click the OK button.

The Data Center begins reading the odd numbered pages (the front sides of the forms). When finished processing the odd numbered pages, you will be prompted to read in the other direction.

7. When prompted, turn the stack of forms over and place it back in the automatic document feeder of the scanner. Do not rearrange the forms. The Data Center will collate the forms properly.

8. Click the checkbox for Begin Reading in Other Direction.
9 Click the **Continue** button.

10 When finished reading the even pages (the back sides), you will be prompted to start a new batch or finish processing. Continue reading forms in this manner until all forms have been processed.

**Tip:** When using Collate Mode, scan complete form sets in batches. Complete an entire set of odd and even pages before scanning more forms in a single direction. This way if the scanning process is interrupted unexpectedly, you will be less likely to lose any data and it will be easier to recover.

If the scanning process is interrupted, Remark Office OMR has a Resume option. Follow the directions above, but mark the checkbox for **Resume last Collate Mode session** in the Read Wizard. This option will pick up the scanning from where you last left off.

### 8.6 Overwriting Data Records

The Remark Office OMR Data Center also allows you to process forms in their original order beginning on a selected form template page. This method is useful if your reading session was interrupted unexpectedly and you need to resume form processing midway into your data. To use this method, you must first select a grid row. You can then use the Read Wizard to process new forms either at the beginning of the selected data grid row or beginning with a certain form template page. The latter option is the same as reading from the scanner or image files normally except that you can choose the page on which to begin.

**To overwrite data**

1 Highlight the data grid row(s) containing the data you wish to overwrite.

2 Select the **Tools** menu and then click **Read Wizard**, or click ![Read Wizard](image). Alternatively, you may select the **Read Wizard** link from the Task Pane.

3 In the **Read Method** window, select the radio button for the option you wish to use: **Read from scanner** or **Read from image files**.

4 In the **Advanced Collection Options** area, mark the checkbox for **Start reading from form template page**. Enter the page number at which to start processing. You may use the up and down arrow keys or type a number. If you are using a single page form template, or overwriting the entire data grid row, you do not need to use this setting.
5 Configure the remaining **Read Wizard** options by clicking the **Next>>** button (see Section 8.3 The Remark Office OMR Read Wizard for detailed information about using the Read Wizard). If processing image files, click the **Next>>** button to choose the image files.

6 If scanning forms, place all pages to be read in the scanner, starting with the page corresponding to the form template page entered in step 4, and then click the **Read** button.

   **Note:** If you place more than one page in the scanner, the Data Center continues reading pages and placing data across the selected grid row sequentially. However, the Data Center will not read past the last highlighted grid row(s).

7 When prompted to overwrite the data, click the **Overwrite** button. If you do not wish to overwrite the data for any reason, click the **Cancel** button.

   The Data Center will continue processing forms beginning on the selected form template page until all selected pages in the data grid row have been replaced.

**8.7 Using Form, Page and Respondent Detection**

Remark Office OMR allows for three types of automatic tracking and detection to assist with form processing: Auto Form ID, Auto Page ID and Respondent Tracker. With Auto Form ID, Remark Office OMR can automatically recognize a form and match it to its form template, allowing you to process various form types at once without pre-sorting the forms. With Auto Page ID, Remark Office OMR will take it a step further and identify specific page order within a form template if the pages are scanned out of order. With Respondent Tracker, Remark Office OMR will recognize a specific respondent’s page and place it in the correct data grid row with the rest of that respondent’s data if the pages are processed out of order. Form, Page or Respondent IDs can be either OMR or Barcode regions.

   **Note:** See Section 7.3.3 Tracking for detailed information on setting up Form ID, Page ID and Respondent Tracker regions in a form template.

**8.7.1 Auto Form ID**

Remark Office OMR provides an Auto Form ID option for automatically matching a form with its corresponding form template. This type of form recognition allows you to process many different form types without pre-sorting the forms.
Note: You cannot use the Collate option with Auto Form ID.

Each form type you want to use with Auto Form ID must contain an ID region on every form template page. The ID region can be an OMR or Barcode region.

Note: For backwards compatibility, forms with an ID region on the first page only will still work in Auto Form ID mode, when using Auto Form ID by itself. If you wish to use Auto Page ID or Respondent Tracker in conjunction with Auto Form ID, you must have identifying regions on every page of the form.

To use Auto Form ID

1. Outside of Remark Office OMR, create a form that contains a unique identifier on each page that can be captured as an OMR or Barcode region in the Remark Office OMR form template.

   Tip: The Auto Form ID region could be a series of bubbles that represent form numbers, such as 1-4. Or it could be a barcode that identifies a specific form, such as Form A.

2. Create a form template for each form you wish to process in Auto Form ID mode. When creating the form template, set the region to be used as the Form ID region in the Tracking section of the region’s properties. Mark the checkbox for Use Region as a Unique Identifier. Then select the radio button marked Form ID. See Section 7.3.3.a Auto Form ID for further information about setting up ID regions in the form template.

3. When you are ready to start processing forms, open the form templates you wish to use in Auto Form ID mode in the Data Center (see Section 8.2 Opening Form Templates). Only open form templates that contain Auto Form ID regions.

4. Read forms from either scanner or image file by selecting the Tools menu and then clicking Read Wizard, or click .
5 In the Read Wizard, go to the section titled Advanced Collection Options and mark the checkbox for Auto Form ID Mode.

6 Click the Next>> button to configure remaining Read Wizard options. (See Section 8.3 The Remark Office OMR Read Wizard for further details about processing forms.)

Caution: When using Auto Form ID alone, the Data Center processes multiple page forms sequentially. After recognizing the first page of a multiple page form, Remark Office OMR assumes the following pages belong to the same form template. You may optionally use the Auto Page ID and/or Respondent Tracking features (described in the next two sections) to process pages out of normal order.

After recognizing the form type, the Data Center places the data into the appropriate data grid window. Any images that the Data Center cannot recognize enter a list of unrecognized images. You can review these images during or after form processing. See Section 8.7.4 Reviewing Unrecognized Images for further information about reviewing unrecognized images.

8.7.2 Auto Page ID

The Auto Page ID feature allows you to process form pages out of normal page order. The Data Center will search for the page identifier region on each page first, and place the data in the proper order. Auto Page ID can be used alone or in conjunction with Auto Form ID and/or Respondent Tracker. When used alone, you must process only those forms associated with one specific form template and be certain that all pages belonging to each respondent are grouped together for processing. Without the use of Respondent Tracker, if pages from differing respondents are mixed together, you will be prompted and form processing will stop. You will need to re-sort your forms so that each...
respondent’s pages are processed together; an individual respondent’s pages can be out of order within the same form, but a single respondent’s pages cannot be interspersed with another respondent’s pages. Auto Page ID regions can be OMR or barcodes regions.

**To use Auto Page ID**

1. Outside of Remark Office OMR, create a form that contains a unique identifier on each page that can be captured as an OMR or Barcode region in the Remark Office OMR template. Remember that if you are also using Auto Form ID, you will need a second unique identifier to be used as the Page ID. Each Page ID must be unique from page to page.

   **Tip:** The Page ID region could be a series of bubbles that represent page numbers, such as 1-4. Or it could be a barcode that identifies a specific page.

2. Create a form template for each form you wish to process using automatic page detection. When creating the form template, set the region to be used as the Page ID region in the **Tracking** section of the region’s properties. Mark the checkbox for **Use Region as a Unique Identifier**. Then select the radio button marked **Page ID**. See Section 7.3.3.b Page IDs for further information about setting up ID regions in the form template.

3. When you are ready to start processing forms, open the form templates you wish to use with Auto Page ID in the Data Center (see Section 8.2 Opening a Form Template).

4. Read forms from either scanner or image file by selecting the **Tools** menu and then clicking **Read Wizard**, or by clicking . (See Section 8.3 The Remark Office OMR Read Wizard for more details about processing forms.)

After recognizing the page, the Data Center places the data into the appropriate template grid section. Any images that the Data Center cannot recognize enter a list of unrecognized images. You can review these images during or after form processing. See Section 8.7.4 Reviewing Unrecognized Images for further information about reviewing unrecognized images.

**8.7.3 Respondent Tracker**

The Respondent Tracker feature allows you to scan respondents’ form pages in any order. Remark Office OMR will use the respondent identifier region of the form template to determine the appropriate record for each respondent. This
feature is only useful for multi-page forms. Therefore, you will need to also use the Auto Page ID feature along with Respondent Tracker. Remark Office OMR will first identify the page being processed, and then the respondent. Optionally, you may use Auto Form ID as well. Using all three features will allow you to process various forms, form pages and individual respondent pages in any order and still have Remark Office OMR properly record the data. Respondent Tracker ID regions can be OMR or Barcode regions.

**Note:** If you are only processing one multi-page form, use of Auto Form ID is not necessary. If you would like to process various form types at once and use the Respondent Tracker feature, you will need to also use Auto Form ID.

**To use Respondent Tracker**

1. Outside of Remark Office OMR, create a form that contains a unique identifier on each page that can be captured as an OMR or Barcode region in the Remark Office OMR form template. Remember that if you are using Auto Form ID and Auto Page ID, you will need a third unique identifier to be used as the Respondent Tracker.

   **Tip:** The Respondent Tracker region can be a bubble region where the respondent marks identifying information, such as name, ID number, etc. It can also be a Barcode region that contains similar information and is pre-printed. The information must appear on every page of the form.

2. Create a form template for each form you wish to process using the Respondent Tracker feature. When creating the form template, set the region to be used as the Respondent Tracker region in the Tracking section of the region’s properties. Mark the checkbox for **Use Region as a Unique Identifier**. Then select the radio button marked **Respondent tracker**. See Section 7.3.3.c Respondent Tracker for further information about setting up Respondent Tracker regions in the form template.

3. When you are ready to start processing forms, open the form templates you wish to use with Respondent Tracker mode in the Data Center (see Section 8.2 Opening a Form Template).

4. Read forms from either scanner or image file by selecting the **Tools** menu and then clicking **Read Wizard**, or by clicking **. (See Section 8.3 The Remark Office OMR Read Wizard for more details about processing forms.)
After recognizing the page and respondent, Remark Office OMR places the data into the appropriate data grid section. Each unique respondent tracker will produce a new row of data in the data grid.

8.7.4 Reviewing Unrecognized Images

Forms that are not recognized while processing in Auto Form ID, Auto Page ID or Respondent Tracker mode are stored for review. You can choose whether to review the unrecognized images during or after form processing. You must match the unrecognized image with the appropriate form template, page or respondent.

The Unrecognized Images Utility is used to match unrecognized form templates, form pages or respondents and can be used in one of two ways:

During Form Processing: If used during the reading process, whether scanning forms or processing saved image files, the Unrecognized Images Utility provides an option to have the Data Center software pause after encountering an unrecognized tracker region. You can then match the region to the appropriate form template, page or respondent.

After Form Processing: The Review Unrecognized Images Utility can also be used after the forms have been processed; therefore, you are not required to have the software stop when a form, page or respondent is not recognized. Any images that are not recognized will be stored in a queue. You can then access this queue after the forms have been processed and make the appropriate identifications.

Note: When using automatic page identification without the Response Tracker feature, you must process all pages of one complete form before moving on to the next form. If a page is not recognized, processing will stop even if you are not using the option to review during the read operation. Please sort your pages so that an entire respondent’s form is read at one time.

Regardless of how you use the Unrecognized Images Utility, the Data Center will display the Unrecognized Images Utility window when an unrecognized form or page is encountered. This window is described in detail in Section 8.7.5 Using the Unrecognized Image Utility.

To use the Review Unrecognized Images Utility during form processing

1. Open the correct form template. (See Section 8.2 Opening a Form Template.)
2 Begin processing forms by selecting the **Tools** menu and then clicking **Read Wizard**, clicking or by clicking the **Read Wizard** link in the Task Pane.

3 Make the necessary selections on the **Read Method** screen. If using Auto Form ID, mark the **Auto Form ID Mode** checkbox. (If automatically recognizing page or respondent IDs, you do not need to make any extra indications in the Read Wizard.)

4 Click the **Next>>** button to continue.

5 Make the necessary selections on the **Scanned Image Naming Conventions** (if scanning) or **Image Selection** window (if reading image files) screen. See Section 8.3 The Remark Office OMR Read Wizard for detailed information about these screens.

6 Click the **Next>>** button to go to the **Review Exceptions** screen.

7 Mark the checkbox for **Review unrecognized images when using region tracking** to turn on the **Review Unrecognized Images** feature.

8 Click the **Read** button to begin the reading process.

Remark Office OMR will begin processing forms normally. When an image is not recognized, the **Unrecognized Images Utility** window will appear. You will use this window to make changes. Please proceed to Section 8.7.5 for detailed information about the Unrecognized Image Utility window.

To use Review Unrecognized Images after form processing

1 After processing forms, select the **Tools** menu and then click **Review Unrecognized Images**.

The **Unrecognized Images Utility** window will appear, displaying any images that were not recognized during the read operation. You will use this window to
make changes. Please proceed to Section 8.7.5 for detailed information about the Unrecognized Image Utility window.

8.7.5 Using the Unrecognized Images Utility

When an image is not automatically recognized, the Unrecognized Images Utility will appear. You will use this window to see which specific ID region was not recognized and then match the image to the appropriate form template, form template page or respondent. The following table details the available Unrecognized Images Utility options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Templates</td>
<td>Provides a list of open form templates from which you can match the form that is not being automatically recognized. Use the drop-down list to select the correct form template for the image that is displayed in the image area and then click the Read button.</td>
</tr>
<tr>
<td>Pages</td>
<td>Provides a list of pages corresponding to the form template that the unrecognized page matches. Use the drop-down list to select the correct form template page for the image that is displayed in the image area and then click the Read button.</td>
</tr>
<tr>
<td>Respondent ID</td>
<td>Allows you to enter the correct respondent ID for the form. An exception flag will be present to show you why the region was not automatically recognized (e.g., BLANK or MULT flags). Once you enter the correct respondent ID, the software will either match it to an existing record (if one exists) or begin a new record. After entering the correct response, click the Read button.</td>
</tr>
<tr>
<td>Details</td>
<td>Lists the details pertinent to the page being read, including the Form ID, Number of Pages, and the Page ID (if applicable). If a region has not been automatically recognized, its details will not be listed until a form template/form page is selected.</td>
</tr>
<tr>
<td>Image</td>
<td>Provides an image representation of the form to assist in matching forms and pages to the appropriate form template.</td>
</tr>
</tbody>
</table>
### Option Description

- **Cancel**
  - Use this button to cancel processing of the current page. The Cancel button offers three options:
    - **Cancel**: Cancels the current image and stops the reading process. If you are reviewing images after form processing, the review process will end.
    - **Skip Image**: Skips the current image but continues with the unrecognized image review. This option is only available when using the Review Unrecognized Images utility after form processing.
    - **Discard Image**: Skips the current image and:
      1) if reviewing images created while scanning forms, deletes the corresponding image, or
      2) if reviewing images created by processing saved image files, does not place the image into the Unrecognized Image queue for later review (the actual image file will not be deleted).

- **Read**
  - After matching a form, page or respondent to its form template, click the Read button to continue processing forms.

When using multiple tracker regions, you will match one region at a time. For example, if a form template, page and respondent are all not recognized, you will first match the form template, then the utility will appear again so that you can match the form template page, and finally the utility will appear again so that you can match the respondent ID.

Continue to the next sections to understand how to use the Unrecognized Images Utility when both forms and pages are not recognized automatically.

#### 8.7.5.a Reviewing Unrecognized Auto Form ID Images

If the Data Center cannot automatically match a form to its form template, the Unrecognized Images Utility will appear. If you have chosen to review unrecognized images during form processing, the window will appear for each unrecognized form ID region. If you have chosen not to review during form processing, the images will be stored in a queue so that you can process them all at once.
To use the Unrecognized Images Utility for Auto Form ID regions

1. Follow the directions in Section 8.7 Form, Page and Respondent Detection to begin form processing using Auto Form ID.

2. When the Unrecognized Images Utility appears for an unrecognized image, the Form Templates list will be empty. Click the drop-down list to choose the correct form template for this image. Use the Image Viewer in the right portion of the screen to assist with understanding which form has been processed.

3. If desired, click the Cancel button to skip recognizing this image. This might be appropriate if the wrong form was scanned (or the wrong image was processed). If desired, use the Skip Image or Discard Image options.

4. Once you have matched a form to its form template, click the Read button to continue processing.

5. If using the Unrecognized Images Utility during form processing, forms will continue to be read until you end the read process. If reviewing unrecognized images after form processing, once all forms have been identified, the Unrecognized Images Utility will close automatically. If you are also using Page IDs, please see the next section.

8.7.5.b Reviewing Unrecognized Page ID Images

If the Data Center cannot automatically match a page to its form template, the Unrecognized Images Utility will appear. There are three possible scenarios when using Page IDs:

1. Page IDs alone: If using only Page IDs, you will need to process each respondent’s form completely before processing another respondent’s form. If the pages are out of order for a particular respondent, the Page IDs will be used to put the data in the correct place. If multiple respondents’ pages are processed together, the processing will stop and you will need to sort the pages by respondent before continuing.
2. Page IDs with Form IDs: If using Page IDs with Form IDs, the software will attempt to first recognize the form template for the overall form and then each page of the form. If both the form and page are not recognized, the Unrecognized Images Utility will first appear for the form and then again for the page. You will need to process each respondent’s form completely before processing another respondent’s form. If the pages are out of order for a particular respondent, the Page IDs will be used to put the data in the correct place. If multiple respondents’ pages are processed together, the processing will stop and you will need to sort the pages by respondent before continuing.

3. Page IDs with Form IDs and Respondent Tracker (Respondent IDs): If using Page IDs with Form IDs and Respondent Tracker regions, forms can be processed in virtually any order and still be recognized. The software will attempt to first recognize the form, then the page and then the Respondent Tracker. The Unrecognized Images Utility will assist you when any ID region cannot be automatically matched. When using Respondent Tracker with your Page IDs, you do not have to process each respondent’s form in its entirety before processing another form.

If you have chosen to review unrecognized images during form processing, the window will appear for each unrecognized page ID region. If you have chosen not to review during form processing, the images will be stored in a queue so that you can process them all at once.

**Note:** When using automatic page identification without the Respondent Tracker feature, you must process all pages of one complete form before moving on to the next form. If a page is not recognized, processing will stop regardless of whether you are using the option to review during the read operation. Please sort your pages so that an entire respondent’s form is read at one time.

### To use the Unrecognized Images Utility for Page ID regions

1. Follow the directions in Section 8.7.2 Auto Page ID to begin processing forms. If you are using the Auto Form ID feature, remember to mark the **Auto Form ID Mode** checkbox in the **Read Wizard**.

2. If you are using the Auto Form ID feature, when the **Unrecognized Images Utility** appears, the **Form Templates** list may be empty if the form was not recognized. If necessary, click the drop-down list to choose the correct form template for this image. Use the Image Viewer in the right portion of the screen to assist with understanding which form has been processed.
3 Once the correct form is identified (or if you are not using Auto Form ID), you may select the page being processed. Click the Pages drop-down list and then select the correct page for the form being processed. Use the Image Viewer in the right portion of the screen to assist with understanding which form has been processed.

4 If desired, click the Cancel button to skip recognizing this image. This might be appropriate if the wrong form was scanned (or the wrong image was processed). If desired, use the Skip Image or Discard Image options.

5 Once you have matched a page to its form template page, click the Read button to continue processing.

6 If using the Unrecognized Images Utility during form processing, forms will continue to be read until you end the read process. If reviewing unrecognized images after form processing, once all forms have been identified, the Unrecognized Images Utility will close automatically. If you are also using Respondent Tracker regions, please see the next section.

8.7.5.c Reviewing Unrecognized Respondent Tracker Images

If the Data Center cannot automatically read a Respondent Tracker region the image will be added to the Unrecognized Images queue. If you have chosen to review unrecognized images during form processing, the Unrecognized Images window will appear for each unrecognized Respondent Tracker region. If you have chosen not to review unrecognized images during form processing, the images will be stored in a queue so that you can process them all at once.

Note: If you are using the Review Exceptions feature to correct exception cases (either during form processing or before reviewing unrecognized images), it is possible to provide a valid respondent tracker value before the image is added to the Unrecognized Images queue. Depending on the types of exceptions you are reviewing, Review Exceptions may show you exceptions in your Respondent Tracker regions (e.g., BLANK, MULT, etc.). Once
corrected, the software will match data records based on the Respondent Tracker region. Exceptions that have not been corrected in Review Exceptions will cause the image to be added to the Unrecognized Images queue.

**To use the Unrecognized Images Utility for Respondent Tracker regions**

1. Follow the directions in Section 8.7.3 Respondent Tracker to begin form processing.

2. Optional: If you are using the Auto Form ID feature, when the **Unrecognized Images Utility** appears, the **Form Templates** list may be empty if the form was not recognized. If necessary, click the drop-down list to choose the correct form template for this image. Use the Image Viewer in the right portion of the screen to assist with understanding which form has been processed. NOTE: If the form is automatically recognized, you will not see this step.

3. Once the correct form is identified (or if you are not using Auto Form ID), you may select the page being processed, if it is not recognized. Click the **Pages** drop-down list and then select the correct page for the form being processed. Use the Image Viewer in the right portion of the screen to assist with understanding which form has been processed. NOTE: If the page is automatically recognized, you will not see this step.

4. When the **Unrecognized Images Utility** appears for an unrecognized **Respondent Tracker** region, the **Respondent ID** box will show an exception flag indicating why the software could not recognize the region (e.g., BLANK, MULT, etc.). Enter the correct response for this image in the Respondent ID box. Use the Image Viewer in the right portion of the screen to assist with understanding which form has been processed. Once the response is entered, the software will either match the record to an existing data record or begin a new record if the
Respondent Tracker is unique from the existing data.

5 If desired, click the **Cancel** button to skip recognizing this image. This might be appropriate if the wrong form was scanned (or the wrong image was processed). If desired, use the **Skip Image** or **Discard Image** options.

6 Once you have matched a form to its form template, click the **Read** button to continue processing.

7 If using the **Unrecognized Images Utility** during form processing, forms will continue to be read until you end the read process. If reviewing unrecognized images after form processing, once all forms have been identified, the **Unrecognized Images Utility** will close automatically.

### 8.8 Batch Processing

The Remark Office OMR Data Center includes a batch processing feature that allows you to process batch header forms along with your forms. Batch header forms can provide further information about the group of forms being processed that will make your data more meaningful. For example, if you are processing student tests, you can process a batch header form containing information such as instructor name, class name, class section, and so forth. The batch header form is processed once, at the beginning of each batch. Then the forms that correspond to that batch header form are processed subsequently. The data from the header form is pre-pended to (added to the beginning of) each data record. You can start processing a new batch and its corresponding forms at any time.

To create a batch, you create form templates for the batch header form(s) and the form you wish to process with that batch header form. You will then combine these form templates into a batch file. Both forms must have different Page IDs on them. Remark Office OMR will use the page IDs to understand when a batch header form is being processed along with the regular forms.

**To use batch header forms**

1 Create a form template for the form you wish to process as a batch header form. (See Chapter 7 for further information about creating form templates.)

2 Create a form template for the form you wish to process along with the batch header form.
3 In the **Remark Office OMR Data Center**, select the **File** menu and then click **Batch Wizard**. Alternatively, select the **Batch Wizard** link from the **Task Pane**.

4 In the **Batch Wizard (Step 1)** window, select the form template that will be used as the primary form template. This is the form template that corresponds to the form you wish to process with the batch header form. Click the **Add File(s)** button to add the form template to the **Primary Form Template** box. You may add more than one form template for processing if desired.

5 Click the **Next>>** button to continue.

6 In the **Batch Wizard (Step 2)** window, select the form template corresponding to your batch header form. Click the **Add File(s)** button to add it to the **Batch Header Form Templates** box. You may select multiple batch header form templates if desired.

7 Click the **Next>>** button to continue.

8 In the **Batch Wizard (Step 3)** window, enter a file name for the new combined batch file. The Data Center will combine the form template(s) and batch header form template(s) into one batch file. The new combined file will have a .obf file extension.

9 Click the **Create Batch** button to combine the templates and exit the **Batch Wizard**.
When the batch file opens in the template grid, a blue line will define the end of the batch header form template regions from the beginning of the primary form regions.

10 Process the first batch header form (or forms) by starting the Read Wizard and either scanning forms or reading image files. (See Section 8.3 The Remark Office OMR Read Wizard for detailed information about using the Read Wizard.)

11 Follow the batch header form with the forms that correspond with the group identified on the batch header form.

12 When the first group of forms has been processed, insert a new batch header form and follow it with the corresponding forms.

13 Continue processing forms in this fashion until you have processed all of your batches.

Tip: If you have already created a batch file and want to open it without using the Batch Wizard, select the File menu, click Open and then click Form Template. Change the Files of type drop-down list to Remark Batch Files to view available batch files.

8.9 Server Mode

Server Mode is a mode of operation in which Remark Office OMR runs in the background, processing pages or image files according to your instructions. Server Mode allows you to simultaneously use your computer for other projects while using Remark Office OMR to process forms. Server Mode can also be used to process completed forms that are received as image files over a network or by fax. You can use Server Mode in conjunction with Auto Form ID to process a variety of form types.

Server Mode works in two ways: continuously polling the scanner for pages and/or checking a user-specified directory on your computer for image files. The following table summarizes how each event works.
### Processing Forms

#### Action Event | Description
--- | ---
Read from scanner | If you have a scanner set up in Remark Office OMR, you may use this option. Your scanner must have an Automatic Document Feeder (ADF), and this feeder must be capable of telling Remark Office OMR when a page is placed in it (some scanners do not have this capability). The Data Center will poll your scanner for pages at a user-specified interval. If pages are found, they will be scanned automatically with the open template(s). The Data Center will store images of these scanned forms for later correction. Note that some computer performance degradation should be expected while a page is being scanned.

Read from image files | You may have the Data Center process image files from a folder that you specify on your computer. Supported graphics files will be read in the order of file creation date. This feature allows you to use scanning software that came with just about any input device to scan your pages. Then save these scanned images to a folder and the Data Center will automatically process them.

---

**To scan forms using Server Mode**

1. Open the correct form template. (See Section 8.2 Opening a Form Template.)
2. Select the Tools menu and then click Read Wizard, or click . Alternatively, you may select the Read Wizard link from the Task Pane.
3. In the Read Method window, select the radio button for Read from scanner.
4. In the Advanced Collection Options
area, mark the checkbox for **Server Mode**.

5. Click the **Next>>** button to continue.

6. If you would like to configure image naming conventions, click the **Next>>** button to continue. Otherwise click the **Read** button to begin scanning pages.

The **Scanned Image Naming Conventions** window allows you to specify options about the images that will automatically be stored each time you scan forms.

7. In the **Begin image names with** box, enter a file base name that the software can use to name the images stored for this form. The default base name is the form template name. However, you may use any name you like. We suggest using something that identifies to you that the images belong to a certain form. The images that are stored will all begin with this base name and then have the page number (if scanning a multi-page template), date and time appended to them to keep track of the various images. You may optionally choose a region from the template to use as the base name. The value that is collected from the form for the specified region will be used as the base name for the corresponding stored image (along with the page number, date and time). If you leave the **Begin image names with** option blank, your images will only have the page number (if applicable), date and time as the name of each image.

8. In the **Image target directory** box, click the **Browse...** button to select a location in which to store the images for this form. You may use the default directory for images or select a different directory.

9. Mark the checkbox for **Save images in a subfolder based on the form template’s name** to have the Data Center automatically create a folder in which to store these images. The folder name will be the name of the form template and the folder will be created in the directory you have selected in the **Image target directory** box.

**Tip:** We recommend using the **Save images in a subfolder based on the form template’s name** feature for easier organization of image files. Use of this feature will keep all images associated with this form template in one folder for easy access. The unique date and time portion of the image names will prevent images from being overwritten.

10. In the **Saved image type** box, select an image type to use for storing images. The choices are: PCX/DCX, PDF or TIF.
Note: PDF support is only enabled if you turn on this feature by selecting the Tools menu, clicking Preferences and then clicking the Recognition link in the Task Pane.

11 When saving to the PDF or TIF formats, you can choose the compression rate under Image compression level: Uncompressed, Group 3, Group 3 2d and Group 4. Group 4 will create the most compressed (smallest file size) image.

12 Mark the checkbox for Save multiple page form templates as multiple page image files if you are scanning with a multi-page template and would like all of the images for one complete form to be saved as one image file.

13 If you would like to configure Review Exceptions options, click the Next button to continue. Otherwise click the Read button to begin scanning pages.

Note: If using Review Exceptions during Server Mode, scanning will stop each time an exception is found until the exception is reviewed. We suggest using Review Exceptions after form processing so that Server Mode can run uninterrupted (see Section 8.4 Reviewing Exceptions for more information about Review Exceptions after form processing).

14 In the Review Exceptions window, specify whether to review exception cases during the reading process by marking the Activate Review Exceptions checkbox.

15 In the Review Exceptions Options area, mark the checkboxes for those cases that you wish to review during reading. The following options are available: Multiple responses, Blank responses, Recognition errors, Image regions, Database Lookup regions, Barcode regions and Required items.

16 Place the completed forms in the scanner.

17 Click the Read button to begin processing pages.

When you click the Read button in the Read Wizard window, Server Mode begins and you may continue working in other Windows applications. By default, Remark Office OMR will poll the scanner every five seconds for pages. If you want to change the number of seconds between polls, select the Tools Menu and then click Preferences. You will see the System poll interval during Server Mode setting under the General section.
To read image files using Server Mode

1. Open the correct form template. (See Section 8.2 Opening a Form Template.)

2. Select the Tools menu and then click Read Wizard, or click . Alternatively, you may select the Read Wizard link from the Task Pane.

3. In the Read Method window, select the radio button for Read from image files.

4. If desired, click the link for Advanced Image Recognition Properties. This link will allow you to set the following options: Invert image, Auto deskew images during recognition, Auto despeckle images during recognition.

   **Caution:** We do not suggest making changes to the Advanced Image Recognition Properties unless you encounter difficulties related to these settings.

5. In the Advanced Collection Options area, mark the checkbox for Server Mode.

6. Click the Next>> button to continue.

7. In the Image Source Directories area, use the Add Directories button to locate the folder on your computer that contains the images you wish to process. Any images found in the folders listed here will be processed, based on the filters you select in the next step.

8. In the Image Filters area, mark the checkboxes corresponding to the types of images in the Image source directory that you wish to process. Only images corresponding to these file types will be read; all others will be ignored.

   **Tip:** The last item in the Image Filters list is *, meaning all image types. Mark this checkbox if you want all images in the
source directory to be read. Note that only images of the software's supported file types will be processed.

9 If desired, you may use the **Custom Filters** box to further refine your file list. You can specify specific cases here by using wildcards. For example, if you wanted to process all images that start with "English 101" you could enter "English 101.*.*" as a custom filter. Only images that start with this text will be processed. Type the custom filter into the **Custom Filter** box and then click the **Add** button. The filter will be added to the **Image Filters** list and automatically selected. Unused custom filters will be removed from the list automatically the next time you run the **Read Wizard**.

10 If desired, mark the checkbox for **Delete images after they have been processed** to remove the images from the specified directories after the Data Center has processed them.

   **Note:** Marking this checkbox will permanently delete the images! However, if you do not delete the images and stop and start Server Mode, the same images will be processed again if they still reside in the specified folder(s).

11 If you would like to configure **Review Exceptions** options, click the **Next>>** button to continue. Otherwise click the **Read** button to begin processing image files.

   **Note:** If using **Review Exceptions** during Server Mode, scanning will stop each time an exception is found until the exception is reviewed. We suggest using Review Exceptions after form processing so that Server Mode can run uninterrupted (see Section 8.4 Reviewing Exceptions for more information about Review Exceptions after form processing).

12 In the **Review Exceptions** window, specify whether to review exception cases during the reading process by marking the **Activate Review Exceptions** checkbox.

13 In the **Review Exceptions Options** area, mark the checkboxes for those cases that you wish to review during reading. The following options are available: Multiple responses, Blank responses, Recognition errors, Image regions, Database Lookup regions, Barcode regions and Required items.

14 Click the **Read** button to begin processing image files.

When you click the Read button in the Read Wizard window, Server Mode begins and you may continue working in other Windows applications. By default, the Data Center will poll the specified image directory every five seconds for images. If you want to change the number of seconds between
polls, select the **Tools** Menu and then click **Preferences**. You will see the **System poll interval during Server Mode** setting under the **General** section.

**Important Note About Using Server Mode and Page IDs:** If you are using Page IDs with Server Mode, form processing will stop if a Page ID cannot be recognized. You will need to sort your forms/images so that each respondent’s form is scanned in its entirety before another form is processed. See Section 8.7.2 Auto Page IDs for further information about using Page IDs.

**To end Server Mode**

1. Select the **Tools** menu and then click **Stop Server Mode**, or click ![Stop Server Mode](image), to stop Server Mode and allow access to the complete Remark Office OMR feature set.

**8.10 Respondent Detection**

Remark Office OMR includes a facility for determining which respondents’ forms have been processed, as well as locating duplicate respondents. This feature, called Respondent Detection, is used in conjunction with Database Lookup. If a region is linked to an external database using Database Lookup, the software will provide a report of which respondents listed in the external database have been processed, not been processed or have been processed more than one time. For example, suppose you have a region on your form where the respondent fills in an ID number. You can link this ID number region to an external database that has all of the ID numbers of your expected group of respondents. Any time you use the Respondent Detection feature, you also have the option to return additional data from the external database if desired (this is not required to use Respondent Detection). When you process your forms, Remark Office OMR will confirm which ID numbers from the external database exist in the processed data. The software will then provide a report showing found ID numbers, missing ID numbers and duplicate ID numbers. If you are returning additional fields, this information will also be available in the report. You can save this report as a text file to use outside of Remark Office OMR.
To use Respondent Detection

1. Setup a form template that uses the Database Lookup feature. See Section 7.3.4 Database Lookup for complete details on using Database Lookup.

2. Process forms using the scanner or by reading from image file. See Section 8.3 The Remark Office OMR Read Wizard for information about using the Read Wizard to process forms.

3. Once the forms have been processed and the data cleaned, select the Tools menu and then click Respondent Detection. The Respondent Detection wizard will appear.

4. From the Regions available for detection drop-down list, select the form template region you wish to use for detection.

5. If the region is linked to a database containing additional fields, you may optionally select those fields from the Database Field List. Use the green arrow to move the desired fields into the Additional Fields box. Any fields moved to the Additional Fields box will also be used for detecting respondents.

6. Click the Next>> button to continue. The Detection Results window appears.

7. Use the Detection Results window to view your results. The main region on which you are basing the detection will be listed first. You will then see a Detected column which marks the values that were detected. The Duplicates column is next, which marks any duplicate values that are found. After the Duplicates column, you will see any additional return fields from the external database that you selected in the previous step (if you selected any).

8. If desired, use the Export button to save the results to an external file. You may click the Export button to export the entire set of results, or use the...
arrow on the **Export** button to select which portions of the results to export. The export options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Exports all results (region, detected, missing, duplicates and additional fields).</td>
</tr>
<tr>
<td>Export Missing</td>
<td>Only exports the missing respondents, those that exist in the external database but were not processed as part of the data file.</td>
</tr>
<tr>
<td>Export Detected</td>
<td>Exports only the detected respondents, those that both exist in the external database and were processed as part of the data file.</td>
</tr>
<tr>
<td>Export Duplicates</td>
<td>Exports only the duplicate respondents, those that appear more than once in the data file. The software will only detect duplicate entries that have also been verified as existing in the linked database.</td>
</tr>
<tr>
<td>Print Results</td>
<td>Prints all results to the default printer on your computer.</td>
</tr>
</tbody>
</table>

9 Click the **Close** button to return to the Remark Office OMR Data Center.
Working with Your Data

Chapter 9

9.1 Overview
This chapter explains the basics of data manipulation and using the template grid in the Remark Office OMR Data Center, and includes the following:

- Understanding the template grid
- Editing the template grid
- Printing grid data
- Saving grid data
- Opening grid data

The Remark Office OMR software requires a form template file for each type of form that you want to process. For each form template created, there is a corresponding template grid. The Remark Office OMR Data Center uses a template grid to store data recognized from forms. A form may contain up to 150 pages. The data read from one form are considered a single record and display in one grid row. Each column in the grid represents one variable or question on the form, as defined in the form template.

9.2 Understanding the Template Grid
The Remark Office OMR template grid window employs a spreadsheet style interface to display recognized data. Each grid column corresponds to an item or question on the form, as it was defined in the form template. The grid employs two cell types to store data: text and list. The cell type depends on the kind of region being used. Barcode regions, Image regions that do not contain Database Lookup information and OMR regions set to the Grid, Add or Binary Data Type use text cells. Text cells are used to data enter information. All other
OMR regions use list cells. List cells contain a drop-down list of possible answer items (labels) as they are defined in the form template. See Section 9.3.2 Changing Cell Contents later in this chapter for information on how to edit individual cells.

If an individual region contains more than one question, by default the corresponding column headers will also contain question numbers. For example, Eval2 would correspond to the second item of a region titled Eval. If you entered individual Question Names in the OMR region properties of the form template, these Question Names will appear instead (See Section 7.3.2.b Question Names for more detailed information about Question Names).

9.3 Editing the Template Grid

The template grid window behaves like a spreadsheet. You can cut, copy and paste selections to and from the grid. Additionally, you can change the contents of individual grid cells by clicking in a cell. This section explains the basics of manipulating data within the grid and includes the following:

- Making selections
- Changing cell contents
- Cutting, copying, pasting and deleting
- Resizing, inserting and deleting rows
- Using find and replace
- Sorting regions

9.3.1 Making Grid Selections

The following table lists the different methods for making selections in the grid:

<table>
<thead>
<tr>
<th>Selection Area</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Cell</td>
<td>Click in it. Use the mouse, tab or arrow keys to move from cell to cell. Double clicking within a cell puts you in edit mode.</td>
</tr>
<tr>
<td>Multiple Cells</td>
<td>Click the upper, left-hand corner of the desired selection, drag the mouse to the lower, right-hand corner and release.</td>
</tr>
</tbody>
</table>
### Selection Area Method

<table>
<thead>
<tr>
<th>Selection Area</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Column</td>
<td>Click the column header.</td>
</tr>
<tr>
<td>Multiple Columns</td>
<td>Click and drag a range of column headers or click a beginning column header, press and hold the <strong>Shift</strong> key, and then click an ending column header.</td>
</tr>
<tr>
<td>Single Row</td>
<td>Click the row header.</td>
</tr>
<tr>
<td>Multiple Rows</td>
<td>Click and drag a range of row headers or click a beginning row header, press and hold the <strong>Shift</strong> key, and then click an ending row header.</td>
</tr>
<tr>
<td>Entire Grid</td>
<td>Select the <strong>Edit</strong> menu and then click <strong>Select All</strong>, or click the upper, left-most grid header cell.</td>
</tr>
</tbody>
</table>

### 9.3.2 Changing Cell Contents

The template grid allows in-cell editing by clicking within a particular cell. The grid employs two cell types to store data: text and list. The cell type depends on the kind of region being used. Each cell changes to either a text box or list box depending on its region type. Grid, Add and Binary OMR regions, barcode regions and Image regions without the use of Database Lookup are considered text regions. You will not have a drop-down box for these region types. All other types of OMR regions are considered list regions and will have a drop-down box from which you can choose correct responses, as they were defined in the form template.

To change the contents of a text cell

1. Select the cell by clicking within its borders.
2. Type the desired cell contents into the cell and press **Enter**.

To change the contents of a list cell

1. Select the cell by clicking within its borders.
2. Click the down arrow on the cell’s list box.
3. Click the correct response.
Note: An asterisk appears next to selected responses.

4 If more than one response is permitted, repeat steps 2 and 3 to select more than one response.

Editing a cell removes any exception case flags that may have been present.

9.3.3 Cutting, Copying, Pasting and Deleting

The Remark Office OMR template grid supports all normal Windows clipboard functions: cut, copy and paste. In addition, it supports the Paste Special command, which allows you to copy the contents of one cell and then paste them into multiple cells.

Tip: This section refers to making grid selections in order to select grid cells. See Section 9.3.1 Making Grid Selections for detailed information about this topic.

To cut data from the grid

1 Select an area to cut. Select the Edit menu and then click Cut, click [ ] or press Ctrl + X.

The selected data are cut from the grid and placed on the Windows clipboard.

To copy grid data

1 Select an area to copy.

2 Select the Edit menu and then click Copy, click [ ] or press Ctrl + C.

The selected data are copied to the Windows clipboard.

To paste data from the clipboard to the grid

1 Select the area to which you want to paste.

2 Select the Edit menu and then click Paste, click [ ] or press Ctrl + V.

The data on the Windows clipboard are pasted into the selected grid cell(s).
Working with Your Data

**Note:** You do not need to select the same amount of space in the grid as the amount of space you copied to the clipboard.

To use Paste Special
1. Select a cell containing the data you wish to copy.
2. Select the **Edit** menu and then click **Copy**, or click ![Clipboard].
3. Select the cells in which you want to paste the data.
4. Select the **Edit** menu and then click **Paste Special**.

The data on the Windows clipboard are pasted into the selected grid cells.

To delete grid data
1. Select the area that you want to delete.
2. Select the **Edit** menu and then click **Delete**, right click in a cell and select **Delete**, click the toolbar button for **Delete**, or press the **Delete** key.

You may also delete an entire grid row by clicking the row header or in a cell in the row and then right clicking and selecting **Delete Row** or by selecting the **Edit** menu and then clicking **Delete Row**.

9.3.4 Resizing, Inserting and Deleting Rows
You can change the number of rows contained in each template grid by adding rows to the end of the grid, inserting rows into the grid or deleting rows from the grid.

**Tip:** This section refers to making grid selections in order to select grid cells. See Section 9.3.1 Making Grid Selections for detailed information about this topic.

To insert row(s) into the grid
1. Select the desired insertion point by clicking a grid cell.
2. Select the **Edit** menu and then click **Insert Row** to insert a row. Or right click within the cell and choose **Insert Row**.
Note: You may also select multiple rows to insert the same number of rows above the selection (e.g., select two complete rows to insert two rows above the highlighted rows).

3 Click the OK button.

The row will be inserted above the row you initially selected.

To delete rows from the grid
1 Select the rows to delete.
2 Select the Edit menu and then click Delete Row. Or, right click the mouse and then select Delete Row.

Tip: You may delete multiple rows by selecting more than one grid row. Use the row headers to select the rows.

9.3.5 Using Find and Replace

The Remark Office OMR Data Center provides find and replace commands for locating and replacing text. You can search for each occurrence of characters, including uppercase and lowercase letters, whole words and parts of words.

By default the Data Center will search the entire data grid when performing a find and replace operation. However, you can search a specific region by highlighting the area you would like to search prior to using Find and Replace. (See Section 9.3.1 See Making Grid Selections.)

To find text
1 Select the Edit menu and then click Find, or click .
2 If searching for text, enter the search text in the box titled Find what.
3 Select the other options you want to use to control the search.
Working with Your Data

<table>
<thead>
<tr>
<th>Search Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case sensitive</td>
<td>Mark this checkbox to make the search case sensitive.</td>
</tr>
<tr>
<td>Include partial matches</td>
<td>Mark this checkbox to search for part of the text (does not require the entire contents of the cell to match what you have entered in the Find what box).</td>
</tr>
<tr>
<td>Search for values greater than or equal to specified value</td>
<td>If searching for numeric data, mark this checkbox to search for numeric values that are greater than or equal to the value you have typed in the Find what box.</td>
</tr>
<tr>
<td>Search selected block only</td>
<td>Mark this checkbox to search in the selected cell(s) only.</td>
</tr>
</tbody>
</table>

4 Click the Find Next button.

If Remark Office OMR locates a match, the grid scrolls to display the cell where the match is found.

5 Make any necessary changes to the grid.

6 Click Find Next to continue searching.

7 When you have completed searching the data, click the Cancel button.

To find and replace text

1 Select the Edit menu and then click Replace.

2 Enter the search text in the box titled Find what.

3 Select the other options you want to use to control the search.
4 To replace items located in the search, enter the replacement text in the box titled **Replace with**.

5 Choose one of the following search commands by clicking the appropriate button:

<table>
<thead>
<tr>
<th>Search Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Next</td>
<td>Locate the next item meeting search criteria.</td>
</tr>
<tr>
<td>Replace</td>
<td>Locate and automatically replace the next item meeting search criteria.</td>
</tr>
<tr>
<td>Replace All</td>
<td>Locate and automatically replace all items meeting search criteria.</td>
</tr>
</tbody>
</table>

6 When you have completed searching the data, click the **Cancel** button.
9.4 Sorting Grid Columns

Columns in the template grid can be sorted according to the values in a specific region. Data can be sorted in ascending or descending order. For example, you can sort your data by student ID number. There are two ways to sort data: right clicking a column header or using the menus.

To sort data by right clicking the mouse
1. Select the column by which you want to sort the data. (See Section 9.3.1 Making Grid Selections.)
2. Right click the column header, click Sort and then click Ascending or Descending.

The entire data set will be sorted according to your selection.

To sort data using the menus
1. Select the Edit menu and then click Sort.
2. In the Primary sort key box, use the drop-down list to choose a region on which to base the sort operation.
3. Mark the checkbox for Descending if you want the data to be sorted in descending order. Leave this checkbox blank to sort the data in ascending order.
4. If you want to sort the data by more than one criterion, select the appropriate regions on which to sort in the Secondary sort key and Third sort key boxes.
5. When finished selecting regions, click the Sort button.

The entire data set will be sorted according to your selection(s).
9.5 Saving Grid Data

You can save the data in the template grid to dozens of different file formats. The Remark file format was specifically designed to optimize the data storage process in the Remark Office OMR software.

**Tip:** When working with data in Remark Office OMR, use the Remark file format (RMK). This is the only format that preserves the link between the data and the corresponding images, as well as exception flags. Export data to other formats after you have collected and cleaned all of your data.

When saving data, you have the option of using Save Data or Save Data As. The Save Data option can be used to save a data set for the first time or to overwrite the current data set. The Save Data As option allows you to save the current data set with new parameters (e.g., new file name, different directory, different file type, etc.)

The following table lists the different save file formats, their extensions and a brief description:

<table>
<thead>
<tr>
<th>File Format</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remark</td>
<td>RMK</td>
<td>Remark Office OMR format; saves grid flag colors and image links</td>
</tr>
<tr>
<td>Remark Office Archive</td>
<td>ROA</td>
<td>Remark Office OMR Archive format; combines template, data and stored image files into one file; saves grid flag colors and image links; existing files may only be overwritten (there are no append options)</td>
</tr>
<tr>
<td>Access</td>
<td>MDB</td>
<td>Microsoft Access 2000-2003 format</td>
</tr>
<tr>
<td>Access 95-97</td>
<td>MDB</td>
<td>Microsoft Access 95-97 format</td>
</tr>
<tr>
<td>Access 2.0</td>
<td>MDB</td>
<td>Microsoft Access 2.0 format</td>
</tr>
<tr>
<td>Access 1.0</td>
<td>MDB</td>
<td>Microsoft Access 1.0 format</td>
</tr>
<tr>
<td>Excel 97-2003</td>
<td>XLS</td>
<td>Microsoft Excel 97-2003 format</td>
</tr>
<tr>
<td>Excel 95</td>
<td>XLS</td>
<td>Microsoft Excel 95 format</td>
</tr>
<tr>
<td>Excel 4.0</td>
<td>XLS</td>
<td>Microsoft Excel 4.0 format</td>
</tr>
<tr>
<td>Excel 3.0</td>
<td>XLS</td>
<td>Microsoft Excel 3.0 format</td>
</tr>
</tbody>
</table>
**File Format** | **Extension** | **Description**  
---|---|---  
Questionmark | QSF | Perception Questionmark format (save only)  
SPSS | SAV | SPSS format  
Survey Pro | SRV | Survey Pro standard format (Apian Software)  
Survey Pro STL | STL | Survey Pro STL format (Apian Software)  
ASCII [commas] | ASC | Comma delimited ASCII  
ASCII [tabs] | ASC | Tab delimited ASCII  
Spreadsheet [commas] | TXT | Comma delimited ASCII with quotes around non-numeric data  
Spreadsheet [tabs] | TXT | Tab delimited ASCII with quotes around non-numeric data  
Survey System | DAT | The Survey System format (Creative Research Systems)  
dBase 5.0 | DBF | dBase 5.0 format  
dBase 4.0 | DBF | dBase 4.0 format  
dBase III | DBF | dBase III format  
Paradox 5.X | DB | Paradox 5.X format; existing files may only be overwritten (there are no append options)  
Paradox 4.X | DB | Paradox 4.X format; existing files may only be overwritten (there are no append options)  
Paradox 3.X | DB | Paradox 3.X format; existing files may only be overwritten (there are no append options)  
Lotus WK3 | WK3 | Lotus Works 3 format; existing files may only be overwritten (there are no append options)  
Lotus WK1 | WK1 | Lotus Works 1 format  
Lotus 1-2-3 | WKS | Lotus 1-2-3 format  
LXR Test | MRG | LXR Test format
### File Format | Extension | Description
--- | --- | ---
Report | RPT | Fixed format ASCII, cell text padded or truncated to specified record length
Data Interchange Format | DIF | Standard format using file header and data section
CCI Assessment | DAT | CCI Assessment format; existing files may only be overwritten (there are no append options)
XML | XML | Extensible Markup Language format
HTML | HTM | Hypertext Markup Language
ODBC | *.* | Open Database Connectivity
Custom | ASC, TXT | Custom Text format

**To save grid data**

Before saving data to another data format, we suggest saving a copy of the data to the Remark (RMK) format to preserve exception flags and links to stored images. Once your project is complete, you may delete or archive the RMK file, or save all of your files to the Remark Office Archive (ROA) format.

When exporting to a specific format (e.g., Access, Excel, etc.) make certain your data meets the format's specific requirements (see Appendix B for more information).

1. Select the **File** menu and then click **Save**, or click ![Save Data](image), if saving the data set for the first time or to overwrite the data. Click **Save As** to save the data with new parameters.

   **Note:** Clicking the toolbar button for **Save Data**, ![Save Data](image), will overwrite the current data set.

If saving for the first time or using **Save As**, the **Save Data** window opens, allowing you to choose a file name, a file type, the directory in which you would like the file saved and **Advanced** saving options.
2 Select the desired directory location using the Look in drop down box.

3 Enter a name in the box titled File name.

4 Select the desired output format in the box titled Save as type.

5 If saving to a database type that supports internal table names, enter a table name in the box titled Table name.

   **Note:** Each database format has different table name limitations. Refer to your database documentation for information on table name limitations.

6 Optional: If exporting to the Report file format, you can specify the length of each record by entering the number of characters in the box titled Record length.

7 When exporting, you can save the column headers and/or image names for certain formats by selecting the Save headers and/or Save image names checkboxes. The Save headers and Save image names checkbox will only display when appropriate.

8 Click the OK button to save the file.

### 9.5.1 Advanced Saving Options

When saving data to database formats, you have the option of setting advanced parameters. The advanced window shows you each question and pertinent information about the region. You can then choose options about the region that you want included in your database. This feature can be useful if you are saving to a database format that has specific requirements. You can temporarily override the form template settings by using the advanced parameters.

   **Note:** Setting parameters in the advanced saving window does not make any changes to the form template.
The following advanced features are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include</td>
<td>Mark this checkbox to include the region (question) in the database.</td>
</tr>
<tr>
<td>Name</td>
<td>Use this column to enter a new field name to be used in the exported database, if desired. Changing the field name in this window will not affect the region’s name in the form template.</td>
</tr>
<tr>
<td>Data Type</td>
<td>Use this column to change the data type for this question.</td>
</tr>
<tr>
<td>Size</td>
<td>Use this column to specify a field size for the data for this question. Do not specify a size that is smaller than what is in your data.</td>
</tr>
</tbody>
</table>

**To use advanced saving options**

1. Select the **File** menu and then click **Save Data As**.

   The **Save Data** window opens, allowing you to choose a file name, a file type, the directory in which you would like the file saved and advanced saving options.

2. Select the desired directory location using the **Look in** drop down box.

3. Enter a name in the box titled **File name**.

4. Select the desired output format in the box titled **Save as type**.

5. If saving to a database type that supports internal table names, enter a table name in the box titled **Table name**.

6. Click the **Advanced** button.

7. OPTIONAL: If you have previously saved a definition file for this data set, click the Load button to locate the appropriate INI file containing your settings. Otherwise, continue to Step 8 to build a new data file.
8 Make any desired changes in the **Include, Names, Data Type** or **Size** columns.

9 Optional: If desired, click the **Save** button to save the settings to a configuration file (ini file). You can then open this configuration file for future save operations with this same form template. This feature can save time when saving future data sets.

10 Click the **OK** button to save the changes.

11 In the **Save Data** window, click the **OK** button to save the data.

**9.5.2 Remark Office Archive Format**

The Remark Office Archive format saves the form template, data file and stored images in one zipped file. By having all items stored together, the information becomes portable. For example, this feature is useful if you own and use multiple copies of the software. One person can scan forms on one system and then save the data to the Remark Office Archive Format. Another person can then open that Remark Office Archive file, which will provide the form template, data file and stored images, and run Review Exceptions to clean the data. This process makes sharing the workload easier.

**Caution!** Please read the license agreement in the front of this user’s guide carefully before installing Remark Office OMR on multiple computers. Licensing is computer-based, meaning that one copy of the software may only be installed on one computer.

**To save data to the Remark Office Archive format**

1 Select the **File** menu and then click **Save As**.

   The **Save Data** window opens, allowing you to choose a file name, a file type and the directory in which you would like the file saved.

2 Select the desired directory location using the **Look in** drop down box.

3 Enter a name in the box titled **File name**.
4 Select the **Remark Office Archive (*.ROA)** format in the box titled **Save as type**.

5 If desired, mark the checkbox for **Delete original images after archiving** to delete the original images that are stored during form scanning. These images are included in the archive format in case you need to access them at a later point.

6 Click the **OK** button to save the file.

**To open a saved Remark Office Archive file**

1 In the **Data Center**, select the **File** menu, select **Open** and then select **Data**. Alternatively, you may select the **File** menu, select **Open** and then select **Form Template** and change the **Files of type** to **Remark Office Archive**.

2 Set the **Files of type** to **All Data Files** or **Remark Office Archive**.

3 Highlight the ROA file you wish to open and then click the **OK** button.

4 A **Browse for Folder** window will appear. Use this window to select a location in which to unzip the files associated with this form template (form template, data and stored images). We suggest putting them in a folder based on the form template name so that you can easily associate the files with the right form.

5 Click the **OK** button once you have selected a folder.

The files will automatically be unzipped to the location specified. The template and data will load normally into the template grid. All associated image files will then be available so that you can click in a cell and view the corresponding image or use Review Exceptions to clean the data.
9.5.3 Custom Format

The Custom format allows you to create a customized text file. This format is useful for exporting data into a database that has very specific requirements. The format can also be used to break apart rows of data into multiple rows. For example, if you are processing an attendance sheet where each student should be one data record, you can use the Custom format to separate the data into separate records.

Note: When saving to an existing custom data file, regions are not matched by region name; instead they are matched by position in the data file. Ensure that the data you are saving matches the existing custom wizard data file before appending new records.

The following table summarizes the screens and options that are found in the Custom Wizard and the corresponding descriptions of each option:

<table>
<thead>
<tr>
<th>Custom Wizard Screen</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1: Configuration File</td>
<td>Configuration File</td>
<td>Use the <strong>Browse...</strong> button to locate a previously saved configuration file that you created when using the Custom Wizard.</td>
</tr>
<tr>
<td>Step 2: File Type and Start Row</td>
<td>File Type</td>
<td>Delimited: Fields are separated by a delimiter, such as a comma or tab</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fixed Width: Fields are aligned at fixed character spaces</td>
</tr>
<tr>
<td></td>
<td>Automatically format questions that allow multiple responses</td>
<td>Mark this checkbox to automatically set formatting for questions that allow more than one answer choice (e.g., (1,5,12) becomes 1 5 12).</td>
</tr>
<tr>
<td>Custom Wizard Screen</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Start export at row</td>
<td>Enter the row number that you want to use as the first record in the exported data file. All rows from this point forward will be included in the data file. Enter 0 to include region names as the first record.</td>
</tr>
<tr>
<td>Step 3: Column Delimiter and Text Qualifier (Delimited Fields Only)</td>
<td>Column Delimiter</td>
<td>Select the item to be used to separate the columns in the data file: Comma, Tab, Semi-colon, Space, Other.</td>
</tr>
<tr>
<td>Text Qualifier</td>
<td></td>
<td>Select an item to be used to qualify text. Textual responses will be encapsulated within this setting. Options include: None, double quote (&quot;), single quote (').</td>
</tr>
<tr>
<td>Field Size</td>
<td></td>
<td>The maximum number of characters allowed in the field.</td>
</tr>
<tr>
<td>Start Position</td>
<td></td>
<td>The position, in characters, where the field will begin. For example, if your field sizes are 25, the first field will start at position 1 and the second field will start at position 26 (25 characters later).</td>
</tr>
<tr>
<td>Pad With</td>
<td></td>
<td>Enter the character to use to pad the field (typically a space character).</td>
</tr>
<tr>
<td>Pad On</td>
<td></td>
<td>Select whether to pad the field on the left or right of the text that resides in the field.</td>
</tr>
</tbody>
</table>
Worki
Working with Your Data

<table>
<thead>
<tr>
<th>Custom Wizard Screen</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 4: Record Delimiter</td>
<td>Record Delimiter</td>
<td>Sets the delimiter to be used to separate records: Carriage Return/Line Feed, Carriage Return, Line Feed, Other.</td>
</tr>
<tr>
<td>Step 5: Field Exclusion and Record Breaks</td>
<td>Exclude</td>
<td>Mark this checkbox to exclude the region listed from the data file.</td>
</tr>
<tr>
<td></td>
<td>Break After</td>
<td>Mark this checkbox to start a new record in the data file after this field.</td>
</tr>
<tr>
<td></td>
<td>Every Record</td>
<td>Mark this checkbox to include the field in every record that of the data file (e.g., repeat the field for each record).</td>
</tr>
</tbody>
</table>

To use the Custom format

1 Select the **File** menu and then click **Save As**.

The **Save Data** window opens, allowing you to choose a file name, a file type, the directory in which you would like the file saved and advanced saving options.

2 Select the desired directory location using the **Look in** drop down box.

3 Enter a name in the box titled **File name**.

4 Select the **Custom (*.ASC, *.TXT)** format in the box titled **Save as type**.

5 Click the **OK** button.

6 If you have used the Custom Wizard format previously and have a saved configuration file that applies to this data set, click the **Browse...** button to locate the configuration file. Otherwise, click the **Next>>** button to begin creating a new configuration file.

7 Select the options you wish to use to customize your data set. Each option is described in the table above. Use the **Next>>** button to navigate from screen to screen.
8 When finished, click the OK button.

9 When the Save Text Export Configuration window appears, click the Yes button to save your settings to a file that you can use later when saving data. If you do not wish to save this configuration file, click the No button. If you are not saving the configuration file, the data file will be saved when you click the No button. Continue with the next steps if you are saving the configuration file.

10 Optional: If saving the configuration file, in the Save Text Export Configuration As box, select a location in which to save the configuration file in the Save in box.

11 Optional: Enter a name for the file in the File name box.

12 Optional: Leave the Save as type box set to Text Export Configuration Files (*.tec).

13 Optional: Click the Save button to save the file and create the data file.

9.6 Printing Grid Data

The Remark Office OMR Data Center allows you to print grid data on any Windows-supported printer.

To print the grid data

1 Select the File menu and then click Print, or click , to display the Print Options window.

2 Click the Printer down arrow and then click the desired printer.

3 In the Print Display section, mark the checkboxes corresponding to the items you wish to print: Column headers, Row headers, Grid lines, Border.
4 In the **Margins** section, choose the print margins in inches. The default settings are 1 inch margins on the top and bottom, and ½ inch margins on the left and right.

5 In the **Header** and **Footer** area, optionally enter text to be displayed in the header and footer of the page.

6 In the **Print Range** area, select page range to print: **Active Sheet** (currently selected form template) or **All Sheets** (all open form templates).

7 In the **Print Color** area, select whether to print the page in **Color** or **Black & white** (only applies if the selected printer is color-enabled).

8 If desired, click the **Properties** button to further configure your printer’s options.

9 Click the **Print** button to print the grid.

### 9.7 Opening Grid Data

The Remark Office OMR Data Center can open data saved in dozens of different file formats. Principia Products specifically designed the Remark file format to optimize the data storage process in the Remark Office OMR software. The software was designed to work with data that is collected using a form template. Therefore, you must first open a form template and then open the corresponding data file.
The following table lists the different file formats the Data Center can open, their extensions and a brief description:

<table>
<thead>
<tr>
<th>File Format</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remark</td>
<td>RMK</td>
<td>Remark Office OMR format; saves grid flag colors and image links</td>
</tr>
<tr>
<td>Remark Office</td>
<td>ROA</td>
<td>Remark Office OMR Archive format; combines template, data and stored image files into one file, Saves grid flag colors and image links</td>
</tr>
<tr>
<td>Archive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Survey</td>
<td>RWD</td>
<td>Remark Web Survey format</td>
</tr>
<tr>
<td>Access</td>
<td>MDB</td>
<td>Microsoft Access 2000-2003 format</td>
</tr>
<tr>
<td>Access 95-97</td>
<td>MDB</td>
<td>Microsoft Access 95-97 format</td>
</tr>
<tr>
<td>Access 2.0</td>
<td>MDB</td>
<td>Microsoft Access 2.0 format</td>
</tr>
<tr>
<td>Access 1.0</td>
<td>MDB</td>
<td>Microsoft Access 1.0 format</td>
</tr>
<tr>
<td>Excel 97-2003</td>
<td>XLS</td>
<td>Microsoft Excel 97-2003 format</td>
</tr>
<tr>
<td>Excel 95</td>
<td>XLS</td>
<td>Microsoft Excel 95 format</td>
</tr>
<tr>
<td>Excel 4.0</td>
<td>XLS</td>
<td>Microsoft Excel 4.0 format</td>
</tr>
<tr>
<td>Excel 3.0</td>
<td>XLS</td>
<td>Microsoft Excel 3.0 format</td>
</tr>
<tr>
<td>SPSS</td>
<td>SAV</td>
<td>SPSS format</td>
</tr>
<tr>
<td>Survey Pro</td>
<td>SRV</td>
<td>Survey Pro standard format (Apian Software)</td>
</tr>
<tr>
<td>ASCII [commas]</td>
<td>ASC</td>
<td>Comma delimited ASCII</td>
</tr>
<tr>
<td>ASCII [tabs]</td>
<td>ASC</td>
<td>Tab delimited ASCII</td>
</tr>
<tr>
<td>Spreadsheet [commas]</td>
<td>TXT</td>
<td>Comma delimited ASCII with quotes around non-numeric data</td>
</tr>
<tr>
<td>Spreadsheet [tabs]</td>
<td>TXT</td>
<td>Tab delimited ASCII with quotes around non-numeric data</td>
</tr>
<tr>
<td>dBase 5.0</td>
<td>DBF</td>
<td>dBase 5.0 format</td>
</tr>
<tr>
<td>dBase IV</td>
<td>DBF</td>
<td>dBase IV format</td>
</tr>
<tr>
<td>dBase III</td>
<td>DBF</td>
<td>dBase III format</td>
</tr>
</tbody>
</table>
### File Format

<table>
<thead>
<tr>
<th>File Format</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paradox 5.X</td>
<td>DB</td>
<td>Paradox 5.X format</td>
</tr>
<tr>
<td>Paradox 4.X</td>
<td>DB</td>
<td>Paradox 4.X format</td>
</tr>
<tr>
<td>Paradox 3.X</td>
<td>DB</td>
<td>Paradox 3.X format</td>
</tr>
<tr>
<td>Lotus WK4</td>
<td>WK4</td>
<td>Lotus Works 4 format (open only)</td>
</tr>
<tr>
<td>Lotus WK3</td>
<td>WK3</td>
<td>Lotus Works 3 format</td>
</tr>
<tr>
<td>Lotus WK1</td>
<td>WK1</td>
<td>Lotus Works 1 format</td>
</tr>
<tr>
<td>Lotus 1-2-3</td>
<td>WKS</td>
<td>Lotus 1-2-3 format</td>
</tr>
<tr>
<td>LXR Test</td>
<td>MRG</td>
<td>LXR Test format</td>
</tr>
<tr>
<td>Report</td>
<td>RPT</td>
<td>Fixed format ASCII, cell text padded or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truncated to specified record length</td>
</tr>
<tr>
<td>Data Interchange</td>
<td>DIF</td>
<td>Standard format using file header and data</td>
</tr>
<tr>
<td>Format</td>
<td></td>
<td>section</td>
</tr>
<tr>
<td>CCI Assessment</td>
<td>DAT</td>
<td>CCI Assessment format</td>
</tr>
<tr>
<td>XML</td>
<td>XML</td>
<td>Extensible Markup Language format</td>
</tr>
<tr>
<td>HTML</td>
<td>HTM</td>
<td>Hypertext Markup Language</td>
</tr>
<tr>
<td>ODBC</td>
<td><em>.</em></td>
<td>Open Database Connectivity</td>
</tr>
<tr>
<td>Custom</td>
<td>ASC, TXT</td>
<td>Custom Text format</td>
</tr>
</tbody>
</table>

**Tip:** When working with data in Remark Office OMR, use the Remark file format (RMK). This format will save the link to the image files and exception case flags. Only save data to other formats when exporting.

**To open grid data**

1. Open the correct form template. (See Section 8.2 Opening a Form Template.)

2. Select the **File** menu and then click **Open Data**, or click ☐️, to display the **Open Data File** window. Alternatively, use the **Open data file** link from the Task Pane.
3. Select a file from the list. Use the **Look in** box to locate saved data files.

**Note:** The data contained in the file must correspond to the currently active form template or an error may occur.

4. Click the **OK** button to open the data file.

**Caution:** When opening a database file type, the Data Center attempts to match grid column headers to the database’s field names. If any column headers can’t be matched, an error occurs. Grid column headers do not need to appear in the same order as the database fields.
Remark Quick Stats

Chapter 10

10.1. Overview

Remark Quick Stats is an analysis package that ships with the Remark Office OMR software. Remark Quick Stats allows you to tabulate surveys and grade tests right in the software. An overview of Remark Quick Stats is provided here; a complete user’s guide is installed in PDF format with the software and can be found by clicking Start|Programs|Remark Office OMR 6|Documentation|Remark Quick Stats User’s Guide.

The software ships with two versions of Remark Quick Stats. The legacy version is the previous version of the software that was part of Remark Office OMR 5 (and Remark Web Survey 3). The new version of Remark Quick Stats has a completely updated interface, new reports and new options. We encourage you to use the new version of Remark Quick Stats but if there is a particular report you used in the previous version, you may toggle between the two versions. To use the legacy analysis tool, select the Tools menu and then click Preferences. On the General tab, mark the checkbox for Use Legacy Analysis as your Default Analysis Tool.

Depending on the version and report selected, Remark Quick Stats can include the following statistics:

Survey Statistics include:

- For each item Remark Quick Stats calculates: Mean, Variance, Standard Deviation, Standard Error, Min, Max, Range, Median, Skewness, Kurtosis, T-Value, Percentiles, Confidence Intervals
- For each answer choice Remark Quick Stats calculates: Frequencies, Percentages, Valid Percent
- A Response Report displays all of the handwritten comments for any Image region on one, easy to read, report
- Crosstabs
- A Group Report displaying means for question groupings (new version only)
Test Statistics include:

- A Grade Wizard steps you through the process of setting up an answer key, grade scale, questions points, learning objectives, benchmark scores and other grading information for your test
- For each item Remark Quick Stats calculates: Mean, Variance, Standard Deviation, Standard Error, Min, Max, Range, Median, Skewness, Kurtosis, T-Value, Percentiles, Confidence Intervals, P-values, Point Biserial Correlation
- For each answer choice Remark Quick Stats calculates: Frequencies, Percentages, Point Biserial
- For each student Remark Quick Stats calculates: Total score, Raw score, Grade, Dev. IQ, Number correct, incorrect, unanswered
- For the test Remark Office OMR calculates: Number of graded tests and items, Max, Min, Median, Range, Percentile scores, Mean, Variance, Standard Deviation, Confidence Intervals (1, 5, 95, 99%), KR 20, KR21, Coefficient (Cronbach) Alpha
- A Grade Report displays each student’s results on the test and optionally includes an image of the test
- A Group Report displaying grades for specific subsets of your data (new version only)

A variety of graph types are also included (all of which can be copied and printed):

- Pie
- Bar
- Horizontal Bar
- Line
- Area
- Point
- Polar
- Fast Line
- Box and Whisker (legacy only)
- Error (legacy only)
- Volume (legacy only)
- Bezier (legacy only)
- Radar (legacy only)
10.2 Tabulating Surveys

Surveys can be tabulated in two ways: Easy Survey and the Survey Wizard. Easy Survey uses the parameters specified in the form template, such as which questions to tabulate, and then launches Remark Quick Stats. The Survey Wizard allows you to customize the tabulation process by choosing which questions to include, assigning numeric values to answer items, assigning benchmarks, adding question text, specifying question groups and more.

To access survey tabulation features

1. In the Remark Office OMR Data Center, open a form template and then process forms or open an existing data file.

2. Select the Tools menu, click Analysis and then click Easy Survey or Survey Wizard. Alternatively, select the Easy Survey or Survey Wizard links in the Task Pane.

Remark Quick Stats will open allowing you to configure and display reports. Please consult the Remark Quick Stats user’s guide PDF for further details about using Remark Quick Stats.

Tip: The Survey Wizard and Easy Survey screens and functions are described in complete detail in the Remark Quick Stats User’s Guide PDF file. Access the file by clicking Start|Programs|Remark Office OMR 6|Documentation.

10.3 Grading Tests

Tests can be graded in two ways: Easy Grade and the Grade Wizard. Easy Grade uses the parameters specified in the form template, such as which questions to grade and their point values. In addition, Easy Grade uses the first row of data in the template grid as the answer key; therefore, you should process your answer key before your tests if you plan to use Easy Grade. The Grade Wizard allows you to customize the grading process by choosing which questions to include, assigning point values, setting benchmarks, adding question text, specifying learning objectives and more.
To access test grading features

1. In the **Remark Office OMR Data Center**, open a form template and then process forms or open an existing data file.

2. Select the **Tools** menu, click **Analysis** and then click **Easy Grade** or **Grade Wizard**. Alternatively, select the **Easy Grade** or **Grade Wizard** links in the Task Pane.

Remark Quick Stats will open allowing you to configure and display reports. Please consult the Remark Quick Stats user’s guide PDF for further details about using Remark Quick Stats.

**Tip:** The Grade Wizard and Easy Grade screens and functions are described in complete detail in the Remark Quick Stats User’s Guide PDF file. Access the file by clicking **Start|Programs|Remark Office OMR 6|Documentation**.
Remark Office OMR Data Center

Preferences

Chapter 11

11.1 Overview

This chapter details how to customize the Remark Office OMR Data Center software by setting up preferences. Preferences allow you to set the way the software functions by default, which can facilitate your use of the software.

**Important Note:** The Preferences are global software settings. When you make a change to the Preferences, it will affect all actions from that point forward. It will not affect anything you have already completed.

To access the Preferences

1. In the **Remark Office OMR Data Center**, select the **Tools** menu and then click **Preferences**, or click ![Preferences icon](image).

Use the links in the left Task Pane to access all of the available preferences.

**Note:** Each component of the software has its own set of preferences. The Remark Office OMR Template Editor preferences are covered in Section 7.7 Template Editor Preferences. The Remark Quick Stats preferences are covered in the Remark Quick Stats User’s Guide PDF file, which can be accessed by clicking **Start|Programs|Remark Office OMR 6|Documentation**.

The available Data Center preferences are described in the sections that follow.
11.2 General Preferences

General preferences allow you to setup defaults for basic software functions. The following options are available:

<table>
<thead>
<tr>
<th>Preference Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shade alternate rows to look like</td>
<td>Mark this checkbox to shade every other template grid row. Click the paint bucket to choose a shading color.</td>
</tr>
<tr>
<td>Use Legacy Analysis as your Default Analysis Tool</td>
<td>Mark this checkbox to use the Remark Quick Stats analysis package that was part of Remark Office OMR version 5. This feature is useful if there are certain reports that you created previously and you would like to maintain the style of formatting. If this checkbox is turned off, Remark Office OMR will use the current analysis version for displaying reports.</td>
</tr>
<tr>
<td>Preference Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update the Image Viewer During Read Operations</td>
<td>Mark this checkbox to have the Image Viewer update with a new form image each time a form is processed. The Image Viewer is located beneath the template grid window. Using this option could alert you to issues such as skewed forms.</td>
</tr>
<tr>
<td>Review Exceptions: Auto search the response combo box when typing</td>
<td>Mark this checkbox so that you can type the first letter(s) of a response into the Response box of Review Exceptions and the software will automatically select the response that begins with those characters. This option applies to questions that employ list box style cells only (Multiple, List and Boolean OMR regions and Image regions that utilize Database Lookup).</td>
</tr>
<tr>
<td>Review Exceptions: Play sound on review exceptions startup</td>
<td>Mark this checkbox to play a sound when Review Exceptions first starts. This feature is useful as an alert if you are processing forms in an unattended manner.</td>
</tr>
<tr>
<td>Review Exceptions: Play sound when an exception case is located</td>
<td>Mark this checkbox to play a sound every time an exception case is located in Review Exceptions. Click the … button to select a .wav sound file. You may also click the button 🎧 to preview the sound.</td>
</tr>
<tr>
<td>Maximum length for a value in a data grid cell</td>
<td>Enter the maximum number of characters allowed in a template grid cell. You will not be able to enter more characters than allowed (e.g., when entering text using a Data Entry Image region). Note that performance may be affected by template grid cells that contain very large amounts of text.</td>
</tr>
<tr>
<td>Preference Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Replace missing data values with</td>
<td>Enter the value to be used when missing data are encountered during a data file export. Missing data means that the piece of data captured does not match what was defined as Labels in the form template. A MULT, BLANK and ERROR left in the data set would all be considered missing. If you typed a response in a list cell in the grid but it did not match the labels defined, this data would also be considered missing (e.g., “A” is defined in the form template, but you type “a”). The Missing Value will also be used when running reports in Remark Quick Stats. The default value is -1.</td>
</tr>
<tr>
<td>System poll interval during Server Mode (secs.)</td>
<td>Enter the number of seconds in between polls for Server Mode. The software will search for image files in a directory or pages in the scanner's sheetfeeder based on this time interval.</td>
</tr>
</tbody>
</table>
11.3 File Storage Location Preferences

File Storage Location preferences allow you to setup the default directories that will be used to store various file types. If you prefer to store files on a network drive, you can enter that location here (ensure that you have permission to fully access that drive). The following options are available:

<table>
<thead>
<tr>
<th>Preference Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form templates</td>
<td>Sets the default location in which to store form template files. Highlight this selection and then click the Modify Directory button to set a directory. The default directory is C:\Program Files\Principia Products\Remark Office OMR 6\Templates.</td>
</tr>
<tr>
<td>Data</td>
<td>Sets the default location in which to store data files. Highlight this selection and then click the Modify Directory button to set a directory. The default directory is C:\Program Files\Principia Products\Remark Office OMR 6\Data.</td>
</tr>
<tr>
<td>Dictionaries</td>
<td>Sets the default location in which to store spell check dictionary files. Highlight this selection and then click the Modify Directory button to set a directory. The default directory is C:\Windows\System32.</td>
</tr>
</tbody>
</table>
### Preference Option Description

**Image Directory Search List**
Sets the locations(s) in which images will be stored for processed forms and Image region Image Clips. When a cell in the template grid is clicked, the stored image file is displayed in the Image Viewer. The Image Viewer can be used for image-assisted data entry, Review Exceptions and in-cell editing. Use the **Add Directory…** button to add any directories in which you plan to store image files for processed forms. Remark Office OMR will search for these images in the order in which the directories are specified. Use the **Move Up** or **Move Down** buttons to change the order, and the **Remove Directory** button to remove a directory from the search list.

**Active Dictionary**
Sets the active dictionary to be used for Spell Check. Click the down arrow to view any dictionaries that are currently installed in your default **Dictionaries** directory.

### 12.4 Recognition Preferences

Recognition preferences allow you to setup the default settings for how basic recognition functions are handled. The following options are available:

![Remark Office OMR Data Center Preferences](image-url)
### Preference Option

<table>
<thead>
<tr>
<th>Preference Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Enhanced Reading Mode</td>
<td>Mark this checkbox to enable enhanced recognition options. Enhanced recognition allows the software to do a more in depth recognition of uncertain fields. <strong>Note:</strong> This option is on by default. Under most circumstances, you will want to leave this option enabled.</td>
</tr>
<tr>
<td>Override OMR Region Thresholds</td>
<td>Mark this checkbox to override the Recognition Threshold settings defined for OMR regions in the form template. Use a higher setting if you are having problems discriminating among filled marks. Use a lower setting if you are having problems picking up light/less filled marks. See Section 7.3.1.d Recognition Threshold for detailed information about the Recognition Threshold setting.</td>
</tr>
<tr>
<td>Override Image Region Thresholds</td>
<td>Mark this checkbox to override the Recognition Threshold settings defined for Image regions in the form template. Use a higher setting if the software is picking up stray marks. Use a lower setting if you are having problems picking up light text or smaller amounts of handwriting. See Section 7.3.1.d Recognition Threshold for detailed information about the Recognition Threshold setting.</td>
</tr>
<tr>
<td>Default image clip file type</td>
<td>Select the type of file to be used when storing Image Clips: <strong>PCX, TIF</strong> or <strong>PDF</strong>. <strong>Note:</strong> The PDF option is only available if you have enabled PDF support (see next page).</td>
</tr>
<tr>
<td>Image compression level</td>
<td>If using the TIF or PDF format for Image Clips, select a compression level: <strong>Uncompressed</strong> (largest file), <strong>Group 3</strong>, <strong>Group 3 2Dd</strong>, <strong>Group 4</strong> (smallest file).</td>
</tr>
<tr>
<td>Preference Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bit Depth Conversion Threshold:</td>
<td>Use this setting to adjust pixel depth on images that are scanned in color or grayscale. Remark Office OMR converts the image to black and white for recognition purposes. You can adjust the resulting image quality by raising or lowering the threshold value. A higher threshold will create a darker image and a lower threshold will create a lighter image.</td>
</tr>
<tr>
<td>Set the global threshold value to:</td>
<td></td>
</tr>
<tr>
<td>Enable PDF Image File Support</td>
<td>Mark this checkbox to enable PDF support in the software. Once enabled, you can save image files and image clips to the PDF format and read PDF files into the software.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> PDF support is optional. If you choose to enable PDF support you will need to restart the application before the change will take effect. Enabling PDF support causes the software to use more system memory while it is running. If you are using a system with limited memory and free resources, we recommend turning off this feature. You may still save image files to the PCX or TIF file formats.</td>
</tr>
</tbody>
</table>
Appendix A

A.1 Overview

The following appendix provides some useful tips for getting the most out of your Remark Office OMR software. There are several key areas of the software that you will use often. Look through the following sections to learn more about how to best utilize the software. For complete details about a feature, consult the proper section in this user’s guide.

A.2 Scanners

Remark Office OMR works with image scanners. There are a wide variety of scanners that fall into this category. Use the following guidelines when selecting and using a scanner with Remark Office OMR:

- There are three basic categories of scanners: low-end, mid-range and high-end. Generally speaking, a low-end scanner is capable of scanning up to 10 pages per minute (ppm). Low-end scanners are often geared toward graphics scanning rather than document scanning, and therefore are not typically recommended for use with Remark Office OMR. A mid-range scanner is capable of scanning about 11 to 40 pages per minute. A high-end scanner is capable of scanning over 40 pages per minute. Speed will have a direct effect on price.

- There are three major points to consider when purchasing a scanner: your budget, the volume of forms you will be processing and whether the scanner will be used for purposes other than scanning forms in Remark Office OMR. If you have low volume (e.g., a few forms-processing applications a year, a few hundred forms each time), a low-end scanner may be fine. For moderate volume (e.g., several forms-processing applications a year, a few thousand forms each time) look into a mid-range scanner. For high volume (e.g., a many forms-processing applications a year, several thousands of forms total) look into a high-end scanner. Note that price goes up considerably with speed. If the scanner will be used for other purposes as well, look into its color and resolution capabilities. Remember that you get
what you pay for when it comes to scanners. Know what you need before you begin shopping.

- Purchase a scanner with an automatic document feeder (ADF). You do not want to have to scan forms one at a time. The ADF will allow you to place a batch of forms in the scanner at one time.
- Use the resources on our web site to find scanner information. You will find a list of supported scanners and links to scanner manufacturers.
- If you experience a problem using your scanner in Remark Office OMR, verify that the scanner is working properly before contacting support. You can verify that the scanner is functioning by scanning pages in another scanning application. Many scanners will bundle an application for scanning with the scanner driver. Or use another default Windows application that permits scanning if it is available on your computer. If the scanner does not work in another program you may be experiencing a hardware problem and should contact your scanner manufacturer for assistance.
- If your scanned image is unclear, check the settings being used by your scanner. If using a TWAIN driver, go to the Scanner Properties window and mark the checkbox to Show TWAIN interface. When you scan, verify that you are scanning in a black and white (line art) mode for the best results. You can also check page size, resolution and brightness settings in the scanner’s user interface. A resolution of 200 dots per inch (DPI) is recommended.

A.3 Forms

Creating forms correctly is the most important step to a successful experience with Remark Office OMR. When a form is created well, many potential problems can be averted. Note the following points when creating your forms:

- Create your forms where you are most comfortable- a word processing program, survey design program, etc.
- Review Chapter 6 Form Design Guidelines before creating your own forms. These guidelines will help you understand how to consistently create forms that will scan well and produce more accurate results.
- Consider using barcodes to capture information such as ID numbers, names, etc. You can easily create barcodes yourself with the Code 39 barcode font (installs with the software and is available on our web site for download). Make the barcode about 26 points in size (do not make it smaller than 24 points). If using the Code 39 font, you must begin and end the barcode with asterisks and use the exclamation point for a space. For example, to barcode John Doe, you would type *John!Doe*. Barcodes must be in the
same position on each form of the same type. You can use barcode stickers as well to attach the barcode after the forms have been duplicated. If using Microsoft Word to create barcodes, turn off the Auto Format/Correct feature to Replace *Bold* with Real Formatting. This feature will turn anything between two asterisks to bold and ignore the last asterisk, which will lead to recognition problems if left activated.

- Take advantage of Principia's free form review service. Fax or email forms to Principia Support before you duplicate them. The support department will provide feedback on your form’s compatibility with Remark Office OMR and provide suggestions if necessary.
- Test your form with the software before duplicating and distributing it. Create a form template and fill in a few forms as you expect to have them returned (not perfectly!) to get an idea of how well the form will work.

## A.4 Form Templates

The form template is another key to accurate form processing. Every form that is scanned will be compared to the form template in order for Remark Office OMR to locate the marks on the page and output the correct information. Therefore, the form template must be the same as the forms that will be scanned. The form template determines the order of fields in your data as well as the labels your data contains. If you plan to export your data to another file format (e.g., Access, Excel, SPSS, etc) adhere to the limitations imposed by that specific file format (see Appendix B and your file format’s documentation for these limitations). Make sure you know where your data will eventually end up before you create your form template so that the form template can be setup to meet your database’s needs. Note the following points when creating your form templates:

- Always use a form that has not been filled in to create the form template.
- Use the same quality form to create the form template that you will be distributing to your respondents. This means that if you photocopied the forms, use a blank photocopy to create the form template. If you had the forms professionally printed, use a printer’s copy to create the form template. If you printed them on a laser printer, use a copy from the same laser printer to create the form template. When forms are duplicated, offset may occur. By using the same quality form, you will compensate for this offset.
- If your scanner has an automatic document feeder, feed the form through the document feeder when scanning it for the form template. Do not place the form directly on the flatbed glass, as the positioning will be different.
Scan the form for the form template at a resolution of 200 DPI (dots per inch). Use the same setting when you scan the filled in forms that was used when you created the form template. Resolution will affect the size of the image, which in turn will affect the location of the marks on the page. Changing the resolution midway may lead to recognition errors.

Use the default brightness setting on your scanner when you scan the form for the form template. You should only change the brightness setting when you encounter a problem (e.g., the image for the form template looks too light and the marks are not complete). If you change the brightness setting for the form template, use the same brightness setting when you scan the filled in forms.

Before you create the form template, know what you will be doing with the data after the forms are scanned. The format in which you want to save your data should determine how you set up the form template. For example, if you want to export the data to SPSS, your form template Region Names must be unique and limited to eight characters (allows for general SPSS compatibility). If you plan to export the data to a survey design and analysis package, find out the data requirements of the particular survey design and analysis package before creating the form template.

When you create an OMR region, you may only capture the marks on the form (no text, lines, etc.). If text or lines separate the marks, you must use the Append Linked Region feature. Take advantage of the Append Linked Region feature as you go to link the regions as you define them. This is a great time saver.

The Remark Office OMR form template editor utilizes basic Windows commands such as cut, copy, paste, drag/drop and undo. These shortcuts can be tremendous time savers when you are creating regions. You may also copy regions from one page to the next, or from one form template to another (use Copy/Paste Special for the latter case).

The order in which the regions are defined in the tree view is the order in which they will be processed (e.g., the order in which the data will appear in your data set). You can move regions in the tree view using drag and drop or cut and paste to reorder them.

If you need to make a change to the form template, remember that major changes will not change data that have already been processed. These types of changes would include changing Labels, rearranging the order of regions and changing the size of a region. If you make such changes you will need to process your forms again because the existing data will no longer match the form template. You can either scan the forms or read the stored image files to recreate your data file.
If you change your form slightly but have already created a form template, you do not have to create a new form template. You can scan the new page with the existing form template by using the Reset Images feature or by editing the page properties and acquiring a new image. Once you have scanned or imported a new image, use the Auto Align feature to move the existing regions to their proper location on the new image (double check positioning after using the Auto Align feature and adjust as needed).

Test your form and form template with the software before duplicating and distributing forms. Create a form template and fill in a few forms to get an idea of how well the form will work and whether you have set up the form template properly for your data analysis needs.

A.5 Reading Forms

When the form and template guidelines in the above sections are followed, reading forms is a smooth process. Here are some tips to keep things running efficiently:

- Scan filled in forms at the same resolution and brightness settings that were used for the form template. If you are unsure of these settings, open your form template in the Template Editor. Double click any page node and then hover your mouse over the information button, in the image viewer to view details about the stored image.

- You have two options when it comes to cleaning your data: 1) Use Review Exceptions during form processing to stop processing when selected exception cases are encountered and make a correction immediately, or 2) Use Review Exceptions after form processing the forms to have the software cycle through the data and allow you to make corrections based upon an image of the problem area. If you want to review the data after scanning, you must save your data to the Remark (RMK) or Remark Office Archive (ROA) formats. These formats will preserve the links between the data and stored images as well as the exception case flags.

- If you receive a recognition error, consider the following when trying to resolve it: 1) Did you use the same quality forms for the form template and filled in forms? 2) Did you set up the region properly in the form template? 3) Have you changed any settings on the scanner since you scanned the form for the form template? 4) Did you use the ADF for both the form template and the filled-in forms?

- If you want to scan your forms in batches over a period of time, use the Remark (RMK) format to save the data. This format will allow you to save the stored images with the data so that you can make corrections at a later
time. Once you have scanned all of your forms, you can resave the data in another format for exporting, if desired.

- If you are scanning double-sided forms with a duplex scanner, you do not need to use the Collate Options when reading. Instead, turn on the duplex capabilities of your scanner in the Scanner Properties window or your scanner’s user interface.

- If you are scanning in color or grayscale mode and find that the resulting image quality is not as good as expected, try adjusting the Bit Depth Conversion Threshold under Tools|Preferences|Recognition. Remark Office OMR uses a black and white version of the image for recognition. Sometimes the conversion to black and white can leave the image a little lighter or darker than expected. You can raise the Bit Depth Conversion Threshold to create a lighter image and lower the threshold to create a darker image.

A.6 Working with the Data

Once you have scanned your forms, you will need to clean the data. After the data is cleaned, you have two options for the data: 1) Use Remark Quick Stats to grade or tabulate the data, or 2) export the data to another program for analysis. Note the following points when working with your data:

- To clean your data, make use of in-cell editing and Review Exceptions to make changes to the data. In-cell editing is convenient when making just a few corrections. Review Exceptions will allow you to automate the review process and allow you to refer to images to make large scale corrections.

- When exporting data to another program, know the limits and specifications of the file format. You may need to set up your form template in a specific manner to accommodate your file format. File Format specifications are outlined in detail in Appendix B of this user’s guide.

A.7 Analysis

The Remark Quick Stats program can provide detailed analysis of your data. Detailed information about Remark Quick Stats is included in a separate user’s guide in PDF format, which is installed with the software. Go to Start|Programs|Remark Office OMR|Documentation 6 to locate this file.

Keep the following in mind when using Remark Quick Stats:

- There are two versions of Remark Quick Stats included with the software. The legacy version is the version included with version 5 of the Remark Office OMR software. It is useful if you have existing report files you want to use or have a report style that you would like to keep using. The latest
version of Remark Quick Stats is the default reporting tool. It contains updated reports that existed in the previous version of the software as well as new reports. You are encouraged to review the new reports to see if they meet your needs. The reports can be customized by clicking Tools|Report Properties. You may toggle between analysis versions by clicking Tools|Preferences|General in the Data Center.

- To facilitate the grading process, set up an answer key file that you can use over again. You can specify an answer key, ID and subjective regions, learning objectives, benchmarks, multiple test versions and a grade scale in the answer key file.

- Use the program Preferences to set global options so that you can take advantage of Easy Survey and Easy Grade for fast and simple reporting. These reports will utilize the settings in your Remark Office OMR preferences.

- Save reports as internal Report Files from within Remark Quick Stats if you feel that you will need to recall them. Saving a modified report can save a great deal of time if you need to reuse it.

- When grading tests, remember that you can select an answer key in one of several ways: 1) Scan the answer key as the first grid row of the data, 2) Scan the answer key when you perform the grade operation, 3) import an image of your form with the correct responses, 4) Enter a grid row containing the answer key when you perform the grade operation or 5) Reopen an answer key file that contains the answer key when you perform the grade operation.
Understanding File Formats

Appendix B

B.1 Overview

This appendix is designed to provide an overview of Remark Office OMR supported data file formats. The following table lists the different file formats the Remark Office OMR software supports, their extensions and a brief description. Please refer to individual format sections for more in-depth information. You should consider the file format to which you want to save your data when you are creating the template for your form. Certain file formats have options and limitations that should be addressed in the template.

Note: The format descriptions and limitations listed are for the most recent version supported. Consult the documentation of application specific formats for up-to-date description and limitation information.

<table>
<thead>
<tr>
<th>File Format</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remark</td>
<td>RMK</td>
<td>Remark Office OMR format; saves grid flag colors and image links</td>
</tr>
<tr>
<td>Remark Office Archive</td>
<td>ROA</td>
<td>Remark Office OMR Archive format; combines template, data and stored image files into one file (new file or overwrite existing file only).</td>
</tr>
<tr>
<td>Access</td>
<td>MDB</td>
<td>Microsoft Access 2000-2003 format</td>
</tr>
<tr>
<td>Access 95-97</td>
<td>MDB</td>
<td>Microsoft Access 95-97 format</td>
</tr>
<tr>
<td>Access 2.0</td>
<td>MDB</td>
<td>Microsoft Access 2.0 format</td>
</tr>
<tr>
<td>Access 1.0</td>
<td>MDB</td>
<td>Microsoft Access 1.0 format</td>
</tr>
<tr>
<td>Excel 97-2003</td>
<td>XLS</td>
<td>Microsoft Excel 97-2003 format</td>
</tr>
</tbody>
</table>
### File Format

<table>
<thead>
<tr>
<th>File Format</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excel 95</td>
<td>XLS</td>
<td>Microsoft Excel 95 format</td>
</tr>
<tr>
<td>Excel 4.0</td>
<td>XLS</td>
<td>Microsoft Excel 4.0 format</td>
</tr>
<tr>
<td>Excel 3.0</td>
<td>XLS</td>
<td>Microsoft Excel 3.0 format</td>
</tr>
<tr>
<td>Questionmark</td>
<td>QSF</td>
<td>Questionmark Perception format (save only)</td>
</tr>
<tr>
<td>SPSS</td>
<td>SAV</td>
<td>SPSS format</td>
</tr>
<tr>
<td>Survey Pro</td>
<td>SRV</td>
<td>Survey Pro standard format (Apian Software)</td>
</tr>
<tr>
<td>Survey Pro STL</td>
<td>STL</td>
<td>Survey Pro STL format (Apian Software)</td>
</tr>
<tr>
<td>ASCII [commas]</td>
<td>ASC</td>
<td>Comma delimited ASCII</td>
</tr>
<tr>
<td>ASCII [tabs]</td>
<td>ASC</td>
<td>Tab delimited ASCII</td>
</tr>
<tr>
<td>Spreadsheet [commas]</td>
<td>TXT</td>
<td>Comma delimited ASCII with quotes around non-numeric data</td>
</tr>
<tr>
<td>Spreadsheet [tabs]</td>
<td>TXT</td>
<td>Tab delimited ASCII with quotes around non-numeric data</td>
</tr>
<tr>
<td>Survey System</td>
<td>DAT</td>
<td>The Survey System format (Creative Research Systems)</td>
</tr>
<tr>
<td>dBase 5.0</td>
<td>DBF</td>
<td>dBase 5.0 format</td>
</tr>
<tr>
<td>dBase IV</td>
<td>DBF</td>
<td>dBase IV format</td>
</tr>
<tr>
<td>dBase III</td>
<td>DBF</td>
<td>dBase III format</td>
</tr>
<tr>
<td>Paradox 5.X</td>
<td>DB</td>
<td>Paradox 5.X format (new file or overwrite existing file only)</td>
</tr>
<tr>
<td>Paradox 4.X</td>
<td>DB</td>
<td>Paradox 4.X format (new file or overwrite existing file only)</td>
</tr>
<tr>
<td>Paradox 3.X</td>
<td>DB</td>
<td>Paradox 3.X format (new file or overwrite existing file only)</td>
</tr>
<tr>
<td>Lotus WK4</td>
<td>WK4</td>
<td>Lotus Works 4 format (open only)</td>
</tr>
<tr>
<td>Lotus WK3</td>
<td>WK3</td>
<td>Lotus Works 3 format</td>
</tr>
<tr>
<td>Lotus WK1</td>
<td>WK1</td>
<td>Lotus Works 1 format</td>
</tr>
<tr>
<td>Lotus 1-2-3</td>
<td>WKS</td>
<td>Lotus 1-2-3 format</td>
</tr>
</tbody>
</table>
Remark Office OMR can save and open data in dozens of different file formats. Each format has its own requirements and limitations. The following sections are designed to give you a brief overview of each format, some considerations when using the format in Remark Office OMR and some possible format limitations. Please consult the User's Guide of any application specific formats (e.g., Access, Excel, SPSS…) for more detailed information.

### B.2 Remark File Format (RMK)

The Remark File Format is proprietary to the Remark Office OMR software and, therefore, can only be used in Remark Office OMR. We recommend that you use the Remark file format as your default file format and only save to other file formats when exporting data to other applications.

**Tip**: The Remark and Remark Office Archive formats are the only formats that will preserve the link between each grid cell and the corresponding image, as well as exception case flags. If you export data to another format you will not be able to click in a cell and view the corresponding image. We do not recommend exporting data to other formats until you have fully cleaned your data.

---

<table>
<thead>
<tr>
<th>File Format</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LXR Test</td>
<td>MRG</td>
<td>LXR Test format</td>
</tr>
<tr>
<td>Report</td>
<td>RPT</td>
<td>Fixed format ASCII, cell text padded (you will receive an error message if the text exceeds the specified record length)</td>
</tr>
<tr>
<td>Data Interchange</td>
<td>DIF</td>
<td>Standard format using file header and data section</td>
</tr>
<tr>
<td>Format</td>
<td>DAT</td>
<td>CCI Assessment format (overwrite existing file only)</td>
</tr>
<tr>
<td>XML</td>
<td>XML</td>
<td>Extensible Markup Language format</td>
</tr>
<tr>
<td>HTML</td>
<td>HTM</td>
<td>Hypertext Markup Language</td>
</tr>
<tr>
<td>ODBC</td>
<td><em>.</em></td>
<td>Open Database Connectivity</td>
</tr>
<tr>
<td>Custom</td>
<td>ASC, TXT</td>
<td>Custom Text format</td>
</tr>
</tbody>
</table>
### B.3 Remark Office Archive File Format (ROA)

The Remark Office Archive File Format is proprietary to the Remark Office OMR software and, therefore, can only be used in Remark Office OMR. This feature is useful if you own and use multiple copies of the software. For example, one person can scan forms on one system and then save the data to the Remark Archive Format. Another person can then open that Remark Archive file, which will provide the template, data file and stored images, and run Review Exceptions to clean the data. Use of this format eliminates the need to search for various file types when sharing the workload.

**Caution!** Please read the license agreement in the front of this user’s guide carefully before installing Remark Office OMR on multiple computers. Licensing is computer-based, meaning that one copy of the software may only be installed on one computer.

<table>
<thead>
<tr>
<th>Extension</th>
<th>RMK</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td>Saving Images: The RMK format will save the link between stored images and the data. You may then refer to the image files to review data later.</td>
</tr>
<tr>
<td><strong>Limitations</strong></td>
<td>None</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Extension</th>
<th>ROA</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td>Saving Images: The ROA format will save the link between stored images and the data. You may then refer to the image files to review data later.</td>
</tr>
<tr>
<td></td>
<td>Delete original images after archiving: Mark this checkbox to delete the original images that are put into the archived file. If you do not delete the images, you will have the original copies as well as those in the zipped file. If you delete the images, you may open the ROA file to retrieve them again.</td>
</tr>
<tr>
<td><strong>Limitations</strong></td>
<td>None</td>
</tr>
</tbody>
</table>
B.4 Access Formats (MDB)

The Access file formats are proprietary to the Access database program by Microsoft Corporation. Use an Access file format when exporting data to Microsoft Access. Remark Office OMR supports the Access version 1.0 through 2003 file formats. Column (region) names in Remark Office OMR are used as field names when saving to an Access database.

Remark Office OMR can save data to a new Access database, add new tables to existing Access databases and append data to existing Access tables.

<table>
<thead>
<tr>
<th>Extension</th>
<th>MDB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Table Name: When saving to an Access database, you must select a table name to which to save the data.</td>
</tr>
<tr>
<td>Limitations</td>
<td>Field (called region names in Remark Office OMR) and table names can contain a maximum of 60 characters (including spaces).</td>
</tr>
<tr>
<td></td>
<td>Field (called region names in Remark Office OMR) and table names cannot include: leading spaces, periods (.), exclamation points (!), accent graves (´) and brackets ([]).</td>
</tr>
<tr>
<td></td>
<td>An Access table can hold a maximum of 255 fields.</td>
</tr>
<tr>
<td></td>
<td>All field names (called region names in Remark Office OMR) must be unique.</td>
</tr>
<tr>
<td></td>
<td>An Access table record can hold a maximum of 2000 characters (excluding Memo and OLE object regions).</td>
</tr>
<tr>
<td></td>
<td>If saving data to an existing table, grid column headers in Remark Office OMR must match table field names.</td>
</tr>
<tr>
<td></td>
<td>When Remark Office OMR creates an Access table, textual fields can contain a maximum of 255 characters. If you would like a field to support more than 255 characters, edit the database in Microsoft Access and change the field type from a Text field to a Memo field. Alternatively, click the Advanced button in the Save Data window and change the field type.</td>
</tr>
</tbody>
</table>
B.5 Excel Formats (XLS)

The Excel file Formats are proprietary to the Excel spreadsheet program by Microsoft Corporation. Use an Excel file format when exporting data to Microsoft Excel. Remark supports the Excel version 3.0 through 2003 file formats. Column (region) names in Remark Office OMR are used as field names when saving to an Excel database.

Remark Office OMR can save data to a new Excel database, add new sheets to existing Excel databases and append data to existing Excel files.

<table>
<thead>
<tr>
<th>Extension</th>
<th>XLS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td></td>
</tr>
<tr>
<td>Limitations</td>
<td></td>
</tr>
<tr>
<td>Sheet Name: When saving to an Excel database, you must select a sheet name to which to save the data.</td>
<td></td>
</tr>
<tr>
<td>Spaces in field names (called region names in Remark Office OMR) will be automatically converted to underscores.</td>
<td></td>
</tr>
<tr>
<td>All field names (called region names in Remark Office OMR) must be unique.</td>
<td></td>
</tr>
<tr>
<td>Field names (called region names in Remark Office OMR) are limited to 60 characters.</td>
<td></td>
</tr>
<tr>
<td>An Excel table can hold a maximum of 255 fields (columns).</td>
<td></td>
</tr>
<tr>
<td>If saving data to an existing sheet, grid column headers in Remark Office OMR must match table field names.</td>
<td></td>
</tr>
<tr>
<td>A cell can contain a maximum of 255 characters.</td>
<td></td>
</tr>
</tbody>
</table>

B.6 Questionmark Format (QSF)

The Questionmark format is proprietary to the Questionmark Perception assessment software program. Use the Questionmark format when exporting data to Perception. This format has specific parameters that must be defined, including a Snapshot ID (the value that uniquely identifies the assessment) and the Participant (the region that identifies each respondent). Additionally, there are optional parameters you may specify, including the Group, Details, Date and Monitor. This information should closely match what was originally defined in Perception. For example, the Snapshot ID used should already be defined in Perception as the ID for this particular form, the Participant IDs should already be defined in Perception as the student identifiers, Group should already be
defined, Questions should already be defined in the same order as they appear in this form, Special fields should already be defined in the appropriate order, Details should already be defined (as to what type of information the field should contain). Please see the table below for further details.

<table>
<thead>
<tr>
<th>Extension</th>
<th>QSF</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Required Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Snapshot ID:</td>
<td>A value that uniquely identifies the assessment. Each record in the data file must contain the same Snapshot ID. The Snapshot ID must be a numeric value from 1 to 99999999. Choose a region containing the Snapshot ID or enter one manually.</td>
</tr>
<tr>
<td>Participant:</td>
<td>Participant, student or respondent identifier. This field uniquely identifies each respondent. Every record in the data file must contain a unique Participant identifier. Choose the region containing this information.</td>
</tr>
<tr>
<td><strong>Optional Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Group:</td>
<td>Group, category, course or department. This entry should match the groups defined in your Questionmark application. Choose the region containing the group or enter a group name manually.</td>
</tr>
<tr>
<td>Details:</td>
<td>Optional demographic data. Choose the region containing the details or enter a value manually.</td>
</tr>
<tr>
<td>Date:</td>
<td>Date the assessment took place. Choose a region containing the date or enter one manually.</td>
</tr>
<tr>
<td>Monitor:</td>
<td>Monitor, teacher or instructor name. Choose the region containing the monitor name or enter one manually.</td>
</tr>
<tr>
<td><strong>Limitations</strong></td>
<td></td>
</tr>
<tr>
<td>The Questionmark format is only available when saving data. You may create new files or overwrite existing files. These files cannot be opened in Remark Office OMR.</td>
<td></td>
</tr>
<tr>
<td>Field names (called region names in Remark Office OMR) cannot contain double quotes (&quot;).</td>
<td></td>
</tr>
<tr>
<td>Spaces entered before or after a field name or data label will be ignored. However, spaces in the middle of a field name or data label will be counted. (e.g., &quot; John&quot; becomes &quot;John&quot; but &quot;John Smith&quot; remains &quot;John Smith.&quot;</td>
<td></td>
</tr>
<tr>
<td>Graded questions MUST use field names of &quot;Q1, Q2, Q3...&quot; or &quot;Question1, Question2, Question3...&quot;</td>
<td></td>
</tr>
</tbody>
</table>
You may optionally define questions called "Special1 - Special10" that can contain more optional demographic data.

The following fields can contain a max of 50 characters (any more will be truncated): Participant, Group, Details, Monitor, Special1 - Special10

All exceptions should be corrected before exporting to this format. Any exception found in the graded questions when exporting will be treated as an unanswered question.

B.7 SPSS File Format (SAV)

The SPSS File Format is proprietary to the SPSS statistical software program by SPSS, Inc. Use the SPSS file format when exporting data to SPSS. The column headers (region names) in Remark Office OMR are saved as SPSS variable names. The question text, if entered, is saved as SPSS variable labels. Remark Office OMR uses the Labels and Values defined when creating the template as SPSS value labels and value numbers, respectively. Missing, invalid or unrecognized responses in Remark Office OMR are assigned an SPSS missing value of −1 by default. The missing value can be changed to a user-defined value by selecting the Tools menu and then clicking Preferences and then General. Please note that as new versions of SPSS are released, some items listed below may change. The SPSS format defined in Remark Office OMR will allow the most flexibility by being compatible with both older and newer versions of the software.

Note: The SPSS file format outputs numeric data for each of your Labels. By default, Remark Office OMR uses a sequential numbering scheme, called Values, which begins with 1 for the first Label. You may change these values in the Template Editor by selecting a region’s properties.

<table>
<thead>
<tr>
<th>Extension</th>
<th>SAV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Save Headers: The Save Headers option in the Save Data File window will save the grid column headers as the header names in the SPSS data file. If Save Headers is not selected, default variable names will be used (e.g., v1, v2, etc.).</td>
</tr>
</tbody>
</table>
**Limitations**

- Data saved to an SPSS format can have a maximum of 255 characters per cell. Remark Office OMR will automatically truncate any cell text that is greater than 255 characters when saving to an SPSS file.
- Labels (called Value Labels in SPSS) can have a maximum of 60 characters.
- Values: If custom Values are not defined during form template creation, Remark Office OMR automatically assigns Values in sequential order to be used as SPSS Values.
- Region names (called Variable Names in SPSS) can have a maximum of 8 characters. If a region name has more than 8 characters, it will automatically be truncated.
- Region names (called Variable Names in SPSS) must be unique. If a region is used more than once, SPSS will convert the name to a standard naming convention (e.g., v1).
- Question text (called Variable Labels in SPSS) can have a maximum of 120 characters.
- Remark Office OMR can open and save to an uncompressed SPSS file format only. Remark Office OMR cannot open compressed SPSS files. If you need to uncompress your SPSS data file, first open the file in SPSS. Select the File menu and then click Save As. Enter a file name and then click the Paste button. In the Syntax Editor window, change the word “COMPRESSED” to “UNCOMPRESSED.” Press Ctrl + A to select the text, then select the Run menu and click Current.
- SPSS cannot import multiple responses (e.g., (A,B,C)) as numeric data. Questions which allow multiple responses in Remark Office OMR will be formatted as a string when exported to the SPSS file format, which will not import properly. To import questions that allow multiple responses into SPSS as numeric data, choose the Boolean region type when defining the region in Remark Office OMR Template Editor. As a result, Remark Office OMR will output either a 1 (for filled responses) or a 0 (for blank responses) to a separate cell for each mark in the region. Once the data have been opened in SPSS, you can combine the data for each mark in the region back into one question. Refer to the SPSS User’s Guide for more information.
B.8 Survey Pro File Format (SRV)

The Survey Pro File Format is a comma delimited ASCII file designed for importing into older versions of Survey Pro by Apian Software. Use the Survey Pro file format when exporting data to Survey Pro. Survey Pro imports numeric data most readily. Therefore, when creating a template for a form that you want to use in Survey Pro, choose the Numeric data type for multiple choice questions. For example, if the possible answers for a particular question are: Excellent, Good, Fair and Poor, use 4, 3, 2 and 1 as the Output Labels. Textual data are quoted and should only be used for Image regions. Multiple responses are delimited by semicolons. For example, (1;3;5).

<table>
<thead>
<tr>
<th>Extension</th>
<th>SRV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Save Header: The Save Header option in the Save Data File window will save the grid column headers as the first record in the Survey Pro data file. They can be used in region matching when importing the data file.</td>
</tr>
<tr>
<td>Limitations</td>
<td>You must use the numeric data type for OMR region questions and enter corresponding numbers for each answer choice, as described above.</td>
</tr>
</tbody>
</table>

B.9 Survey Pro STL File Format (STL, ST3)

Survey Tag Language (STL) is a file format that describes a survey questionnaire and its database. This format is created in the Survey Pro software by Apian Software. Remark Office OMR also includes a Survey Pro STL (STL, ST3) format. Use this format when working with STL files in Survey Pro. The STL format allows you to export Survey Pro files to STL files, open those STL files in Remark Office OMR as templates, scan forms into the STL file and save data back to the STL file. Data is always appended to STL files. The Remark Office OMR Data Center cannot open or overwrite STL data.

<table>
<thead>
<tr>
<th>Extension</th>
<th>STL, ST3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Limitations</td>
<td>You may only append to existing STL/ST3 files</td>
</tr>
</tbody>
</table>
To create the STL file in Survey Pro
1. Once the survey has been created in Survey Pro, select the Database menu, click Export to, and then click Survey Tag Language 3.0.
2. Use the on-screen instructions to set up your STL file (consult the Survey Pro user’s guide for further information about creating STL files).

To open the STL file in Remark Office OMR
1. To scan forms with your STL file, open the Remark Office OMR Data Center.
2. Select the File menu and then click Open Form Template, or click.
3. In the Open Form Template window, select Survey Tag Language from the Files of type box.
4. Locate and select your STL file.
5. The file will open as a template grid. You are now ready to begin processing forms.

Tip: When the STL file is opened in Remark Office OMR, the region coordinates are automatically interpreted. However, if you experience recognition errors, you may edit the STL file in the Remark Office OMR Template Editor. The purpose of editing the template is to align it with a scanned image. Open your STL file in the Remark Office OMR Template Editor and then scan blank copies of your form and ensure the regions are properly aligned (see Chapter 7 for further information about using the template editor). You should not make structural changes to the template file because they will adversely affect your data import. All structural changes to the STL file should be made in Survey Pro before you begin using Remark Office OMR.

B.10 ASCII File Formats (ASC)
The ASCII file formats are generic, and can therefore be used by many different applications. Grid cells are delimited by either commas or tabs. Grid rows are delimited by a carriage return line feed sequence. The file extension used by other applications for ASCII files can vary. Here are some of the more common extensions: ASC, CSV, TSV, TXT.
### B.11 Spreadsheet File Formats (TXT)

The Spreadsheet file formats are generic, and can therefore be used by many different applications. The Spreadsheet formats are identical to the ASCII formats with one exception: spreadsheet formats place quotes around textual data. Grid cells are delimited by either commas or tabs. Grid rows are delimited by a carriage return line feed sequence.

<table>
<thead>
<tr>
<th>Extension</th>
<th>TXT</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td></td>
</tr>
<tr>
<td>▪ Save Headers: The Save Header option in the Save Data File window will save the grid column headers (region names) as the first record in the Spreadsheet data file.</td>
<td></td>
</tr>
<tr>
<td>▪ Save Image Names: The Save Image Names option in the Save Data window will save the path and names of image files for each scanned page as the columns at the end of the data set.</td>
<td></td>
</tr>
<tr>
<td><strong>Limitations</strong></td>
<td>None</td>
</tr>
</tbody>
</table>

**Limitations**

- If saving a comma delimited ASCII file, other applications may have difficulty opening the file if the data contain multiple responses. Multiple responses typically contain commas, which are also used as cell delimiters. Consider using the Custom format if you have questions that allow more than one response.

B.12 The Survey System File Format (DAT, CRS)

The Survey System File Format is proprietary to The Survey System survey design and analysis software program by Creative Research Systems. Use the Survey System file format when exporting data to The Survey System. When saving to the Survey System file format, Remark Office OMR actually creates two files: a data file and a questionnaire definition file. To import the data into The Survey System, first import the questionnaire definition file (CRS extension) and then open the data file (DAT extension) within that questionnaire. Consult The Survey System User’s guide for additional information. Data may only be saved to (not opened) The Survey System format.

<table>
<thead>
<tr>
<th>Extensions</th>
<th>DAT, CRS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Limitations</td>
<td>The Survey System data files cannot be opened in Remark Office OMR. You may create new files or overwrite existing files only.</td>
</tr>
</tbody>
</table>

B.13 dBase Formats (DBF)

The dBase File formats are commonly used database file formats used to transfer information between applications. Remark Office OMR supports dBase version III, IV, and 5.0 file formats. Column (region) names in Remark Office OMR are used as field names when saving to a dBase table. A dBase database is represented by a directory. A dBase table is represented by a DBF file within a dBase database.

Remark Office OMR can save data to a new dBase table and append data to existing dBase tables.

<table>
<thead>
<tr>
<th>Extension</th>
<th>DBF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Limitations</td>
<td>Field names (called region names in Remark Office OMR) can contain a maximum of 10 characters (including underscores). Spaces in region names will be automatically converted to underscores.</td>
</tr>
</tbody>
</table>
All region names (called region names in Remark Office OMR) must be unique.

Region names (called region names in Remark Office OMR) cannot include punctuation.

A dBase table can hold a maximum of 255 fields.

If saving data to an existing table, grid column headers (region names) in Remark Office OMR must match table region names.

When Remark Office OMR creates a dBase table, textual fields can contain a maximum of 255 characters. If you would like a field to support more than 255 characters, edit the database table in the dBase software program and change the region type from a Text region to a Memo region. Alternatively, click the Advanced button in the Save Data window and change the field type.

B.14 Paradox Formats (DB)

The Paradox Formats are proprietary to the Paradox database program by Borland International, Inc. Use a Paradox file format when exporting data to Borland's Paradox. Remark Office OMR supports Paradox version 3.X, 4.X, and 5.X file formats. Column names in Remark Office OMR are used as field names when saving to a Paradox database.

Remark Office OMR can save data to a new Paradox database or overwrite existing tables.

**Extension**

- DB

**Options**

- Primary Index: When saving to a Paradox database, you must select a region to use as the primary index.

**Limitations**

- For Remark Office OMR to save data to a Paradox table, you must select a region to use as a primary index. A primary index must contain a unique value for every record.

- For Remark Office OMR to save data to a Paradox table, the ParadoxNetStyle must be set to the selected Paradox save format. (See your Paradox database documentation for more information on the ParadoxNetStyle property.)
For Remark Office OMR to link to an existing Paradox table, the table must contain a primary index.

- All field names (called region names in Remark Office OMR) must be unique.
- A Paradox table can hold a maximum of 255 fields (columns).
- A Paradox record can hold a maximum of 10,800 bytes.
- If saving data to an existing table, grid column headers (region names) in Remark Office OMR must match table region names.
- When Remark Office OMR creates a Paradox table, textual regions can contain a maximum of 255 characters. If you would like a region to support more than 255 characters, edit the database in Paradox and change the region type from a Text region to a Memo region. Alternatively, click the Advanced button in the Save Data window and change the field type.

### B.15 Lotus Formats (WKS, WK1, WK3, WK4)

The Lotus file formats are proprietary to the Lotus 1-2-3 program by Lotus Development Corporation. Use the Lotus file formats when exporting data to Lotus 1-2-3. Remark supports the Lotus 1-2-3, WK1, WK3 and WK4 formats.

<table>
<thead>
<tr>
<th>Extension</th>
<th>WKS, WK1, WK3, WK4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Limitations</td>
<td>Data saved to a Lotus 1-2-3 version 2.0 format can have a maximum of 240 characters per cell. Remark Office OMR will display an error message (listing the cell location) if any cell exceeds 240 characters when saving to a Lotus 1-2-3 file format.</td>
</tr>
<tr>
<td></td>
<td>If a cell contains any textual data, the entire column will be saved as a string (text) rather than numeric data.</td>
</tr>
<tr>
<td></td>
<td>Data in the WK4 format can only be opened (not saved).</td>
</tr>
</tbody>
</table>
B.16 LXR Test Format (MRG)

The LXR Test format by Logic Extension Resources is a tab delimited ASCII file made for exporting data to LXR Test. The file contains a custom header followed by the data. Grid rows are delimited by a carriage return line feed sequence. Use the LXR Test format to export data to the LXR Test software package.

<table>
<thead>
<tr>
<th>Extension</th>
<th>MRG</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Limitations</td>
<td>None</td>
</tr>
</tbody>
</table>

B.17 Report Format (RPT)

The Report file format is a fixed width ASCII file. Each cell is padded, if necessary, to the specified length. Grid rows are delimited by a carriage return line feed sequence. The specified record length is written to the beginning of the file followed by the actual data.

<table>
<thead>
<tr>
<th>Extension</th>
<th>RPT</th>
</tr>
</thead>
</table>
| Options   | • Save Headers: The Save Headers option in the Save Data window will save the grid column headers (region names) as the first record in the Report data file.  
|           | • Record Length: The Record Length option in the Save Data window allows you to choose the fixed length of each piece of data written to the file. |
| Limitations | • If any cells contain data longer than the specified record length, Remark Office OMR will display an error message that lists the cell location. |

B.18 Data Interchange Format (DIF)

The Data Interchange file format is a "standard" method of exchanging data between non-compatible programs. By its nature DIF cannot support program-specific information, such as cell formats.
B.19 CCI Assessment Format (DAT)

The CCI Assessment file format is used to save data to the CCI Assessment System. This format is specific to the CCI Assessment package; please see the CCI documentation for specific information about using this format.

<table>
<thead>
<tr>
<th>Extension</th>
<th>DIF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Limitations</td>
<td>None</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Extension</th>
<th>DAT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
</tbody>
</table>
| Limitations | See CCI Assessment
documentation for information about using this format. |

B.20 XML Format (XML)

XML stands for Extensible Markup Language and is widely used for the exchange of data on the Internet.

<table>
<thead>
<tr>
<th>Extension</th>
<th>XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
</tbody>
</table>
| Limitations | Field names (called region names in Remark Office OMR) can contain a maximum of 60 characters (including spaces).
                           - Field names (called region names in Remark Office OMR) cannot include: leading spaces, periods (.), exclamation points (!), accent graves (´) and brackets ([]).
                           - An XML file can hold a maximum of 255 fields.
                           - All field names (called region names in Remark Office OMR) must be unique.
                           - An XML record can hold a maximum of 2000 characters (excluding Memo and OLE object regions). |
If saving data to an existing file, grid column headers in Remark Office OMR must match field names.

When Remark Office OMR creates an XML file, textual fields can contain a maximum of 255 characters. If you would like a field to support more than 255 characters, edit the file and change the field type from a Text field to a Memo field. Alternatively, click the Advanced button in the Save Data window and change the field type.

B.21 HTML Format (HTM, HTML)

HTML stands for Hyper Text Markup Language. Use HTML to publish data and results from Remark Office OMR to the Internet or an intranet. Remark Office OMR saves data as well as graphs for inclusion in web based documents.

<table>
<thead>
<tr>
<th>Extension</th>
<th>HTM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Limitations</td>
<td>None</td>
</tr>
</tbody>
</table>

B.22 ODBC

ODBC stands for Open Database Connectivity. Many types of databases have ODBC drivers available. To use Remark Office OMR with an ODBC driver, it must be installed and configured correctly. Consult your database documentation for configuration and installation instructions.

<table>
<thead>
<tr>
<th>Extension</th>
<th><em>.</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Limitations</td>
<td>Consult your database documentation for specific format limitations.</td>
</tr>
</tbody>
</table>
B.23 Custom (TXT, ASC)

The Custom format allows you to create a customized text file. This format is useful for exporting data into a database that has very specific requirements. The format can also be used to break apart rows of data into multiple rows. Please see Section 9.5.3 for further details about using the Custom format.

<table>
<thead>
<tr>
<th>Extension</th>
<th>TXT, ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>See Section 9.5.3</td>
</tr>
<tr>
<td>Limitations</td>
<td>See Section 9.5.3</td>
</tr>
</tbody>
</table>
Remark Office OMR Windows

Appendix C

C.1 Overview

This appendix provides pictures of the basic screens in Remark Office OMR and describes what is contained in each window. The appendix is designed to provide an overview of these windows for reference purposes. For detailed descriptions of software functions, please consult the proper chapter in this user’s guide.

Note: This appendix includes windows from the Template Editor and the Data Center. Please see the Remark Quick Stats User's Guide.pdf file under Start|Programs|Remark Office OMR 6|Documentation for detailed descriptions for the Remark Quick Stats windows.

C.2 The Remark Office OMR Template Editor

C.2.1 New Form Template Properties

Template Description: optional information about the form
Page Size: Choose the page size corresponding to the form you are scanning (must all be the same for one form template).
Orientation: Choose the orientation corresponding to the form you are scanning (must all be the same for one form template).
C.2.2 Create Page Elements

**Information button:** Hover your mouse over this button after acquiring an image to view details about the image.

**Read from scanner:** Choose this option to scan a blank form as the basis for your form template.

**Read from image files:** Choose this option to import previously scanned image files as the basis for your form template.

**Acquire Images from (Scanner/File):** After selecting the image acquisition method, click this button to acquire the image(s).

**Image Preview:** Use this window to preview your image(s). Use the icons at the bottom to move between multiple images or delete images.

**Navigation Buttons:** Use Delete to delete the current image and Delete All to delete all pages. Use the Next and Back buttons to review your images.
C.2.3 Template Editor Main Window

**Tree View:** List of elements (pages and regions) in the form template. Regions will be read in the order in which they appear here.

**Toolbar:** Contains the basic functions within the software. Hover the mouse over any button to see its function.

**Task Pane:** Displays available options in the software. The Task Pane updates automatically with new options based on the last process executed.

**Image Representation:** Displays the form image so that you can outline regions to be recognized.

**Barcode Region**

**OMR Regions**

**Image Region**
C.2.4 OMR Region Properties Window

**Region name:** Enter a name to identify the region.

**OMR type:** Select the type of OMR region: Multiple, Grid, List, Add.

**Data Type:** Select the type of data to output when exporting the processed data: Textual or Numeric.

**Region orientation:** Select whether the region is oriented in Rows or Columns.

**Columns in the region:** Enter the number of columns within the region.

**Rows in the region:** Enter the number of rows contained in the region.

**Label Scales and Labels:** Enter a label for each mark within the region. Use the Possible label scales as a shortcut to select a pre-defined range of labels.

**Values:** If using textual data, enter a corresponding value for each label. Values are used to calculate statistics and when exporting to certain file formats (e.g., SPSS).

**Define Format:** For Grid regions only, you may define the format of the data output. The delimiter (an asterisk by default) represents each character within the region. Put formatting options between these delimiters.

**Include region in read operation:** Mark this checkbox to include this region and produce output when processing forms.
C.2.5 Barcode Region Properties Window

**Region name:** Enter a name to identify the region.

**Barcode type:** Select the type of barcode you are using: Auto Detect (let Remark Office OMR determine), Code 39, Codabar, Interleaved 2 of 5.

**Include region in read operation:** Mark this checkbox to include this region and produce output when processing forms.

**Region orientation:** Select whether the barcode is oriented horizontally or vertically.

**Data Type:** Select the type of data to output when exporting the processed data: Textual or Numeric.
C.2.6 Image Region Properties Window

**Region name:** Enter a name to identify the region.

**Region type:** Select the type of Image region: Data entry (you hand enter data while looking at an image) or Image clip (the software takes a snapshot of the region).

**Data Type:** Select the type of data to output when exporting the processed data: Textual or Numeric.

**Default Fill:** Enter a value for the software to automatically place in the region for every record (data entry only).

**Auto increment fill value:** If desired, mark this checkbox to automatically increment the value entered as the Default Fill (e.g., if 1 is the default fill and you use auto increment, each record will have a sequential number in the image region).

**Attempt to detect the presence of handwriting in the region:** The software will attempt to locate handwriting/text in the region and flag the cell as needing attention (for data entry regions). For image clips, if handwriting is detected, the path will be written to the data cell.

**Include in read operation:** Mark this checkbox to include this region and produce output when processing forms.

**Image Clip Options:** Enter a target directory to store each image clip. Use the Begin names with option to name your images. If desired, add the image clip path to the data grid during processing.

**Link Region to an Existing OMR Region:** Link the region to a response from another OMR region (e.g., for an "Other" question). When processing forms, the region will be flagged for review if that answer choice is selected in the OMR region. Choose the region, question within the region and answer choice to link to the Image region.
**C.2.7 Region Item Properties Window**

Note: The items displayed may vary slightly depending on the type of region selected.

**Test Settings:** Select whether to grade or not grade the item. If using multiple answer keys for a test, you can also designate the region as the answer key identifier (e.g., Key 1, 2, 3...).

**Survey Settings:** Select whether to include or exclude the region when tabulating a survey.

**Test Point System:** If grading, choose whether the region is objective or subjective. For objective regions, enter the number of points to be awarded for correct, incorrect and unanswered questions.

**Analysis**

**Respondent ID:** Mark this checkbox to designate the region as an identifier on your reports. The value from the region will display on select reports.

**Recognition**

**Threshold:** Select a value to determine the sensitivity of the software. In most cases, you will want to use the default value of 3.

**Blank Exception Handling:** Select the output to display when a blank response is encountered. The default value is BLANK. For Grid regions, you may also customize how blank characters are flagged within the region.

**Multiple Exception Handling:** Select whether multiple responses are allowed. Select the output to display when a multiple response is encountered. The default value is MULT.

**Required item:** Mark this checkbox to make this region required, meaning it must be filled in by the respondent. Blank responses will be flagged and you can use the Review Exceptions feature to locate them.
C.2.8 Question Text and Names

Note: This screen may vary slightly depending on the type of region selected.

Question Text:
Enter descriptive text for each question. This text will appear on select reports to make them more meaningful.

Question Names:
Enter individual region names for multiple questions within an OMR region. If names are not entered here, the Region name on the OMR region properties window will be used to sequentially name each question in the region.

Use Region as a Unique Identifier:
Mark this checkbox to designate the region as an ID region. Then select whether it is a form identifier, page identifier or respondent identifier.

ID Value:
Enter the unique value that identifies this region. If using a barcode, you may click the Recognize button to have the software read the barcode.

Insert ID data into the grid during the read process:
Mark this checkbox to have the value obtained during processing be displayed in the data grid.
C.2.10 Database Lookup

**Use Database Lookup:** Mark this checkbox to link the region to an external database for data verification and the extraction of data from the database.

**Type:** Select the type of external database to which you are linking. Click the Browse button to locate the database.

**DSN:** If using ODBC, select the database from the DSN list. Select whether it is directory or DSN based (see your database administrator for this information).

**Connect Authorization:** If the database is password protected, enter a username and password.

**Connect to Database:** Click this button to connect to the specified database.

**Table:** Select the table within the database that contains the information you wish to link to the region.

**Lookup:** Select the field in the external database to lookup. The software will validate the processed data against this field.

**Replace:** Select the field in the external database to use as a replacement for the data is processed. If you only want to verify data, use the same lookup and replace fields.

**Additional Return Fields:** Optionally select additional fields in the database to add to your processed data. You can also specify a name for the field and whether to use it as an Analysis Respondent ID on your reports.
C.2.11 Reset Images

**Image Representation:** Displays the form image that you acquire. Use the Delete button to remove images. Use the Next and Previous Page buttons to between pages.

**Read from scanner:** Choose this option to scan a blank form to replace the current image(s).

**Read from image files:** Choose this option to import previously scanned image files to replace the current image(s).

**Acquire Images from (Scanner/File):** After selecting the image acquisition method, click this button to acquire the image(s).

**Page Details:** Displays information about the currently selected page of the form template.

**Navigation Buttons:** Use Delete to delete the current image and Delete All to delete all pages. Use the Next and Back buttons to review your images.
C.2.12 Template Editor Preferences – General

Note: All preferences are default settings to make form template creation faster. However, you can change settings on a region by region basis any time.

Default region name: Specifies a value to use for each region name by default.

Format delimiter: Specifies a symbol to display in the OMR Region Properties window when formatting grid regions. This symbol represents the characters in your expected response.

Perform logging: Maintains a log file should the program terminate unexpectedly. The log file will recover any lost work. Under most circumstances, you will want to leave this option on.

Dictionary location: Specifies the location of spelling dictionaries on your computer.

Active dictionary: Specifies the dictionary to use when using the Spell Check feature.
C.2.13 Template Editor Preferences – OMR Regions

Note: All preferences are default settings to make form template creation faster. However, you can change settings on a region by region basis any time.

**OMR type:** Specifies a default OMR region type to be used when creating new OMR regions.

**Data type:** Specifies a default data type (Textual or Numeric) to be used when creating new OMR regions.

**Orientation:** Specifies the default orientation (Row or Column) to be used when creating new OMR regions.

**Threshold:** Specifies the default threshold to use for recognition. The range is 1-6, with 1 being the most sensitive and 6 being the most discriminate.

**Regions to Grade:** Specifies the regions types to grade in Remark Quick Stats by default.

**Regions to Tabulate:** Specifies the region types to tabulate in Remark Quick Stats by default.

**Default Multiple Exception Handling:** Specifies what to output for multiple responses for Multiple/List or Grid regions. The default output is MULT.

**Default Blank Exception Handling:** Specifies what to output for blank responses for Multiple/List or Grid regions. The default output is BLANK. You may also customize blank flags for Grid regions.
C.2.14 Template Editor Preferences – Image Regions

Note: All preferences are default settings to make form template creation faster. However, you can change settings on a region by region basis any time.

**Image type:** Specifies a default Image region type to be used when creating new Image regions. (Data Entry to hand enter data or Image Clip to capture snapshot images).

**Data type:** Specifies a default data type (Textual or Numeric) to be used when creating new Image regions.

**Threshold:** Specifies the default threshold to use for recognition. The range is 1-6, with 1 being the most sensitive and 6 being the most discriminate.

**Target directory:** Specifies a default path for storing Image Clips.

**Grade region:** Specifies whether to grade Image regions in Remark Quick Stats by default.

**Tabulate region:** Specifies whether to tabulate Image regions in Remark Quick Stats by default.
C.2.15 Template Editor Preferences – Barcode Regions

Note: All preferences are default settings to make form template creation faster. However, you can change settings on a region by region basis any time.

- **Orientation**: Specifies the default orientation (Horizontal or Vertical) to be used when creating new Barcode regions.
- **Data type**: Specifies a default data type (Textual or Numeric) to be used when creating new Barcode regions.

**Grade region**: Specifies whether to grade Barcode regions in Remark Quick Stats by default.

**Tabulate region**: Specifies whether to tabulate Barcode regions in Remark Quick Stats by default.
C.3 The Remark Office OMR Data Center

C.3.1 Data Center Main Window

**Task Pane:** Displays available options in the software. The Task Pane updates automatically with new options based on the last process executed.

**Data Grid:** This grid displays all processed data. Each respondent’s form appears in one grid row, regardless of how many pages the form contains. Each column represents one region in your form template.

**Toolbars:** Contains the basic functions within the software. Hover the mouse over any button to see its function.

**Form Template/Data Name:** Displays the name of the active form template and data file. If a data file is open, its name is listed in brackets.

**Image Viewer:** Displays the corresponding image of each processed form when a cell in the grid is clicked.
C.3.2 Read Wizard - Read Method

**Read from scanner:** Mark this radio button to scan pages with the selected form template file. Use the Scanner Properties link to view/modify scanner settings, if necessary.

**Read from image files:** Mark this radio button to read forms from existing image files. Use the Advanced Image Recognition Properties link to configure reading options, if necessary.

**Server Mode:** Mark this checkbox to scan in Server Mode, providing unattended scanning or image processing.

**Auto Form ID Mode:** Mark this checkbox to scan in Auto Form ID mode, where the software will match each form to its form template. *You must have Form IDs on each page.

**Collate Mode:** Mark this checkbox to scan double sided forms with a simplex scanner. The software will collate the data.

**Resume last Collate Mode session:** Mark this checkbox to resume the previous Collate Mode session.

**Start reading from template page:** Mark this checkbox to read on the current grid row beginning at a specific form template page. This feature is useful for overwriting data.
C.3.3 Read Wizard - Scanned Image Naming Conventions

**Begin image names with:** Enter a base name for the stored image files of each form. The form template name is recommended.

**Image target directory:** Select a location on your computer or network to store the image files of each scanned form.

**Save images in a subfolder based on the form template's name:** Mark this checkbox to store the images for this form template in a subfolder with the form template's name. This feature is useful for image organization.

**Image target directory:**
- C:\Program Files\Principle Products\Remark Office OMR 6\Images
- Browse...

**Saved image type:** Select a format for the stored images: PCX, TIF or PDF (to use PDF, support must be enabled in the Preferences).

**Image compression level:** For TIF and PDF formats, choose a compression level for the stored images.

**Save multiple page form templates as multiple page image files:** For multi-page templates, mark this checkbox to store one respondent's complete form images as one file.

Please note that image names will also contain the date and time when they were processed as well as the corresponding form template page if applicable.
C.3.4 Read Wizard - Image Selection Window

**Folder containing images** Select a folder containing the images you wish to process.

**Available Images:** A list of images in the folder designated in the Select the Images to Read drop-down list.

**Images in Read Order:** The list of images that will be processed once you click the Read button. Images will be processed in the order in which they appear in this list.

**Supported Image Types:** Listing of supported image file formats. You may select a specific format from the list to narrow down the image types that appear in the available images box.

**Add Selected Images** Click this button after selecting an image or images from the available images list to move the image(s) to the Images in Read Order list.

**Add All Images** Click this button to add all images from the available images list to the Images in Read Order list.
C.3.5 Read Wizard - Review Exceptions

Review unrecognized images when using region tracking: Mark this checkbox to review images containing unrecognized Form, Page or Respondent ID regions. If not selected, images will go into a queue for later review.

Activate Review Exceptions: Mark this checkbox to review exception cases during scanning or image processing. Then select the checkboxes corresponding to the type of exceptions you want to review.

C.3.6 Server Mode (Reading from Image Files)

Note: Reading from scanner in Server Mode is the same as C.3.3 Read Wizard - Scanned Image Naming Conventions

Image Source Directories: Use the Add Directory and Delete Directory buttons to select directories containing the images you wish to have the software process.

Image Filters: Select a filter representing the types of images you wish to process. Or, create a custom filter and then click the Add button to add it to the Image Filters window.

Delete images after they have been processed: Use this option to delete images once they are processed. Images will be permanently deleted from the specified directory.
C.3.7 Respondent Detection

**Regions available for detection:** Select a filter representing the types of images you wish to process. Or, create a custom filter and then click the Add button to add it to the Image Filters window.

**Database Field List/Additional Fields:** If desired, add additional fields to your report by selecting them in the Database Field List and moving them to the Additional Fields list using the green arrows.

**Field from Database:** This column contains the values from the linked field in your external database.

**Detected:** This column contains the data that was processed and is present in the external linked database.

**Duplicates:** This column contains data that was processed more than once (and exists in the external linked database).

**Export:** Click the down arrow to export missing, detected or duplicate data values found during form processing.

---

C.3.8 Review
Exceptions

Review Exceptions: Mark the checkboxes corresponding to the types of exceptions you wish to review.

Search by: Use Row/Respondent to search across respondent rows or Column/Item to search by column.

Response for: Shows the type of exception encountered. Use the drop-down list or textbox to enter the appropriate response.

Next/Back: Use the green arrows to go to the next or previous exception case in the selected search region.

Data Grid: Shows the current exception case.

Image Viewer: Use the Image Viewer to assist with determining why the exception case occurred and to make appropriate changes.

Finished: Click this button to end Review Exceptions.
C.3.9 Batch Wizard

**Primary Form Template:** Use the Look in box to find a form template to use for processing your main data form. Select the form template from the resulting list and then click Add File(s) to move it to the Primary Form Template box.

**Batch Header Form Templates:** Use the Look in box to find a form template to use as a batch header form. Select the form template from the resulting list and then click Add File(s) to move it to the Batch Header Form Template box.

**Specify a Batch File Name:** The form templates selected in the previous two steps will be combined to form a batch template. Enter a name in the File name box and leave the Files of type set to Remark Office Batch Files.
C.3.10 Unrecognized Images Utility

**Form Templates:** Use this drop-down list to match an image to its form template if the form is not automatically recognized.

**Pages:** Use this drop-down list to match an image to its form template page if the form page is not automatically recognized.

**Respondent Tracker:** Enter the appropriate Respondent Tracker information for the current image if it is not automatically recognized.

**Details:** Shows the details about the form template and/or pages.

**Read:** After entering the Form Template, Page or Respondent Tracker, click the Read button to process the information.

**Image Viewer:** Use the Image Viewer to view the problematic region (Form, Page or Respondent) and make the appropriate adjustments.
C.3.11 Scanner Properties

**Scanner Type:** Use the drop-down list to select your scanner type: TWAIN or ISIS. TWAIN is recommended.

**Source:** After selecting a Scanner Type, click the Source button to choose your specific scanner. If no sources are listed, you need to install a driver for your scanner.

**Use legacy driver:** Use this checkbox for older scanner drivers (only recommended if you experience difficulties with the software recognizing your scanner).

**Parameters:** If not showing the scanner’s user interface, select the scanning resolution and brightness.

**Scan Options:** Use the Invert image drop-down list to compensate for images that appear as black background with white text (inverted). Use the Auto Deskew and Auto Despeckle options if your images look skewed or have speckles on them (we only recommend turning these options on if you experience these problems). To scan in duplex mode, mark the checkbox for Scan duplex. To show your scanner’s scanning interface, mark the checkbox for Show TWAIN interface (highly recommended the first time you scan and if the scanner is used in other applications).

**Hardware Options:** Select the type of scanner you are using: Flatbed only, ADF (sheetfeeder) only or Flatbed and ADF. Mark the Center Feed box to have each page aligned with the center of the ADF. If using a duplex scanner (one that scans two-sided pages in one pass), mark the checkbox for Duplex scanner.

**Rotate front/back side:** Use these options if your images are improperly rotated when scanning (especially for landscape and duplex forms).
C.3.12 Preferences - General

**Shade alternate grid rows to look like:**
Mark this checkbox to shade every other row in the template grid. Click the paint bucket to choose a shading color.

**Use Legacy Analysis as your Default Analysis Tool:**
Mark this checkbox to use the Remark Quick Stats from version 5 of the software instead of the new reporting tool.

**Update the Image Viewer During Read Operations:**
Mark this checkbox to update the Image Viewer window with each processed form.

**Auto search the response combo box when typing:**
Mark this checkbox to have the software look at the first letter(s) you type in the Review Exceptions window and then auto fill the appropriate response if possible.

**Play sound on review exceptions startup:**
Mark this checkbox to have a sound alert you when the Review Exceptions feature is started.

**Play sound when an exception case is located:**
Mark this checkbox to play a sound each time Review Exceptions finds an exception case. Click the note icon to choose a .wav file.

**Maximum length for a value in a data grid cell:**
Enter the maximum length to allow for any individual cell in the data grid. Note that large amounts of text can slow performance.

**Replace missing data values with:**
Enter a value to use for missing data. Missing data are any data that do not match what was defined in the template (e.g., BLANK, MULT, etc.).

**System poll interval during Server Mode (secs):**
Enter the number of seconds between attempts to poll the scanner for pages or a user-specified directory for images when using Server Mode.
C.3.13 Preferences - File Storage Locations

Home Directories:
Select a directory from the list and then click the Modify button to setup a default directory to be used when searching for the specified file type.

Image Directory Search List: Use the Add Directory button to add directories containing images to the list. Remark Office OMR will use the directories in list order to search for stored images when opening data files.

Active dictionary:
Select a dictionary to use as your active dictionary when running Spell Check.
C.3.14 Preferences - Recognition

Use Enhanced Reading Mode: Use this option to enable options that perform more in depth recognition of uncertain fields.

Override OMR Region Thresholds: Use this setting to override all form template settings for OMR region thresholds. Use a lower setting to read light/less filled marks. Use a higher setting to better discriminate among dark marks.

Override Image Region Thresholds: Use this setting to override all form template settings for Image region thresholds. Use a lower setting to read light/less filled areas. Use a higher setting to compensate for false positives.

Bit Depth Conversion Threshold: Use this setting to adjust pixel depth on images that are scanned in color or grayscale. Remark Office OMR converts the image to black and white for recognition purposes. You can adjust the resulting image quality by raising or lowering the threshold value. A lower threshold will create a darker image and a higher threshold will create a lighter image.

Default image clip file type: Select a file type for storing Image Clips: PCX, TIF or PDF.

Image compression level: If using the TIF or PDF formats, specify a compression level: Uncompressed, Group 3, Group 3 2d or Group 4 (most compressed).

Enable PDF Image File Support: Mark this checkbox to enable PDF support. Once enabled, you can save image files and image clips to the PDF format and read PDF files into the software.

Note: PDF support is optional. If you choose to enable PDF support you will need to restart the application before the change will take effect. Enabling PDF support causes the software to use more system memory while it is running. If you are using a system with limited memory and free resources, we recommend turning off this feature.
Understanding Error Messages

Appendix D

D.1 Error Message Details

This appendix details the different error messages in Remark Office OMR. Use this appendix to gain a better understanding of any problems that may arise while using the software. The following table lists error class, error category, error number and the error text.

<table>
<thead>
<tr>
<th>Class #</th>
<th>Category</th>
<th>Error #</th>
<th>Error Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>0100</td>
<td>Memory Errors</td>
<td>100-106</td>
<td>Not enough memory to perform specified operation. Close other applications to free up more memory or restart Windows.</td>
</tr>
<tr>
<td>0200</td>
<td>Windows Errors</td>
<td>200-206</td>
<td>Windows function errors (internal to Remark Office OMR). Could signify that the Windows environment is functioning improperly. Close other software applications and restart Windows.</td>
</tr>
<tr>
<td>1000</td>
<td>File Open Errors</td>
<td>1001-1012</td>
<td>Remark Office OMR could not open the specified file. The file no longer exists or could not be opened for an unknown reason. Possible causes could be: a full hard drive, an inaccessible network drive, or the file is being used by another application.</td>
</tr>
<tr>
<td>1100</td>
<td>File Read Errors</td>
<td>1101-1103</td>
<td>Error reading the specified file. Possibly indicates a corrupt file. Possible causes could be a full hard drive, an inaccessible network drive, or the file is being used by another application.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------</td>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1200</td>
<td>File Write Errors</td>
<td>1201-1214</td>
<td>Error occurred while writing file to disk. Possible causes could be a full hard drive, an inaccessible network drive, or the file is being used by another application.</td>
</tr>
<tr>
<td>1300</td>
<td>File Access Errors</td>
<td>1301-1310</td>
<td>Error occurred while attempting to access a file. The file may be damaged. Possible causes could be a full hard drive, an inaccessible network drive, or the file is being used by another application.</td>
</tr>
<tr>
<td>1400</td>
<td>File Close Errors</td>
<td>1401-1403</td>
<td>An error occurred while trying to close a file. Check the amount of free disk space. Possible causes could be a full hard drive, an inaccessible network drive, or the file is being used by another application.</td>
</tr>
<tr>
<td>1500</td>
<td>File Creation Errors</td>
<td>1501-1502</td>
<td>An error occurred while trying to create a file. Check the amount of free disk space. Possible causes could be a full hard drive, an inaccessible network drive, or the file is being used by another application.</td>
</tr>
<tr>
<td>1600</td>
<td>View Image Errors</td>
<td>1600-1610</td>
<td>Not enough memory or disk space available to perform the view image operation. Free up more memory by closing other applications or restarting Windows.</td>
</tr>
<tr>
<td>1700</td>
<td>Miscellaneous File</td>
<td>1700-1703</td>
<td>A file cannot be accessed due to a bad name or path. Check that the file name is valid and that the target directory can be accessed from your system.</td>
</tr>
<tr>
<td></td>
<td>Errors</td>
<td>1704</td>
<td>A file has already been opened by Remark Office OMR or by some other application and cannot be opened again. Close other applications using this file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1705</td>
<td>The disk is full. Delete some files or try saving to another location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1706</td>
<td>Too many files are currently open on your system. Close some applications and try the operation again.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------</td>
<td>-----------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1707</td>
<td>Permission was denied or the disk was not ready when trying to write the file.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1707-1708</td>
<td>Permission was denied or the disk was not ready when trying to write the file.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td>Graphics File Errors</td>
<td>2001-2005</td>
<td>The graphics file selected is not of a type recognized by Remark Office OMR. Check to see that it is a supported file type.</td>
</tr>
<tr>
<td>2001-2005</td>
<td>The graphics file selected is not of a type recognized by Remark Office OMR. Check to see that it is a supported file type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2006-2015</td>
<td>Error encountered while processing the graphics file. File may not be a type recognized by Remark Office OMR or may be corrupted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2006-2015</td>
<td>Error encountered while processing the graphics file. File may not be a type recognized by Remark Office OMR or may be corrupted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2016-2031</td>
<td>Error encountered while processing the .TIF graphics file.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2016-2031</td>
<td>Error encountered while processing the .TIF graphics file.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3000</td>
<td>Form Template Training Errors</td>
<td>3000</td>
<td>The number of rows specified does not match the number of labels specified. Check to ensure that your marks (bubbles, checkboxes) are not degraded.</td>
</tr>
<tr>
<td>3001</td>
<td>The number of columns specified does not match the number of labels specified. Check to ensure that your marks (bubbles, checkboxes) are not degraded.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3004-3005</td>
<td>The number of rows and columns found does not agree with the number found in the region. The specified region orientation could be incorrect. Check to ensure that your marks (bubbles, checkboxes) are not degraded.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3004-3005</td>
<td>The number of rows and columns found does not agree with the number found in the region. The specified region orientation could be incorrect. Check to ensure that your marks (bubbles, checkboxes) are not degraded.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3006</td>
<td>The software could not locate a region that matches the description specified in the OMR Region Properties window. Could indicate that the page was not scanned correctly (skewed, upside down...).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3006</td>
<td>The software could not locate a region that matches the description specified in the OMR Region Properties window. Could indicate that the page was not scanned correctly (skewed, upside down...).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3008</td>
<td>No marks were found in the region. Reselect the region.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3008</td>
<td>No marks were found in the region. Reselect the region.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3009</td>
<td>Incorrect region definition. The number of columns and rows are reversed or the label location selection is incorrect.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3009</td>
<td>Incorrect region definition. The number of columns and rows are reversed or the label location selection is incorrect.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------</td>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3010-</td>
<td>A border of your region definition is touching your marks. Adjust the border.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3013</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3018</td>
<td>An invalid number was specified for the number of rows contained in the region. Check to ensure that your marks (bubbles, checkboxes) are not degraded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3019</td>
<td>An invalid number was specified for the number of columns contained in the region. Check to ensure that your marks (bubbles, checkboxes) are not degraded.</td>
</tr>
<tr>
<td>3100</td>
<td>Recognition Errors</td>
<td>3100</td>
<td>Cannot locate the region on the page. Possible causes may be a skewed or offset page, form design, or a degraded image.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3101</td>
<td>The image is degraded. Cannot locate marks. Possibly scanned incorrectly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3102</td>
<td>Multiple answers were entered for a region in which multiple responses were not permitted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3103</td>
<td>No response was given.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3104</td>
<td>Unable to locate the region on the page. Possible causes: scanning a page that is smaller than the form template or scanning pages with the wrong template.</td>
</tr>
<tr>
<td>3200</td>
<td>Barcode Errors</td>
<td>3200</td>
<td>Unable to recognize barcode. Check to ensure it is a supported barcode type. If using the Code 3 of 9 barcode type, make sure that you used the required beginning and ending asterisks in your barcode.</td>
</tr>
<tr>
<td>4000</td>
<td>Scanner Errors</td>
<td>4000</td>
<td>The scanner is not ready. Check to make sure it is connected correctly and that the power is turned on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4001</td>
<td>No scanner is selected. A scanner cannot be used until it is selected in the Scanner Properties window.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4014</td>
<td></td>
<td></td>
<td>The HP or compatible scanner reports a lamp error. Make sure the bulb is working and remove any paper from the flatbed.</td>
</tr>
<tr>
<td>4020</td>
<td></td>
<td></td>
<td>The ISIS scanner is not ready. Make sure the scanner is connected properly and that the power switch is turned on.</td>
</tr>
<tr>
<td>4021</td>
<td></td>
<td></td>
<td>The ISIS scanner reports a communication error. Make sure the power switch is turned on and that the cables are connected properly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Cycle the power switch and wait for the READY light to come on.</td>
</tr>
<tr>
<td>4022</td>
<td></td>
<td></td>
<td>The ISIS scanner reports a parameter error prior to reading. Make sure a valid height, width, and resolution are being used.</td>
</tr>
<tr>
<td>4023-4026</td>
<td></td>
<td></td>
<td>ISIS parameter error. An invalid parameter was specified. Check selected page size and resolution.</td>
</tr>
<tr>
<td>4027</td>
<td></td>
<td></td>
<td>Remark Office OMR is unable to use the ISIS driver because it is either out of date or lacks the correct permissions file.</td>
</tr>
<tr>
<td>4100</td>
<td>TWAIN Errors</td>
<td>4100</td>
<td>No TWAIN sources are available on your system. Make sure that sources have been installed correctly. Check the documentation that came</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>with your scanner for more details on installing it.</td>
</tr>
<tr>
<td>4101</td>
<td></td>
<td></td>
<td>Could not select the specified source (scanner). Check that the source has been installed correctly.</td>
</tr>
<tr>
<td>4102</td>
<td></td>
<td></td>
<td>Could not communicate with the TWAIN source manager. Make sure that the file TWAIN_32.DLL is in your Windows directory.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>4103</td>
<td></td>
<td></td>
<td>Could not open the specified TWAIN source. Make sure that the scanner and scanner driver are installed correctly.</td>
</tr>
<tr>
<td>4104-4105</td>
<td></td>
<td></td>
<td>The specified source (scanner) is not compatible with Remark Office OMR. The capabilities of the source and Remark Office OMR are not compatible.</td>
</tr>
<tr>
<td>4106</td>
<td></td>
<td></td>
<td>Error transferring the image file to Remark Office OMR. Check to make sure there is enough memory and disk space.</td>
</tr>
<tr>
<td>4107</td>
<td></td>
<td></td>
<td>The specified source (scanner) is not compatible with Remark. The source is not capable of providing data to Remark in the appropriate format.</td>
</tr>
<tr>
<td>4108</td>
<td></td>
<td></td>
<td>The TWAIN source (scanner) returned an invalid image size (height or width set to zero). Reset the source’s image size information on the source’s user interface.</td>
</tr>
<tr>
<td>4109</td>
<td></td>
<td></td>
<td>Remark Office OMR and the TWAIN source have fallen out of sync. Terminate the current operation and retry.</td>
</tr>
<tr>
<td>4110</td>
<td></td>
<td></td>
<td>The TWAIN source did not close correctly. Check to make sure your scanner is installed properly.</td>
</tr>
<tr>
<td>4111-4112</td>
<td></td>
<td></td>
<td>The TWAIN32.DLL file could not be found. Make sure that the file TWAIN32.DLL is located in your Windows directory.</td>
</tr>
<tr>
<td>4113</td>
<td></td>
<td></td>
<td>The specified TWAIN Source could not be enabled. Not all TWAIN drivers allow showing/hiding of their User Interface. Try changing your selection for the Show TWAIN interface option in the Scanner Properties window.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>6000</td>
<td>Output File Errors</td>
<td>6000</td>
<td>Error saving because the template grid contains no data. You cannot save an empty grid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6001</td>
<td>Error saving the data because the specified data do not correspond to the selected form template file. The data may contain misplaced characters, such as: commas, periods, semicolons and parentheses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6002-6005</td>
<td>Error saving the data in the selected file format because a cell exceeds the maximum size for storage. Edit the text in the grid or save to another file format. Some file formats maintain a maximum cell size, question number, etc. (See Section 9.5 Saving Grid Data.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6006</td>
<td>Too many questions to save in dBase (.DBF) format. Maximum of 128 questions permitted. Try saving the data to another file format.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6007</td>
<td>Too much data to save in dBase (.DBF) format. Maximum of 4,000 bytes per record. Try saving the data to another file format.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6008-6009</td>
<td>Unable to save to Fixed (.SDF) file format because responses are not of a fixed size. Data in each column must contain the same number of bytes. For example, if the possible answers for a question are 1 - 10, you should set the region up using the labels: 01, 02, 03... ...09, 10 so that each answer item will contain two bytes.</td>
</tr>
<tr>
<td>6100</td>
<td>File Import Errors</td>
<td>6100-6104</td>
<td>Error importing specified file format. Incompatible data encountered during the conversion.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>6105</td>
<td></td>
<td></td>
<td>The data contained in the data file do not correspond to your form template file. The data were truncated. The data file contains more grid columns than the current template grid. Make sure you have selected the correct form template and data file.</td>
</tr>
<tr>
<td>6106-6108</td>
<td></td>
<td></td>
<td>Error importing SPSS (.SAV) file format. Note that SPSS reformats data when saving; consequently, data saved as compressed in SPSS may not import back into Remark Office OMR.</td>
</tr>
<tr>
<td>6109-6110</td>
<td></td>
<td></td>
<td>Error importing the Fixed (.SDF) format file.</td>
</tr>
<tr>
<td>7000</td>
<td>Database Memory Errors</td>
<td>7000</td>
<td>The application doesn't have enough memory or resources to complete the selected database operation. Close other applications, files and windows to free up more memory or restart Windows.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7001</td>
<td>You have reached the limit on the number of files that can be opened at one time. Close one or more files, and then try the operation again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7002</td>
<td>You have reached the limit on the number of tables and/or databases that can be opened at one time. Close one or more tables and then try the operation again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7003</td>
<td>The database has reached its maximum size. To add data to this database, you must first reduce its size by deleting data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7004</td>
<td>You tried to add new records to a Microsoft Excel version 3 or version 4 file, but the file is full. Files of these types can hold a maximum of 16,384 records.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>7005</td>
<td></td>
<td>7005</td>
<td>You tried to perform a Btrieve operation that involves too many Memo or OLE object regions. Reduce the number of Memo and OLE object regions, and then try the operation again.</td>
</tr>
<tr>
<td>7006</td>
<td></td>
<td>7006</td>
<td>You tried to perform an operation that involves more than 255 regions. Reduce the number of regions, and then try the operation again.</td>
</tr>
<tr>
<td>7100</td>
<td>Database Syntax</td>
<td>7100</td>
<td>A syntax error occurred. Check the data to make sure they were entered correctly. This can occur if an incorrect value type is provided as part of an expression. For example, textual data entered into a numeric region.</td>
</tr>
<tr>
<td>7101</td>
<td>Syntax Errors</td>
<td>7101</td>
<td>Unable to locate specified table, region or index. Check the name to make sure it was entered correctly then retry the operation.</td>
</tr>
<tr>
<td>7102</td>
<td></td>
<td>7102</td>
<td>The specified file, table or region name doesn't follow standard naming conventions. Enter a new name, and then try the operation again. Consult your database's documentation for information on valid names and naming limitations.</td>
</tr>
<tr>
<td>7200</td>
<td>Database Read</td>
<td>7200</td>
<td>You tried to access a database that is currently in use by another user or application. Wait for the other user or application to finish working with the database, and then try the operation again.</td>
</tr>
<tr>
<td>7201</td>
<td>Read Errors</td>
<td>7201</td>
<td>An error occurred updating the database. The database, file, table or field is defined as read-only.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>--------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>7202</td>
<td></td>
<td>7202</td>
<td>An error occurred accessing the specified path or filename. The path or filename is not valid. Check the name and path to make sure they were entered correctly then retry the operation.</td>
</tr>
<tr>
<td>7203</td>
<td></td>
<td>7203</td>
<td>A permissions error occurred accessing the specified database, table or object. You don't have the necessary permissions. Contact the database administrator regarding access rights.</td>
</tr>
<tr>
<td>7204</td>
<td></td>
<td>7204</td>
<td>A file, disk or network access error occurred. Resolve the error condition and then retry the operation.</td>
</tr>
<tr>
<td>7205</td>
<td></td>
<td>7205</td>
<td>An error occurred attempting to create the database, table or object because it already exists. This error can also occur if an ODBC database contains several tables with the same name.</td>
</tr>
<tr>
<td>7206</td>
<td></td>
<td>7206</td>
<td>An error occurred attempting to open or access the database file. The file is either invalid or corrupt.</td>
</tr>
<tr>
<td>7207</td>
<td></td>
<td>7207</td>
<td>An error occurred trying to access a necessary database file or table. Resolve the error condition and then retry the operation.</td>
</tr>
<tr>
<td>7208</td>
<td></td>
<td>7208</td>
<td>An attempt was made to import or attach to an empty text file. To import or attach a text file, the file must contain data.</td>
</tr>
<tr>
<td>7209</td>
<td></td>
<td>7209</td>
<td>You tried to perform an operation that would have violated referential integrity rules for related tables.</td>
</tr>
<tr>
<td>7210</td>
<td></td>
<td>7210</td>
<td>The installable ISAM you are using does not allow updates and/or deletes to records in external tables. You can add new records, though.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>7211</td>
<td></td>
<td>7211</td>
<td>You cannot use ODBC to access an external Microsoft Access or ISAM database table. Use Remark Office OMR’s direct support of the database instead.</td>
</tr>
<tr>
<td>7300</td>
<td>ODBC Errors</td>
<td>7300</td>
<td>Using ODBC, you tried to perform an operation on data in a SQL database. This error may occur when the SQL database is on a network drive and the network is not connected or when the path specified is invalid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7301</td>
<td>An error occurred attempting to update the ODBC table. Possible causes could be the database is read-only, the database is on a network drive and the network is not connected or the update would have caused a rule violation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7302</td>
<td>The ODBC remote query timeout expired. The ODBC server may not be properly installed, or a required network connection isn't active. Check the network connection or contact your system administrator, and then try the operation again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7303</td>
<td>The ODBC table definition has changed since you created the link. End the current operation and then retry.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7304</td>
<td>An error occurred attempting to lock records in the ODBC database. All records in the database cannot be locked.</td>
</tr>
<tr>
<td>7400</td>
<td>Database Index Errors</td>
<td>7400</td>
<td>An error occurred attempting to create an index for the database because the index already exists.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7401</td>
<td>An error occurred trying to create an index because the index definition is invalid.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Class #</th>
<th>Category</th>
<th>Error #</th>
<th>Error Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>7402</td>
<td></td>
<td>7402</td>
<td>An error occurred adding a record to the table or updating the table because the current record contains an invalid value in the region(s) defined as the primary key.</td>
</tr>
<tr>
<td>7403</td>
<td></td>
<td>7403</td>
<td>An error occurred making changes to the table because of a duplicate value in a field that is the underlying table's primary key or an index that doesn't allow duplicates. The changes were unsuccessful.</td>
</tr>
<tr>
<td>7404</td>
<td></td>
<td>7404</td>
<td>The operation you attempted requires a (primary) database index. An index was not found. The operation was unsuccessful. Create a primary index for this database and then retry the operation.</td>
</tr>
<tr>
<td>7405</td>
<td></td>
<td>7405</td>
<td>An error occurred creating the index. Possible causes: the key fields are named improperly, there are duplicate records based on this index or there were too many indexes already defined.</td>
</tr>
<tr>
<td>7406</td>
<td></td>
<td>7406</td>
<td>An error occurred deleting the index. The current index cannot be deleted.</td>
</tr>
<tr>
<td>7500</td>
<td>Database</td>
<td>7500</td>
<td>An error occurred initializing the database engine due to invalid initialization or registry settings or an engine conflict.</td>
</tr>
<tr>
<td></td>
<td>Registry Errors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7501</td>
<td></td>
<td>7501</td>
<td>Unable to locate current record. Move to or select another record, and try the operation again.</td>
</tr>
<tr>
<td>7502</td>
<td></td>
<td>7502</td>
<td>You tried to use a Paradox table, but the table's associated lock (.LCK) file is outdated. Delete the .LCK file and then try the operation again.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>7503</td>
<td></td>
<td>7503</td>
<td>An unexpected error occurred when you tried to access data in an attached Btrieve table. Try the operation again, or contact your system administrator or network administrator.</td>
</tr>
<tr>
<td>7504</td>
<td></td>
<td>7504</td>
<td>You tried to perform an operation that requires the Btrieve engine. To access Btrieve files, you must have purchased and installed a copy of the stand-alone Btrieve for Windows engine. This file must be in your Windows System directory.</td>
</tr>
<tr>
<td>7505</td>
<td></td>
<td>7505</td>
<td>Cannot perform this operation with an unsupported database version. Convert the file you want to use to a supported version and/or data type and then retry the operation.</td>
</tr>
<tr>
<td>7506</td>
<td></td>
<td>7506</td>
<td>The operation stopped before its normal completion. Some data changes may not have been saved.</td>
</tr>
<tr>
<td>7507</td>
<td></td>
<td>7507</td>
<td>The external database driver returned an error. This error can be caused by performing an operation not supported on this type of external database.</td>
</tr>
<tr>
<td>7508</td>
<td></td>
<td>7508</td>
<td>The database you are attempting to use has an unspecified problem and, as a result, it is marked as corrupt.</td>
</tr>
<tr>
<td>7600</td>
<td>Database Record Errors</td>
<td>7600</td>
<td>The database you are attempting to use has an unspecified problem and, as a result, it is marked as corrupt.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7601</td>
<td>You defined a table with records larger than can be supported. Redefine the table by making some regions shorter or by removing unneeded regions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7602</td>
<td>A field error occurred due to a data type conflict or an invalid data type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7603</td>
<td>An error occurred saving a field value. The value specified is invalid.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>7604</td>
<td></td>
<td></td>
<td>The specified table doesn't contain the specified field(s). Check the spelling of the region name(s) in the form template.</td>
</tr>
<tr>
<td>7605</td>
<td></td>
<td></td>
<td>None of the import region names matches fields in the associated table. At least one region name in the import table and one field name in the appended table must match.</td>
</tr>
<tr>
<td>7606</td>
<td></td>
<td></td>
<td>An error occurred creating the table or appending the field because more than one field was defined with the same name. Each field name in a table must be unique. Check the region name(s) specified in the form template.</td>
</tr>
<tr>
<td>7607</td>
<td></td>
<td></td>
<td>You referred to a record that you deleted or that another user in a multi-user environment deleted. Move to another record, and then try the operation again.</td>
</tr>
<tr>
<td>7608</td>
<td></td>
<td></td>
<td>You attempted to import an invalid range of spreadsheet cells.</td>
</tr>
<tr>
<td>7609</td>
<td></td>
<td></td>
<td>The first row of data contains invalid region (field) names, such as quoted and unquoted strings in the same field name. Check the import table for properly matched quotation marks, and then try the import operation again.</td>
</tr>
<tr>
<td>7610</td>
<td></td>
<td></td>
<td>An error occurred creating the table or index definition because it does not contain any fields.</td>
</tr>
<tr>
<td>7611</td>
<td></td>
<td></td>
<td>An error occurred attempting to change a table or field definition because the object has already been appended to the corresponding object.</td>
</tr>
<tr>
<td>7612</td>
<td></td>
<td></td>
<td>An error occurred attempting to delete a field. You can't delete a field included in an index. To delete a field that is part of an index, you must first delete the index.</td>
</tr>
<tr>
<td>Class #</td>
<td>Category</td>
<td>Error #</td>
<td>Error Text</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>7613</td>
<td>Text file specification field separator matches decimal separator or text delimiter. Two or more delimiters settings used by the Text ISAM are the same.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9000</td>
<td>Miscellaneous Program Errors</td>
<td>9000</td>
<td>These miscellaneous errors signify an internal problem or undocumented error type. Please report any reproducible occurrences of these errors to Principia Products Technical Support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9101</td>
<td>The DLL could not be loaded because it could not be located on your system. Make sure all required DLL files are in directories where they can be found. Uninstall and reinstall the software.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>active</td>
<td>A term that refers to the window to which the next keystroke or command applies.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASCII</td>
<td>American Standard Code for Information Interchange. ASCII is a standard code for representing characters as binary numbers. In addition to printable characters, ASCII code includes control characters.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>batch</td>
<td>A group of form templates that contains a batch header form to process descriptive information and regular scannable forms, such as student tests. Batch header forms are useful for collecting information about the group of forms that you are scanning (e.g., school, teacher and class name for a test).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>bubbles</td>
<td>A mark that can be either filled in or empty. Bubbles are arranged in rows and columns, creating a region that has an orientation.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>checkbox</td>
<td>A small square that can be selected or cleared. When selected, it contains an X.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>choose</td>
<td>The act of selecting an item by clicking on it or by using the appropriate key sequence.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>click</td>
<td>To quickly press and release the left mouse button.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>clipboard</td>
<td>Whenever you cut or copy a section of text, the contents are placed on the clipboard. This intermediary holds the information so that it can be pasted (multiple times if desired) until you place something new on the clipboard (by cutting or copying something else). The clipboard is also shared by other programs. Data can be copied from a document of one program and pasted to a document of another as long as the data are compatible (Remark Office OMR only uses plain text.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>copy</td>
<td>To place the selected text or item on the Windows...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
clipboard so that you can paste it into another location.

- **Ctrl** The Control key on your keyboard.
- **current** The window to which the next keystroke or command applies.
- **cut** To remove the selected text or item and place it on the Windows clipboard.
- **defaults** Pre-defined Remark Office OMR settings.
- **double click** Double click means to click the left mouse twice in succession.
- **drag** To move the mouse while holding down the left mouse button.
- **duplex** Two-sided. Some scanners support duplex mode in which the reader will scan both sides of a sheet of paper at the same time.
- **Esc** The Escape key on your keyboard.
- **exception cases** Portions of the data that do not contain valid entries and require cleaning, such as blanks, multiple responses, region recognition errors, barcode errors, Database Lookup errors and data entry Image regions.
- **extension** An extension consists of the letters following the period in a file name.
- **grid** A grid stores data from processed forms. Each template has its own specially sized and labeled grid.
- **form** The prepared page(s) that are intended to be hand marked. Forms can consist of one or multiple pages.
- **form template** A file that contains information that allows Remark Office OMR to correctly process the regions of a form.
- **format** The structure of a data file.
- **highlighted** Highlighted indicates that an item has been selected.
- **icon** A graphical representation of an application program.
- **label** Labels identify the responses for the markable areas. For example, “TRUE,” “FALSE,” and “MAYBE” are possible labels for a region with three choices. See the listing under OMR Region for more information.
**mark**  The term for the bubbles checkboxes or other shapes that are to be filled in with pen or pencil. A mark is either empty or filled in to designate the selected response.

**menu**  A list of commands appearing under an item on the menu bar.

**menu bar**  Located below the title bar, the horizontal bar containing menu pull-down items.

**node**  An element in the tree view in the Remark Office OMR Template Editor.

**OMR**  Optical Mark Reading or Recognition. A method of automated input of hand produced data into a computer. OMR differs from OCR in that block hand printed or machine printed data are processed by OCR and bubbles, checkboxes and other marked areas are processed by OMR.

**OMR region**  An OMR region consists of an area of a form where the questions contain similar attributes. More than one question can be asked in a specific OMR region. The following is an example:

<table>
<thead>
<tr>
<th></th>
<th>True</th>
<th>False</th>
<th>Maybe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question 1</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Question 2</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
</tbody>
</table>

The six bubbles make up one OMR region. The output labels for this region are True, False, and Maybe, and are oriented by row.

**orientation**  The orientation of an OMR region is either Column or Row, depending on how the marks are laid out on the form.

**ParadoxNetStyle**  The ParadoxNetStyle is the network access style to use when accessing Paradox data. Possible values are: 3.x and 4.x.

**Note:** Paradox 3.x users can't set this to 4.x or the driver will use the wrong locking method. Paradox 5.0 users must use the 4.x ParadoxNetStyle setting to
ensure proper locking behavior.

This entry should correspond to whatever version of Paradox the users in the group are using. It must be consistent for all users sharing a particular database (directory). If you indicate a ParadoxNetStyle, you must also specify a ParadoxUserName and a ParadoxNetPath or you will receive an error when trying to access external Paradox data. Consult your Paradox documentation for information on how to specify a different ParadoxNetStyle.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>paste</td>
<td>To insert the contents of the clipboard into the current cursor location.</td>
</tr>
<tr>
<td>path</td>
<td>A file location in a directory tree.</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory.</td>
</tr>
<tr>
<td>region</td>
<td>See OMR region.</td>
</tr>
<tr>
<td>region name</td>
<td>A name assigned to an OMR Region. If an OMR Region contains more than one question, Remark Office OMR will append numbers sequentially to the specified region names to provide a name for each question. Or you can specify individual region names in the OMR Regions Properties window. Region names are used as grid column headers in the template grid window. When saving data to databases, the column headers are used as the field names in the database table. If opening, linking or saving to an existing database table, the column headers must already exist in the selected table or an error will occur. Additionally, most databases have field name limitations. If you are planning on exporting to a particular database type, consult your database's documentation or Appendix B Understanding File Formats for region/field name limitations.</td>
</tr>
<tr>
<td>reorder</td>
<td>The operation of changing the order of the regions in a template. It is necessary when the reading operation does not produce data in the correct order.</td>
</tr>
<tr>
<td>scroll bars</td>
<td>Horizontal or vertically aligned bars that facilitate scrolling through displays.</td>
</tr>
<tr>
<td>status bar</td>
<td>Located at the bottom of a window, a status bar is the horizontal bar that displays pertinent information about</td>
</tr>
</tbody>
</table>
application processes or the currently selected item.

task pane  A guide to help you navigate through the software. The task pane appears on the left side of the Template Editor, Data Center and Remark Quick Stats. Once you perform a function, the task pane will automatically update with new options based on the last function you performed. You may use this tool as a way to understand what options are available to you at any time. Most options displayed in the task pane are also available from the menus or tool bar.

title bar  Located at the top of a window, a title bar is the horizontal bar that displays the window title.

tool tips  Remark Office OMR will display the function of a tool on the tool bar if you hold the mouse cursor over the desired tool. The functional displays are called Tool Tips.

tree view  The section of the Remark Office OMR Template Editor and Remark Quick Stats window containing the nodes representing the regions on the form. The tree view can be expanded and contracted by clicking the plus (+) or minus (-) on the left side of a node.

window  A rectangular portion of your screen in which a program executes. Normal window control allows you to move, resize, minimize, and maximize windows.
Index

A
Access File Format.................................269
  Field Name.........................................269
  Table Name .......................................269
Accessing
  Online Help ..........................................33
Add Region.............................................116
ADF ..........................................................38
Adjusting Region Borders ......................156
Advanced
  Reading Options ..................................194
  Region Options ....................................134
Analysis ..................................................245
  Tips ....................................................262
Analysis Respondent ID.........................137
Append Linked Region.....................32, 125
ASC ................................................276, 283
ASCII File Format...................................275
Auto Align .........................................32, 159
Auto Form ID ..................................145, 197
Auto Increment........................................129
Auto Page ID ........................................199

B
Barcodes ................................................102
  Errors ................................................187
  Regions ..............................................132
Batch Processing .................. 210, 306, 329
Binary Region.........................................119
Bit Depth.................................................256
Blank Responses ...........................139, 187
Boolean Region......................................118
Brightness ................................................38

C
CCI File Format......................................281
Cell
  Changing..............................................223
  Editing ................................................223
  Selecting .............................................222
Changing
  Data Cell Contents..............................223
  Clipboard................................................224
  Collate Mode .......................................180, 194
Configuring
  TWAIN Drivers.....................................41
Contacting
  Technical Support..............................14
Copy Special...........................................153
Copying
  Data ...................................................224
  Forms ................................................103
  Regions .............................................152
Correcting Output ..................................186
Create Page Elements..........................286
Creating
  Form Templates ..................................107
  Image Regions ......................................128
  New Form Template Images ....... 157
  OMR Region .........................................113
  Regions ..............................................111
  Response Scales ..................................161
CRS .......................................................277
Custom File Format .......................237, 283
Customer Assistance............ See Technical Support
Customizing
  Data Center ........................................249
  Template Editor ..................................167
Cutting
  Data ...................................................224

D
DAT ..................................................277, 281
Data
  Advanced Saving Options ............ 233
  Custom File Format ................... 237
  Opening .............................................241
  Overwriting ......................................196
  Printing .............................................240
  Remark Office Archive Format .... 235
  Saving ..............................................230
  Sorting ..............................................229
<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Center</td>
<td>249, 309</td>
</tr>
<tr>
<td>Data Entry Region</td>
<td>128</td>
</tr>
<tr>
<td>Data Grid</td>
<td>188, 299</td>
</tr>
<tr>
<td>Data Interchange Format</td>
<td>280</td>
</tr>
<tr>
<td>Data Type</td>
<td>169, 173, 175</td>
</tr>
<tr>
<td>Database</td>
<td></td>
</tr>
<tr>
<td>Opening</td>
<td>241</td>
</tr>
<tr>
<td>Saving</td>
<td>230</td>
</tr>
<tr>
<td>Database Lookup</td>
<td>149</td>
</tr>
<tr>
<td>Additional Return Fields</td>
<td>151</td>
</tr>
<tr>
<td>Errors</td>
<td>188</td>
</tr>
<tr>
<td>Respondent ID</td>
<td>151</td>
</tr>
<tr>
<td>Return Names</td>
<td>151</td>
</tr>
<tr>
<td>DB</td>
<td>278</td>
</tr>
<tr>
<td>dBase File Format</td>
<td>277</td>
</tr>
<tr>
<td>Field Name</td>
<td>277</td>
</tr>
<tr>
<td>DBF</td>
<td>277</td>
</tr>
<tr>
<td>Default Fill</td>
<td>129</td>
</tr>
<tr>
<td>Deleting</td>
<td></td>
</tr>
<tr>
<td>Data</td>
<td>224, 225</td>
</tr>
<tr>
<td>Grid Rows</td>
<td>226</td>
</tr>
<tr>
<td>Regions</td>
<td>155</td>
</tr>
<tr>
<td>Designing Forms</td>
<td>97</td>
</tr>
<tr>
<td>Detecting</td>
<td></td>
</tr>
<tr>
<td>Handwriting</td>
<td>129</td>
</tr>
<tr>
<td>Respondents</td>
<td>218</td>
</tr>
<tr>
<td>DIF</td>
<td>280</td>
</tr>
<tr>
<td>DPI</td>
<td>260</td>
</tr>
<tr>
<td>Drag/Drop</td>
<td>154</td>
</tr>
<tr>
<td>Drivers</td>
<td>36</td>
</tr>
<tr>
<td>TWAIN</td>
<td>42</td>
</tr>
<tr>
<td>Duplex</td>
<td>39</td>
</tr>
<tr>
<td>Forms</td>
<td>194</td>
</tr>
<tr>
<td>Duplicating</td>
<td></td>
</tr>
<tr>
<td>Forms</td>
<td>103</td>
</tr>
<tr>
<td>Regions</td>
<td>152</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Easy Grade</td>
<td>247</td>
</tr>
<tr>
<td>Easy Scan</td>
<td>183</td>
</tr>
<tr>
<td>Easy Survey</td>
<td>247</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>25</td>
</tr>
<tr>
<td>Editing</td>
<td></td>
</tr>
<tr>
<td>Cells</td>
<td>223</td>
</tr>
<tr>
<td>Data</td>
<td>222</td>
</tr>
<tr>
<td>Form Templates</td>
<td>107, 163</td>
</tr>
<tr>
<td>Regions</td>
<td>165</td>
</tr>
<tr>
<td>Response Scales</td>
<td>161</td>
</tr>
<tr>
<td>Template Grid</td>
<td>222</td>
</tr>
<tr>
<td>Enhanced Reading Mode</td>
<td>255</td>
</tr>
<tr>
<td>Error Messages</td>
<td></td>
</tr>
<tr>
<td>Understanding</td>
<td>313</td>
</tr>
<tr>
<td>Errors</td>
<td></td>
</tr>
<tr>
<td>3100</td>
<td>316</td>
</tr>
<tr>
<td>Recognition</td>
<td>187, 316</td>
</tr>
<tr>
<td>Exam Grading</td>
<td>247</td>
</tr>
<tr>
<td>Excel File Format</td>
<td>270</td>
</tr>
<tr>
<td>Field Name</td>
<td>270</td>
</tr>
<tr>
<td>Table Name</td>
<td>270</td>
</tr>
<tr>
<td>Exception Cases</td>
<td></td>
</tr>
<tr>
<td>Barcode Errors</td>
<td>187</td>
</tr>
<tr>
<td>Blank Responses</td>
<td>187</td>
</tr>
<tr>
<td>Database Errors</td>
<td>188</td>
</tr>
<tr>
<td>Form Errors</td>
<td>187</td>
</tr>
<tr>
<td>Image Regions</td>
<td>188</td>
</tr>
<tr>
<td>Multiple Responses</td>
<td>187</td>
</tr>
<tr>
<td>Exception Handling</td>
<td></td>
</tr>
<tr>
<td>Blanks/Mults</td>
<td>139</td>
</tr>
<tr>
<td>Exiting</td>
<td></td>
</tr>
<tr>
<td>Remark Office OMR</td>
<td>17</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>File Formats</td>
<td></td>
</tr>
<tr>
<td>Access</td>
<td>269</td>
</tr>
<tr>
<td>ASCII</td>
<td>275</td>
</tr>
<tr>
<td>CCI Assessment</td>
<td>281</td>
</tr>
<tr>
<td>Custom</td>
<td>283</td>
</tr>
<tr>
<td>Data Interchange Format</td>
<td>280</td>
</tr>
<tr>
<td>dBase</td>
<td>277</td>
</tr>
<tr>
<td>Excel</td>
<td>270</td>
</tr>
<tr>
<td>HTML</td>
<td>282</td>
</tr>
<tr>
<td>Lotus</td>
<td>279</td>
</tr>
<tr>
<td>LXR Test</td>
<td>280</td>
</tr>
<tr>
<td>ODBC</td>
<td>282</td>
</tr>
<tr>
<td>Paradox</td>
<td>278</td>
</tr>
<tr>
<td>Questionmark</td>
<td>270</td>
</tr>
<tr>
<td>Remark</td>
<td>267</td>
</tr>
<tr>
<td>Remark Office Archive</td>
<td>268</td>
</tr>
<tr>
<td>Report</td>
<td>280</td>
</tr>
<tr>
<td>Spreadsheet</td>
<td>276</td>
</tr>
<tr>
<td>SPSS</td>
<td>272</td>
</tr>
<tr>
<td>O</td>
<td>ODBC File Format .................................. 282</td>
</tr>
<tr>
<td>---</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>OMR Region ......................................... 114</td>
</tr>
<tr>
<td>OMR Region Types</td>
<td>Add ................................................. 116</td>
</tr>
<tr>
<td></td>
<td>Binary .............................................. 119</td>
</tr>
<tr>
<td></td>
<td>Boolean ............................................. 118</td>
</tr>
<tr>
<td></td>
<td>Grid .................................................. 115</td>
</tr>
<tr>
<td></td>
<td>List .................................................. 116</td>
</tr>
<tr>
<td></td>
<td>Multiple ........................................... 114</td>
</tr>
<tr>
<td>OMR Regions</td>
<td>Colors ................................................. 127</td>
</tr>
<tr>
<td></td>
<td>Creating ............................................. 113</td>
</tr>
<tr>
<td></td>
<td>Defining ............................................. 121</td>
</tr>
<tr>
<td></td>
<td>Linking .............................................. 125</td>
</tr>
<tr>
<td></td>
<td>Orientation ......................................... 120, 122</td>
</tr>
<tr>
<td></td>
<td>Types ................................................ 121</td>
</tr>
<tr>
<td>Opening</td>
<td>Data .................................................... 241</td>
</tr>
<tr>
<td></td>
<td>Form Templates ...................................... 177</td>
</tr>
<tr>
<td>Orientation</td>
<td>Region ............................................... 120</td>
</tr>
<tr>
<td></td>
<td>Overview ............................................ 9</td>
</tr>
<tr>
<td>Overwriting Data</td>
<td>.................................................. 196</td>
</tr>
<tr>
<td>P</td>
<td>Page IDs .............................................. 147, 199</td>
</tr>
<tr>
<td></td>
<td>Page Menu ............................................ 31</td>
</tr>
<tr>
<td>Paradox File Format</td>
<td>.............................................. 278</td>
</tr>
<tr>
<td></td>
<td>Field Names ......................................... 278</td>
</tr>
<tr>
<td></td>
<td>Index .................................................. 278</td>
</tr>
<tr>
<td></td>
<td>Table Name ......................................... 278</td>
</tr>
<tr>
<td>Paste Special</td>
<td>.................................................. 153</td>
</tr>
<tr>
<td>Pasting</td>
<td>Data .................................................... 224</td>
</tr>
<tr>
<td>PDF</td>
<td>.................................................. 256</td>
</tr>
<tr>
<td>Preface</td>
<td>.................................................. 9</td>
</tr>
<tr>
<td>Preferences</td>
<td>Data Center ........................................ 249, 309</td>
</tr>
<tr>
<td></td>
<td>Template Editor ..................................... 167, 295</td>
</tr>
<tr>
<td>Printing</td>
<td>Data .................................................... 240</td>
</tr>
<tr>
<td>Processing</td>
<td>Image Files ........................................ 184</td>
</tr>
<tr>
<td>Q</td>
<td>QSF ................................................... 270</td>
</tr>
<tr>
<td>Question Names</td>
<td>.............................................. 142</td>
</tr>
<tr>
<td>Question Text</td>
<td>.............................................. 142</td>
</tr>
<tr>
<td>Questionmark File Format</td>
<td>.............................................. 270</td>
</tr>
<tr>
<td>R</td>
<td>Read Wizard ......................................... 179, 300</td>
</tr>
<tr>
<td>Reading</td>
<td>Advanced Options .................................. 194</td>
</tr>
<tr>
<td></td>
<td>Forms .................................................. 177, 179</td>
</tr>
<tr>
<td></td>
<td>Image Files ......................................... 184</td>
</tr>
<tr>
<td></td>
<td>Recognition Threshold ............................. 138, 255</td>
</tr>
<tr>
<td></td>
<td>Record Length ....................................... 280</td>
</tr>
<tr>
<td></td>
<td>Redo .................................................. 155</td>
</tr>
<tr>
<td></td>
<td>Region Item Properties ............................ 134</td>
</tr>
<tr>
<td></td>
<td>Region Menu ......................................... 31</td>
</tr>
<tr>
<td>Region Properties</td>
<td>Analysis Respondent ID ............................ 137</td>
</tr>
<tr>
<td></td>
<td>Auto Form ID ......................................... 145</td>
</tr>
<tr>
<td></td>
<td>Database Lookup .................................... 149</td>
</tr>
<tr>
<td></td>
<td>ID Regions ........................................... 145</td>
</tr>
<tr>
<td></td>
<td>Page IDs .............................................. 147</td>
</tr>
<tr>
<td></td>
<td>Question Text ........................................ 142</td>
</tr>
<tr>
<td></td>
<td>Recognition Threshold ............................. 138</td>
</tr>
<tr>
<td></td>
<td>Region Names ....................................... 142</td>
</tr>
<tr>
<td></td>
<td>Required Items .................................... 141</td>
</tr>
<tr>
<td></td>
<td>Respondent Tracker ................................. 148</td>
</tr>
<tr>
<td></td>
<td>Survey Settings ..................................... 136</td>
</tr>
<tr>
<td></td>
<td>Test Settings ....................................... 134</td>
</tr>
<tr>
<td>Regions</td>
<td>Advanced Options .................................. 134</td>
</tr>
<tr>
<td></td>
<td>Barcode ............................................... 132</td>
</tr>
<tr>
<td></td>
<td>Borders ............................................... 156</td>
</tr>
<tr>
<td></td>
<td>Copying ............................................... 152</td>
</tr>
<tr>
<td></td>
<td>Creating ............................................. 111</td>
</tr>
<tr>
<td></td>
<td>Data Type ............................................ 169, 173, 175</td>
</tr>
<tr>
<td></td>
<td>Deleting ............................................. 155</td>
</tr>
<tr>
<td></td>
<td>Editing ............................................... 165</td>
</tr>
<tr>
<td></td>
<td>Image .................................................. 128</td>
</tr>
<tr>
<td></td>
<td>OMR Types ............................................ 114</td>
</tr>
<tr>
<td></td>
<td>Positioning ......................................... 156</td>
</tr>
<tr>
<td>Remark File Format</td>
<td>.............................................. 267</td>
</tr>
<tr>
<td>Remark Office Archive File Format</td>
<td>235, 268</td>
</tr>
<tr>
<td>Remark Office OMR</td>
<td>Customizing ........................................ 249</td>
</tr>
<tr>
<td></td>
<td>Edit Menu ............................................ 25</td>
</tr>
<tr>
<td></td>
<td>Exiting ............................................... 17</td>
</tr>
<tr>
<td>Index</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>Review Exceptions</td>
<td>186</td>
</tr>
<tr>
<td>Server Mode</td>
<td>212</td>
</tr>
<tr>
<td>Spell Check</td>
<td>160</td>
</tr>
<tr>
<td>Template Editor</td>
<td>108</td>
</tr>
<tr>
<td>Unrecognized Images Utility</td>
<td>204</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Values</td>
<td>122</td>
</tr>
<tr>
<td>View Menu</td>
<td>28</td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Template Editor</td>
<td>285</td>
</tr>
<tr>
<td>WK*</td>
<td>279</td>
</tr>
<tr>
<td>X</td>
<td></td>
</tr>
<tr>
<td>XLS</td>
<td>270</td>
</tr>
<tr>
<td>XML File Format</td>
<td>281</td>
</tr>
</tbody>
</table>
If you want to gather information from the Internet quickly and easy, Remark Web Survey is the solution for you! With Remark Web Survey® you can create online surveys, evaluations, tests, assessments, registrations and more without knowing any HTML. Remark Web Survey is the perfect companion for Remark Office OMR. One click of a mouse button will convert a Remark Office OMR form template into a web survey. You can distribute paper and web based forms, collect the corresponding data in Remark Office OMR and Remark Web Survey and then use Remark Quick Stats to do a combined analysis. Contact us today for more information.